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Copyright 
This documentation is protected by law. All rights, especially the right of duplication, 
circulation, and translation are reserved. 

No part of this publication may be reproduced in form of copies, microfilms or other 
processes, or transmitted into a language used for machines, especially data 
processing machines, without the express written consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. Errors in 
and changes to the contents as well as program modifications reserved. 

Copyright © Xara Group Ltd., 1994 – 2012. All rights reserved. 
Xara is a registered trademark of Xara Group Ltd. 
Xara Group Ltd. is an affiliate company of MAGIX AG. 
MAGIX is a registered trademark of MAGIX AG. 

Other mentioned product names may be registered trademarks of the respective 
manufacturer. 

This product uses MAGIX patent pending technology. 

Xara is a registered trademark of Xara Group Ltd. 

Xara Group Ltd. is an affiliate company of MAGIX AG. 

MAGIX is a registered trademark of MAGIX AG.  

Other mentioned product names may be registered trademarks of the respective 
manufacturer. 

PANTONE® Colors displayed here may not match PANTONE-identified standards. 
Consult current PANTONE Color Publications for accurate color. PANTONE® and 
other Pantone, Inc. trademarks are the property of Pantone, Inc. ©Pantone, Inc., 2012. 

Pantone, Inc. is the copyright owner of color data and/or software which are licensed 
to MAGIX Software GmbH to distribute for use only in combination with MAGIX 
Page & Layout Designer 2013. PANTONE Color Data and/or Software shall not be 
copied onto another disk or into memory unless as part of the execution of MAGIX 
Page & Layout Designer 2013. 
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Introduction to MAGIX Page & Layout 
Designer 2013 

 

Welcome to MAGIX Page & Layout Designer 
2013 
MAGIX Page & Layout Designer 2013 is the ideal solution for creating a successful 
business image. You can design your own company logo, create marketing and 
advertising material, and present your business in the best possible light. This 
program makes it simple to impressively market your products or services using 
flyers, posters, brochures, newsletters and more. Professional templates help you get 
amazing results in no time and can be easily customized to fit your own unique image. 
Enjoy the advantages of this flexible software solution for layout and print and save 
time, effort and money in the process. 

MAGIX Page & Layout Designer 2013 contains a vast selection of high-quality, 
customizable design templates for the perfect business image: business cards, 
stationery, invitations, menus, appointment cards and much more. With the program 
you can make your own affordable advertising material: flyers, posters, brochures, 
coupons, create sales-boosting media for successful e-commerce like sales mailings, 
PDF documents or  add company logos and lettering to promotional material: e.g 
cups, pens, keychains etc. It's easy to do it all yourself and save money. To do this, no 
previous experience is required! 
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All functions are on one screen: Quick layout design, convenient text and image 
editing tools and print-ready proofs are all at your fingertips. 

Features 
• Comprehensive template catalog with license-free designs for all your business 

needs: Business documents, presentations and much more. 
• Quick formatting of text blocks and large amounts of text: Format your headers, 

text blocks or footnotes and easily transfer the formatting to other texts. A 
uniform design doesn't get any easier! 

• Includes text flow around shapes and images, multilingual spell check, 
expandable user dictionary, support for all installed fonts with a live preview as 
well as a find and replace function. 

• Magic Snap (quick arrange): Arranging elements of all kinds (photos, graphics, 
text, etc.) with absolute precision is now even easier and faster. 

• Create company logos, extract images and enjoy the advantages of integrated 
photo editing. 

• Complete PDF workflow from input to creation and output. 
• Galleries for a better overview: Flexible organization and full control thanks to the 

Page & Layer gallery and the Bitmap Gallery displays all of the graphics that have 
already been used. It's the ideal feature for multipage documents. 

• Complete file support for all standard formats: Easy import of text files, graphics 
and photos. 

• Print-ready output: High-quality output thanks to PDF/X, support of CMYK and 
PANTONE color separation, spot colors, print color scale previews and much 
more. 

Page & Layout Designer terminology 
This section describes some of the terminology used in Page & Layout Designer. 

Document 
You can think of a document as a conventional sheet of paper (or a couple of it). Like 
a sheet of paper, you can draw lines and curves, place objects like shapes, cliparts and 
photos and write text (and erase them later). You can save the document for later use 
by storing it on disk or printing it. 

Page 
This is the white area in the document. You can place objects on the page margin, on 
the page, or overlapping both. However, only objects on the page are printed. A 
document can contain one or several single pages or double page spreads. A double 
page is like two separate sheets of paper placed next to each other. 
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Lines, shapes, and objects 

 

These are all lines 

A line can be straight, curved or a mixture 
of both. A line must have a start and an 
end, thus it is always open. You can apply 
a thickness and color to a line. 

 

These are all shapes 

A shape is a solid or closed object. The 
difference between a line and a shape is 
that a shape has no start or end. Because 
a shape is a closed object, you can fill it 
with a color or leave it empty with no 
color. You can apply a thickness and color 
to the line around the shape. 

In postscript terminology, a shape is a closed path. Page & Layout Designer 
sometimes uses "shape" as shorthand for "line or shape". 

 

These are all objects 

Object is a general term. This manual 
uses it where the same information 
applies to lines, shapes, bitmaps and 
text. For example, moving a line is 
exactly the same as moving a shape, 
moving a bitmap or moving text. 

Many operations in Page & Layout Designer apply equally to a single object or a 
collection of objects. "Object" can refer both to one object and to several objects. 

Attributes are the characteristics of objects such as line width and pattern, colors and 
so on. 

Bars 
There are three types of bars: the MAIN TOOLBAR, the INFOBAR, and then various other 
button bars which are sometimes just referred to as control bars, e.g. the GALLERY 
button bar. 

Attributes 
The various characteristics that define the appearance of objects on the page, such as 
color, line width, fill style etc are all called ATTRIBUTES of the object. 

The Attributes of objects can be copied and pasted between different objects using 
the Paste Attributes (on page 128) menu command. 
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Getting Help 
If you need some help using this program, here are some sources of information that 
may be of use: 

• Program help - Choose "MAGIX PAGE & LAYOUT DESIGNER 2013 HELP" from the 
"HELP" menu to open MAGIX Page & Layout Designer 2013 Help (containing 
hundreds of pages of information).  

• Status bar - Try reading the text on the status bar at the bottom of the main 
MAGIX Page & Layout Designer 2013 window. It always describes what actions 
are currently possible and what they will do (even during drags), and helps you 
learn to use the MAGIX Page & Layout Designer 2013 tools. It also gives details 
of what buttons and controls do as you move the pointer over them. See Status 
Bar for more details.  

• ToolTips - If you hold the mouse pointer over a button or control for a short 
while, then small message appears telling you what it does.  

• Menus - If you want to know what a menu item does, highlight it and press "F1". 
• Dialog boxes - If you want to know what a dialog box does or how to use it, click 

HELP.  
• Movies - Use the menu option "HELP" > "MOVIES".  



 

Getting Help 15  

 

Support 
Dear MAGIX customer, 

Our aim is to provide convenient, fast and solution-focused support at all times. To 
this end, we offer a wide range of services: 

• Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration on www.xara.com 

• The online community - on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 120,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials and 
a discussion forum. The multiple experts, found round-the-clock on 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

• Email support for MAGIX products:  
For every new MAGIX product you will receive, as of date purchase, 12 months of 
email based customer service. 
Premium email support: 
For priority support, or if you want the MAGIX support team to help with non-
MAGIX related harware problems you can purchase an Premium email support 
ticket. The ticket is for a specific problem, and is valid until it is solved, it is not 
restricted to an email. 

Please note: To be able to use the Premium email support and free product email 
support via the Internet, you have to register your MAGIX product using the serial 
number provided. This can be found on the CD case of your installation CD or on the 
inside of the DVD box. 

• Additional telephone service: 
Besides the large number of free customer service offers, we also offer a fee-
based telephone customer service available to customers that have purchased 
from Magix. Here you can find a summary of our technical support telephone 
numbers: 

http://support.magix.net (on page 218)/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 
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Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  
Denmark: 699 18149  
Sweden: 0852500858  
Finland: 09 31581630 
Norway: 0210 30665 

North America 
9 am to 4 pm EST Mon-Fri 
Phone: 1-305-722-5810  

Document info 
"FILE -> DOCUMENT INFO" displays information about the selected document such as 
its size and any fonts or plug-ins used. This is a good way to find out if you are 
missing a required font or plug-in that could prevent the document from displaying 
correctly. 

Anything you type into the comment field is stored as part of the file. This comment is 
displayed whenever you display the document info dialog box. 
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About MAGIX Page & Layout Designer 2013 
Choose "HELP" > "ABOUT MAGIX PAGE & LAYOUT DESIGNER 2013". This displays general 
information about the program. If you contact the support, you may be asked for this 
information. 

Tooltips 

 

When you move over a button, the tooltip tells you the 
function of the button. 
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Getting Started 
This section gives an overview of the main functionality of Page & Layout Designer. 
Later sections go into more detail about each tool. 

Program Layout 

 

 Info Bar - changes with each tool 

 Zoom 

 Designs Gallery 

 Page & Layer Gallery 

 Selector Tool 

 Photo Editing Tool 

 Drawing tools 

 Text Tool 

 Shadow Tool 

 Color line 

 Tabs for all open documents - icon identifies document type. 
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Objects On The Page 
Whether you customize a template or create your own graphics from scratch, you 
can rotate, resize and position anything on the page, anywhere you like. You can 
easily resize the page to be any required size and add new pages as required. Certain 
features, such as changing color schemes, work across all pages simultaneously. 

These are the basic types of page element: 

• Text: Using the TEXT TOOL you can create anything from single word headings to 
columns of text or even blocks of text that flow from one block into another. You 
can also create bulleted or numbered lists. The TEXT TOOL InfoBar provides 
controls over the font, size, line spacing and more. You can resize text either by 
using the SELECTOR TOOL or by selecting the text in the usual fashion and 
choosing alternative point or pixel sizes. Perhaps surprisingly you can even rotate 
text by any angle, and by using REPEL TEXT UNDER (right click an object to see this 
option) you can automatically flow text around objects on the page, such as 
photos.   

• Graphics: Any type of logo or heading on your page is graphic. Page & Layout 
Designer is a vector graphics program which means you can edit the shape, 
rotate and resize your graphic objects with no loss of quality (unlike pixel photo 
editing tools such as Photoshop). 

• Photos: You can drag and drop photos directly from your camera or File Explorer 
window onto the page, rotate, enhance and crop it. Replacing existing photos in 
templates is as easy as drag and drop - and you can alter the size and angle of 
photos 'inside' their frame very easily. 

Object Based Design 
All the types of elements are collectively referred to as objects. 

One of the unique benefits of Page & Layout Designer is that you have complete 
freedom to place any object anywhere on the page, and your document will faithfully 
reproduce this. 

 
The SELECTOR TOOL can be used to select any object on the page, and to move 
(just drag it), resize and rotate the objects. 

You can adjust the stacking order (that is whether an object appears in front or 
behind others on the page) using the ARRANGE menu options or right click and choose 
ARRANGE. With the SELECTOR TOOL you can resize objects by dragging on the corner 
resize handles. You can rotate any object by dragging just inside the corner selection 
handles. 

 
To add some text to your design, select the TEXT TOOL and click anywhere on 
the page and start typing.  
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You can also create text columns, by clicking and dragging horizontally in the Text 
Tool, or text boxes by dragging horizontally. See the Text section (on page 36) below 
for more details and the Chapter Text Handling (on page 178) for a complete 
reference of text functions of MAGIX Page & Layout Designer 2013 

 

 

You can use the drawing tools to create rectangles, rounded 
rectangles, circles and ellipses, and just about any shape you like 
using the SHAPE EDITOR TOOL. See the Drawing tools section for 
more detail.  

 

 

Stacking Order 
All objects on the page are placed one on top of another. The most recently drawn or 
created object is always on top, that is, in front of any others. You can adjust the 
stacking position by right clicking and choosing ARRANGE or using the ARRANGE menu 
options. 

For example, when you draw a new rectangle it always appears to cover all the 
objects behind it. By right clicking and choosing ARRANGE or pressing "Ctrl + B" (or the 
menu "ARRANGE" > "PUT TO BACK") the object is moved behind everything 
else. Similarly "Ctrl + F" brings any selected object to the top, that is, in front of 
everything else. 

There is an added complication: layers. All objects are collected into named layers, 
and each layer can be turned on or off to show or hide everything on that layer. See 
the Layers section for more detail. 

The PAGE  & LAYER GALLERY allows you to easily see and adjust the stacking order of 
objects and layers. Objects are listed in order from front to back in the gallery. See 
Page & Layer Gallery (on page 149) for details. 

Drawing Tools 

 

 

Page & Layout Designer provides all the graphics tools you need to create just about 
any graphical object on your page, as well as a range of pre-designed graphical 
elements in the Designs Gallery. There are several basic drawing tools that let you 
create rectangles, ellipses, regular polygons stars or any shape you like.  
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Page & Layout Designer provides vector drawing tools, which means you can resize, 
edit the outline shape and re-color with no loss of quality. You can zoom in to see 
almost infinite detail, and all edits can be undone. For details on drawing 
rectangles/squares, circles/ellipses and other shapes, see Drawing Lines and Shapes 
and Shape Handling. 

 
The SHAPE EDITOR TOOL  allows you to create detailed vector based shapes, 
and also to edit the outline of any shape. 

Refer to the section "THE SHAPE EDITOR TOOL" (on page 83) to learn how to use this 
very powerful tool. 

 
The STRAIGHT LINE & ARROW TOOL adds arrow heads and tails to any type of 
line as well as drawing single lines. 

 
Shapes are an important part of any drawing, the other essential element 
that we’ve ignored until now is freehand drawing. Click on the FREEHAND & 
BRUSH TOOL. See the FREEHAND & BRUSH TOOL (ON PAGE 78) for more 
information. 

 

Current attributes 
An ‘attribute’ is some characteristic of an object which you can modify in MAGIX 
Page & Layout Designer 2013. For example a shape’s attributes include its color, its 
outline width and its outline color.  

As mentioned above you can change the attributes of an object after you’ve drawn it, 
by selecting it and then changing its fill color, line width, or any of its other attributes. 
But MAGIX Page & Layout Designer 2013 also keeps track of the ‘current’ attributes, 
which are the attributes that get applied to newly drawn objects as they are created. 

Setting current attributes manually 
If, for example, you want the next rectangle you draw to be red, make sure you have 
nothing selected (press "Esc" or click an empty part of the page) and then click red on 
the color line. You’ve now set the current fill color attribute to red. Now when you 
draw a new shape, it will be filled red. You can set other current attributes the same 
way – by first making sure nothing is selected before changing the attribute’s value.  

Setting current attributes automatically 
By default, MAGIX Page & Layout Designer 2013 automatically updates the current 
attributes for you, to match the object you last drew, or last selected. So for example if 
you draw a rectangle and then make it green, the next shape you draw will also be 
green. If you have a blue rectangle in your design and you wish to draw another one 
just like it, first select the blue rectangle (this makes its attributes current) and then 
the next shape you draw will also be blue. So by simply clicking an object, you set the 
current attributes to match that object. 
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This allows you to use existing objects as a ‘palette’ of available styles. Click an object 
to select it, then draw new objects in that style. 

You can turn off this behavior in the GENERAL TAB (on page 346) of the "UTILITIES" > 
"OPTIONS" dialog. Select the GIVE NEW OBJECTS MOST RECENT ATTRIBUTES checkbox. 
Now the current attributes will only change when you set them manually, as 
described above. 

Attribute groups 
Many designs consist of a combination of closed filled shapes and open shapes (lines 
where the start and end points are not coincident). Normally it wouldn’t be desirable 
to have the attributes of an open shape used for a closed shape, nor vice-versa. 
Therefore the attributes for open and closed shapes are kept separate – these are 
known as attribute groups. Setting the values of one group does not affect the other 
group. So for example, selecting a filled rectangle with no outline will not change the 
current line width to zero for open shapes. 

For the same reasons, text attributes make up a third attribute group. The text 
attribute group is only set when you select text objects, or when you set the attributes 
manually while in the text tool. 

Exempt attributes 
Some attributes do not get set as current automatically even when ‘Give new objects 
most recent attributes’ is on. This is because some attributes can cause problems if 
they become current.  

For example if you applied a 10 pixel feather to a large object (to blur the edges) and 
then drew a new 10 pixel sized shape, that new shape would be invisible if the feather 
attribute was copied to it, due to the amount of feathering!  

Other attributes can adversely affect the way designs export, or significantly increase 
the time taken to render the design and so should not be applied unnecessarily. 

Examples of attributes which are copied automatically: 

• Fill colors, fill styles, line width, line color, line style, line join style, line endcap 
style, arrow heads/tails, text font, text font size, text margins. 

Examples of attributes which are not copied automatically: 

• Feather, transparency, shadow, bevel, contour, 3D extrude, live effects. 

Resetting current attributes 
You can reset all current attribute groups instantly by pressing "Esc" when you have 
no objects selected. If you have objects selected, pressing "Esc" clears the selection, 
so just press "Esc" again to reset the current attributes back to their default values. 
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Fill Tool 

 
You can easily put a graduated color fill onto a shape using this tool 
(and a lot more besides). Select the tool and just drag across your 
object. 

The fill arrow can be adjusted by dragging the ends to alter the direction, angle and 
extent of the graduation.  

  

Rounded rectangle with a graduated fill. 

Note: If you drag with the FILL TOOL across a grouped item, such as a text panel, 
then everything in the group takes on the same fill style. To overcome this you must 
first select just the item you want to fill. You can do this several ways. A single click 
on the item with the FILL TOOL will select just that item, as will a click in the 
SELECTOR TOOL with the "Ctrl" key pressed (this is called 'select inside' because it 
selects just the one item inside the group).  Now when you drag it will fill only the 
selected object. 

To edit the start or color of the fill just drag and drop a color from the color line onto 
the shape, or you can select the end of the Fill Arrow in the FILL TOOL and use the 
Color Editor ("Ctrl + E"). 

You can create a multi-stage graduated fill by making sure the fill arrow is visible 
(select it with the FILL TOOL), now just drag a color from the Color Line and carefully 
drop it on the arrow line where you want the new color. You can now drag this fill 
point, or select "Ctrl + E" to adjust the color using the Color Editor. There are different 
fill styles, for example this is a circle with a circular fill. 

 

The shadow is another ellipse with a graduated color fill and feathered (see below). 
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Transparency Tool 

 

You can adjust the transparency of any graphic or photo to make it see-through. More 
than this, Page & Layout Designer supports graduated transparency. It works very like 
the graduated color fill. In the Transparency tool just drag across your shape and you 
can see the transparency fades.  You can adjust the degree of transparency of each 
end of the fill arrow, by clicking on either end of the arrow, and adjusting the 
Transparency slider. See Transparency (on page 222) for more information. 

Feather 
This is a graphical term for blending the edges of objects. Page & Layout Designer 
provides a feather control that enables any object, graphics, text or photo to be 
feathered - giving it a blurred edge that blends with the background. The Feather 
control is not a tool on the left, but one of the controls on the top bar. Try it on your 
rectangle shape. Select the shape and then click this Feather control on the right of 
the top bar. 

 

The shadow below the ball drawing above has a feathered edge. Combining all of 
these controls you can very quickly produce amazing layered graphics for your design, 
all directly in Page & Layout Designer without needing any other graphics tools. 

This is an example of a rounded rectangle with 
grad color, grad transparency and feathered 
edges with some text placed on top of it. 

This has a graduated color fill, light to dark green 
going left to right. It also has a vertical graduated 
transparency fading from top to bottom. The 
feather gives it a soft edge. It takes a couple of 
seconds to create such an image, and it's 
automatically converted to the right graphic 
when you save your design. 

 

Shadow Tool 
A very popular graphics effect is to create a soft drop-shadow under a graphic or 
some text. This serves to lift the object away from the background.  
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The SHADOW TOOL lets you add a soft shadow to any object, text, graphics or 
photo. Select the SHADOW TOOL and just drag on the object. You can adjust the 
shadow blur and transparency using InfoBar controls. 

 

Some text with a soft shadow.  

To adjust the position of an existing shadow, go into the SHADOW TOOL and drag on 
the shadow. 

Example Graphics 

 

This button combines many of the features described above - it's drawn by combining 
just a few feathered shapes, and using graduated transparency (the white reflection 
effect). The text has a slight soft shadow and the button has a glow shadow. The 
whole thing is grouped.  (You do not need to draw this button as it's provided in the 
Button category of the DESIGNS GALLERY). 

The huge benefit of vector graphics, compared to 'bitmap' graphics created in pixel 
editing software such Photoshop, is that you can re-color, edit, rotate, and resize the 
button with no loss of quality. Make it huge and it remains pin sharp: 

 

On top of that you can re-color using the Named Color system, and it will even 
stretch as required - everything in Page & Layout Designer remains non-destructive 
(which means you can always edit it, with no loss of quality). 

 

Something that would take skill and time to produce using alternative graphics 
software, is trivially easy in Page & Layout Designer. 
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The Selector Tool 

 
This tool is a general purpose tool that allows you to select, move, resize and 
rotate all objects on your page. 

You can do all these things by just dragging on the objects on the page, or on the 
selection handles around the object, or you can enter precise numeric values. The 
selected object is shown with  8 handles around the outside, and the status line at the 
bottom of the screen also tells you what is selected. 

 

Drag on any corner handle to resize an object. Drag just inside the corner handles to rotate.  

Nudging Objects 
The arrow keys can be used to nudge the selected object, one pixel at a time. If you 
hold "Shift", it nudges objects 10 pixels at a time. 

Rotating Objects 
There are two ways to rotate an object. Either click on the object a second time, so 
the selection handles change to show rotation handles, which you can then drag on to 
rotate the object. Or, when it's showing the square selection handles, move the 
mouse pointer just inside the corner handles until you see the mouse pointer change 
to a rotation indicator - you can then also drag to rotate the selected object. 

Unusually you can rotate just about anything in Page & Layout Designer, including 
photos, headings, even blocks of text. 

InfoBar 
When an object is selected, the InfoBar - just above your document - shows all the 
relevant controls for the current tool.  This bar changes depending on which tool is 
selected. This is the InfoBar in the SELECTOR TOOL: 

 

The InfoBar, just above your document, shows controls for the selected tool. 
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You can enter numeric values into any field. e.g. to reduce the size of an object by 
20% you can enter 80% into the W field (which is a % size). The little padlock 
selects whether both the width and height change together. 

Copying Objects 
You can use the usual "EDIT" > "COPY" ("Ctrl + C") and "EDIT" > "PASTE" ("Ctrl + V") 
options or right click an object and choose COPY, but a really quick way to copy any 
item is drag on it with the right mouse button. 

You can also copy and paste a page anywhere in your document from the current 
document or another document – see Copying and pasting (on page 52) pages. 

Right-click menus 
When you right-click any object in the MAGIX Page & Layout Designer 2013 
workspace, a drop-down menu lists useful operations that are relevant to the object 
clicked on. For example, if you right-click a rectangle you've drawn previously, the 
drop-down menu allows you to perform actions only relevant to a rectangle. 

If you right-click a photo, however, some of the menu options that appear apply only 
to photos, while others are similar to the actions you can perform on a rectangle. The 
object-specific operations are listed towards the top of the right-click menu's list, e.g., 
in the case of a rectangle the first three actions above apply only to rectangles. 

You can also right click both the page and pasteboard to see a menu of page- and 
pasteboard-related operations you can apply.  

If you select more than one object and right-click, the menu lists actions specific to 
multiple objects, such as group, align and combine, as well as the common operations 
such as cut, copy and delete. Similarly if you right-click objects that you have 
previously grouped, actions specific to a group are displayed.  

It's recommended that you right-click any object or multiple objects in the workspace 
to access the menu specific to those objects. Once you've done this a few times you 
will know which actions you can quickly perform with right-click menus.  

Using Templates & Clipart 

 Open the Designs Gallery by clicking the DESIGNS GALLERY tab in the Galleries 
bar (or use "FILE" > "NEW FROM DESIGNS GALLERY"). 

This shows folders containing collections of template designs and clipart. Browse 
through the folders and double click to open any file as a new document or drag and 
drop designs and widgets onto your page.  
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The Designs Gallery 
The Designs Gallery contains thousands of professionally designed graphics and 
templates. This includes small pieces of graphical ‘clipart’ you can drag onto any page 
design, whole page templates or complete multi-page templates for newspapers, 
flyers, brochures, calendars, etc. 

Opening the Gallery 
By default the Designs Gallery is available as a flyout near the top right corner of the 
MAGIX Page & Layout Designer 2013 window. Just hold your mouse pointer over the 
"DESIGNS GALLERY" tab to make it appear. When you move the mouse pointer away it 
closes again, or you can make it stay open by ‘docking it’ by clicking the ‘pin’ icon at 
the top of the gallery. 

Or choose "FILE" > "NEW FROM DESIGNS GALLERY". 

 

See Document Handling (on page ) for more information on using galleries generally. 

Gallery folders 
If you are online, the gallery is automatically updated with any available new and 
modified content each time you start the program.  
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To open a folder in the gallery, click the folder icon, or double click on the folder name. 
To open a design as a new document, double click on the design thumbnail. To import 
a design into your current open document, drag it from the gallery onto your page. If 
it’s a whole page template, a new page will be added to your document, after the 
currently selected page. 

If you are running a trial version of the program, folders shown in red can be 
previewed only (that is, you can view the design thumbnails inside these folders, but 
not open or import the designs). When you purchase the program online ALL the 
contents of red folders become immediately available to you and the folders turn blue 
to indicate this.  

If you are running the full unlocked program, you may see additional red folders 
appear at the bottom of the gallery. These are additionally available folders of designs 
that you can preview and then use immediately when you buy online. Double click on 
an item in a red folder to see purchase options. Additional content  that you have 
already purchased appears in blue folders, just as the main gallery content does. 

You can also right-click on a thumbnail and choose IMPORT TO NEW PAGE to force any 
design to be imported onto a new page in your document. The gallery also contains 
color scheme files, which allow you to change the color of your design (drag and drop 
onto your page, or just double click to apply the scheme). 

Adding New Pages To Your Document 
You can drag any template design from the DESIGNS GALLERY onto your page. If this is 
a page template, it will add a new page to your document, after first asking if you 
want to match any color changes. If you drag a clipart item, heading or photo object, 
this gets added onto the page where you dropped it, and again you will be asked if you 
want to match any color changes you've made. 

Your imported graphic is just another object on the page, and can be re-positioned, 
resized and rotated using the Selector tool as usual. 

  
To add a new page of the same design, the easiest way is to use the duplicate 
page option in the page flyout bar on the top bar. 

Or use the option under the EDIT > PAGES menus. This replicates the current page 
below. You can then just delete or edit the elements as required. You can add a new 
blank page by selecting the menu EDIT > PAGES > NEW PAGE. 

Or you can copy and paste an existing page in the same or another document. Right-
click an empty part of a page and choose COPY PAGE. In the destination document 
right-click a page and choose PASTE > PAGE (or press "Ctrl + V").  

The page on the clipboard is added as a new page immediately following the current 
page. The pasted page adopts the page size of the document it’s pasted into (as long 
as the ALL PAGES IN DOCUMENT THE SAME checkbox is enabled in FILE > PAGE 
OPTIONS). Page layers and attributes and all the objects on the page are also pasted. 
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You can delete pages using the same EDIT > PAGES menu or the flyout bar. Or right 
click a page and choose CUT PAGE. 

You can also use the PAGE & LAYER GALLERY (on page 149) to add, delete or duplicate 
pages. 

Theme Colors 
Most templates use a small set of theme colors, and various shades of those theme 
colors (also referred to as 'Named colors'). If you don’t like the provided colors you 
can edit the named colors individually yourself almost as  'Named Colors' appear on 
the left side of the Color Line along the bottom of the window easily. 

 

 Current Outline and Fill Color 

 Color Editor 

 Eye dropper color picker 

 ‘No color’ patch. 

 Named ‘Theme’ Colors and Linked Colors 

 Fixed palette of standard colors 

 Hold pointer over a color to see its name 

 Status line. Shows what is selected, and provides hints 

Simply right-click on any of the Named Colors and select the Edit option (if you hover 
the mouse pointer over the color you will see a tooltip name). 
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 When editing a color you can drag the eye dropper to pick colors off screen, 
even from other open windows 

 Select the color to edit: Fill color/Line color of the selected object or any of the 
named theme colors 

 Click the label icon to create a Named Color 

 Click to show extended color controls 

 Previous Color 

 Actual color 

 Drag here to select any shade of the selected hue 

 Drag here to select any hue 

The Color Editor provides easy way of choosing any color. Click the Extended 
Controls to enter RGB values. 

Note that when you change a Theme Color in this way, all the related shades used 
throughout the document will change as well. 

Coloring Shapes 
You can fill any drawn shape with a color, either by dragging the color from the Color 
Line and dropping it on to the shape, or by first selecting the object and then clicking 
on the Color Line.  

 Alternatively right click the shape and choose FILL COLOR or click the small Color 
Editor icon (or press "Ctrl + E") to display the Color Editor, where you can set any 
color you like. 

You can give drawn objects a graduated color fill using the FILL TOOL (ON PAGE 213). 

Coloring Imported Clipart 
When you import a clipart graphic by dragging from the DESIGN GALLERY, using the 
"FILE" > "IMPORT" option, or dragging a .web or .xar file onto your page, you will 
usually be asked whether you want to match the colors. If you select not to, then any 
named colors used in this graphic will be added to the Color Line. Clicking on any 
color on the Color Line will give you the option to edit the color. 

Coloring Photos 
If you try to color a photo it turns it into a 'contoned' photo. For example, to make any 
photo black and white, right click and choose "CONTONE" > "MAKE BLACK AND WHITE" 
or select it and click on the white color patch on the end of the Color Line. You can set 
the light or dark color to be any two colors, not just white and black - right click, 
choose "CONTONE" > "LIGHT" and click a color in the Color Editor. 

Note: If the photo is inside a group, as many of the photo objects in the templates or 
clipart are, then you will have to select the photo inside (on page 100) the group 
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first. You can do this by holding "Ctrl" down when clicking on the object in the 
SELECTOR TOOL. Another way of directly selecting the photo is to click on it in the 
PHOTO TOOL. 

Page Background Color 
To set the page background color, right click a page, choose CHANGE PAGE 
BACKGROUND and click a color in the COLOR EDITOR. Alternatively you can drag a color 
from the Color Line over the page and drop it on an empty part of the page. 

 
To set a repeating background texture, drag the photo or bitmap onto your 
document. Open the Bitmap Gallery, scroll to the photo you just loaded, click 
on it to select it, and then click the Background button on the gallery. 

 

Creating your own Named Colors 
If you want to use a color many times throughout a document, you can create your 
own named color by clicking the Name label on the top of the Color Editor. This color 
will now appear on the Color Line. 

 

Click the label icon to create a Named Color 

The power of a named color is that when you edit it later (right click the color in the 
Color Line, select EDIT) all objects using this color are instantly changed. 

Linked shades 
You can create colors that are lighter or darker shades of another color, so that when 
you alter the 'parent' color, all the lighter and darker shades change to match the new 
hue. For example a graduated color shade on a button, such as this: 

This is a simple rounded rectangle with a graduated color 
fill created with the FILL TOOL. In the FILL TOOL you can 
click on the either end of the arrow to set the color. 
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If you create the main green color as a named color, and then make a lighter or darker 
shade of the color, as a linked shade, when you now edit the named color the shades 
change as well, so you get simple re-coloring of complex shaded objects. 

 

To create a linked shade, open the extra controls in the Color Editor and select the 
'NORMAL COLOR' drop-down menu and choose 'SHADE OF ANOTHER COLOR'. 

 

 Click this button to reveal the extra controls. 

 You can now select any light or darker shade of the parent color. The cross marks 
the parent color. 

 Select SHADE from this drop-down list and then the parent color. 

You can also create a Linked Shade that appears on the Color Line (so you can easily 
apply it to other objects). When you select to create a new Named Color you can 
choose to make this a linked 'Shade of another color'. 
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Photos 
You can replace any photo by dragging and dropping it from your File Explorer onto 
any photo in Page & Layout Designer. If you drop it onto the background then it is 
imported and placed on the page where you dropped it. All imported photos are 
shown as 500 pixels wide, but you can of course change this to be any size in the 
usual way with the SELECTOR TOOL. 

 

Drag and drop your photo over any existing picture to replace it. Drop onto the background to 
import as a new photo 

 
When you replace an existing photo, the FILL TOOL is selected and a pair of fill 
arrows are shown at right angles on the photo. 

This is because the photo is really a fill inside a shape. You can drag on the picture to 
re-position it, or drag on the ends of the fill arrows to resize and rotate the picture 
inside its outline shape. 
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Drag on photo to re-position inside its frame. Drag on end of arrows to resize and rotate.  

The Photo Tool 
The Photo Tool provides a range of ways to enhance and crop any photo. 

 

 
To crop a photo, just drag across the photo while in the ENHANCE PHOTO TOOL. 
You can adjust the crop edges by dragging on the crop handles around the 
outside of the photo.  

 
Or use the CLIP TOOL for more control over crops.  

See the section on Photo Handling for background information on the advanced way 
in which MAGIX Page & Layout Designer 2013 handles photos, and the section on 
the Photo tool to find out how to use the Photo tool. 

Photo Resolution 
Page & Layout Designer always stores the full resolution image (unless you chose to 
import reduced resolution images when asked during import, as mentioned above). 
This means you can resize or crop your image as required with no loss of quality. 

If you want to size a photo, or any object, to a specific size, just enter the required size 
into the SELECTOR TOOL InfoBar width or height fields. 

When you drop a photo on the page (assuming you're not replacing an existing 
photo), it's sized to be 500 pixels wide. But if you want this to be exactly 200 pixels 
wide, just enter 200px into the W size field of the SELECTOR TOOL. You can enter it 
in any unit, e.g., entering 2in will make it 2 inches wide. 
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Text 

 
You can edit the text by selecting the TEXT TOOL and clicking on the text. 

You have all the usual word processing facilities, and can paste text from the system 
clipboard. Double click will select a word, triple click will select a whole line - which 
can be useful for selecting all the text in a button. As usual the InfoBar provides a wide 
range of controls for this tool. Alternatively you can right click within text and choose 
ADVANCED TEXT PROPERTIES. 

 

The font menu displays a list of fonts and is split into three sections. The top section 
shows fonts already used in the document, the next section shows web safe fonts, 
and finally the lower section shows all fonts installed on your computer. 

 

The three sections of the font menu. In this example the font selected is showing the available 
bold and italic variants. Not all fonts have such variants. 
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The font menu offers live font selection. As you traverse the menu, the selected text 
changes font allowing you to immediately preview what the font will look like in the 
document.  

Creating New Text Objects 
There are three types of text object - a single line of text, a column of text or a 
rectangular text area. To create a simple line of text, select the TEXT TOOL and then 
you can click anywhere on the background and start typing. To create a column click 
and drag horizontally on the background, and then start typing. You can adjust the 
column width at any time. To create a text area, click and drag diagonally. You can 
adjust the width and height of a text area by clicking and dragging on it in the TEXT 
TOOL. 

Bulleted and numbered lists 
Use the bullet and numbered list buttons on the TEXT TOOL info bar to quickly enter 
bulleted or numbered lists. You can right click on a numbered list and choose LIST 
PROPERTIES… from the context menu to change the numbering scheme for your list. 
You can also use any graphic as the bullet or number in your list. See the Text Tool 
chapter (on page 178) for more information. 

Soft Shadows, Color Filled Text, Transparent Text 
You can apply any of these effects using the appropriate tools, e.g., if you drag across 
some text in the FILL TOOL it will give it a graduated color, or if you drag on it with the 
SHADOW TOOL it will give it a soft shadow. 

Text Repel Around Objects 
If you right click on an object like a photo and select the menu option 'REPEL TEXT 
UNDER (ON PAGE 192)'' you can make text flow around the object that is on top of the 
text. 

Many of the objects, such as photos, side panels, buttons and headings used in the 
templates from the DESIGNS GALLERY are automatically repelling - the text will always 
flow around these objects as you drag them around.  

Repelling objects only repel text that is behind the object - so you may have to 'bring 
to front' the object in order for the repel to work ("Ctrl + F"). Alternatively if you only 
want an object to repel text within an individual layer (on page 39), you can prevent 
text that is below that layer from being repelled - see Layer Properties (on page 155). 

All operations in the TEXT TOOL are live - the text re-formats and re-flows as you 
adjust the column width or move repelling objects around. 

Note: You can now also repel text around anchored objects (on page 38). 
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Anchored Objects 
If you want a graphical object to appear next to a particular part of a block of text, you 
can anchor the object to the text so it moves with it.  

Right click the object and choose ANCHOR TO TEXT. Using the SELECTOR TOOL click 
and drag the anchor symbol that appears in the top left of the object to the location in 
the text where you would like the object anchored. Now if you edit or move the text, 
the anchored object moves with the anchor point.  

Spell Checker 

 
On the TEXT TOOL InfoBar is a button that selects the spell checker options and 
language. If you select CHECK SPELLING AS YOU TYPE this will also mark all 
unrecognized words with a red dotted underline. Right click on any marked 
word to be presented with suggested alternatives. 

 

Embedded Fonts 
Page & Layout Designer stores the character shapes of all the fonts used in your 
document. This means if you give someone else your Page & Layout Designer file, or 
transfer the file to another computer they will see exactly what you see, even if the 
correct fonts are not installed on that computer. But this only embeds the characters 
that are used in the document (it's not a full font that is included). So on computers 
with the fonts missing, any text that is added in the missing fonts may be missing the 
correct character shapes. 

Text Tip: There are a lot of shortcuts available in the TEXT TOOL. Refer to 
the reference section on keyboard shortcuts (on page 382) to see them all. One 
useful one for experimenting with page layouts, "Ctrl + Shift + L", inserts a block of 
random pseudo Latin. 

Page Size 
You can set any page size you like by selecting the PAGE SIZE tab of the OPTIONS 
DIALOG (right click > "Page Options" or choose Page Options from the File menu). 
The dialog offers a range of commonly used page sizes in the drop-down list. Or 
Choose the custom option to enter any other page size. 

Attention: If you plan to print your design in a printing company please put attention to the Bleed 
setting as well! 
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Layers 
As mentioned earlier all objects have a stacking order on the page - from the 
backmost to the frontmost item. 

 

These objects are stacked over each other. 

In addition, all items can be placed into named layers.  Each layer can have any 
number of objects, and has the ability to be turned on or off. When the layer is turned 
off all objects on that layer become invisible. 

 The layers are controlled from the PAGES & LAYER GALLERY on the Galleries bar 
to the right of the workspace. 

 

Saving & Exporting Your Work. 
Use the SAVE or SAVE AS menu options to save your work in progress. This saves a file 
with the .xar extension, which is the native file format for Page & Layout Designer. If 
you want to edit or update your document in future, you must save a .xar file this way 
and use it to do further updates, even if you've also exported it to different standard 
file formats. 

To export your document, right click and choose EXPORT or use "FILE" > "EXPORT" and 
choose the file format you want to export to from the list of formats shown. Use JPEG 
for exporting photos, PNG for graphics, and usually PDF is best if you want to print or 
distribute print work.  

See the Importing & Exporting (on page 304) chapter for information on these and 
many other export formats supported by MAGIX Page & Layout Designer 2013. 
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Document handling 

Starting a new document 
Choose FILE > NEW 

This opens a sub menu with several pre-defined but blank template documents to 
start from. You’ll find a range of blank templates under the FILE > NEW menu for 
creating them. 

Primarily, there are two different types of documents in MAGIX Page & Layout 
Designer 2013. 

Icon Document type Menu option Use for.. 

 
Print  A4 PORTRAIT 

A4 LANDSCAPE 
US LETTER 

Creating drawings, DTP and text 
documents (single or multi-page) 
that you want to print or perhaps 
export as PDF documents. 

 
Photo       BLANK PHOTO If you load a JPEG photo into 

MAGIX Page & Layout Designer 
2013 it’s loaded as a photo 
document. Photo documents are 
used where the purpose of the 
document is only to edit or produce 
a photo. 

Choosing the first entry A4 PORTRAIT creates a document based on the Page & Layout 
Designer default template. 

 
Clicking the NEW button on the STANDARD control bar (shortcut 
"Ctrl + N") also creates a document based on the default template. 

When your new document opens, its tab is added to the top of the workspace with an 
icon showing which type of document it is. 

You can save your own templates with the "File" > "Save Template" command – see 
Changing the template document (on page 345) for details. 

Opening an existing document 
To open an existing document: 

• Drag & drop a file. Select the file in Windows Explorer or on your desktop, and 
drag it over an existing open document to import it  into that document, or any 
other part of the Page & Layout Designer window to open the document. 

• Or double click a Page & Layout Designer file. 
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• Or to open a recently used file, select it from "FILE" > "OPEN RECENT" 
• Or select "FILE" > "OPEN" (shortcut "Ctrl + O"). 

 
• Or click the OPEN button on the standard control bar. 

The open dialog will be displayed. The dialog allows multiple file selection, "Ctrl + 
click" to select several files or "Shift + click" to select a range of files. 

 
As in Explorer windows, you can switch the file display to a detailed or 
thumbnail view with this button 

If SHOW PREVIEW in the upper right corner is checked, the selected file is shown in an 
even bigger preview (this does not work for a multiple file selection). 

Selected document and title bar 
You can have more than one file open at a time in Page & Layout Designer, which 
displays all open documents as tabs at the top of the workspace. 

The current document is displayed in the workspace and its name is highlighted gray 
in the document tabs. The current document type is indicated in the top left corner of 
the Page & Layout Designer window, next to the menu options. The current document 
receives all input. Any unsaved changes in a document are indicated with a star after 
the file name. 

 

Document tabs show all open documents, with the current document tab highlighted gray. 

Control bars 
These contain buttons that you can use to operate Page & Layout Designer. You can 
customize control bars in several ways, such as re-ordering, creating, and hiding bars. 

The default window shows the standard button bar with commonly used buttons: 

 

You can customize the standard control bar in the same way as other control bars. 

Those icons with a triangle indicator in the bottom right corner have "fly-out bars" on 
them. Hold the mouse pointer over these icons and you’ll see the fly-out bar appear, 
with more icons. 

For information on customizing control bars, refer to "Customizing Page & Layout 
Designer (on page 360)". 
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InfoBar 
This is a special control bar. Its contents change when you select different tools. 
InfoBars specific to certain tools are described in their relevant chapters. 

You cannot customize the InfoBar. 

 

The InfoBar for the Selector Tool 

Main toolbar 

 

This is a control bar that initially contains all the tools available in Page & 
Layout Designer (see left). You can customize the toolbar, or move tools 
to other control bars. 

Some of the toolbar icons have a small triangle indicator in the bottom 
right corner. This indicates that there is a flyout bar containing more tool 
icons. Hold your mouse pointer over the icon to see the flyout bar appear.  

 

You can then move the mouse pointer over each icon in the bar to see a 
tooltip indicating what each one does. Click on a tool to select it (some 
tools have keyboard shortcuts, too). 
For information on customizing control bars, refer to "Customizing Page & 
Layout Designer (on page 360)". 

 

Rulers 

 

You can hide the rulers, change their zero point (origin), and 
use them to create guidelines. For more information, see 
Rulers (on page 59). 
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The status line 

 

 Selected objects 

 Available options 

 Indicators 

 Mouse pointer X-Y 

This appears at the bottom of the window. The status line tells you about the selected 
objects, available options, live drag/snapping indicators, and the X/Y position of the 
pointer. 

The indicators 
These appear on the right of the status line: 

 Live drag indicator 
This indicator shows whether live drag is active or not (it is active by default). 
Double click the indicator to toggle live drag on/off. When active, if you 
reposition, resize, or rotate an object, the whole object moves (not just an 
outline), making it far easier to judge the effect of your edits in real time. 
Drawing in the FREEHAND, STRAIGHT LINE, QUICKSHAPE, RECTANGLE and 
ELLIPSE TOOLS is also live with this option on. If your computer is unable to 
cope with a particularly complex document, it will automatically turn active 
drag off to ensure editing remains fast and efficient. 

 

 

Snapped indicator 
This indicator is active when SNAP TO OBJECTS is enabled. Click the SNAP TO 
OBJECTS button (shown left) to toggle off and on. Snap to objects allows you 
to see potential snapping paths and points relative to other objects and the 
page center and edges by showing blue snapping lines for snapping paths and 
red dots for points as you drag an object. For more information on snapping, 
refer to "Object Handling". 

 

X/Y co-ordinates 
Page & Layout Designer shows measurements relative to the bottom left corner of the 
page area or spread. However, this is configurable. For more information refer to 
"Object Handling (on page 103)". 
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Normal/full screen modes 
In normal screen mode part of the window is occupied by the title bar, menu bar, and 
scroll bars. This can be inconvenient if you want the maximum possible editing area. 
Page & Layout Designer has a second screen mode, fullscreen, which displays a more 
streamlined screen. You can configure each screen mode as you wish. For example, 
each can have its own configuration of the control bars. The configuration is 
remembered and applies whenever you swap between screen modes. 

Normal/full screen is controlled by "WINDOW" > "FULL SCREEN" or right click and 
choose FULL SCREEN ("8" on the numeric keypad). 

To display the menu bar in full screen mode, move the pointer to the top of the 
screen. 

Opening a second window 
You may want to open a second window onto the same document to: 

• Get an enlarged or reduced view of the document; 
• Show another part of the document; 
• Have two views of the same area at different quality settings (quality settings are 

described later.) 

Choose "WINDOW" > "NEW VIEW" to open another window. You can have several 
windows open on the same document. 

Changing the zoom value 
It’s often useful to enlarge your view of the document to examine details or reduce 
your view to get an overall impression. Scalings above 100% show an enlarged view 
(similar to looking through a magnifying glass); below 100% a reduced view. The only 
change is your view of the document; the size of the document itself and the objects 
in it are unchanged (changing the document size is described later). To change the 
zoom value you can use either the ZOOM TOOL, mouse, or control bars. 

Some shortcuts are available for quick setting of zoom values: The plain numeric keys 
(1, 2, 3, 4) set the zoom to between 100% and 400%. The number 5 key sets it to 
50%. 

Using the Zoom Tool 

 
To zoom: 

• Select the ZOOM TOOL from the Main Toolbar. 
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• Or press "Alt + Z" to toggle between the current tool and the ZOOM TOOL. 
• Or press and hold down "Alt + Z" to temporarily swap to the ZOOM TOOL (release 

"Alt + Z" to return to the previous tool). 
• Or press "Shift + F7" to select the ZOOM TOOL. 

Changing the zoom value using the mouse 
If you have a mouse wheel: 

• Hold "Ctrl" and scroll your mouse wheel to change the zoom level. 

You can also configure a mouse button to zoom in or out. Furthermore, you can 
change the mouse wheel action between scrolling and zooming in "UTILITIES" > 
"OPTIONS" > "MOUSE TAB (ON PAGE 351)" or right click and choose "PAGE OPTIONS" > 
"MOUSE" tab. The opposite action is available then by pressing "Ctrl". 

Alternatively, select the ZOOM TOOL, and 

• Click to zoom in (enlarge). 
• "Shift + click" to reduce the zoom value (to see more of the document). 
• Drag the mouse diagonally to create a rectangle. When you release the mouse 

button, the area within the rectangle is enlarged to fit the window. 

Changing the zoom using the zoom InfoBar/control bar 
There is a flyout bar on the standard toolbar which gives you quick access to zoom 
functions, without having to go into the ZOOM TOOL. There is also a flyout bar on the 
ZOOM TOOL icon on the main toolbar. 

  

Hold the mouse pointer over the zoom icon on the standard toolbar to see the 
flyout bar. 

To change the zoom: 

 
Shortcut "Ctrl + R". Click the PREVIOUS ZOOM button. This is the zoom value 
before the current setting. Using this button lets you flip zoom in and out on 
the document. This is useful for switching between examining an area in detail 
and an overall view. The previous zoom value is stored for each window. You 
can swap between windows and the previous zoom values are retained. 

 
Shortcut "1" Click the Zoom to 100% button. The zoom factor is changed to 
100%. 

 
Shortcut "Ctrl + Shift + J". Click the ZOOM TO DRAWING button. The window 
shows all the objects in the document. 

 
Shortcut "Ctrl + Shift + P". Click the ZOOM TO PAGE button. The window shows 
the entire page or pair of pages. 
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Shortcut "Ctrl + Shift + Z". Click the ZOOM TO SELECTION button. The selected 
object or objects fill the window. 

 

 

Type a value into the text box. Press "" to implement 
the change, or select preset zoom values including 
those above (page, drawing, selected, previous) in the 
drop-down menu. 

 

Sliding the document within the window 
The quickest and easiest way to move around the document is to use the middle 
mouse button (normally the mouse wheel) if you have one. Click and hold the middle 
button down and then move the mouse. Release the button to return to your previous 
tool. 

To move the document within the window you can also: 

• Use the scroll bars and arrows at the side of the window. 
• Use the mouse wheel to scroll the document up and down ("Shift + mouse 

wheel" for left and right) 

 
• Or select the PUSH TOOL from the main toolbar ("H"). 

• Or press the space bar or "Alt + X" to toggle between the current tool and the 
PUSH TOOL. 

• Or press and hold down the space bar or "Alt + X" to temporarily switch to the 
PUSH TOOL (release key(s) to return to the previous tool). You can then use the 
mouse to drag the document around in the window. 

The PUSH TOOL InfoBar is the same as the ZOOM TOOL InfoBar (described above). 

Displaying the scroll bars is optional. Choose "WINDOW" > "BARS" > "SCROLLBARS" to 
turn them off. 

You can change the mouse wheel action between scrolling and zooming in 
"UTILITIES" > "OPTIONS" > "MOUSE" or right click and choose "PAGE OPTIONS" > 
"MOUSE". The opposite action is available then by pressing "Ctrl". 

Changing the page size 
You can change the size of the current page to a standard size: 

1. Right click the page and choose PAGE OPTIONS -> PAGE SIZE (on page 38) tab or 
choose "UTILITY -> OPTIONS". 
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2. Choose the required paper size. 

 

"Customizing Page & Layout Designer (on page 345)" has full details of the options 
dialog box. 

Paper size 
You can either choose the CUSTOM option from the paper size list and then enter the 
width and height, or choose a standard size. 

Attention: If you plan to print your design in a printing company please put attention 
to the Bleed setting as well! 

Orientation 
• Portrait orientation displays the longest sides vertically. 
• Landscape orientation displays the longest sides horizontally. If you entered a 

custom page size, landscape turns the page sideways. 
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Outer margin 
This lets you set the width of the pasteboard around the page or spread. 

Bleed 
To produce format filling print results printing shops use a larger format paper and 
crop it to the target format after it has been printed. Due to mechanical tolerances 
inaccuracies can happen while this process. For this reason, printing shops 
recommend including an additional "safe area" around the actual print motif. This is 
often referred to as the "bleed". This ensures that no important content is cropped 
and that no white borders appear on the edges if the motif background is not white or 
a background pattern is used. 

 

Without this "bleed" area a mechanical error during cropping can lead to white 
borders or image elements that are too close to the edge may be cut. 

The bleed area is set in the Page area of the Page Options (on page 353) and in the 
program it is displayed as a red rectangle around the page. Normally this bleed area is 
1-3mm wide. When a PDF is exported for the print shop the final page size of the PDF 
will appear based on the page size settings plus the bleed area beyond the actual 
page. For example, an A4 page (29.7 x 21cm) with a 2mm bleed area will result in a 
format of 30.1 x 21.4cm.  

The exact value depends on the print shop and can most often be found on a 
corresponding information page on the print shop's website. Some online print shops 
also request a file format that already contains the bleed area. Here is an example: For 
a flyer in A6 format (14.8 x 10.5cm) the shop may request a file format of 15 x 10.7cm. 
This corresponds to a value of 1mm for the bleed area beyond the actual page. 

Make sure that the rectangle that contains the background pattern or color extends 
beyond the page borders at least to the end of the bleed area. It is also important to 
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make sure that all important page elements are a safe distance from the page borders. 
This distance should have at least the size of the bleed area. 

 

The background image was extended to the end of the bleed area (red frame) and the header 
was made smaller. If a cropping error does occur, the background will still cover the entire format 
and the heading will not be affected. 

Double page spread 

Single page      Double page spread 

Your illustration may run across two 
facing pages in a multi-page publication. 
This is called a "double-page spread". 

Multi-page Documents 
MAGIX Page & Layout Designer 2013 supports multi-page documents to make DTP 
projects simple.  

You can easily create documents that are comprised of many pages, for example 
newsletters, PDF eBooks, brochures or small magazines.  

By default when you open or create a new document,  Page & Layout Designer  shows 
documents in multiple page view. Right click a page and deselect MULTIPLE PAGE VIEW 
to show only one page at once.  
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Double page spreads in multi-page documents 

 

Your illustration may run across two 
facing pages. This is called a double-
page spread. 

Single Double page  

You can have single pages or double-page spreads in your multi-page document, as 
illustrated above, but only one or the other within a document. 

To switch between single or double-page spreads, right click the page and choose 
"PAGE OPTIONS", and then check or uncheck the "DOUBLE-PAGE SPREAD" option. 

If you change from a double-page spread to single pages in an existing document, 
your spreads will be split into single pages. Similarly, converting to a double-page 
spread will cause the pages in your document to be "paired up" into spreads. 

 

The result of converting a double page spread document to individual pages, and then back 
again. 
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Note: it is possible for objects to overlap the pages of a spread (i.e. on pages 1 and 2 
in the illustration above) but not over separate pages or spreads (i.e. 1 and 3; if you 
did want to do this, you would need to copy the object from page1 and paste it on to 
page 3 so that it appears there as well). 

The current page 
If you click a page in a multi-page document it will become the current page. 

 

The current page is relevant when inserting, duplicating, or moving pages as 
described in the following sections. 

The current page in the document is shown by indicators on the page’s 
corners. 

 

Adding page numbers 
To insert page numbers into your document - use the TEXT TOOL to click in your 
document page at the place you want the page number to appear. Right click and 
select "Insert". Then choose from one of the available number formats. As you add 
pages to your document the page numbers will update incrementally. 

It’s common to place a page number on every page in a document. It’s a good idea to 
make this page number a Repeating Object (on page 129), so you can move or 
change the style of the number on one page and have those changes applied to all 
pages automatically. After inserting the page number on one page, select it using the 
SELECTOR TOOL and then select "Arrange" > "Repeat on all pages", to place it in the 
same position on all pages. You can still delete the number from some pages if you 
don’t want the number to appear on every page. 

Inserting pages into your document 
Right click a page and choose NEW PAGE or NEW DOUBLE PAGE SPREAD. A new blank 
page is inserted after the page. 

or 

Right click a page and choose DUPLICATE CURRENT PAGE or DUPLICATE CURRENT 
DOUBLE PAGE SPREAD. A duplicate of the current page is inserted after the page. 
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The new page will be the 
same as the original page, 
including its size and 
orientation, and will include 
all its content so that you 
can use it as a template for 
new content. 
You can also use the Menu 
items under "EDIT" > "PAGES" 

In addition, the standard toolbar has a flyout bar which allows you to add, duplicate 
and delete pages quickly. 

 

Hold the mouse pointer over each icon in the bar to see a tooltip for each available 
operation. You can add a new blank page, duplicate the current page or delete the 
current page. 

Copying and pasting pages 
You can copy and paste whole pages in the current document or paste pages to 
another document. This copies the page dimensions, layers and other page attributes 
in addition to all the objects on the page.  
 
To copy the current page, clear any current selection by pressing Esc or by clicking on 
an empty part of the page or pasteboard. The status line says "No objects selected". 
Right click an empty part of a page and choose COPY PAGE (or press "Ctrl + C"). When 
you paste a copied page, it is added immediately following the current page. To paste 
use "Ctrl + V" or  right click the page and choose PASTE > PAGE from the context 
menu. 

Note: If the document into which you paste a page has the ALL PAGES IN DOCUMENT 
THE SAME option enabled in FILE > PAGE OPTIONS, the dimensions of the pasted page 
will be overridden by the page dimensions of the document. So the new page will be 
given the same dimensions as all the other pages in the document.  

New page from template 

 To insert a new page into your document using a pre-designed template, open 
the DESIGNS GALLERY, drag your chosen page template thumbnail, and drop it 
onto your document. The new page is added immediately following the page 
that you drop on. 
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Duplicate a page 
To create a copy of the current page after the page, right click the page and choose 
"DUPLICATE CURRENT PAGE". 

You can also use this toolbar button: 
 

 

The new page will be the 
same as the original page, 
including its size and 
orientation, and will include 
all its content so that you can 
use it as a template for new 
content. 

You can also duplicate a page using the PAGE & LAYER GALLERY. Select the page in the 
Page & Layer Gallery and click the DUPLICATE button. The new page is added after the 
current page. 

Moving pages within the document 
If you wish to change the order of pages in your document you can do so. 

Right click a page and choose "MOVE PAGE/DOUBLE PAGE SPREAD UP" or "MOVE 
PAGE/DOUBLE PAGE SPREAD DOWN". 

 You can also change the order of pages in the PAGE & LAYER GALLERY. 

Click the PAGES button in the PAGES & LAYER GALLERY so it shows a simple list of 
pages. Then you can drag and drop pages up and down in the gallery to change the 
page order. 

Alternatively, to move the current page: 

• Choose "Edit" > "Pages" > "Move page up" or right click and choose Move page 
up to swap the current page with the one previous to it. 

• Choose "Edit" > "Pages" > "Move page down" or right click and choose Move 
page down to swap the current page with the one after it. 

These options will be grayed-out of if you are on the first or the last page of the 
document respectively. 
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Removing pages from your document 
To delete the current page from your document right click and choose "DELETE 
CURRENT PAGE/DOUBLE PAGE SPREAD" or to cut the current page, right click an empty 
part of the page and choose CUT PAGE.  

Or select the page in the PAGES & LAYER GALLERY and click the DELETE button. The 
current page and all its content will be deleted. In the case of a spread, the entire 
spread will be deleted along with its content. 

Navigating between pages 
As well as the usual methods of moving through your document (such as scrollbars 
and the mouse wheel), there are also some other ways to navigate through the pages 
using the set of keys to the right of your keyboard: 

Page up: Moves up the document. The amount moved depends on your zoom level. 
The further you are zoomed out the bigger the move. 

Ctrl + Page up: Go to and center on the previous page. 

Page down: Moves down the document. The amount moved depends on your zoom 
level. The further you are zoomed out the greater the move. 

Ctrl + Page down: Go to and center on the next page. 

Or click the up or down arrow on the status line:  

The status line is also useful for knowing what page(s) you are currently viewing. 

Note: All of these movements are relative to the page you are viewing, not the 
current page. 

The PAGE & LAYER GALLERY also makes it easy to go to find a specific page in your 
document. Click the PAGES button in the gallery, so it shows a simple list of pages. 
Then as you click on each page in the gallery, the document view is scrolled 
automatically to show that page. 

Pages with different sizes and layers 
You can choose whether the pages in your document should be all the same size or 
not, and whether or not all pages should have the same layers. See the Document 
section (on page 354) on the PAGE SIZE tab of the UTILITIES->OPTIONS dialog or right 
click a page and choose "PAGE OPTIONS". 
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Page & Layer Gallery 
You can also use the PAGE & LAYER GALLERY to conveniently manage the pages in 
your document. It allows you to view, add, duplicate, delete, re-order and rename 
pages all from a single view. For more information see PAGE & LAYER GALLERY (on 
page 149). 

Saving the document 
This section covers saving in Page & Layout Designer’s own format (native format). 
Refer to Importing and Exporting (on page 304) for details of exporting in other 
formats. 

We recommend that you always save documents regularly. A complicated document 
may represent many hours of work and power failures or computer crashes always 
happen at just the wrong moment.  Make sure you have the automatic backup facility 
turned on, so that regular backups are taken of your open documents as you work. 
See the Automatic Backups (on page 56) section below for details. 

Save option (on the File menu) 

 
("Ctrl + S", or click the SAVE button on the standard control bar.) 

This provides a quick way to save a document using the same file name. The option is 
disabled unless the document has unsaved changes, i.e. you have made changes, but 
haven't saved them to disk. 

For a new document that has not been saved to disk, this option acts like "Save as" 
(described below). 

Save as (on the File menu) 
This opens a dialog box letting you save the document under a different name or to a 
different directory. This option is useful for making backups of Page & Layout 
Designer documents. 

Save all (on the File menu) 
This acts like a series of SAVE or SAVE AS commands to save all currently open files. 

Closing the document 
To close the document: 

• Choose "FILE" > "CLOSE". 
• Or press "Ctrl + F4", or "Ctrl + W". 
• Or click the smaller, lower X of the two in the top right hand corner. 
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Automatic Backups 
MAGIX Page & Layout Designer 2013 will optionally save regular backup copies of 
your open documents while you work.  

To turn automatic backups on or off, open the "UTILITIES" > "OPTIONS" dialog and 
choose the BACKUPS tab. 

 

Backup open documents 
To turn backups on select this checkbox and choose how often you would like 
backups to be taken. The suggested period is 10 mins, which means each open 
document will be backed up if it’s more than 10 mins since the last backup of that 
document was taken (or since the document was created or opened).  

Note that once the configured period since the last backup has expired, the next 
backup is only saved when the program has been idle for at least 15 secs. This is to 
avoid interrupting your work as much as possible and to avoid backing up the 
document while it is being actively modified. In normal use it’s unlikely that there 
won’t be regular inactive periods of 15 secs or more, allowing a backup to be taken 
soon after it is due. But note that if you are actively editing for an extended period of 
time it could be significantly longer than the configured backup period before the next 
backup runs. 

The Automatic Backup facility does not save modifications to open ‘edit inside’ sub-
documents. Only the parent main document is saved when a scheduled backup runs, 
in its current state without the unsaved group edits. For this reason it's recommended 
that you save ‘edit inside’ edits back to the parent document regularly.  

When a backup is taken, you’ll see the save progress bar appear at the bottom of the 
MAGIX Page & Layout Designer 2013 window while the save is completed. 
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Backup location 
User the BROWSE button if you want to change the folder where your backups are 
stored.  

You can access the backup documents saved here at any time using the "FILE" > 
"OPEN RECENT" > "BACKUPS" menu option. This opens a file dialog onto your backup 
folder so that you can browse, open, or delete any of your backup files. 

Revisions 
By default up to 10 revisions of each design are kept in your backups folder, but you 
can choose to change this number in the revisions field.  Older revisions in excess of 
the number chosen are deleted automatically. Each backup file is named using the 
name of the document from which it is taken, suffixed by the date and time at which 
the backup was taken.  

Warning: Note that if you have multiple documents that share the same filename in 
different folders on your computer, their backups will also share the same names in 
the backups folder. Therefore try and use unique filenames for your designs to avoid 
the backups of one design overwriting another with the same name. 

Untitled documents 
Documents that you have created and not saved are backed up using the name 
"Untitled" followed by a number and the date/time. This name and number 
corresponds to those shown in the titlebar when you are editing new unsaved 
documents.  

Warning: Since all new unsaved documents are named Untitled1, Untitled2, etc. 
backups of these documents are likely to be overwritten relatively quickly. Therefore 
you should always save important documents with a unique name of your choice, so 
that you can easily identify backups of that document in the backups folder. 

Backup open documents on program close 
The Backups tab in the Options dialog also allows you to turn on AUTOMATIC BACKUP 
AND RESTORE. When this option is on, when the you close MAGIX Page & Layout 
Designer 2013 you will not be prompted to save  any modified documents that you 
have open. Instead all open documents are backed up to the backups folder and the 
program closes. Then when you next start the program, the same documents are 
automatically reloaded so that you can continue working where you left off.   

Note that if you have any "Edit inside" sub-document views open, these are silently 
closed and saved back to the main document when the program is closed, and the 
main document is backed up. The ‘edit inside’ sub-document views are not re-opened 
on next program start. See editing inside groups (on page 121).  
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Recovering from abnormal program closures 
If you have automatic backups turned on and the program closes abnormally 
(perhaps due to a power failure for example)  the program should detect this when it 
is next restarted. It will then offer you the chance to restore the most recent backup 
version of each document that was open at the time of the last backup. 

Abnormal closure will not be detected if no automatic backup completed since the 
last normal program closure. 

Backups on system shut down 
If you shut down Windows without first closing the program, all open documents are 
backed up to the backup folder even if ‘Backup open documents on program close’ is 
not turned on. This allows system shutdown to proceed without MAGIX Page & 
Layout Designer 2013 interrupting it by prompting you about unsaved or modified 
documents. On next program startup you’ll be asked whether or not you want to 
restore the documents that were open at the time of the system shut down. 

Recovering backups 
You can access your document  backups using the "FILE" > "OPEN RECENT" > 
"BACKUPS" menu option. This opens a file dialog onto your backup folder so that you 
can browse, open, or delete any of your backup files. It’s a good idea to use this file 
dialog to clear out any old unwanted backups periodically. 

Note that when you load a backup document, it is not automatically associated with 
the design file from which the backup was taken. It’s treated as an independent 
document in its own right. Therefore if you decide to keep a backup document you 
should use "FILE" > "SAVE AS" to save it elsewhere with a suitable name. 

On-screen grid 
To help you lay out your document, Page & Layout Designer can display a grid on the 
screen (the grid appears only on the screen; it is never exported or printed.) The grid 
helps you align objects (similar to using graph paper as a drawing aid). 

Right click and choose "SHOW GRID/GUIDES" > "SHOW GRID" to turn display of the grid 
on/off or choose "SNAP TO" > "SNAP TO GRID". You can also choose "WINDOW" > 
"SNAP TO GRID".  

The grid points then act like magnets, and as you move objects, they snap to the 
nearest grid point. The type of grid (isometric/rectangular), the 0,0 point (the origin), 
and spacing of grid points is controlled by the GRID & RULERS TAB (on page 348) of the 
options dialog box. Any changes you make apply only to the selected document. 

Magnetic object snapping is a very powerful way of accurately aligning lines, points 
and the edges of objects to any other object so they exactly touch. 
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You can even use this to align the centers of objects, or align objects to the center of 
the page, or align them horizontally and vertically anywhere in the middle of the page 
or edge of the page. 

 
To toggle object snapping, click the SNAP TO OBJECTS button or right click and 
choose "SNAP TO" > "SNAP TO OBJECTS". You can also choose "WINDOW" > 
"SNAP TO GRID".  

Refer to Object Handling for details on snapping to grid and snapping to objects. 

Rulers 
Rulers are turned off by default. To turn them on: 

• Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" to turn display of 
the grid on/off. 

• Press "Ctrl + Shift + R". 
• Or select "WINDOW" > "BARS" > "SHOW RULERS". 

Page & Layout Designer uses rulers to: 

• Control text margins, tabs and indents (on page 189) in the TEXT TOOL. 
• Let you know which part of the page you are viewing; 
• Show the current pointer X/Y position; 
• Apply guidelines. If "WINDOW" > "SNAP TO GRID" is active, guidelines snap to 

divisions on the ruler. For more information on guidelines, refer to the guides & 
guidelines section in "Object Handling". 

As you create or scale objects, you can use the rulers to check their size. You can also 
more accurately use the SELECTOR TOOL (see "Selecting objects (on page 98)" for 
more information). 

Rulers are displayed at the left and top of the window. A dotted line on each ruler 
follows the current pointer position. 

The units and number of divisions on the rulers are the same as those set for 
customizing the on-screen grid. These are set using the Grid & Ruler Tab (on page 
348) of the options dialog box. The current units and any scaling factor are displayed 
on the right hand end of the top ruler. 

Displaying/hiding rulers 
Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" ("Ctrl + Shift + R") to 
turn rulers on/off. Any change applies to the current window and subsequent 
windows you open. It does not affect other open windows. 
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Changing the ruler zero points 
It is often easier to measure objects if you align the origin (0,0) point of the rulers 
with the object. To move the origin (0,0) point, drag the square at the intersection of 
the two rulers. 

 

You can drag vertically or horizontally along the rulers 
or over any part of the Page & Layout Designer editing 
window. As you do, a dotted line will outline the new 
position. 
This also moves the grid origin so that divisions on the 
ruler always align with the grid. 

You can also move the zero point under the GRID & RULER tab (on page 348) of the 
Options dialog. 

Measurement units 
You can define the units in which to display measurements. The default display units 
are: 

• points (1/72 of an inch) for text and line widths; 
• centimeters for most measurements. 

You can enter dimensions in the other units by using a suffix or prefix (dependent on 
the unit type). For example, 2.5in for 2.5 inches. You can enter dimensions using two 
units. For example, 2pi 4pt for a dimension of 2 picas, 4 points. Note that units 
entered will be converted and displayed in your default unit. 

Millipoints 
A millipoint is 1/1,000th of a point (1/72,000th of an inch). All Page & Layout 
Designer measurements are stored internally in millipoints and then converted to the 
appropriate units when displayed. Dimensions other than millipoints are rounded if 
necessary. If you want to work in exact units without rounding, display measurements 
in millipoints. 

"Customizing Page & Layout Designer (on page 345)" has full details of the options 
dialog box. 

Options dialog box 
Measurement units for the selected document are controlled by the Options dialog. 
Choose "UTILITIES -> OPTIONS" or right click a page and choose  "PAGE OPTIONS -> 
UNITS". 
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Changing the default display units 
Display the options dialog box. If necessary, click the units tab. 

 

Font units are used for 
text sizes.  
Page units are used for 
other measurements. 

 

Creating a new unit 
You may want to specify measurements in units not provided as standard. For 
example, racecourses are measured in furlongs (220 yards). Or a financial diagram 
may use US$. 

Display the OPTIONS dialog box. If necessary, click the UNITS tab. 

1. Click NEW UNIT. The unit properties window will appear: 
2. Type in the unit name (e.g. US dollars). This name appears in menus. 
3. Type in the ABBREVIATION ($). This is used when entering or displaying the 

units. 
4. Select PREFIX ($ 12.34) or SUFFIX (12.34 $ ) as appropriate. Page & Layout 

Designer must be able to relate the new unit to an existing unit. Type the 
relationship into the "IS EQUIVALENT TO" field. For example, if you had used 
furlongs, then 1 furlong is equivalent to 220 yards. 

 

For units that do not relate to distance (for example US$), type in an appropriate 
scaling factor. For example, 10US$ as equivalent to 10 millimeters. 

Deleting a unit 
You can only delete a unit you have created, not a standard unit. 

Display the OPTIONS dialog box. If necessary, click the UNITS tab. 
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1. Choose the unit you want to delete from the UNIT DEFINITION list. 
2. Click DELETE UNIT. 

Applying a scaling factor 
For example, you may want to specify dimensions in kilometers when drawing a map. 
You can apply a 1:10,000 scaling factor to kilometers. A line 10cm long on the map is 
reported as a dimension of 1km. 

 

1. Choose "Utilities -> Options". If necessary, click the SCALING tab. 
2. Select USE SCALE FACTOR. 
3. Type in the appropriate scaling. For example, 10cm to 1km. 

Alternatively, type 1 into the drawing field and 10,000 into the real-world field. 

Deleting a scaling factor 
This is similar to applying scaling: 

1. Choose "Utilities -> Options". If necessary, click the SCALING tab. 
2. Deselect "USE SCALE FACTOR". 
3. Click "OK". 

View quality slider 

 

This slider (on the STANDARD 
control bar) affects how the 
document appears on the screen. It 
has no effect on the actual 
document or on printing. 

There are 5 different quality settings: 
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 OUTLINE ONLY. This is now fully anti-aliased for higher quality screen display. 

 OUTLINE WITH BLEND STEPS. 

 FULL COLOR (no anti-aliasing). 

 HIGH QUALITY (full anti-aliasing and image smoothing) 

 VERY HIGH QUALITY Bi-cubic photo display considerably improves the quality of 
scaled down photos. 

The default quality level is VERY HIGH QUALITY which means the document is 
displayed on screen exactly as it will be printed (except that the monitor is lower 
resolution than a printer.) Anti-aliasing gives a much smoother and more accurate 
screen display, especially when displaying small details. However, one of the 
consequences is that sometimes objects can look slightly blurred. 

FULL COLOR shows the document colored, but with anti-aliasing turned off. 

On the OUTLINE setting only the outlines of the shapes appear (they are drawn as wire 
frames). This makes it easier to select objects hidden behind other objects. 

OUTLINE WITH BLEND STEPS is particularly useful for seeing outlines of the various 
steps of a blend. 

 
You can also change these settings with "WINDOW -> 
QUALITY". There are toolbar buttons available for the 
five quality settings on the Window toolbar (on page 
360). 

Refer to "Blends (on page 242)" for more on how the quality setting affects the 
display of blends. 

The constrain key 
The "Ctrl" key has a special function in Page & Layout Designer. It constrains the 
action of the current operation in some way. For example, normally you can rotate an 
object to any angle. But in Page & Layout Designer,if you hold down "Ctrl" while you 
rotate an object, the rotation is constrained to a subset of the possible angles. By 
default the object will rotate only to multiples of 45 degrees plus any rotations where 
a significant straight edge in the object becomes vertical or horizontal.  

 

The black line on the left can be rotated 
to any angle within the circle. On the 
right is the same line, but with "Ctrl" held 
down it can only be rotated to the 
positions indicated. 

Similarly, constraining a rectangle creates a perfect square and constraining an ellipse 
creates a perfect circle. Release "Ctrl", and they will not be constrained. 

The constrain angle feature is defined in OPTIONS -> GENERAL -> ANGLE CONSTRAINT 
(on page 347) . 
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Galleries 
MAGIX Page & Layout Designer 2013 uses galleries to provide convenient access to 
external libraries of content like templates, fonts, colors, clip-art, line attributes, and 
bitmaps/photos.  This section of the manual gives general information on features 
which are common to multiple galleries. Individual sections of this manual describe  
features specific to a particular gallery. 

When you create a new Page & Layout Designer document, the following gallery tabs 
are displayed in the gallery bar to the right of the workspace in the following default 
order. 

Designs 
Page & Layer 
Bitmap 
Line 
Fill 
Font 
Color 

 

Name 

Some galleries view objects held in libraries external to the document: 

FONTS, DESIGNS, FILL. 

Other galleries relate to objects in the document, or options for those objects: 

COLOR, BITMAP, LINE, PAGE & LAYER, NAME. 
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Displaying a gallery 
To display a gallery: 

1. Click or hover the mouse pointer over the vertical tab for the gallery to the right 
of the workspace (the gallery bar). The gallery opens automatically. When you 
move the mouse pointer away from the gallery, it automatically closes. 

2. To keep a gallery open while you work, click the Auto Hide (pin) button in its 
top right corner.  The Auto Hide button changes so the pin points downwards 
to indicate that the gallery is now ‘pinned’ to the workspace.  

3. To close a ‘pinned’ gallery, see Closing a Gallery. 

 
Unpinned: gallery closes when you move the mouse pointer away from 
the gallery. 

 
Pinned: gallery stays open when you move the mouse pointer away, and 
can also be moved and docked (on page 65) elsewhere. 

Note: By default the Line, Fill, Fonts, Color and Name Gallery do not display their 
title, just their individual icons, until they have been opened. Page & Layout Designer 
always displays the title of the last gallery that you have viewed. 

Moving and docking a gallery 
You can ‘detach’ any gallery from the gallery bar and move it to a more convenient 
location anywhere in the workspace. You can also dock the gallery (or a gallery group, 
see Grouping Galleries) in the top, bottom, left or right of the workspace. 

 

You can move a gallery anywhere in the workspace 
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To move a gallery: 

1. Open a gallery and click the Auto Hide button to pin the gallery. The button 
changes to a downward-pointing pin to indicate that the gallery can be moved 
and pinned elsewhere.  

2. Click and drag on the gallery’s title bar to move it around. You can either leave 
the gallery ‘free floating’ anywhere in the workspace or dock it in a new location. 

If you move any of the following galleries, the others accompany it as a group. Access 
an individual gallery by clicking its tab at the bottom of the group or click and drag a 
gallery tab to move it away from the group. 

• Bitmap 
• Line 
• Fill 
• Font 
• Color  
• Name 

When you click and drag on a dockable gallery’s title bar, a number of arrows appear 
on the workspace, indicating where you can dock the gallery.  

 

Dragging a gallery causes docking arrows to appear in the center, top, bottom, left and right of 
the workspace. Dock the gallery by dragging it to an arrow. 
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Example of a gallery that has been docked to the left of the workspace 

To dock a gallery: 

1. Click and drag the gallery to the arrow pointing towards the location where 
you want to place the gallery. For example, if you want the gallery at the top of 
the screen, move it to the upward pointing arrow at the top of the workspace. 

2. When the mouse pointer reaches the arrow, a gray transparent box highlights 
the gallery’s new location.  

3. Let go of the mouse button to dock the gallery. Now when you close or ‘auto 
hide’ the gallery, its tab will be displayed in the new location. 

4. Hover over or click its tab to reopen the gallery.  

Note: To move all galleries back to their default position, choose CONTROL BARS from 
the WINDOW menu, click GALLERIES then RESET. 

Grouping galleries 
You can also group galleries and move the whole group to a new location if, for 
example, you are working primarily with 2 or 3 galleries that you want to be close to 
each other and easily accessible.  
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Example of a gallery group with gallery tabs at the bottom - click and drag to add a gallery to or 
remove a gallery from the group. 

To group galleries: 

• Disable the AUTO HIDE button (pin) on one of the following galleries: Bitmap, Line, 
Fill, Font, Color and Name gallery.The gallery is automatically grouped with the 
other five galleries, displayed as tabs at the bottom of the group. Click on a tab to 
open a gallery in the group. 

To group a gallery with one previously docked: 

• Click and drag the second gallery to the four arrows in the workspace center. Let 
go of the mouse when you are over the arrow pointing towards the previously 
moved (first) gallery. The second gallery is now grouped with the first. 

To add a gallery to an existing group: 

1. Click and drag a gallery group over the center of the 4 docking arrows in the 
center of the workspace. When you subsequently click and drag the gallery 
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you want to add over the group you want to add it to, the four docking arrows 
now appear in the center of the gallery group. 

2. Drag the gallery to the center of the arrows within the group. The gallery is 
added to the group and its tab displayed at the bottom of the group. When you 
dock a gallery group, all galleries within the group are also docked. 

To remove a gallery from the group, click its tab and drag to move it away. When you 
auto hide or close a gallery group, all gallery tabs in the group are displayed in the 
workspace border nearest to the last docking location. 

Using galleries 
To fold or unfold a section in a gallery: 

• Click the FOLD/UNFOLD icon. 
• Or double click the title strip. 
• Or right click a section to display a pop-up menu. Select FOLD/UNFOLD section. 

The pop-up menu also has options to scroll to the previous section or next 
section. 

 

This illustration shows the gallery is unfolded. Other galleries are similar. 
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The buttons along the top depend on the gallery (e.g. FILL and TRANSP are specific to 
the BITMAP GALLERY.) However, most galleries have these buttons: 

APPLY applies the selected item in the gallery. Click on an item to select it. 

MORE opens a menu where you can then choose: 

• FIND is described later in searching for an item name. 
• SORT is described later in re-ordering items in a gallery. 
• PROPERTIES provides control over size of the icons and amount of information 

displayed in the gallery. 
• ADD (clipart, fill, and fonts galleries) is described later in adding to a gallery. 
• REMOVE (clipart, fill, and fonts galleries) is described later in deleting sections 

from a gallery. 

Selecting items 
To select an item: 

• Click an item to select it. 
• Or click an item, then "Shift + click" on another item; all items in between the two 

points will be selected. 
• Or "Ctrl + click" to add that item to the selection. 

Re-ordering items in the gallery 
In some galleries, "MORE" > "SORT" opens a dialog box. You can sort by name and, 
depending on the gallery, by other criteria. The primary key controls the initial sort. 
For some sort parameters such as file type or name length, there may be two or more 
files with the same type or name length. These files can be further sorted using the 
secondary key. 

Searching for an item name 
You can search, for example, for all names containing the word red: 

1. Choose "MORE" > "FIND". 
2. Type "red" into the text box. 
3. Select "SEARCH NAMES & KEYWORDS" to search 

only the item names, e.g. file, color, etc., or 
"SEARCH ALL INFORMATION" to search the names 
and keywords available in some galleries. 

 

Adding to a gallery 
You may want to add extra items to these galleries (DESIGNS, FILL & FONTS galleries 
only). To do this: 
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1. Copy the files you want to add into a new directory (folder) using the 
Windows Explorer. 

- For the DESIGNS GALLERY these files can be any of a wide range of vector or 
bitmap file types. 

- For the FILL GALLERY they can be any of the bitmap formats supported by 
Page & Layout Designer (listed in importing and exporting (on page 304)). 

- For the FONTS GALLERY they can be Adobe Type 1 or TrueType fonts. 
2. In the appropriate gallery, click the "DISC DESIGNS/FILLS/FONTS" button. This 

opens a dialog box. 
3. Use the dialog box to select the directory you want to add. 
4. Click "ADD". This creates a new section in the gallery. 

If you later want to add more items to the folder: 

1. Copy the new files into the existing folder. 
2. In the gallery, click "DISC DESIGNS/FILLS/FONTS". This opens a dialog box. 
3. Use the dialog box to select the folder you want to add. 
4. Click "UPDATE" to update the section in the gallery. 

Deleting sections from a gallery 
To delete a section from a gallery (CLIPART, FILL & FONTS galleries only): 

1. Click on the title strip of the section or sections you want to delete. 
2. Click "REMOVE". 

If you later want the section again, add its folder to the gallery (described earlier). 

Closing a gallery 
By default a gallery’s AUTO HIDE button is enabled (i.e., the gallery’s AUTO HIDE button 
in the top right corner is unpinned), so that the gallery closes automatically when you 
move the mouse pointer away from it. 

However if you have disabled the AUTO HIDE button (pinned the gallery), you have to 
close the gallery manually. 

To close a free-floating gallery, click the CLOSE button in the top right of the gallery. 
The gallery closes and its tab is displayed in the gallery bar. 

To close a docked gallery, click the AUTO HIDE (pin) or CLOSE button in the top right of 
the gallery. The gallery closes and its tab is displayed in the workspace border where 
you docked it.   

To re-open the gallery, hover over or click on its tab. 
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Note: To remove a gallery completely, choose GALLERIES from the UTILITIES menu 
and choose the gallery you want removed.  

Moving content from previous versions of MAGIX Page & Layout Designer 
2013 
Sometimes when MAGIX Page & Layout Designer 2013 is updated from one version 
to another, some content is dropped from the Designs Gallery to make space for new 
content. If you discover that some content you liked and used is missing from the 
latest version of the program, you can import it from an installation of an earlier 
version. 

Designs Gallery content is installed into the "Clipart" folder of the main program 
folder. Eg. C:\Program Files\MAGIX\MAGIX Page & Layout Designer 2013\Clipart\ 
The sub-folder names inside the Clipart folder loosely correspond to the names of the 
categories as they appear in the Designs Gallery.  

So before uninstalling an older version of the program, you may want to copy out 
some of the Designs Gallery content and then add to the Designs Gallery in the latest 
version of the program. Follow these steps:- 

1. Identify the location of the old Clipart folder and the decide which sub-folders 
inside it you want to keep. 

2. Copy the sub-folders to a convenient location on your machine.  
3. Select the "Disc designs…" button in the Designs Gallery and in the dialog that 

appears navigate to the sub-folder. If you want to add the "food" folder for 
example, you need to navigate right into the food folder, before clicking Add in 
the dialog. 

4. All the items in the folder are added to a new category in your gallery. Repeat 
the above process for each folder of content that you want to add. 

5. Once you’ve copied out all the folders you want and have added them to your 
Designs Gallery, you can uninstall the old version of the program if it is no 
longer required. 

You can following a similar process to that above to copy fills and fonts from previous 
versions to the Fill and Font galleries. Fills are installed into a "Fills" folder in the 
program folder and fonts in a "Fonts" folder. 

Removing a gallery from the workspace 
By default, when you close a gallery, Page & Layout Designer returns it to the gallery 
bar so that you can reopen it by hovering the cursor over its icon or tab. However you 
can configure Page & Layout Designer to remove any gallery from the workspace if 
it’s not needed.  

To remove unwanted galleries from the workspace, do one of the following: 
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• Choose GALLERIES from the UTILITIES menu and choose the gallery you want 
removed. The selected gallery disappears from your workspace. If you want to 
reinstate a gallery, choose GALLERIES from the UTILITIES menu and choose the 
gallery you want to reinstate. 

• Choose CONTROL BARS from the WINDOW menu and scroll down the list of 
available control bars to find GALLERIES. Click the GALLERIES box to show the 
Galleries toolbar. Click CLOSE. In the Galleries toolbar that is now displayed above 
the workspace, you can toggle display of a gallery by clicking its toolbar button.   

Restoring the default control bars/galleries 
Choose "WINDOW" > "CONTROL BARS" and click RESET to restore the control bar setup 
to the default setting. 

The Name Gallery 
The NAME GALLERY gives you information about the current document, and is an easy 
way to manage the various elements of your document. It lists: 

• Names – you can name objects using either the NAME GALLERY or the NAMES 
DIALOG (via NAMES BUTTON in the SELECTOR TOOL). 

• Fonts used – if you have text in your document, then the used fonts will be listed. 
• Bitmaps used  – a list of bitmaps currently used. 
• Colors used – The USED COLORS section of the NAME GALLERY lists the colors used. 
• Styles used – Use this section of the gallery to select text on the current page that 

uses a given style. 

Note: In the case of multi-page documents, the Name Gallery lists the items usage 
by the current page. All Names are shown anyway, because a Name can be present 
in the document without actually using it. In the case a Name is not applied to an 
object on the page, the little selection circle (see below) is not present before the 
Name. 

To display the NAME GALLERY: 

• Choose "UTILITIES -> NAME GALLERY" ("Ctrl + Shift + F9"), 
• Or click the NAME GALLERY button on the GALLERIES bar. 
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With the commands on the buttons you manipulate names, for some commands to 
work, a name, a property like color or font and/or an object has to be selected: 

• APPLY is used to give names to objects. 
• NEW opens the NAMES dialog (on page 75) to apply a new or existing name to the 

selected object(s). 
• DELETE deletes a name from the NAME GALLERY and from any objects using that 

name. 
• INTERSECT selects the objects that have all the selected items (name, font, bitmap 

or color). 
• REMOVE deletes a name from any objects using that name, but do not delete it 

from the NAME GALLERY. 
• RENAME changes the name shown in the NAME GALLERY. 
• REDEFINE changes which objects use a name. 
• MORE reveals some more options: 

- SELECT selects (in the document) the objects that have any of the selected 
items (name, font, style, bitmap or color). 

- EXPORT exports the selected named objects. 

- HELP shows the according help article  

Batch Export 
You can do a batch export of all objects with a name applied. Just select the names 
(multiple selection is possible with the Shift and Ctrl key) and choose MORE > EXPORT. 

A click on the arrow displays a dialog box that lets you select the file name, 
destination folder  and file format to export in. By default the file name is the same as 
the name in the Name Gallery. Note that clicking "APPLY" just stores the selected 
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options, and that it doesn't save a bitmap; do this by exporting the image with the 
MORE > EXPORT option. 

 (Extension displayed depends on the file format chosen.) Click the box to open 
the according "Export dialog (on page 333)" to specify more details. Click 
"APPLY" to store the selected options. 

 

Object Selection and Name Gallery 
When you select an object or several objects on the page, its name and other 
properties, like named color, font and style (text objects) are shown highlighted in the 
Name Gallery with a half or full red circle: 

 indicates that there are other objects or copies of this object with the according 
name or property. 

 indicates the selected object/s are the only occurrences of the name or other 
property on the page. This is useful if you want to be sure of selecting all 
occurrences of a named object or e.g. a specific font used. 

The other way around you can also select objects using the NAME GALLERY. By 
clicking in the circle to the left of an item in the gallery you will select some or all 
occurrences of the object with that property. 

 As above, means there are other occurrences of this named object that were not 
selected, typically because they are locked and so are not selectable.  

 means all occurrences of this name are selected. 

If there is no selection circle is before a name, that is because this name is not applied 
to any object on the page. 

With the INTERSECT and SELECT command you can use a combination of Name gallery 
items to select objects by. Intersect selects objects that use all of the chosen items, 
e.g. chosing the red color and the Arial font selects all text objects that are red and 
using the Arial font. With the SELECT command (you'll find it under the MORE... 
button) you select objects that use any of the chosen items, given the above example 
this would be any object that is red or using the Arial font. 

Naming objects 

 
You can apply names to any object in MAGIX Page & Layout Designer 2013 
using the “Apply, remove or inspect names of objects” button on the SELECTOR 
TOOL infobar. Alternatively right click an object and choose NAMES from the 
context menu. 

Naming is a general mechanism which has a variety of uses, some of which are 
described below. Most commonly names are used to form loose sets of objects. 

Example uses of names 
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• Record information about the objects, e.g. what they are used for; 
• Select the objects. This is particularly useful if the objects are widely separated in 

the drawing or in a complicated drawing. One click and you can select just those 
objects that share a name; 

• For linked stretching where one named object can automatically stretch another 
named object. For example, changing the text over a colored background shape 
can automatically change the size of the shape. 

 

This dialog is modeless, so you can change the selection while the dialog is displayed. 
It shows the names for the current selection. The text field at the top of the dialog 
shows you how many objects are currently selected. 

Adding names 
To add a name to an object, select the object and open the NAMES dialog using the 
button on the SELECTOR TOOL infobar or right click on the object and choose NAMES... 

Type the new name into the APPLY NAME field, or use the drop down list on the same 
field to select a name which is already used elsewhere in the current document. Click 
ADD. You should see the name appear in the NAMES APPLIED list. 

Names applied 
The NAMES APPLIED field shows you the names applied to the current selection. If 
more than one object is selected, a list of names is only shown if all objects in the 
selection have exactly the same set of names applied. Otherwise “<many>” is 
displayed, indicating that there are differences in terms of the names applied to 
different objects in the selection. 

To remove a name from the selected object(s), click the name in the NAMES APPLIED 
list to select it and then click the REMOVE button. 
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Undo and Redo 
The undo command 

 
"UNDO" cancels the effects of the last operation. To undo an operation: 

• Click UNDO on the standard control bar. 
• Or choose "EDIT" > "UNDO" (the exact wording tells you what the next undo step 

is, i.e. undo scale). 
• Or press "Ctrl + Z". 
• Or press the comma key (in any tool except the TEXT TOOL). 

You can repeat the undo command to step back through the sequence of previous 
operations. 

The redo command 

 
Redo cancels the last undo command. To redo the last operation: 

• Click the REDO button on the standard control bar. 
• Or choose "EDIT" > "REDO" (the exact wording tells you what the next redo step 

is, i.e. redo scale). 
• Or press "Ctrl + Y". 
• Or press the period (full stop) key (in any tool except the TEXT TOOL). 

You can only redo immediately after undo. You cannot redo after changing the 
document (for example, by moving or adding an object). 
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Drawing Lines and Shapes 

Drawing a line or shape 

 

You can use any of these tools to draw lines and shapes: 
• The FREEHAND & BRUSH TOOL ("F3"). 
• The STRAIGHT LINE & ARROW TOOL 
• The SHAPE EDITOR TOOL ("F4"). 

The FREEHAND & BRUSH TOOL is the easiest way to draw simple lines, curves, and 
shapes, and it acts rather like a pencil. 

The STRAIGHT LINE & ARROW TOOL is best if you want to draw single segment straight 
lines, or add arrow heads and tails to any types of lines. 

The SHAPE EDITOR TOOL is best for drawing precise curves and lines. It is also the 
main tool to edit lines and shapes. 

  

Note: Although it is not in the Drawing Tools toolbar, you can also use the PEN 
TOOL to create precise shapes. It has limited functionality and works like the 
line tool of other drawing programs. To use the PEN TOOL, choose CONTROL 
BARS from the WINDOW menu and click the BUTTON PALETTE checkbox. Then 
click the PEN TOOL icon in the Button Palette.  

The Freehand & Brush Tool 

 
You can use this tool to draw in a freehand manner, as you would with a 
pencil. It can also be used to create brush strokes, which is described later. 
And it includes the option to draw variable width lines using a compatible 
pressure sensitive drawing device such as a graphics tablet. While using this 
tool the status line provides reminders on how to use the tool. 

1. Position the pointer where you want the line to start. 
2. Press and hold down the mouse button. (or draw with your graphics tablet or 

other connected device). 
3. As you drag the pointer around the document, your line is drawn in real time. 
4. Release the mouse button to terminate the line.  

Smoothing  Re-fit Indicator 

After you’ve drawn a freehand line you 
can control how smooth the curve is 
(i.e. how many control points) by 
adjusting the smoothing control slider 
on the InfoBar. 
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Low values make the line follow your mouse movement more closely by creating 
more control points, and higher values produce smoother curves with fewer control 
points. 

Low values are less smooth  Higher values produce a smoother curve 

You can change the smoothing at any time until you make further edits to the line 
(the re-fit indicator on the InfoBar tells you when you can still change the smoothing.) 

Erasing while drawing 
Before you release the mouse button you can erase part of the line by holding "Shift".  

 

The pencil icon reverses so the eraser at 
the end is downwards. You can now 
erase back along the line. Release "Shift” 
and you can continue drawing. 

 

Drawing straight segments in the Freehand Tool 
While drawing a freehand line hold down "Alt", move the pointer to a new position 
and release "Alt" to draw a straight line. You can continue drawing a line or hold down 
"Alt" again to draw another straight segment. Remember, you can use "Ctrl" to 
constrain the angle of the line. If you only want to draw lots of single segment straight 
lines, use the STRAIGHT LINE TOOL described below. 

Extending a line 
Make sure the line is selected (a single click on the shape or line in the FREEHAND & 
BRUSH TOOL will do this). Now if you move over the end of the line, a small + sign next 
to the pencil icon will indicate you can just draw to add a new freehand section to the 
line. 

Joining two lines 
Select both lines, ("Shift + click" on the second line to add it to the selection) and you 
can now just draw from the end of one line to an end of the other. A small + sign next 
to the pencil icon (appearing after a pause) indicates you are over the end. 

Closing a freehand shape (to create a filled shape) 
If you connect the start and end of a line, then it becomes a filled shape. You can now 
alter the fill color by dragging colors from the Color Line or using the Color Editor. 
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Editing lines/shapes with the Freehand & Brush 
Tool 

You cannot directly modify shapes created by the Quickshape, Rectangle, or Ellipse 
Tools. First convert them to editable shapes using "ARRANGE" > "CONVERT TO 
EDITABLE SHAPES". See "Shape handling (on page 142)" for more information. 

You can use the FREEHAND & BRUSH TOOL to edit lines (or outlines of shapes) by 
simply redrawing the section of line you want to replace. For example: 

To edit the object: 

Select the object that you wish to edit. 

 

Move the freehand pencil over a part of the line. A ~ shows 
when the pencil is in position. 

 

Draw the required line, then move the freehand pencil over to 
the second point of the existing line. Again, a ~ shows when 
the pencil is in position. 

Release the mouse button, and the section of line is replaced. 

 
 

Sketch Mode 

  

This option is useful if you are rapidly sketching lots of separate lines close to 
each other, perhaps using a drawing tablet. 

Hold the mouse pointer over an existing line, or end point, and you’ll notice that there 
is a short pause before the mouse pointer changes to indicate that the line will be 
edited or extended. This pause means you can still edit existing lines if you want, but 
you won’t do so unintentionally when you actually mean to sketch new lines. 
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Trace mode 
Trace mode helps you to draw lines which follow visible edges in photo images. For 
most photos it’s best to turn smoothing down from the default value, so that the line 
more closely follows complex edges with less smoothing of the line as you draw. 

Trace mode on/off 

 
Turn on trace mode using the toggle button on the infobar. Draw with the 
Freehand tool over a photo and you should see that the line tries to follow 
edges in the image. 

You can also turn trace mode on and off while you are actively drawing a line, by 
pressing the T key. The mouse pointer changes to indicate whether trace mode is on 
or off.  

 

Commit points 
You’ll often notice as you draw along an edge in a photo that sometimes the last few 
pixels of the line you’ve drawn will ‘jump’ around as it searches for different routes. 
You can ‘commit’ the edge at any time by pressing the SPACE BAR when a correct 
route has been found. Then continue and trace mode will find more routes between 
the last commit point and the mouse pointer. Commit points are automatically added 
for you every 50 screen pixels. 

Cutting out objects from photos 
To cut out part of a photo you can either draw an ordinary shape over the top of the 
photo and then use the combine shapes operations in the ARRANGE menu to cut the 
photo with the shape (see the Shape Handling chapter (on page 135) for details).  
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Once you’ve cut out a piece of a photo, it’s often a good idea to apply a small amount 
of feather to blur the edge slightly.  

Brush styles 
The FREEHAND & BRUSH TOOL can also be used to apply different brush stroke styles 
along the path of the line. Instead of being a solid, fixed-width line, you can change it 
to be a variable-width line, or one of a near-infinite range of fancy brush styles, like 
airbrush, felt tip marker, and many more. 

The Straight Line & Arrow tool 

 

This tool makes it easy to draw single segment straight lines and to add arrow heads 
and tails to any lines in a way that is much easier and more powerful than doing the 
same thing with the LINE GALLERY.  

Drawing & editing straight lines 
Simply click and drag on the page to draw a straight line. You can click on any existing 
line to select it, and once selected you can click-drag on either end to move the end of 
the line around. 

Adding arrowheads & tails 
The infobar has two dropdown lists on the left which allow you to choose an arrow 
head or tail style for each end of the selected line.  

 

 Arrow head 

 Arrow tail 

 Arrow head/tail size 

 Reverse path 

The slider on the infobar allows you to change the size of the arrow head and tail on 
the current selected line. Or you can enter a percentage value into the size text field to 
the right of the slider.  

Enter a value less than 100% to reduce the size of the arrowhead (and tail), or greater 
than 100% to increase. Although the slider only takes the size value up to a maximum 
of 800%, you can enter percentage values larger than this into the size text field. 
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Reverse path 

 
Press the REVERSE PATH button on the infobar to switch around the head and 
tail of the selected line. 

 

The Shape Editor tool 

 
The SHAPE EDITOR TOOL is the main tool used for both creating precise 
curves, lines, and shapes, as well as editing or altering lines and shapes.  

 

 Add/Change/Edit Indicator 

 Make curve 

 Make line 

 Smooth join 

 Sharp join 

 Break at points 

 Delete points 

 Reverse paths 

 Positions of handles 

 Smoothing 

The InfoBar, shown above, provides a wide range of controls as well as precise 
numeric control. 

All lines and shapes in MAGIX Page & Layout Designer 2013 are made from a 
sequence of curve and line sections. Curves are sometimes called "Bézier" curves 
after the mathematician who first described them. 

 

Although this section describes the SHAPE EDITOR 
TOOL, you can also edit lines and shapes using the 
SELECTOR TOOL if you have the SHOW EDIT OBJECT 
handles button selected on the SELECTOR TOOL 
InfoBar. 
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The sections or segments of a line are marked by small black point handles. You can 
drag, add and delete these handles to manipulate the shape of the line or outline. 

Some objects such as quickshapes, rectangles, ellipses, and text have to be converted 
into editable shapes before you can use the SHAPE EDITOR TOOL on them. Select the 
"ARRANGE" > "CONVERT TO EDITABLE SHAPE" menu ("Ctrl + Shift + S") to do this. 

To draw a straight line segment 
Using the SHAPE EDITOR Tool, start a straight line: 

1. Click where you want to start the line. You can start a line at either end; you 
don’t have to work left to right, or top-to-bottom. This creates a point handle, 
and is displayed as a red square to indicate that it is the selected handle. 

2. If necessary select the MAKE LINE button on the InfoBar ("L"). This ensures the 
next click will draw a straight line segment. 

 

 

Either click where you want the next point 
handle to be, or click and drag, and then 
release the mouse button when the line is 
correct. This creates a line segment and 
selects the new end point handle. 

 

Mixing curved and straight lines 
To create an object which is a mixture of straight and curved segments, just switch 
between the MAKE CURVE and MAKE LINE buttons as you create the object (you can 
also press "L" or "C" on the keyboard.) 

Note: You can also use the keyboard shortcut "X" to create a Cusp Join or "S" to 
create a Smooth Join while using the SHAPE EDITOR TOOL. These affect the way two 
line segments come together. A Cusp Join creates 2 independent Bezier control 
handles that you can edit separately. With a cusp join, you can create a sharp angle. A 
Smooth Join creates a symmetrical join that works like a see saw. If you drag one 
Bezier control handle down, the opposing control handle goes up. 

To draw a curved line segment: 

 

This is similar to starting a straight line (described above). 

1. Click where you want to start the line. 
2. If necessary select the MAKE CURVE button (shortcut "C".) 
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3. Either click or drag (as described for straight lines) to create a second point 
handle, and a curve segment will be added to the line. 

A curve segment has CURVE HANDLES associated 
with the selected point handle. You can drag these 
to adjust the angle and radius of the curve. 

 

Extending the line 
Make sure an end point handle is the selected handle (red outline) and then just click 
again to add a new line or curve section.  Each successive click places a new point 
handle and draws a new line segment to the selected point handle. 

This applies also to SHAPE EDITOR and PEN TOOLS. To use the PEN TOOL, choose 
CONTROL BARS from the WINDOW menu and click the BUTTON PALETTE checkbox, or 
press "Shift + F5" on your keyboard. 

Adding a new point handle 
The SHAPE EDITOR TOOL has three modes, depending on whether no point handles are 
selected (a click will start a new line), an end handle is selected (a click will add a new 
section), or one or more other point handles are selected (you can drag or change the 
handles).  

The InfoBar shows the current mode. 

 

• NEW: Click to start a new line, 
• ADD: Click to extend the line, 
• CHANGE: Drag or delete point handles to change. 

This applies to the SHAPE EDITOR TOOL only. 

To the end of a line: 
Make sure the line is selected, then: 

1. If necessary, click on the end point 
to select it. 
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2. Position the pointer and click to 
add a new section. 

 

To the middle of a line: 
Make sure the line is selected, then; 

1. Click on the line to add a new point handle 
into the line 

2. Drag the point handle to the required 
position. 

 

 

To the start of a line: 
If the end point is selected, clicking on the start point closes the shape (this is 
described in "Closing a shape (on page 133)” ). To add a new control handle to the 
start of a line: 

1. Finish the line using "Shift + click". 
2. Click on the start handle. 
3. Position the pointer and click. 

Selecting multiple point handles 
You may want to select several point handles to delete them, move them as a group, 
or change a region of points to curved or straight lines. To do this: 

1. Select one point handle in the normal way by clicking on it. 
2. "Shift + click" the other point handles to select them ("Shift + click" also 

deselects.) 

- Or "Ctrl + Shift + click" on a point handle to select all point handles on the 
line. 

- Or drag the mouse pointer diagonally to create a selection rectangle. All point 
handles in the rectangle are selected. 

- Or "Shift + drag" diagonally to create a selection rectangle. This adds all 
points within the rectangle to those already selected. 

3. If the line has one or more selected point handles: 

- End moves the selection to the end of the line. 

- Home moves the selection to the start of the line. 

- Tab moves the selection to the next point handle towards the end. 

- "Shift + Tab" moves the selection to the next point handle towards the start. 

The start and end points are significant when applying arrows (on page 93). 
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Deleting points 
Select the point handle(s) as described above and either click the 
DELETE POINTS button (SHAPE EDITOR TOOL InfoBar), or press "Del". 

 

Moving point handles—Shape Editor Tool 
You can move one or more selected handles: 

• Drag the handles using the mouse. 
• Or use the arrow keys on the keyboard. 

Or to move a single handle, type new values into the text boxes on the InfoBar (see 
below). 

Using the text boxes on the InfoBar 
The center pair of text 
boxes always shows the 
X/Y co-ordinates of the 
selected point. 

The surrounding X/Y fields show the co-ordinates of the curve handles on either side 
of the selected point. 

X/Y co-ordinates are relative to the bottom left corner of the page. You can change 
this in the "Grid and ruler" (on page 348) tab in the options dialog. 

If the selected point is on the end of a straight line section, the left fields show the 
length and angle of the line. You can adjust either by entering a new value and 
pressing return. 
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 Length and angle for straight line 

 Position of selected point 

 Position of curve handle 
 

Smoothing a line 
Imported shapes or shapes from tracers may have unnecessary points on a line. Lines 
with too many points can be unwieldy and can slow down rendering. MAGIX Page & 
Layout Designer 2013 can smooth the line to remove unnecessary points. 

 

Select all the points on the part of the line you want to smooth (see above). Drag 
selecting around the region in the SHAPE EDITOR TOOL is probably the easiest way to 
select a large number of points. 

Drag the smoothing slider on the end of the 
SHAPE EDITOR InfoBar.  

 

Tip: to make sure important points are not deleted, make sure they are not selected 
("Shift+ click" on a selected point deselects it). 

Constraining the line 

 

When dragging a point handle, holding down the 
constrain key ("Ctrl") will constrain the movement to 
multiples of the constrain angle (controlled from the 
OPTIONS dialog, GENERAL tab). When dragging a curve 
handle the angle is constrained. 
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Changing curves 
Using the curve handle 
Dragging the curve handle will adjust the curvature of the adjoining curve segments. 

 

Move the curve handle towards or away from the point 
handle to pull the curve in the required direction. 

 

Dragging the line segment 
You can also change the curve by dragging the line segment between points. 

 

Notice the difference between dragging the line to change its shape, and clicking on 
the line to add a new point handle. Dragging a straight line segment changes it to a 
curved line segment. 

Making sharp corners 
Normally, MAGIX Page & Layout Designer 2013 draws a smooth curve through a 
point handle. For this, the two curve handles either side of a point handle are linked. 
Moving either curve handle also moves the other. 

Sometimes you will want a sharp corner, and to achieve this, you need to unlink the 
curve handles: 

1. Double click the point handle, 
2. Or select the point handle and either: 

Click the CUSP JOIN button, or press "Z". 

You can now move each curve handle independently. 

Making smooth curves 
To convert a sharp join into a smooth curve: 

1. Double click the point handle, 
2. Or select the point handle and either: 
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Click the SMOOTH JOIN button, or "S". 

The two curve handles become linked and move to opposite sides of the point handle. 
This may change the shape of the curve. 

 

Balancing curves 
Balancing makes the two curve handles the same distance from the point handle, 
which gives smoother, more symmetrical curves. To balance a curve, select the point 
handle, then drag one of the curve handles with "Shift" held down. As you drag one 
curve handle the other one will move to be exactly opposite it and the same distance 
from the point handle. 

Changing a straight line to a curve (and vice 
versa) 
1. Select the point handles at both ends of a line segment. For several line 

segments select all bordering point handles. 
2. Click the Make curve   or Make line  button on the InfoBar, or press "L" 

or "C" (these shortcuts only work in the Shape Editor Tool). 

  

After changing the line type, you may need to move the curve handles for a smooth 
transition between curved and straight line segments. 

You can select several line segments and convert them all. The point handles at both 
ends of the segment must be selected. 

Joining lines 
You can only join lines if both are selected (the point handles are shown on both 
lines): 

Using the SELECTOR Tool, hold down "Shift" and click on the lines to select them (if 
you are already in the SHAPE EDITOR Tool, you can press "Alt + S" to temporarily go 
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into the SELECTOR Tool, "Shift + click" to select the second line, then "Alt + S" again to 
return to the SHAPE EDITOR Tool). 

Selecting objects is described fully in "Selecting objects (on page 98)". 

Once both objects are selected, in the SHAPE EDITOR TOOL or the PEN TOOL, drag the 
end handle of one line over the end of the other line. As you drag the mouse pointer 
will show a + symbol to indicate that the lines will be joined.. 

 

If the ends of the two lines are already very close to each other (but not joined), then 
you can either zoom in or drag the end point away, and then back again so it’s over 
the end point, and you see the + sign to indicate a join will occur. 

To create a filled shape, drag the other two end handles together. Because you join 
the end handles, you can only join lines and not shapes. Shapes are closed objects and 
so have no end handles. 

There’s more information on this in "Shape handling (on page 133)". 
Notes: 
• To use the PEN TOOL, choose CONTROL BARS from the WINDOW menu and click the 

BUTTON PALETTE checkbox, or press "Shift + F5" on your keyboard. 
• You can also use the FREEHAND & BRUSH TOOL (described earlier) to join lines. 
• There is an ARRANGE > JOIN SHAPES menu option which joins two or more shapes 

into one single shape, even if they are separated on the page. This makes 
overlapping areas transparent. For example, joining an object with a smaller circle 
on top this way, produces an object with a circular hole in it. 

Splitting a shape 
If you want to split (break) a line or shape: Either select an existing point handle on 
the line or outline of the shape, or create a new one where you want to break the line. 
Just click on the line in the SHAPE EDITOR TOOL (see above). 

Click on the BREAK AT POINTS button, or press "B". 
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If you split a line, there is no visible change. However, if you move the point handle, 
then only part of the line moves. If you split a shape, it changes to being a line. Any fill 
disappears. 

Note: "Slice shapes" (part of "ARRANGE" > "COMBINE SHAPES") also lets you split 
shapes into two separate shapes. This is described in "Shape handling (on page 
136)". 

Changing the line width (thickness) 
To change the line thickness or the outline thickness of a shape, first select the object 
or objects: 

Type a new line width into the text box on the STANDARD control bar 
or choose the default line thickness from the menu.  

Line thickness is traditionally measured in points, abbreviated to pt. 1 point is 1/72nd of 
an inch (about 0.3mm), which is slightly less than the thickness of one screen pixel 
when viewed at 100% zoom. 

You can use any of Page & Layout Designer’s standard measurement units. 

You can enter the thickness value in any unit, and MAGIX Page & Layout Designer 
2013 will convert it to the correct number of Points. E.g. you can enter 0.5cm, and you 
will get a line half a centimeter thick, but it will show just over 14pt in the line width 
field. 

If you have no object selected and you change the line thickness value, this changes 
the default for all new lines. 

Note: A zero width line is a special case, and should not normally be used. This 
draws a line one device-pixel wide. The actual size will therefore depend on the 
device the drawing is displayed on. On a monitor screen one pixel is clearly visible 
and is never shown anti-aliased. On devices such as printers and particularly on 
image setters, which have a much higher resolution, the line is almost invisible (zero 
width lines in imported files are converted to 0.25pt). 
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Variable width lines 
From the FREEHAND & BRUSH TOOL InfoBar you can select a drop-down menu that 
shows a selection of alternative variable line thickness profiles. As you move the 
mouse over the selection, an enlarged preview is shown on the right. 

 

Selecting one of the styles will change the line (or outline of a shape) from being a 
constant thickness line, to a variable thickness. This is great for creating pen and ink 
style artwork, and is often used in the creation of cartoons. 

The line width dropdown still should be used to change the overall thickness of the 
line. 

To restore a constant line width, select the top left corner item from the menu. 

The special "PRESSURE" profile in the dropdown menu is used to indicate when a line 
has a custom profile as a result of being drawn with a pressure sensitive device, with 
the pressure sensitivity drawing option turned on. 

Line Gallery 
The LINE GALLERY can be used to apply a range of line styles or attributes, such as 
brush strokes, dash patterns, arrow heads, and more. 

To display the LINE GALLERY: 

• Choose "UTILITIES" > "LINE GALLERY" 
• Or click the LINE GALLERY tab on the GALLERIES tab.  
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The LINE GALLERY is split into sections. To open or close any section, click on the small 
folder icon in the gallery window. 

 

 Line Width 

 Join type 

 Line cap 

To apply any line style or attribute from the gallery you can: 

• Drag and drop the required style from the gallery onto the shape or line. 
• Or double click on the required style in the gallery. 
• Or select the style and then click the APPLY button. 

Line width 
The text box at the top of the gallery duplicates that on the standard control bar. 

Brush strokes 
There are several sections that show a selection of various brush styles. 

Dash pattern 
This section provides a selection of line dash styles. 
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Arrowheads 
The best way to apply an arrowhead is to use the STRAIGHT LINE & ARROW TOOL (on 
page 82), as described earlier in this chapter. However you can also use the line 
gallery. Drag and drop the arrowhead from the gallery onto the appropriate end of the 
line. 

Alternatively, to apply an arrowhead: 

• Double click on the arrowhead in the gallery. 
• Or select the required arrowhead and click APPLY. 

Page & Layout Designer has two types of arrowhead designs: beginning and end. If 
the line already has a beginning arrowhead, applying an end arrowhead automatically 
places it at the opposite end of the line. 

If the line has no arrowheads, and you use the APPLY button or double click a style to 
apply it, then the arrowhead will be placed at the end of the line. 

The size of the arrow head is related to the thickness of the line. Thicker lines have 
proportionally larger arrowheads. 

If you hold "Ctrl" down and double click an arrow head or tail style, it will apply it to 
the other end of the line. 

 

For general information about galleries see document handling (on page 64). 

Change join type 
This control on the top of the LINE GALLERY sets the style of corners. 

 

To change an existing line, select the line.  
To change the current join type, deselect all lines. 
Select the required type from the menu. 

 

Change line cap 
This control at the top of the LINE GALLERY sets the style of the ends of the line. 
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To change an existing line, select the line. 
To change the default line cap, deselect all lines. 
Select the required type from the menu. 

 

Brushes 
Brush strokes control the appearance of lines (for example, to apply an air-brush 
effect). 

 

 Select a brush preset 

 Select a preset for a stroke shape/pressure profile 

 

Using an existing brush 
To use an existing brush type for a line: 

1. Click to select an existing brush. Click on the arrow to display a preview 
window of the default set of brush designs and previously created custom 
brushes (if available) from all open documents. 

2. If required, select a stroke shape to change the appearance of the line (and to 
also mimic using a pressure-sensitive tablet). 

3. Draw the line as required, and it will use your chosen brush and stroke shape. 

You can also select an existing line in the document then go through the above 
process to change its appearance. 

You can also browse different brush types using the LINE Gallery (on page 95). 

Creating a new brush 
To create a new brush type: 

1. Design your desired brush in Page & Layout Designer then select it. 
2. Click CREATE BRUSH. 
3. Give your brush an appropriate name. 

You can then draw with your new brush straight away. The new brush is listed in the 
brushes preview window. 
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Brushes are stored in the document. If you want to re-use a brush in another 
document, you have to load the document containing your custom brush first. Only 
the default brushes are always available. 

Editing a brush 
To access advanced editing options for a brush: 

1. Select the brush that you wish to edit. 
2. Click EDIT BRUSH. 

Here you can alter: 

• SPACING: Gap between the objects 
in the brush. 

• OFFSET: Distance between the 
original line and the objects in the 
brush. 

• SCALING: Size of objects in the 
brush. 

• ROTATION: Rotation of the objects 
in the brush as they follow the line. 

• TRANSPARENCY: Transparency of 
the brush. 

• FILL PROPERTIES: Miscellaneous 
options, including color options. 

Transparency is described in "Transparency (on page 222)" and colors are described 
in "Color handling (on page 159)". 

If you use a pressure-sensitive graphics tablet, the transparency and scaling options 
allow you to configure the brush’s sensitivity levels. If you do not have a pressure-
sensitive graphics tablet, you can mimic the effects using brush shapes (on page 93). 

Save your edits with the SAVE button, with the SAVE AS NEW button a new brush is 
created. 

Attention: Although you can edit a default brush, you can not save the edits into this 
brush for use beyond this session. The default brushes are always restored on the 
start of the program. If you want to edit one of the default brushes, for use at a 
further time, then you have to save it as a new one.  
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Selecting Objects 

The Selector Tool 

 
The SELECTOR Tool is the main tool for selecting, moving, scaling, and rotating 
objects. It is typically used more than any other tool and is the central tool for 
manipulating documents. 

 

The Selector tool infobar - left side 

 Show bounds 

 Show edit handles 

 Show fill handles 

 Show rotation handles 

 Rotation center 

 Position of selection 

 Dimensions of selection 

 % size controls 

 Lock aspect ratio 

 

The Selector tool infobar - right side 

 Rotate & Shear 

 Flip horizontal 

 Flip vertical 

 Scale line widths 

 Apply, remove or inspect names of objects  

 Perimeter and area indicator 

To use the SELECTOR Tool: 

• Click on the SELECTOR Tool on the MAIN TOOLBAR. 
• Or press "Alt + S", "V", or "F2". 

When switching to the SELECTOR TOOL, if there are objects selected inside a group or 
other composite object type, the parent object (group) becomes selected instead.  
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The InfoBar 
All the buttons on the InfoBar are described in the following sections except: 

• SHOW EDIT HANDLES which is described in "Drawing lines". 
• SHOW FILL HANDLES which is described in "Fills". 
• APPLY, REMOVE OR INSPECT NAMES OF OBJECTS which is described in "Document 

handling (on page 75)". 

The first two buttons let you edit the outlines and fills of objects without the need to 
switch tools. 

Alt + S 
Because the SELECTOR TOOL is the most used tool, there is an additional shortcut that 
lets you switch to the SELECTOR TOOL to perform a selection or other operation, and 
quickly switch back to the previous tool. If you are using another tool, you can easily 
switch to the SELECTOR TOOL: 

• Press and release "Alt + S" to switch to the SELECTOR TOOL. Press again to return 
to the previous tool. 

Selecting objects 
To select a single object, click on any visible part of the object.  

Change object selection 
Once an object is selected, you can use the following keys to change the selection: 

• End selects the back object. 
• Home selects the front object. 
• "Tab" selects the next object towards the back. 
• "Shift + Tab" selects the next object towards the front. 

Front and back objects are described in "Object handling (on page 103)". 

Marquee selection 
To select multiple objects, press and hold down the mouse button. Dragging the 
mouse draws a selection rectangle, by default all objects wholly within the selection 
rectangle are selected.  

If you have an object in the way which is preventing you from drawing a rectangle 
because you end up moving the object, hold down "Shift" while dragging out the 
selection rectangle. 

By default, dragging a selection rectangle selects only those objects which are 
completely inside the rectangle. This behavior can be changed so it's compatible with 
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the way selection works in other applications, whereby the objects touching the 
rectangle outline also become selected. Hold down "CTRL" while dragging to include 
those objects touching the selection rectangle in the selection. 

The "UTILITIES -> OPTIONS" (on page 346) dialog (General Tab) enables you to 
change the default setting for marquee selection. So you can choose to have objects 
touching the selection rectangle selected, without having to hold down "Ctrl" during 
the drag. In this case, holding "Ctrl" down while dragging selects only the objects 
wholly inside the rectangle. 

Extend Selection 
To select additional objects: 

• "Shift + click" on them. 
• Or "Shift + drag" the mouse pointer. This draws a selection rectangle and adds 

objects within the rectangle to the selection. 

Select under 
Hold down "Alt" to select objects hidden by other objects. By "Alt + clicking" you can 
step through several overlapping objects. 

Select inside 

Groups and blends are described later. Text stories are described in "Text handling 
(on page 178)". Molds are described in "Distorting objects (on page 143)". 

You can select an object that’s inside a group or other container object by holding 
down "Ctrl" while you click on it. This is called selecting inside. The object you click on 
will always become selected, even if it’s deep down inside several levels of nested 
groups. When you have such deep nesting of groups, sometimes you may want to 
select one of the nested groups (a group inside another group). If you hold down the 
"Alt" and "Ctrl" keys while you click you can do this easily. The first such click will 
select the top level group (just as  an unmodified click does). Click again and the next 
group down in the hierarchy will be selected instead. Continue clicking to ‘drill down’ 
into the group structure until the group you want becomes selected. 

Note that some operations are not permitted with select inside. For example, you are 
not permitted to delete the end object of a blend (because the blend would then be 
meaningless). 

Marquee selection does not work for select inside, because "Ctrl" is used to toggle the 
two marquee selection modes. 

Scribble Selection 
In the Selector Tool, drag with "Alt" held down and instead of dragging a box, a 
freehand line is draw. Every object that is touched by the line becomes selected. 
Hence you can drag the mouse around the page, touching all the objects that you 
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want to select. This also works in conjunction "Shift" for extend selection (on page 
100) and "Ctrl" for select inside (on page 100). 

Moving objects selected under or inside 
If you need to move a selected object that’s either under others or inside a group, then 
just dragging doesn’t work as it will select and drag a different object. To overcome 
this hold "Ctrl + Alt" and start dragging. This will always drag the existing selected 
object. You can let go of the keys once you’ve started dragging. 

Or you can use the arrow keyson the keyboard to nudge the object. 

Selecting and layers 
You cannot select objects in locked or invisible layers. 

See "PAGE & LAYER GALLERY (on page 149)" for more details on layers. 

Selecting all objects 
To select all objects: 

• Choose "EDIT" > "SELECT ALL", 
• Or press "Ctrl + A". 

Deselecting an object 
To deselect all objects: 

• Click anywhere on an unused part of the document, 
• Or choose "EDIT" > "CLEAR SELECTION", 
• Or press "Esc". 

To deselect one object from several: 

• "Shift + click" on the object. This deselects that object. Other objects remain 
selected. 

Selecting with Soft Groups 
When you click on an object which is a member of a soft group, all members of the 
soft group become selected. This is one of the main purposes of Soft Groups – to keep 
closely related objects together even when they are on different layers. If you want to 
select just one member of a Soft Group, use Ctrl to select inside, as described above. 
See the “Soft Group (on page 123)” section in “Object Handling” for more information. 
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Double-click shortcuts to tools 
For some types of object, double-clicking on them will take you into the tool which is 
most applicable to that object. So for example if you want to edit some text, double 
click on it to go into the Text Tool, so you can start editing it immediately. The 
following table summarizes the available shortcuts for different object types: 

Double click on Selects this tool 

Text 
 

Text Tool 

Photo 
 

Photo Tool 

Rectangle Rectangle Tool 

Ellipse 
 

Ellipse Tool 

Shape 
 

Shape Editor 

Group 
 

Starts an ‘edit inside’ by opening the contents of the group 
in a separate sub-document view. 
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Object Handling 

Moving objects 
To slide an object across the page 

1. Choose the SELECTOR TOOL. 
2. Drag the object to the required position. Hold down "Ctrl" to restrict the 

direction of movement to one of the constrain angles. 

The constrain angles are user definable. Refer to "Customizing Page & Layout 
Designer (on page 345)" 

Hold down "Ctrl + Alt" and you can drag the selected object even if the pointer is not 
over it. This is useful when the selected object is hidden behind another object or part 
of a group. Release "Ctrl" and "Alt" after you start the move unless you want to 
constrain the move. 

You can also move objects using the arrow cursor keys. This is described on the next 
page. 

Object snapping is a very powerful way of accurately aligning lines, points and the 
edges of objects to any other object so they exactly touch. It also helps you align to 
the horizontal and vertical center lines of the page. 

 
To toggle object snapping, click the SNAP TO OBJECTS button or right click and 
choose "SNAP TO" > "SNAP TO OBJECTS". You can also choose "WINDOW" > 
"SNAP TO OBJECTS".  

Click and drag on the object you want to snap. As you drag, Page & Layout Designer 
displays a magnet icon whenever you are near a "point of interest" or potential 
snapping site relative to a visible object on the page.  

To snap in a path relative to the page center (both horizontally and vertically), move 
the object over the lines that appear as you drag on the page. A red dot on the line 
also indicates potential "point to path" snapping points, so that you can snap the 
object to a point such as the center or center line of the page. 

See Snapping (on page 114) for details on snapping to grid and snapping to objects. 

Drop copy 
During a move (and while still holding the left mouse button down) click the right 
mouse button or press + on the numeric keypad to drop a copy of the object. The 
original object doesn’t move. You can do this as many times as you wish to create a 
series of duplicated objects. 
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You can also hold down the right mouse button and drag a copy of the object. Left 
click to leave a copy at the current mouse position. 

Fills 
Usually, moving an object also moves the fill with it: 

 

Normal move left to right with a linear filled object. 
This also applies to rotating, skewing, scaling and 
stretching objects. 

Page & Layout Designer can also move the object but not the fill origin.  

 

To do this click the "−" key on the numeric keypad 
during the move. 
The same move, but pressing "−" (minus) during the 
drag. 

 

Nudging objects 
Usually you can move an object a small amount by using the arrowkeys to nudge the 
object (these keys sometimes have other uses, especially in the TEXT TOOL). 

Nudging is not affected by either magnetic or grid snapping (snapping is described 
later). 

Nudge modifiers 
To modify the nudge distance, use these key combinations while using the arrow 
keys: 

• Ctrl  nudge 5 times the normal distance 
• Shift  nudge 10 times the normal distance 
• Ctrl + Shift nudge by l/5th the normal distance 
• Alt  nudge by 1 pixel 
• Alt + Shift nudge by 10 pixels 

You can change the normal nudge distance under the GENERAL tab in "UTILITIES" > 
"OPTIONS". Refer to "Customizing Page & Layout Designer (on page 348)". 

Nudge works in most tools. 

Cut, copy and paste 
These let you move or copy an object in the same document or between different 
documents. The procedure is: 

1. Select the object. 
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2. To remove the object, choose "EDIT" > "CUT" (or "Ctrl + X"). To copy the object 
but not remove it, choose "EDIT" > "COPY" (or "Ctrl + C"). Either option puts 
the object (or a copy of it) onto the clipboard. 

3. Choose "EDIT" > "PASTE", "Ctrl + V", or "INSERT". This pastes the clipboard 
contents into the document. 

Note that if the objects you copy are all on the same layer, then you can paste those 
objects to any layer by first making it the current layer and then choosing "EDIT" > 
"PASTE" >  "PASTE IN LAYER" or "PASTE IN PLACE IN CURRENT LAYER". The layer from 
which the objects were copied is ignored in this case. 

However if the objects you copy are on several different layers, then the layer 
structure is maintained when you paste.  

This allows you to copy layered data within a document or to a different document. 
Any layers which are missing in the target document are created automatically by this 
operation. So for example if you copy a mouse-over button, which has one object on 
the MouseOff layer and another object on the MouseOver layer, to a new document, 
the MouseOff and MouseOver layers will be created if they don’t already exist and 
the button objects copied onto them. 

"Ctrl + Shift + V" or "EDIT" > "PASTE IN PLACE" pastes the clipboard contents into the 
same X/Y position from where they were cut or copied or the same position relative 
to the bottom of the page in the case of footer objects. This only applies to objects cut 
or copied from within Page & Layout Designer. Objects imported from other 
programs are always pasted into the center of the current view. 

The object remains on the clipboard so you can paste the same object several times. 

If there is a choice of formats on the clipboard, MAGIX Page & Layout Designer 2013 
will display a PASTE SPECIAL dialog which allows you to choose the format you want to 
paste in (eg. When pasting in text you may have the choice of pasting in unformatted 
text or Rich Text). 

In addition you may see the following paste options, depending on the clipboard 
contents: 

Paste unformatted text 
Pastes any text on the clipboard into your document without any formatting. 

Paste format/attributes 
Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill 
color) of the pasted object. 

Paste position 
This option applies the position of a copied object on the clipboard to a currently 
selected object, which moves to the exact same position as the copied object. 
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If multiple items have been copied to the clipboard, Page & Layout Designer treats 
them as if they are a group and moves the currently selected object to the position of 
the copied group as a whole. 

The currently selected object is pasted or moved into the center position of the copied 
object or group of objects. 

Paste size 
This option applies the size of a copied object on the clipboard to a currently selected 
object, which resizes around its center to the exact size of the copied object. 

If you have multiple items selected when you ‘paste size’, each of those objects is 
made the target size, instead of the selection as a whole. So for example if you copy a 
200x200 pixel photo, then select 10 other photos and ‘paste size’, all 10 photos each 
become 200x200 pixels. This gives a quick way to make a bunch of objects a 
particular size. 

Paste replacing selection 
This is similar to PASTE POSITION, except that the copied object on the clipboard 
replaces the currently selected object and retains the deleted item's position. 

The copied object is pasted into the center position of the deleted object. 

Paste in current layer 
The same as PASTE IN PLACE, except your object will only be pasted into the current 
layer. 

This is useful if you want to display or hide just your pasted object when layers above 
or below are displayed. 

Paste in place in current layer 
The same as PASTE IN CURRENT LAYER, except your object will be pasted into the 
current layer in the exact same position from which you copied it. 

Removing objects from the document 
First select the objects you want to remove. You can then either cut the objects to the 
clipboard or delete them. 

Cutting objects 
Choose "Edit" > "Cut", or press "Ctrl + X".The contents of the clipboard are 
overwritten and you can paste the deleted object(s) somewhere else if desired. 
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Deleting objects 

 
Right click and choose DELETE or choose DELETE from the EDIT menu, or press 
the "Delete" key, or click the DELETE button on the STANDARD control bar. 

In this case the deleted objects are not put onto the clipboard. If you accidentally 
delete an object, undo retrieves it. 

Duplicating and cloning 
Both these options create a copy of the selected object. The original object is 
deselected and the duplicate or clone becomes the selected object. 

You can also duplicate an object during moving, rotating, scaling, or skewing. During 
the drag action (and while still holding the left mouse button down) click the right 
mouse button or press "+" on the numeric keypad to drop a copy of the object. The 
original object doesn’t move. You can do this as many times as you wish to create a 
series of duplicated objects. 

So an easy way to create one or more copies of an object that is exactly horizontally 
or vertical aligned, is to drag the object, hold "Ctrl" to constrain the movement, and 
right click (or press "+" on the numeric keypad) for each copy required. 

 

To quickly create  a line of objects, draw one, then drag while holding "Ctrl" and right click for 
each copy required.  

Duplicating 
Choose "Edit -> Duplicate", or press "Ctrl + Alt + D", or select the object in the PAGE & 
LAYER GALLERY (on page 149) and click the DUPLICATE button. The copy is displaced 
slightly, usually down and to the right, from the original. 

The duplicate distance is user definable, see "Customizing Page & Layout Designer 
(on page 348)" 
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Cloning 

 

Choose "Edit" > "Clone", or press "Ctrl + K". This 
places a copy exactly on top of the original. Cloning 
is an easy way to create concentric shapes. 
This example uses an original large letter "A" with a 
black fill and a 4pt thick white outline and a clone 
with no fill and a 1pt black line. 

 

Moving objects forward and backwards 
Complex documents have objects stacked on top of each other, such as this target: 

 

The target on the left is made from three circles stacked on top of each other. 

To ensure that objects overlay each other in the correct order, you often need to 
rearrange their order from front to back. The front object always covers lower objects, 
and objects always cover other objects which are further back. Each new object you 
create is always created on top of older ones. 

The PAGE & LAYER GALLERY is useful for viewing and manipulating the stacking order 
of objects. It shows you the objects in their stacking order. The order of objects in the 
gallery from top to bottom, mirrors the stacking order of those objects in the design 
from front to back. So the target design above looks like this in the Page & Layer 
Gallery (on page 149): 
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And you can change the stacking order of objects using the Page & Layer Gallery by 
simply dragging them up and down. So for example in the target design, dragging the 
blue circle in the Page & Layer Gallery, and dropping it above the green circle will 
bring the blue circle to the front. The ARRANGE menu gives you four options: 

• BRING TO FRONT ("Ctrl + F"): This makes the selected object the front object, and 
it will hide any other object it covers. 

• MOVE FORWARD ("Ctrl +Shift + F"): This moves the object up a level towards the 
front rather like climbing a staircase one step at a time. 

• MOVE BACKWARD ("Ctrl +Shift + B"): This moves the object one level towards the 
back. 

• PUT TO BACK ("Ctrl + B"): This moves the object to the back. 

These options move objects forwards and backwards within their layer. MOVE TO 
LAYER IN FRONT and MOVE TO LAYER BEHIND lets you move objects between visible 
layers (invisible layers are skipped when moving objects). 

Read more in "Page & Layer Gallery (on page 149)" 
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Rotating objects 
This is part of the SELECTOR Tool. 

 When in rotate mode, the transformation center (around which the object 
rotates) initially appears in the center of the object, as shown by a small target 
like this. 

Simply click on a object again to put the selector into rotate mode, or click the 
ROTATION HANDLES button on the InfoBar. 

 

To move the transformation center: 

• Drag the transformation center target where required. 
• Or use the 3x3 matrix on the InfoBar for accurate positioning. 

 

• This moves the transformation center to the corners, the center or the side mid-
points of the object or selection. The transformation center aligns with the outer 
edges of the object. This means that if the object has a thick line applied, the 
transformation center can be outside of the object. 

Attention: If the rotation center is moved, it remains in this location for any selected 
object until all objects are deselected, at which point it returns to the center of any 
selected object. 

Rotating using the mouse 
The SELECTOR Tool must be in rotate/skew mode (the selection handles are arrow 
shaped). 

Dragging the side handles stretches the object. This is described in Stretching and 
squashing objects (on page 143). 

Drag on a corner arrow. As you drag, the object rotates around the transformation 
center. The InfoBar shows the current rotate angle. 

"Shift + drag" to rotate the object around its center (the transformation center is 
ignored). 
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Hold down "Ctrl" to restrict rotation to the constrain angles. Note that the set of 
constrain angles includes those rotations which align the object with the screen. This 
makes it very easy to ‘straighten’ any object with a straight edge – just hold down the 
Ctrl key and rotate until the object snaps to the screen-aligned rotation you want. 

The constrain angles are user definable. Refer to "Customizing Page & Layout 
Designer (on page 347)". 

To create a copy while rotating, click "+" on the numeric keypad while rotating, or 
click the right mouse button. 

 

To quickly create a fan like this, draw a single line, then position 
the transformation center in the bottom right (click the bottom 
left button of the 3x3 transformation center control on the 
InfoBar), and then as you drag rotate the object, right click for 
each successive line you require. 

 

Rotating by exact angles (using the InfoBar) 
Type an angle into the rotate box and press "". Positive angles rotate anti-clockwise 
and negative angles rotate clockwise. 

 

Click the arrows to the right to nudge the rotate angle. 

 

Rotating objects in Resize Mode 

 

It is possible to rotate and skew an object even if not in rotate mode. Using resize 
mode, move the mouse pointer into the according small areas near the selection area 
handles as illustrated above. The mouse pointer changes into a rotate or skew icon, 
showing you that you are now able to rotate or skew the object by dragging with the 
mouse. 
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Scaling (resizing) objects 
This is part of the SELECTOR TOOL. 

Scale Line Widths button 
The SCALE LINE WIDTHS button on the SELECTOR TOOL infobar is used in many 
operations where the width and height of the selected objects are important. It 
controls whether the line attributes (not just line widths) are taken into account when 
working out the size and position of the selected object(s). 

 

With the SCALE LINE WIDTHS button set, scaling an object also 
scales its line widths. With this button unset, line widths remain 
unchanged. 

You can toggle this button during drags by clicking "/" on the numeric keypad. 

If you have a rectangle with a 4 pixel line width, as you turn SCALE LINE WIDTHS on 
and off you'll see that the X, Y W And H fields in the SELECTOR TOOL change as the 
effects of the line width are included and excluded. 
 
The following features are affected by SCALE LINE WIDTHS: 

• Position and size as reported on the SELECTOR TOOL infobar XYWH fields 
• Changing position and size by entering values into the infobar XYWH fields 
• Changing size by entering values in the W% H% fields 
• Scaling/stretching objects by dragging in the Selector tool 
• Alignment 
• Snapping 

The line attributes that are taken into account when SCALE LINE WIDTHS is turned on 
are: 

• Line width 
• End caps 
• Join type 
• Dash pattern 
• Arrowheads 
• Brush style 
• Stroke type (inc. variable width strokes) 
 
In general, if you are interested in the visual positions of objects you should turn SCALE 
LINE WIDTHS on. If you're interested in the exact positions of lines (e.g. where the 
centers of lines are, as is typical in technical drawings) then you should turn SCALE 
LINE WIDTHS off. 
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Lock Aspect button 

 
With the LOCK ASPECT button set, the width/height aspect ratio 
remains constant as you scale the object.  

In other words, the shape remains in the same proportions as the original. It’s 
recommended that this button remains selected most of the time in order to ensure 
that when you resize objects they do not become squashed. 

With this button unset, you can change the aspect ratio as you scale the object, in 
other words, you can stretch object one way or another when dragging a corner resize 
handle or when entering a new size. 

Scaling using the mouse 
The SELECTOR TOOL must be in 
scale mode (the selection 
bounds handles are squares). If 
necessary, click on the object to 
change to scale mode.  

Drag one of the corner handles. The object scales as you move the pointer diagonally. 
The InfoBar shows the current scaling. The object will scale between the dragged 
handle and the opposite one. To use any other point of the object as the fixed point 
move the transformation center to it and use the InfoBar buttons to scale (on page 
113). 

Hold "Shift" while dragging to scale the object around its center. This works 
independently of the position of the transformation center. 

"Ctrl + drag" scales the object in multiples of its original size (x2, x3, and so on). 

To create a copy while scaling (leaving the original in place) right click, or press "+" on 
the numeric keypad. 

Dragging the side handles stretches or squashes the object. This is described in 
Stretching and squashing objects (on page 143). 

Scaling using the InfoBar 

 

 Type into the SCALE TEXT boxes and press "". 
• Scalings below 100% reduce the object. 50 halves the size of the object. 
• Scalings above 100% enlarge the object. 200 doubles the object size. 
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 If LOCK ASPECT is set, you can type into either text box to resize the object by the 
desired percentage. If this button is unset, you can enter separate values for both 
the width and height. 

 Alternatively, type the required size of the object into the W or H text boxes. 

If the LOCK ASPECT button is on, this scales the object and maintains the aspect ratio. 
You can enter the size in any unit, such as 1 cm. 

Scaling with the InfoBar buttons (or number boxes) always scales around the 
transformation center. You can position this anywhere else in the object, as described 
in "Rotating objects (on page 109)".  

Perimeter & Area 

  

The 2 controls on the right of the Selector tool infobar show the 
perimeter and area of the current selected shape(s). Perimeter is 
shown in the current units for the document and area is shown in 
the current units squared. These fields are not editable. 

Flipping objects 

 
This is part of the SELECTOR TOOL. Clicking on the FLIP buttons flips the 
object vertically or horizontally around the transformation center. 

The scale and aspect ratio do not change; the object just flips. 

Snapping 
Snapping makes it easier to position edges, or specific points on objects, exactly 
where required. It can be used to align edges to a specific point or line, or to evenly 
space objects, using the grid. 

 MAGIX Page & Layout Designer 2013 offers three types of snapping. 

• Snap to grid 
• Magnetic snapping (snap to objects) 
• Snap to guidelines or guide objects 

Grid snap is useful for making objects evenly spaced, or making the sizes exact 
multiples of a given value. Guidelines are useful for aligning edges (although it’s a lot 
more powerful using guide objects) and lastly magnetic snap is a general purpose 
way of accurately positioning lines, points or object edges relative to other objects or 
to the page center or edges. 
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Snap to grid 
When SNAP TO GRID is selected, grid points act like magnets. Right click on the 
pasteboard and choose "SNAP TO" > "SNAP TO GRID" or use the menu option 
"WINDOW" > "SNAP TO GRID", (or press "." (decimal point) on the numeric keypad). 
You can control the grid spacing from the options dialog (right click and choose PAGE 
OPTIONS or use the menu command "UTILITIES" > "OPTIONS") on the Grid and Ruler 
tab.  

When dragging objects the edges will snap to grid points. If the size of the object is 
such that opposing edges can't both be snapped, the edge that snaps depends on the 
direction the object is dragged in. 

 

This shows a coarse grid with 5 subdivisions between major divisions. The shape has a very thick 
gray outline. Because the object has been dragged down and to the left, the lower and left 
outside edges are snapped to the nearest grid point. 

Note: The default grid spacing is 50 pixel spacing for major grid lines with 50 
subdivisions. This means the grid is spaced at exactly one screen pixel and so may 
appear not to be working at a normal 100% zoom. If you zoom in to say 500% then 
you can see it does snap correctly. 

Alternatively, change the grid values to have, say, 10 subdivisions which means that 
the grid points are on 5 pixel boundaries. 

Snapping and line widths 

 

The SCALE LINE WIDTHS control on the SELECTOR TOOL 
InfoBar affects whether snapping happens to the bounds 
of objects including their outlines. 

The above example shows a shape with a very thick gray outline. It also shows (thin 
black line) the outline of the shape itself (you can see the thick outline is drawn 
equally on either side of the center line so that it partly overlaps the inside of the 
shape and partially goes outside). 
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With scale line widths on, the width of the outline is deemed to be important and so 
‘snap to grid’ will snap the bounds of objects, including outlines, to the grid. Snap to 
objects will allow you to snap using the bounds or the outline center lines. If the 
outlines as they appear on screen are small, so there is little difference between these 
two snapping positions, bounds snaps are favored. So zoom in if you want to snap 
outline centers in this case. 

With scale line widths off, ‘snap to grid’ and ‘snap to objects’ will snap the center lines 
of objects, ignoring the outline widths.  
 
Because snapping honors the Scale line widths switch it means that the bounds used 
by snapping are always the same bounds that are reported in the SELECTOR TOOL 
infobar. 

Magnetic object snapping (snap to objects) 
Magnetic object snapping makes it much easier to accurately position objects relative 
to each other or relative to the page center or edges. 

So, for example, if you want several lines to start at exactly the same point, or want a 
line to exactly join the edge of a circle, then using "magnetic object snap" is useful.  

You can even use this to align the centers of objects, or align objects to the center of 
the page, or align them horizontally and vertically anywhere in the middle of the page. 

Magnetic snapping works when either moving or scaling objects using the SELECTOR 
TOOL.  

  
To toggle Magnetic snapping to objects on and off, click the SNAP TO 
OBJECTS button in the top toolbar. Alternatively right click the pasteboard 
and choose "SNAP TO" > "SNAP TO OBJECTS", or use the menu option 
"WINDOW" > "SNAP TO OBJECTS". You can also toggle it on/off during 
dragging by tapping ‘s’. 

Click and drag on the object you want to snap. As you drag, Page & Layout Designer 
displays a magnet icon, blue lines and red points whenever you are near a "point of 
interest" that it has snapped to.  

Snap indicators 
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Snap indicators are shown whenever a snap occurs. That is whenever a point of 
interest on the object you are dragging comes in range of a point of interest in the 
document (which could be on another object or be part of the page). Page & Layout 
Designer snaps to the point of interest and the mouse pointer changes to show a 
magnet symbol so you know a snap has happened. Also further indications are shown 
dynamically on screen to help you see what snap has occurred.  

• A red dot indicates that a specific point has snapped 
• A blue line indicates a snap to some feature of another object (e.g. to the edge of 

a rectangle). 
• An orange line indicates a snap to a page feature (corners, edges, center) 

The snap indicator lines pulse to show that they are temporary "live" indicators and to 
help them be seen over different background colors. 

The snapping distance is controlled by the MOUSE tab of the OPTIONS dialog box 
("UTILITIES" > "OPTIONS" or right click a page and choose PAGE OPTIONS).  

 

You can specify two snap distances in the "Magetic snap radii" section, which control 
how close things need to be before they will snap together. The size of a circle around 
points (point) and the distance either side of lines (lines). It's usually best to make the 
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point value larger than the line value,  so that it's easier to snap to the end points of 
lines. 

Customizing Page & Layout Designer (on page 345) has full details of the Options 
dialog. 

Snapping modes 
You can change the behavior of snap to objects while dragging by tapping a key to 
toggle different modes on and off. These mode changes are effective only for the 
duration of the current drag. 

S Toggle ‘snap to objects’ on and off. This temporarily overrides the Windows-
>Snap to objects setting. 

G Group snapping. By default, to minimise the complexity and numbers of 
snapping lines shown, objects inside groups are ignored and only the bounds 
and centre of the whole group are considered for snapping. Pressing G turns 
on group snapping so that objects inside groups also contribute to snapping 
just as if they were not grouped. 

A Angled snapping. See Angled snapping below. 

Snapping to original position 
When ‘snap to objects’ is on and you drag an object to move it, the bounding box of 
the original position of the object is indicated by a red dashed rectangle. This also 
contributes to snapping making it easy for you to (for example) move an object in one 
dimension only. However note that you can also constrain the angle of any drag by 
holding down "Ctrl" while you drag. 

Angled snapping 
MAGIX Page & Layout Designer 2013 is not restricted to axis-aligned snapping. With 
Angled snapping turned on, the snapping system can snap parallel lines, whatever 
their alignment, and find the intersections between crossing line constraints. So for 
example you can snap the edge of a shape that runs at 30º with the edge of another 
running at the same angle. 

Angled snapping is not on by default, because in most cases it’s not useful. To 
activate it while dragging, simply press the ‘A’ (for Angle) key. Press again to turn off. 

Snapping notes 

Note: Only the objects that are fully or partly visible in the current view are 
considered for snapping. You cannot snap to objects outside the view (except the 
page). 

Note: Snapping distances are measured in screen pixels so if you have several 
snapping positions close together it’s best to zoom in to make sure you snap to the 
one you want. 
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Note: When snapping text to text, the baseline of the text is favored over any other 
snaps that are within snapping distance. This makes it easy to vertically align one 
text object to another with matching baselines, which is normally more useful than 
snapping the centers or bounding boxes of text for example. 

Guide Objects and Guidelines 
Guide objects and guidelines are objects on a special layer, the guides layer. A guide 
layer is automatically created when you create a guideline (see below), or you can 
create one manually by right clicking in the  PAGE & LAYER GALLERY and selecting 
CREATE GUIDE LAYER (see "Page & Layer Gallery (on page 149)" for more information 
on layers). 

Use SNAP TO GUIDES in the Window menu (or key 2 on the numeric keypad) to turn 
on snapping to guide objects. 

Any object placed on the guides layer becomes a guide object. These can be any 
object type including lines at any angle, irregular shapes, and quickshapes. You can 
create, scale, and delete objects on the guides layer as usual, but they always appear 
as thin dotted red outlines; any applied line width or fill color is ignored. This 
information is retained, and if you later move the object from the guides layer to a 
normal layer, line thickness, and colors are shown again. 

You can use guide objects to draw construction lines such as lines passing through a 
vanishing point for perspective drawing.  

Placing objects onto the Guides Layer 
First ensure there is a guide layer in the PAGE & LAYER GALLERY, see above. You can 
create objects directly on the guides layer by selecting it and creating objects as usual. 

 

The Page & Layer Gallery showing a guides layer above two 
other layers, and selected. 

You can also cut or copy 
objects from another layer 
and then paste those objects 
into the guides layer. To 
paste the objects in the same 
relative position on the 
guides layer use the 
keyboard shortcut "Ctrl + 
Shift + V". 
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MOVE TO LAYER IN FRONT and MOVE TO LAYER BEHIND on the ARRANGE menu (or right 
click and choose "ARRANGE" > "MOVE TO LAYER IN FRONT/BEHIND") will skip the 
guides layer and so cannot be used to move objects onto the guides layer. 

Creating a guideline 
Guidelines are vertical or horizontal lines and are a quick and easy way to align a 
series of objects on the page. 

• Turn rulers on ("Ctrl + L"). 
• Drag from a ruler onto the page. 

Or 

• Double click on the ruler to create a guideline aligned to the click point. 

This automatically creates a guides layer and puts the guidelines on that layer. 

Or, using the Page & Layer Gallery (on page 149): 

1. Right click in the Page & Layer Gallery and choose PROPERTIES. 
2. If necessary, click the Guides tab. 
3. Select horizontal or vertical. 
4. Click new. 
5. Type in the required position. 

Deleting a guideline 
Using the Selector TOOL drag the guideline onto the appropriate ruler (the vertical 
ruler for vertical guidelines, horizontal ruler for horizontal). 

Or, right click on the guideline and then choose DELETE. 

Grouping and ungrouping objects 

The Shadow and Transparency Tools offer different results depending on whether 
objects are grouped or not. For more information see "Transparency (on page 222)" 
and "Shadows (on page 233)". 

You will often create complex shapes from several different objects. The "ARRANGE" > 
"GROUP" menu option (or right click selected objects and choose GROUP) lets you lock 
those objects together to form what appears as a single object. You can then select 
the grouped objects and copy, rescale, move or perform any other operation on the 
entire group. 
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To create a group 
1. Select all the objects you want in the group. 
2. Right click and choose GROUP or choose GROUP from the ARRANGE menu (or 

"Ctrl + G") to create the group. 

Ungrouping objects 
1. Select the group. 
2. Right click and choose UNGROUP or choose UNGROUP from the ARRANGE menu 

(or "Ctrl + U"). 

After this, all the individual objects in the group remain selected. 

To add more objects to a group 
1. Select the group. 
2. Ungroup ("Ctrl + U") 
3. Select the extra objects. 
4. Group again ("Ctrl + G") 

You can also incorporate a group into a second group by omitting step 2. Page & 
Layout Designer remembers the original grouping information. If you ungroup the 
objects later, the original group remains. 

Removing objects from a group 
1. Ungroup the objects. 
2. "Shift + click" on the objects you want to remove. This deselects them; the 

other objects remain selected. 

You can then choose "ARRANGE" > "GROUP" to regroup the remaining objects. 

Selecting a single object from within a group 
This feature is useful for changing an object's color, for example. "Ctrl + click" on the 
object (you can also use this to select a "group within a group"). Pressing "Tab", or 
"Shift + Tab" moves the selection within the group, to the next, or previous object. 
Once you have selected an object inside a group, you can also use "Alt + click" to 
select the object under the selected one. 

This is called “select inside”. 

Editing inside groups 
If you want to edit the objects inside a group, there are broadly two ways to approach 
this. You can either select the objects inside the group and work on them directly in 
your document, or you can double click on the group to open its contents in a 
separate document view. 
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Selecting inside 

If you hold down Ctrl and click on an object in the Selector tool, that object will be 
selected even if it’s inside one or more groups. That’s called a "select inside" 
operation. Also some tools will let you directly select objects relevant to them inside 
groups, just by clicking on them. For example in the Photo Tool you can just click on a 
photo to select it, even if it’s in a group. 

Editing group contents 
If you want to edit several objects inside a group, it can get tedious having to keep 
Ctrl+clicking on each one first. So instead you can instantly open the group’s contents 
in a separate sub-document view, to make editing much easier.  

Double click on a group and a new document view opens (or right click on it and 
choose Open from the context menu). It contains only the contents of the group and 
not the group itself, so you can select all the direct children of the group just by 
clicking on them. You can also draw new objects and these will be added to the group 
when you save your changes back. Since the sub-document contains only the 
contents of the group, you won’t see the effects of any group attributes in the sub-
document view.   

Once you’re done editing the group, hit "Ctrl + S" to instantly close the sub-document 
view and save your changes back to the parent document. Or you can close the view 
using the close button in the top right of the window, just as you close ordinary 
documents, and you’ll be prompted to save or discard any changes you’ve made.  

If the group you are editing contains other groups (because the parent document had 
multiple levels of nested groups) you can double-click on them to open those in a 
sub-document too. 

Repeating Objects 

You can edit inside a Repeating Object just as if it was a normal group – just double 
click it to open in a sub-document view. As with all edits made to the objects inside a 
Repeating Object, when you save the changes back, all copies will be updated. 

Molds 

You can edit the contents of a mold, which is something that is not possible using 
direct selection inside (molds do not allow objects inside them to become selected). 
Right click on the mold and choose OPEN MOLD from the context menu. 

Limitations 

Groups cannot contain layers and so if you introduce any layers while editing a group, 
those layers will be ‘flattened’ when you save the changes back to the parent 
document. In other words all the objects will be moved to the original single layer on 
save and any layer structure you introduced lost. 
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Similarly a group can’t contain multiple pages and so any pages you add while editing 
will be ignored and lost when you save back – only the first page is relevant. 

The Automatic Backup facility does not save modifications to open sub-documents. 
Only the parent main document is saved when a scheduled backup runs, in its current 
state without the unsaved group edits. For this reason it’s recommended that you 
save group edits back to the parent document regularly. 

If you close the program or shutdown Windows while you have group sub-documents 
open with unsaved changes, when you next start the program, the main document 
will be loaded and it will include all the group edits that were unsaved at the time of 
closure. 

Other types of groups 
Special types of group are used by some tools and functions to keep objects together 
and/or to give an object some special behavior.  

When you anchor an object to text for example, the object is placed in an Anchored 
Group, as shown on the status line when you select such an object. Similarly when 
you make an object repeating (see Repeating Objects (on page 129)) or make it a Live 
Copy (see Live Copies) the objects are placed inside a "Repeating group" a "Live copy 
group" respectively.  

Soft Groups 
Ordinary Groups as described in “Grouping and ungrouping objects (on page 120)” sit 
on a single layer, they cannot span layers. SOFT GROUPS are an alternative way of 
linking objects together where the objects can be across several different layers. 

Selecting one member of a Soft Group also selects all other members of the same Soft 
Group – even members that are on invisible or locked layers. This means when you 
delete, move, rotate or otherwise transform one member of a Soft Group, all the other 
members are similarly modified.  

The status line indicates when a Soft Group is selected. 

Creating Soft Groups 
To create a Soft Group, select all the objects that are to be included in it and then 
choose “ARRANGE->APPLY SOFT GROUP” (or press “Ctrl+Alt+G”). Note that if the Soft 
Group is to include members on invisible or locked layers, you’ll need to make those 
layers temporarily visible and editable using the Page & Layer Gallery in order to 
select the objects and Soft Group them.  

An object cannot be a member of more than one Soft Group and Soft Groups cannot 
be nested (soft groups as members of soft groups). 
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Removing Soft Groups 
To disband a Soft Group, select it and choose “ARRANGE" > "REMOVE SOFT GROUP” (or 
press “Ctrl + Alt +U”). The objects don’t get deleted, they are just no longer linked 
together by a Soft Group. 

Text Synchronization 
Any text objects which have the same text value and which are members of the same 
Soft Group are kept synchronized if any of those text objects are edited. So change 
the text in one object and any other text objects that had the exact same characters 
will also be changed to match. Only the text value itself if synchronized, so different 
text objects can have different sizes, fonts and text attributes. 

Text synchronization using Soft Groups is useful where a label is duplicated in several 
places, perhaps in different styles and you want each object to show the same label. 

Also sometimes "shadow-like" effects can be achieved by placing two or more copies 
of text very close to each other, but slightly offset.  

To stay synchronized, the text objects must: 

• Be all in the same soft group. 
• And have exactly the same text on them at the time when the soft group is 

created. 
• And either have overlapping bounding boxes, or be on different layers. 

Alignment 
This lets you accurately align or distribute two or more objects. 

Quick aligning 
Select the objects you want to align, and right click the selection to choose ALIGN from 
the drop-down menu, and then do one of the following: 

• Align the objects vertically by choosing LEFT EDGES, CENTERS or RIGHT EDGES. 
• Align the objects horizontally by choosing TOP EDGES, CENTERS or BOTTOM EDGES. 
Aligning and distributing space 
If you want to distribute space between the objects as well as align them, select the 
objects, right click the selection and choose "ALIGN" > "ALIGNMENT" to display the 
Object Alignment dialog. Alternatively choose "ARRANGE" > "ALIGNMENT" ("Ctrl + + 
L"). 
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The small diagram at the top of the dialog box shows 
you the effect of selecting each option. The selected 
objects in the document do not change until you click 
APPLY. 
The alignment dialog is a non-modal dialog, which 
means you can keep it on screen and continue to 
work on the document at the same time. So you can 
change tools, draw, and change your object selection, 
and then easily select from the various alignment 
options. 
If you’ve got your selection wrong, you can change 
the selection, and just click the APPLY button to apply 
the last alignment settings again. This can be a real-
time saver. 

 

Within 
This section of the dialog controls the boundaries within which you align or distribute 
the objects. The options are: 

 

SELECTION BOUNDS: The boundaries are the outer 
edges of the selected objects. Their relative position 
on the page or spread has no effect. 

 

BOUNDS OF BACK OBJECT: The boundaries are the 
outer edges of the backmost selected object. This 
object is not affected by the alignment. 
You can use this to define the "reference" object 
when you want to align several objects in a row, for 
instance. With the normal "Selection bounds" 
options on the leftmost object is the reference object 
(the one that won't move) 
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PAGE(S): If the objects are on a single page, the 
boundaries are the edges of the page. (This lets you, 
for example, center objects on the page or align 
against the page edge.) 

 

SPREAD: The boundaries are the outer edges of the 
spread. In most cases, this is the same as page(s) 
unless you have a double page spread, in which case 
it will use the bounds of both pages. 

 

Aligning 
To align objects, for example, so their left edges are aligned to the left. 

1. Select the objects and right click the selection. 
2. Choose "ALIGN" > "LEFT EDGES" from the drop-down list. 

The selected objects move to align the left edges. 

Alternatively: 

1. Choose "ALIGN" > "ALIGNMENT" or press "Ctrl + Shift + L" or choose 
ALIGNMENT from the ARRANGE menu to open the Object Alignment dialog. 

2. Select the required WITHIN option, e.g. Selection bounds. 
3. Select ALIGN LEFT for horizontal positions. 
4. Leave vertical positions to NO CHANGE. 
5. Click APPLY. 

The selected objects move to align the left edges. 

All the align options act in a similar way. For brevity, only the left align option, shown 
in the illustration of the dialog box is described. Experiment to learn about the other 
options. 

To quick-select any combinations of vertical and horizontal alignment click with the 
mouse in the diagram:  

• A simple mouse click aligns horizontal and vertical positions to the clicked 
position to any of the nine combinations of top-centrally-bottom/left-centrally-
right. 

• "Ctrl + mouse click" leaves the horizontal position unchanged and arranges the 
objects in a to a top, centrally, or bottom aligned row. 
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• "+ mouse click" leaves the vertical position unchanged and arranges the objects 
in a left, centrally, or right-aligned column. 

Distribute 
The distribute options will position all the selected objects evenly across the "Within" 
area (usually within the selection bounds, but it could be the page or spread). 

Again all the distribute options work in a similar way. The following examples show 
how the different vertical position options align objects: 

 

TOP EDGES DISTRIBUTION: the tops of the objects are 
evenly spaced. BOTTOM EDGES distribution is the 
inverse—the bottom of the objects are evenly 
spaced. 

 

CENTERS DISTRIBUTION: the centers of the objects are 
evenly spaced. 

 

EQUI-SPACED DISTRIBUTION: the objects are evenly 
spaced from each other. 

The horizontal position options are similar but operate in the horizontal direction. 

So, for example, to distribute this collection of randomly positioned ellipses, so they 
are all equally spaced and aligned to the top edge: 

 

• Select the shapes 
• Display the Alignment dialog ("Ctrl + + L") 
• Ensure WITHIN shows SELECTION BOUNDS 
• Select Horizontal positions: Distribute centers 
• Select Vertical position: Align top 
• Click APPLY 

 
And they will now look like this, all equally spaced 
horizontally and aligned to the top. 

Remember if you make a mistake you can always undo the operation. 
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Copying Styles: Paste Attributes 
This lets you copy attributes (such as line pattern or fill color) between objects. It is a 
quick way of applying multiple attributes to an object. 

 

The square has a specific color, shadow, 
line and fill style. Copying it and then 
pasting its attributes on to the circle in 
the middle, results in the circle to the 
right. 

1. Select the object from which you wish to copy the attributes. 
2. Copy the selection to the clipboard. ("EDIT" > "COPY", or "Ctrl + C".) 
3. Select the object(s) to which you want to apply the attributes. 
4. Choose "EDIT" > "PASTE FORMAT/ATTRIBUTES", or "Ctrl + Shift + A". 

The object remains on the clipboard until overwritten by a cut or copy operation. This 
lets you repeat paste attributes as many times as required. 

ClipView 
ClipView lets you hide or ‘clip’ parts of a shape within another larger shape. The effect 
is similar to the Intersect shapes option, described in the chapter on Shape handling 
(on page 136). The difference is that the Intersect shapes option actually cuts the 
objects, whereas ClipView just hides the parts outside the ClipView object. What’s 
more you can then adjust the position of the objects inside the ClipView. 

To create a ClipView: 

1. The ‘window’ object must be behind the other 
objects in the ClipView. If necessary move it 
backwards. In this example the dark ellipse is the 
window object. 

2. Select all the objects you want to be inside the 
ClipView (including your ‘window’ object). 

3. Choose "ARRANGE" > "APPLY CLIPVIEW" ("Q"). All of 
the "window" object remains visible plus those parts 
of other objects that overlap the "window" object. 

 

 
 

Setting the ClipView background color 
The fill color of the original object used as the ClipView is the background color. So 
either set this to the desired color before setting the ClipView or perform a "select 
inside" ("Ctrl + click") on the background, and then adjust the color. 
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Select clipping shape 
This selects only the shape that you used to do the clipping. Effectively this is the 
‘window’ through which you see the other object(s) in the clipview. Once it’s selected 
you can move it around or otherwise transform it, to adjust your clipview. 

Select clipped objects 
This selects all the objects in the clipview that are being clipped. Therefore once these 
are selected, you can drag them around inside the clipview to adjust their position 
relative to the clipping shape. 

Selecting objects in the Clipview 
You can perform a "select inside" by holding "Ctrl" and clicking on the desired object. 
This is very like selecting objects inside a group described earlier in this chapter 
(ClipView objects are a type of group). You can now perform most edit operations on 
the object. 

Removing a ClipView 
Just select the object and the menu "Arrange -> Remove ClipView", or press "Alt + 
Q". 

Soft edged ClipView 
With the whole ClipView object selected, you can adjust the FEATHER slider control 
on the top bar, to give the whole clipped object a soft feathered edge. 

Note: You can have ClipView objects inside ClipView objects. 

Repeating Objects 
It's common to have items like headers, page numbers or logos repeating on all pages 
of a multi-page document. 

You can make any object  a repeating object by right clicking it and choosing REPEAT 
ON ALL PAGES. The object is copied to the same place on all pages, displaying the 
repeating symbol icon in the top left hand corner. If you make any further changes to 
this item all the copies will be automatically updated. 

Note: This uses the current page as the source of the repeating items to copy across 
all the other pages. So make sure you're on the right page before updating objects. 
The current page is the one you're working on, and is shown with markers around 
the page corners. Just click anywhere on the page (or even outside it) to make the 
page current. Or click the page in the Page & Layer Gallery. 
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The red box highlights the repeating object symbol, shown on every instance of the repeating 
object 

If you don't want a copy of the repeating object on a page, just delete it from that 
page. When edited, the repeating object is only automatically updated to those pages 
that already have it. This means you can choose which of the pages in your document 
should have the repeating object and which should not. 

If you want a repeating object on just a few pages of a large document, you can: 

1. First make your object repeat on all pages of your site, using ARRANGE > 
REPEAT ON ALL PAGES. 

2. Select one of the repeating objects and copy it to the clipboard ("Ctrl + C"). 
3. Hit the Delete key and choose the DELETE FROM ALL PAGES option when 

prompted. 
4. Now simply paste the repeating object onto each page that needs a copy of it. 

Editing the contents of a repeating object 
When Page & Layout Designer creates a repeating object, the repeating items are 
placed in a containing 'repeating group', similar to a normal group. If you drill down to 
a layer containing a repeating object in the PAGE & LAYER GALLERY, you can see that 
there's a repeating group containing each repeating object on that layer. 
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Page & Layout Designer places each repeating object inside a repeating group 

If you want to edit an item inside this repeating group, press "Ctrl + click" on the item 
to select it inside (on page 100) the repeating group. Alternatively if you go into a 
specific tool you can usually click directly on any object that is applicable to that tool 
and it will be selected inside its repeating group (or any other type of group). So for 
example you can select a rectangle that’s inside a repeating group by simply going 
into the Rectangle tool and then clicking on the shape. 

Alternatively if you go into a specific tool you can usually click directly on any object 
that is applicable to that tool and it will be selected inside its repeating group (or any 
other type of group). So for example you can select a Quickshape that’s inside a 
repeating group by simply going into the Quickshape tool and then clicking on the 
shape. 

As with any other edits made to a repeating object, any edits you make inside a 
repeating group are applied to all instances of that repeating object on other pages. 

Locking a repeating object 
You can lock a repeating object right clicking it and choosing LOCK REPEATING OBJECT. 
Once locked, the object is not selectable. But editing any other copies of that 
repeating object on other pages, which aren’t locked, will change all copies, including 
the locked copy. 

Stopping objects repeating 
Right click an object and choose STOP UPDATING to turn off the repeating nature of an 
object, or all of its copies in your document. Choosing STOP UPDATING from the 
ARRANGE menu also allows this.  
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You’ll be asked whether you want to just stop the selected object repeating or all 
copies of the object in the document. Choose the ALL option. Now the different copies 
of that object can be independently edited and the next time one is changed it won’t 
update any of them. 

Use this if, for example, you’ve used REPEAT ON ALL PAGES to copy an object to all 
pages of your document, but then you want to make those objects different on each 
page so that they are no longer tied together.  

STOP UPDATING is also useful if you want to make a copy of a repeating object (eg. a 
footer or logo) on one page and you don’t want that copy to be updated. In this case 
choose the JUST THIS COPY option when prompted. 

Deleting repeating objects 
If you don't want a copy of the repeating object on a page, just delete it from that 
page. MAGIX Page & Layout Designer 2013 displays a prompt asking whether to 
delete just that copy or all copies of that repeating object.  

Pressing "Ctrl + Delete" will delete just the selected repeating object without asking 
whether you want to delete all instances or just this one. 
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Shape Handling 

Closing a shape 

A shape is a closed object with no start or end handle. Only shapes can be color 
filled. 

To close a shape: 

 

 

1. Create an open object with the end point handle 
close to the start handle. All the point handles 
(except the end handle) should be in their 
required positions. 

2. Position the pointer over the end handle. 
3. Drag the end handle over the start handle and 

release the mouse button. The two handles snap 
together. 

Or: 

 

1. Create an open object with all the control 
handles in their correct positions. Do not create 
the final line segment. 

2. Move the pointer over the start point. A + 
appears to the right of the pointer when it is 
over the start handle. 

3. Click to create the final line segment and close 
the shape. 

Or: 

1. Choose the SHAPE EDITOR Tool. 
2. Click on an end point to select it. 
3. Press the "" key. 

Or: 

4. Use the FREEHAND & BRUSH Tool to create the final segment. 

Any of these closes the shape. If there is a current fill color, the shape is filled with 
that color. 
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Closing a freehand shape 
You can directly create a closed shape by ending a line back at the beginning over the 
start handle. A + by the pointer shows when it is positioned over the start handle. 

Joining shapes 
"Arrange -> Join shapes" lets you create holes in solid shapes. Because overlapping 
parts of the same shape are drawn with no fill color (i.e. you can see through the 
overlapping parts), you can use this effect to create holes in shapes but retain the 
ability to break them apart later. 

For example, to create a donut shape: 

 

 

1. Create an ellipse (described later). 
2. Create a second ellipse over the first. (The color of the 

second ellipse has been changed to make it obvious.) 
3. Select both. 
4. Choose "Arrange -> Join shapes". 

This creates a single shape with a hole in it.  

You can combine or join several shapes. 

The cutout is made using the top object. If that object is a group, you can make 
several holes in one operation. For example, a group of three stars can make a hole in 
this rectangle shape: 

      

Groups are described in Object handling (on page 120). 

When several shapes overlap: 
• The top shape (or top group) becomes a hole through the other shapes. 
• The line attributes and colors of the other shapes change to those of the top 

shape. 
• If several shapes overlay: 

- an even number of shapes overlapping becomes a transparent area; 

- an odd number of shapes overlapping becomes a solid area. 
• The numbers on this example of three circles show how many shapes overlay in 

each area: 
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The joined shape on the left shows the number of segments which overlap. On the right are the 
original three circles shown unjoined. 

Breaking joined shapes 
Choose "Arrange -> Break shapes". This breaks the joined shape into separate 
objects, but the original attributes will not be restored to the separated objects. You 
can also break several joined shapes in one operation. 

Combining shapes 
The COMBINE SHAPES option (select the objects, right click and choose COMBINE 
SHAPES) provides you with a range of advanced options to combine shapes to make 
new shapes, such as adding, cutting, or slicing. You can use combine shapes on any 
type of object, including bitmaps. 

When subtracting, intersecting and slicing, you use the topmost selected shape to do 
the “cutting” of the lower shapes. 

Creating holes in shapes 

 

Right click and choose "COMBINE SHAPES" > "SUBTRACT SHAPES". This is similar to 
using join shapes (described above). The differences are: 

• The top shape becomes a hole through the other shapes. 
• The line attributes and colors of the underlying shapes are unchanged. 
• Combine shapes physically alters the lines. The only way to restore the original 

shapes is by using undo. 
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• The number of overlapping shapes has no effect. 

Merging several shapes into one 
For example, to produce the shape on the right from the three shapes on the left: 

     

1. Create the two circles and the rectangle. 
2. Select all three shapes. 
3. Right click and choose "COMBINE SHAPES" > "ADD SHAPES". 

The new shape takes line attributes and colors from the top shape (in this case the 
rectangle in the illustration). 

Intersecting shapes 
With INTERSECTING SHAPES, the new object is created from those parts of lower 
shapes that are covered by the top object. 

Select the shapes you want to mask and the front 
(mask) shape. 

 

Right click and choose "COMBINE SHAPES" -> 
"INTERSECT SHAPES". This creates a new shape. The 
top shape disappears. 

 

The line attributes and colors of the underlying shapes are unchanged. Areas not 
covered by the top shape are discarded. The top shape can be a group for more 
complex subtracting. Groups are described in Object handling (on page 120). 

Slicing shapes 
MAGIX Page & Layout Designer 2013 lets you easily slice shapes into two or more 
pieces, and you can use either a solid object or a line for slicing. For example, to cut a 
segment from a circle: 
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1. Create a circle and put a triangle on top. 
2. Select them both. 
3. Right click and choose "COMBINE SHAPES" > "SLICE (CUT) 

SHAPES". The edges of the triangle cut the circle into two 
shapes. The triangle disappears. 

4. You can now drag the segment out from the circle: 

 

 

You can also use a line to cut an object: 
The line should be drawn completely though the 
object and extend beyond it (as shown in the 
illustration). If the line is too short, this operation cuts 
out a thin slice.  
 

Creating regular polygons (the Quickshape 
Tool) 
The QUICKSHAPE Tool lets you quickly create almost any regular, symmetrical shape 
with sharp or rounded corners. You can then drag the edges to bend the sides, and at 
any time you can change the number of sides or make the object an ellipse, a polygon, 
or a star. 

 

 Creation Modes: Radius/Diameter/Bounds 

 Polygon 

 Ellipse 

 Stellate 

 Round corners 

 Restore edges 

 Number of sides 

 Editable items menu 

 Editing fields 

 
1. Select the QUICKSHAPE Tool ("Shift + F2"). 
2. Select POLYGON. 
3. Select the number of sides either from the menu, or by typing 

into the text box. 
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To create the polygon drag: 

 

 Radius 

 Diameter 

 Bounds creation 

• From the center outwards (RADIUS button), 
• Or from an outside edge (DIAMETER button), 
• Or diagonally to create an imaginary rectangle enclosing the polygon (BOUNDS 

CREATION button) letting you distort the polygon. 

Polygons with rounded corners 
Select the ROUND CORNERS button or 
double click on a corner point. 

 

The polygon has extra handles (radius 
handles) where the rounding starts. To 
increase or decrease the radius, drag any 
of the radius handles. 

To remove the round corners: 

• Click the ROUND CORNERS button. 
• Or double click a control handle. 

Editing a polygon 
The SELECTOR Tool lets you move, rotate, resize, and skew a polygon as normal (the 
SELECTOR Tool is described in Object handling (on page 103).) 

Using the QUICKSHAPE Tool, you can resize or rotate: 

• Drag the corner handles. 
• Or select SIZE & ROTATION in the EDITABLE ITEMS menu. Type the required values 

into the text boxes. 

Size 
Rotation 

You can also nudge the values using the buttons to the right. 
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To move: 

• Drag the handle in the center of the polygon. 
• Or use the arrow keys on the keyboard. 
• Or select "Center" in the EDITABLE ITEMS" menu. Type the required X/Y values 

into the text boxes. 

 

Apply or remove rounded corners by clicking the ROUND CORNERS button. 
 

Change the polygon to an ellipse by clicking the CREATE ELLIPSE button 
(ellipses are described later) or double clicking the polygon's center.  

Stellate the polygon (make it star-shaped) by clicking the STARRED SHAPES 
button (starred shapes are described later).  

Drag the sides to make them curved. Move the pointer over the edge of the polygon 
(it changes to an arrow shape). You can now drag the sides. 

 

On the left are the original polygons. Just drag on 
the sides to create curved sides. 

"Ctrl + double click" on a side, or click the RESTORE EDGES button to make the sides 
straight again. 

 

Change the number of sides by typing the number into the menu or 
selecting from it.  
 

Creating stars (polygons with indented sides) 

  
Select the QUICKSHAPE Tool.  

To create a star or to make the selected polygon stellated: 

Stellated/stellation = star shaped. 

.  

Select the STARRED SHAPES button 
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Or double click on a side. 

Left: polygon with starred off. Right: starred on. 

Removing stellation 

 

Click the STARRED SHAPES button. 

 

Or double click on the star handle. 

 

Note: double click on the star handle, not the control handle. 

Editing stars 
You can edit stars in the same ways as ordinary polygons (described earlier). 

To increase or decrease the depth of stellation: 

Drag a star handle or select STELLATION RADIUS 
& OFFSET on the EDITABLE ITEMS menu. Type the 
required values into the text boxes. 

 

The original shape is on the left. 

Or drag the sides to make them curved: 

 

The original shape is on the left. 

You can also nudge the values using the buttons to the right. 

 

Offset from center 
Angular offset 

 

"Ctrl + drag" one side of a star moves all the sides symmetrically. "Ctrl + Shift 
dragging" moves pairs of sides as mirror images. "Ctrl + double click" on a side, or 
click the RESTORE EDGES button to make all sides straight again. 
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Creating rectangles and squares 
To create a rectangle: 

 
Use the RECTANGLE TOOL ("Shift + F3", or "M"). Click and drag on the 
canvas to draw a rectangle. 

Creating a square 
To create a square rather than a rectangle, hold down "Ctrl" while dragging. 

Creating and Editing rounded corner rectangles 

 
To give your rectangle rounded corners, select it and then press the 
“Curved corners” button on the RECTANGLE TOOL infobar. 

You can then drag on the selection handles shown on the corners to adjust the 
diameter of the rounded corners. 

 

You can resize rectangles using either the RECTANGLE TOOL (by dragging on the 
handles shown at the corners) or the SELECTOR TOOL.  

Note that if you change the aspect ratio of a rounded corner rectangle using the 
SELECTOR TOOL (by stretching it in one dimension only) the aspect ratio of the 
rounded corners is not stretched, it is maintained. However if you have multiple 
objects selected, or if you’re stretching a group containing a rounded corner 
rectangle, the aspect ratio of the corners is not maintained. 

TIP: When rotating rectangles or any shape with straight edges, hold down Ctrl to 
easily rotate so that one of the straight edges is exactly horizontal or vertical. 

Creating circles and ellipses 
To create an ellipse or circle: 

 
Select the ELLIPSE TOOL ("Shift + F4", or "L").  

The RADIUS AND DIAMETER buttons automatically create circles. 
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 Radius 

 Diameter 

 Bounds creation 

With the BOUNDS CREATION button selected, drag on the canvas to draw an ellipse. 
Hold down "Ctrl" while dragging to create a circle rather than an ellipse. 

Select the RADIUS option to draw circles. The start point of a drag determines the 
circle’s center. 

Select the DIAMETER option. Now the start point of a drag determines the position of 
the edge of the circle. 

You can convert an ellipse into a circle at any time by double clicking on a control handle. 

Making shapes editable 
Choose "ARRANGE -> CONVERT TO EDITABLE SHAPES" ("Ctrl + Shift + S") to convert 
predefined objects like bitmaps and rectangles, ellipses, quickshapes, and text into 
shapes. This lets you edit their outline like a normal shape. 

This has several applications: 

• You can manipulate just a part of predefined objects after making them editable. 
• You can manipulate text in almost unlimited ways, adding new curves and 

ornamentation almost at will. Note that you cannot edit text converted to shapes 
as it ceases to be text. 

• You may want to send a .xar file to someone who does not have that particular 
font. As converted text is just a collection of lines and curves; it does not need to 
use the original font. 

However, the disadvantage is that you can no longer edit the objects with their 
original tools. 

For more information on text refer to "Text handling (on page 178)". 

You can also convert lines (open shapes) to the equivalent closed shape, by selecting 
the line and then "ARRANGE -> CONVERT LINE TO SHAPE". If you have a straight line 
with a 10 pixel line width, converting it to a shape will change it into a filled 
rectangular shape with no outline width. 
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Distorting Objects 

Stretching and squashing objects 
This is similar to scaling objects except that the object is scaled in one direction only. 
Stretching and squashing are basically the same action — stretching makes the object 
larger, squashing makes it smaller. 

Stretching/Squashing using the mouse 
The SELECTOR Tool must be in scale mode. (The selection handles are squares.) If 
necessary, click on the object to change to scale mode. 

 

Drag one of the side handles. The 
object scales as you move the 
pointer in the appropriate 
direction. The InfoBar shows the 
current scaling. 

The LOCK ASPECT button is 
ignored. 

Right click or press "+" on the numeric keypad while dragging to stretch or squash a 
copy of the object, leaving the original in place. 

Stretching/squashing using the InfoBar 
The LOCK ASPECT button must be unset (if it is set, you scale the object instead of 
stretching or squashing it). 

Type into either the width or height text box (as appropriate) and press "". 
Alternatively enter a % scale (width or height). So entering 200% into the top % 
scale box will make the object twice as wide, but the same height. If the LOCK ASPECT 
is set then it will not stretch. 

Skewing objects 

 
This is part of the SELECTOR Tool. 

 

 

Left is the original object, to the right with a 
horizontal skew 

Skewing using the mouse 
Switch the SELECTOR Tool to rotate/skew mode. (The selection handles are arrow 
shaped) by clicking on the object. 
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Drag a side arrow to skew the object. 

As you drag, the object skews in the direction of movement 
(vertical or horizontal).  

  

The InfoBar shows the current skew angle. 

"Shift + drag" to skew the object around its center. Hold down "Ctrl" to restrict the 
skew to the constrain angles. Right click, or press "+" on the numeric keypad as you 
drag to create a copy, leaving the original where it was. Or right-drag with the mouse 
to create instant copies, additional copies by left clicks. 

You can also skew an object in the Selector Tool's resize mode using the skew areas. 
Read more under Rotating objects in resize mode (on page 111). 

Skewing using the InfoBar 

 
To skew horizontally type an angle into the skew text box and press 
"". 

To skew vertically: 

 
1. Click the center-right button on the 3x3 matrix on the InfoBar. 
2. Type an angle into the skew text box and press "". Positive values skew 

downwards, and negative upwards. 
 

The Mold Tool 

 
The MOLD Tool is used to distort shapes. It is used for both perspectivizing 
(that is, rotating in three dimensions) and enveloping (like distorting a rubber 
sheet). 

 

Mold tool InfoBar 

 Mesh 

 Remove mold 

 Detach mold 

 Rotate mold 

 Copy mold 

 Enveloping 
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 Paste envelope mold 

 Perspectivizing 

 Paste perspective mold 

The InfoBar contains two sets of preset mold shapes. Just click a button to apply the 
preset mold. The left-hand button in each group is the default "no distortion" mold 
which you can then manually edit after applying it. 

Perspective 

 

The MOLD TOOL lets you perspectivize shapes 
to give an impression of depth. 

You can perspectivize all types of objects 
including text and bitmaps. Note that bitmaps 
lose perspective if you later blend them or 
convert them to editable shapes. 

1. Select the object or objects. 
2. Select the MOLD TOOL (shortcut "Shift + 

F6"). 
3. Choose one of the perspective options: 

 

The right-hand button (paste perspective) is described later. 

Page & Layout Designer draws a rectangle around the object or selection. You can 
drag the control handles at each corner of the rectangle to produce the perspective 
effect. You can rotate, resize and skew the perspectivized object using the SELECTOR 
TOOL. 

You may want to move control handles without redrawing the perspectivized object 
(doing this speeds up screen redraws). 

 
To do this select the DETACH MOLD button. To refit the object, deselect the 
button. 

Using vanishing points 
As you reduce the size of the sides of the perspective mold, you see a "vanishing 
point" target. This is similar to vanishing points in conventional perspective drawings. 

 

You can use vanishing points to obtain 
consistent perspective for several objects. 
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All three object share a common vanishing point at the small cross. 

The perspective mesh 

 
This button paints a faint series of dots in a grid to preview the degree of 
perspective distortion of an object. 

Using molds 
You may want to apply the same perspective to several objects. To do this you create 
a mold shape, copy it to the clipboard and then use it to perspectivize the other 
objects. A perspective mold shape must have four straight sides: 

 
 

This is acceptable as a mold shape These are not acceptable. The object on the left has too 
many sides (must be four). The object on the right has 
curved sides (must be straight). 

Removing perspective 
Click REMOVE to remove perspective. If the selected object has more 
than one perspective or envelope mold applied, only the most recent 
mold is removed.  

Rotating the object within the mold 

 
Sometimes you will find that the mold is the correct shape but the object needs 
rotating within it. You can rotate the object by clicking the rotate object button. 

 

Enveloping 

 
The MOLD TOOL lets you envelope shapes in a wide variety of ways.  

The effect is similar to a rubber sheet or balloon that you can stretch in any direction.  

You can envelope all types of objects except bitmaps. 

 Sample enveloped text 

Enveloping is similar to applying perspective. That is: 
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1. Select the object or objects. 
2. Select the MOLD TOOL (shortcut "Shift + 

F6"). 
3. Choose one of the envelope options: 

The right-hand button is similar to paste perspective described earlier. 

The left-hand button does not initially alter the object. The other buttons immediately 
alter the object. 

After applying the mold, to edit it: 

1. Drag any of the corner handles. 
2. Or click on a corner handle and then drag the curve handles. 

The above example shows the 4 curve handles of the corners have been dragged 
outwards to bend the content of the mold. 

You can also rotate, resize and skew the enveloped object using the SELECTOR TOOL. 

The mold mesh button 

 
The Mesh button displays a series of faint dots which can help preview the 
distortions that the envelope mold is giving. 

Envelope molds 
You can create an envelope mold from any four sided shape, which you can distort as 
you require, and then use as an envelope mold by clicking the PASTE ENVELOPE button 
on the MOLD TOOL InfoBar. 

Editing mold shapes 
You can edit the contents of a mold (essentially a group) using editing inside groups 
(on page 121). Editing is not possible using direct selection inside (molds do not allow 
objects inside them to become selected). To edit a mold inside, right click on the mold 
and choose OPEN MOLD from the context menu. 

You can edit the shape of envelope or perspective molds with the SHAPE EDITOR TOOL 
(or the edit handles with SELECTOR TOOL, if shown). According to the nature of molds, 
there are some restrictions: 

• You cannot add point handles to a perspective or envelope mold, because it has 
to stay a  four-sided shape 

• You cannot change a straight line of a perspective mold into a curve. 
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Feathering 
Sometimes you want to blur the edges of an object so it blends, or fades, into a 
background object. This is called "feathering". An example is merging two bitmaps 
together when you want to avoid a sharp edge between them. 

The feather control is on the right side of the top bar. 

 To feather an object: 

 

1. Select the object or objects you want to feather. 
2. Either enter a numeric size for the feather into the text box 

Or 
Click the arrow to show the pop-up slider. As you drag the slider the objects 
are feathered. 

 

Feathering blends or blurs the edges of objects. 

If you have multiple objects selected, the feather appears around each object. If you 
group the objects, the feather appears around the outside of the group. 

 
You can also change the feathering profile. Normally a linear 
transition across the feather produces the best effect, but you 
may want to change this. 

Select the PROFILE button to display the PROFILE dialog and adjust the sliders. 
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Page & Layer Gallery 

The Page & Layer Gallery 
By default the PAGE & LAYER GALLERY is displayed open on the right hand side of the 
Page & Layout Designer window when you open or create a new document. If you 
prefer, you can unpin, move, dock or close the gallery - see Galleries (on page 64) for 
more information. 

 If you have previously closed the PAGE & LAYER GALLERY, which is open by 
default, you can reopen it by clicking the PAGE & LAYER GALLERY tab on the 
Galleries bar, or press F10. 

The PAGE & LAYER GALLERY lists everything in your document, from the pages and 
layers right down to each individual item on the page. It provides a way to select, hide, 
lock and re-arrange these items. 

It works at many different levels: PAGES, LAYERS, PRESENTATION STEPS and OBJECTS. 
The hierarchy of items is like this: 

Pages     
 Layers/steps    
  Page items, which may include 

groups 
  

   Group contents  
    ...etc 

Some of the key features of the PAGE & LAYER GALLERY include: 

Page control 
• Displays a list of pages 
• Pages mode displays a narrow list of page thumbnails for easy page navigation 
• Add new page, duplicate, cut, copy and paste or delete pages, single or multiple 
• Re-arrange the page order by dragging 
• Rename pages 

Layer control 
• Displays a list of all layers on each page, from the bottom (usually background 

layer) to the top most layer 
• In a presentation document, displays a list of all presentation steps and layers on 

each page, from the first to the last 
• Create new layers, delete, re-order and rename layers 
• Hide or show layers 
• Lock layers (which makes the layer non-editable) 
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• Solo a layer - turn all other layers off 

Object control 
Display a list of all items (objects) on the page in the stacking order they appear on 
the page, bottom to top. 
• Hide or show any item 
• Move up and down the stack 
• Lock any object so it becomes non-editable 
• Locate and highlight any object in the gallery by clicking it on the page when in 

'Locate' mode - toggle the LOCATE button on (enabled) and off (disabled) 
• Solo an object - turn all other objects off 
• Move objects into or out of a group using drag and drop, or move an object from 

one group to another. (Note this is only supported for ordinary groups, not 
anchored or repeating groups for example). 

In addition the PAGE & LAYER GALLERY shows a thumbnail of each page and a tiny 
thumbnail of each item on the page. Hover the mouse pointer over an item to view a 
larger thumbnail. 
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This shows the MouseOff layer has been expanded to show the contents of that layer. This shows 
a navbar group and other various groups, text line and text column items, and a couple of 
shadow group items. 

Hovering the mouse pointer over the tiny thumbnails will display a larger one so you can easily 
identify each object on the page. 

Note the right two columns indicate (and control) whether the items are editable (a pale arrow) 
or locked (padlock icon) and whether they are visible on the page (pale open eye icon) or hidden 
(darker closed icon). 

Clicking on these icons will change the visibility and / or the locked or editable nature of each object. 
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Pages 
Clicking the PAGES button on the top of the PAGE & LAYER GALLERY (or right clicking in 
the gallery and choosing SHOW PAGE LEVEL) will open pages mode, displaying only the 
pages in the document and collapsing all other opened levels. 

When in pages mode and the gallery is docked, the width of the gallery is reduced to 
its minimum, to take up as little space as possible. Also the number of buttons at the 
top of the gallery is cut down to just those applicable to pages. To leave pages mode, 
simply expand one of the pages to reveal its layers. The gallery returns to its full width 
and the full button set is restored.  

You can select multiple pages in the gallery by Ctrl+clicking on pages to add them to 
the selection, or by holding Shift down  to select a range of pages. Then you can copy, 
paste, delete or re-order multiple pages at once. 

You can re-order pages by dragging on the selected pages in the PAGE & LAYER 
GALLERY, or by right clicking a page and choosing MOVE PAGE UP/DOWN. 

You can rename a page by right clicking it and choosing RENAME PAGE. This is a useful 
way to identify pages in long documents.  

Layers 
Everything in your document has a stacking order but with more complex documents 
that have dozens, maybe hundreds or thousands of items, your work area can be 
become cluttered.  

Using layers you can group a collection of items together and then turn the whole 
collection on or off (make it visible or hidden) in one easy operation. Layers can be 
made invisible, to hide parts of your document. You can give layers names, and you 
can easily create new layers or delete them. And you can open a layer and view its 
contents. 

When you select any object, the layer it's on is shown on the status line at the bottom 
of the window. 

The Current Layer 
When you create any new object on the page, it's placed in one of the layers, called 
the active layer or simply the current layer. On a blank document this will be called 
Layer 1. The current layer is shown with a selection arrow   . 

Important: All new drawn items, shapes, photos, text, and all pasted items, are 
placed on the current layer marked with the  symbol. 



 

Page & Layer Gallery 153  

 

You can change the current layer simply by clicking on its row in the PAGE & LAYER 
GALLERY.  It's important to understand that you can have a selected object on any 
layer or even multiple layers, and these need not be the current layer. The current 
layer, with the arrow, only indicates where new items will be placed. 

 

This example PAGE & LAYER GALLERY shows the current layer is called MouseOff (the current 
page is called news). So if you draw anything new it will be placed on the MouseOff layer. 

It also shows a shadow group item selected in the document (highlighted in blue) inside another 
group which is on a completely different layer called Holiday photo 2. 
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Four layers are hidden (called Holiday photo 4, Holiday photo 3, Holiday photo 1 and 
MouseOver). The 'Page background' layer is locked. 

Make the current layer always visible 
It's possible that the current layer can be hidden or even locked. Just clicking on a 
layer to select it and making it the current layer does not normally change its visible or 
locked state. But there is a preference in the General (on page 346) tab of the Options 
dialog (right click a page and choose PAGE OPTIONS or choose OPTIONS from the 
UTILITIES menu) to make the current layers always visible and editable (unlocked). If 
you select this option then whenever you select any layer in the PAGE & LAYER 
GALLERY it's made visible and unlocked. Moving to another layer will restore the 
previous visible and locked state of the layer you just moved from. 

Layers in PDF documents 
Layers are useful for producing overlays. For example on a floor plan of a building, you 
might have overlays showing the fire points, power outlets or wiring. By putting such 
items on named layers you can easily show or hide them. When saving a document 
as a PDF (on page 314), you can select to enable layers in your PDF document, and so 
then using the Layers control in PDF reader you can turn the layers on or off. 

To enable layers in your PDF file: When exporting as a PDF, select the Advanced 
option on the export screen, and then choose Adobe Reader 6 or higher (PDF 
version 1.5 or higher) from the PDF Version list. And then on the Layers tab of the 
same dialog, select the 'Enable Reader layers..' option. When you view your PDF file 
in Adobe Reader there is a Layers control available. 

Soft Groups and Layers 
Soft Groups (on page 123) are unusual because they are groups of objects that can 
span different layers. (Normal groups have to be contained within one layer). When 
you select any part of a soft group the other parts are also selected, even if they are 
on hidden or locked layers. The PAGE & LAYER GALLERY will show all selected items 
highlighted in blue, but in the case of soft groups these items may be on other layers 
that you've not expanded, and so are not immediately visible.  

See the section on Soft Groups (on page 123) in the Object Handling chapter to find 
out more. 

Layer Operations 
Clicking the LAYERS button on the top of the Page & Layer Gallery (or right clicking in 
the gallery and choosing LAYER MODE) will display only the layers on the current page. 
This is a mode - the Layers button stays depressed. While in layers mode, as you 
move to different pages the layers for the current page are always shown and all other 
page nodes are collapsed. Click the LAYERS button (or right click and choose LAYER 
MODE) again to turn off layers mode.  
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You can re-order the layers, that is, the stacking order on the page, by using drag and 
drop on the layers in the Page & Layer Gallery. 

You can rename a layer by performing a second (slow) click on the layer name. (The 
first click would select the layer.) This is very like file renaming in Windows Explorer. 
Alternatively right click the layer and choose RENAME LAYER. 

Clicking the small right arrow  or double clicking anywhere on the layer row will 
expand the layer to show its contents. Doing the same again will collapse and hide the 
layer contents. 

Holding the mouse pointer over the small layer icons  will show a thumbnail of the 
contents of the layer. 

The NEW LAYER button will create a new blank layer and place it at the top of the 
stack. You can re-arrange the order by dragging it to the required position. 

The DUPLICATE button will copy the layer and its contents and place it on top of the 
stack - that is on top of all other objects on the page. 

Right clicking the layer and choosing NEW LAYER, DUPLICATE LAYER or DELETE LAYER 
performs the same functions. 

Layer Properties 
This opens the Layer Properties dialog. 
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Creating layers and editing layer properties 
Using the Layer tab you can: 

• Create a new layer or edit an existing one. 
• Make the layer editable and visible by default. 
• Define the layer as a page background that will not appear when printed. 
• Specify that all objects in the layer will only repel text objects (on page 192) 

within the same layer. This prevents text on the layer being repelled by objects in 
other layers. 

Using guidelines 
The Guides tab allows you to create layer guidelines at precise numeric values and 
choose a color for guide layer objects. 

See the GUIDE OBJECTS & GUIDELINES section in Object handling for more information 
on using  guidelines. 

Special Layers 
There are several special types of layer. They appear in the Page & Layer Gallery and 
can be turned on and off as usual, but behave slightly differently. 

BACKGROUND LAYERS are non-printing layers that appear at the bottom of the 
document, under everything else. When you apply a color to the page background 
(drag and drop color from the color line) this will create a PAGE BACKGROUND layer 
automatically. Normally this is locked. 

You can also set the color of the pasteboard (the area around the page) by dragging a 
color from the color line and dropping it on the pasteboard. This creates a 
PASTEBOARD BACKGROUND layer automatically. Again, this layer is locked. 

The GUIDES LAYER is where guidelines or guide objects are placed.  When you create a 
guideline this automatically creates a Guides layer. See Guide Objects and Guidelines 
(on page 119) in the Object Handling chapter to find out more. 

Hiding Layers and Objects 
The rightmost two columns of icons in the Page & Layer Gallery control the visibility 
and locking of layers and all objects on the page.  

Clicking on the open eye  icon will hide the layer or object on the page, and the icon 
will turn to a closed eye . Clicking again will revert the layer or object to be visible. 

When any item is hidden, it becomes invisible on the page and can no longer be seen 
or selected. The way to get hidden items back is to click its closed eye  icon. 



 

Page & Layer Gallery 157  

 

Alternatively you can click the MORE... button and select SHOW ALL ON PAGE option, 
which un-hides all items on the current page. 

Locking Layers and Objects 
Clicking the open padlock icon  on the right end of an object or layer row will lock 
the layer or object (icon changes to a closed padlock ). Now you cannot select this 
object or any object on that layer. Any clicks on locked items will go straight through 
it, as if it's not there, and select items underneath. Clicking the padlock icon will 
unlock that object or layer again. Alternatively you can click the MORE.. button and 
select the UNLOCK ALL ON PAGE option. 

Soft Groups 
There is one exception to the locked rules. If a locked item (or item on a locked layer) 
is part of a Soft Group (on page 123), then selecting and operating on that soft group 
will also select and operate on any locked items in that soft group (this is the intended 
operation of soft groups). 

Solo Mode 
If you click any of the  icons in the column next to each layer, it will 'solo' this layer 
which means it hides everything else, except this layer. You can now work on this 
layer in isolation. Clicking the  icon again will restore everything back to how it was 
before. 
 
You can also click and drag down the column of  icons to quickly browse through 
the layers in isolation from everything else. 

To exit the Solo mode, click the  button again. 

Show All & Unlock All 

 

These two controls on the top of the PAGE & LAYER GALLERY are a short-cut to show 
all items on the current page or unlock all items. They are a temporary override of all 
the individual object and layer settings. Clicking the controls again will restore the 
previous state. So this is a quick way of showing or unlocking everything, on all layers, 
performing some operation, and then restoring the previous state. 

The Unlock all button is useful if you have a locked object on the canvas that you want 
to unlock, without having to first locate it in the Page & Layer Gallery. Turn on ‘Unlock 
all’, then right click on the object on the canvas and choose the Unlock option from 
the context menu. Then you can turn ‘Unlock all’ off again. 
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When either button is selected (the buttons are shown pressed in), then it's not 
possible to change the state of individual items. Un-select the buttons to enable the 
normal operation of the layer visibility and locking state. 

Clicking the MORE button will display menu options to SHOW ALL ON PAGE and 
UNLOCK ALL ON PAGE. 

Moving Objects Between Layers 
There are several ways to move objects between layers. First select the object or 
objects you want to move, then; 

• CUT the object ("Ctrl + X" or right click and CUT). Ensure the target layer is the 
current layer (shown with  , click the layer if it's not) and then right click and 
choose PASTE or PASTE IN PLACE. Note that if you cut or copy multiple items that 
are on different layers, the layer structure is preserved when you paste. Items are 
pasted to the same layer they were copied/cut from, instead of being pasted to 
the current layer. If you want to paste all such items to the current layer, ignoring 
the layer structure, use the PASTE IN CURRENT LAYER option instead. If you want to 
retain layer structure, choose PASTE IN PLACE IN CURRENT LAYER. These paste 
options are also in the clipboard fly-out bar on the top bar, as well as the EDIT 
menu. 

• Right click and choose ARRANGE then MOVE TO LAYER IN FRONT / MOVE TO LAYER 
BEHIND to shift the selected objects one layer up or down. 

• Ensure the target layer is selected as current, then find the selected item in the 
PAGE & LAYER GALLERY (click the LOCATE button), right click and select MOVE TO 
CURRENT LAYER. 
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Color Handling 
MAGIX Page & Layout Designer 2013 gives wide control over applying, creating and 
altering the colors of objects. For simple documents, you can just choose colors from 
the on-screen color palette, the Color Line.  More advanced color operations are 
described later. 

The color line 
The Color Line is displayed at the bottom of the window. It shows you the current fill 
and line colors, provides access to the color editor and provides a palette of pre-
defined colors including a special "no color". 

 

 COLOR SWATCH: The outer part of the color swatch on the left-hand end of the 
Color Line shows the line color and the center shows the fill color. These are the 
colors of any selected objects, or the current color attributes if no objects are 
selected. 

 This button provides access to the COLOR EDITOR. 

 COLOR PICKER:  Use the eye-dropper to pick a color from any part of the 
document or any part of the computer screen. See Using the eye-dropper to pick 
colors (on page 164) for details. 

 NO COLOR: Clicking this applies a "no color fill". Shift-clicking applies "no color" 
to a line. Note that this is not the same as 100% transparent. "No color" and 
transparency are different. A shape with transparency applied remains a solid 
shape whereas a shape filled with "no color" is effectively hollow. The NO COLOR 
button can also be used to restore the original colors to a photo which has had a 
contone color applied. 

 Current Fill color - the fill color of the currently selected object (displays a 
diamond marker on top left). 

 Current Line color - the line color of the currently selected object (displays a 
diamond marker on top right). 

If the length of the Color Line exceeds the window, you can scroll through the Color 
Line with the scroll bar below or by "Alt + dragging" the Color Line. 

MAGIX Page & Layout Designer 2013 provides several options for the displayed size 
of the Color Line (described in Customizing Page & Layout Designer on page 359). If 
you do not want to display a Color Line, deselect WINDOW -> BARS -> COLOR LINE. 
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Colors on the color line 

 

 NAMED COLORS: First comes the Named Colors with its according Linked Colors 
(if present in the document, see below).  

 LINKED COLORS are represented differently on the color line by smaller rounded 
rectangles. When editing templates, to change the color scheme of the design 
you should only normally edit the Named Colors (large squares) and leave the 
Linked colors unchanged. 

 SPOT COLORS: If your document contains spot colors (on page 293), they appear 
on the Color Line (and in the Color Gallery) as circles.  

 PALETTE COLORS: By default, there is a 'Standard Palette' of 46 pre-defined 
colors. There are 5 shades of 7 standard hues and 10 shades of gray, black and 
white. Standard Palette colors are not editable (i.e they are not Named Colors) 
and are designed as a simple, limited selection of colors to apply to objects 
(either by dragging on to the object or clicking). Use the Color Gallery (on page 
172) to show other palettes like Web Colors or Pantone® Colors (if available). 

Little markers in the color icons shows which of the named colors (if any) or  palette 
colors have been applied to the selected object(s). 

 Diamond markers show the colors used by the selected objects. A 
diamond in the top-left corner  indicates the fill color, in the top-right 
corner indicates the line color. 

 Cross-shaped markers show the current color attributes if there are no 
objects selected. Line color on the right, fill color on the left. 

 Triangular markers show the colors of a fill if you have applied one. 

This works also when choosing a color with the color picker from existing objects, see 
Using the eye-dropper to pick colors (on page 164). The color line markers update 
immediately and indicate the color of the object under the eye-dropper as you're 
dragging around. 

Re-ordering colors on the color line 
Only named colors can be re-arranged on the Color Line. "Ctrl + drag" colors along 
the Color Line. This also reorders the COLOR GALLERY.  

Color line context menu 
Right click on a color on the Color Line to show a context sensitive menu with the 
following options: 

EDIT  Opens the color editor with the selected color (not 
available for palette colors) 

SET FILL COLOR / SET LINE 
COLOR 

Set the fill or line color of the selected object with this 
color 

RENAME Rename a named color (not available for palette 
colors) 

DELETE Delete a named color (not available for palette colors) 
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If the selected object is a bitmap, the fill and line color options are replaced with SET 
CONTONE DARK COLOR / SET CONTONE LIGHT COLOR. See Bitmap coloring (on page 
217) for more information. 

When right clicking the “no color” swatch, the fill and line color options are replaced 
by: CLEAR FILL COLOR / CLEAR LINE COLOR. This sets the selected object's relative 
attributes to "no color". When applied to a contoned photo/bitmap, this restores the 
original image colors. 

Applying fill & line colors by drag & drop 
• To apply a fill color to an object (selected or unselected), drag a color from the 

Color Line and drop it into the center of the shape. Alternatively right click and 
choose FILL COLOR to display the color editor. 

• To set the line or outline color, drop it on the line, not the center. 
• To change the current fill color, drag a color into a blank space. 
• To change the page background color, "Ctrl + drag" a color onto the page 

background. 

When dragging colors an indicator beside the pointer tells you what effect dropping 
the color will have: 

 
Set flat fill color (seen when you drag over an object) or the intermediary colors 
of a multi-color fill (on page 219) 
 

 
Set line color (seen when you drag over a line). 

 
Set the current fill color (seen when you drag over an empty space). 

 
Set start color of graduated fill (seen when dragged over start of fill). 

 
Set end color of graduated fill (seen when dragged over end of fill). For three 
and four-color fills, a number is added to mark the according end color handle. 

 
Set page background color (seen when you drag a color onto the page). 

Instead of drag & drop, if you have an object selected, you can just click on the Color 
Line. If only open shapes or lines are selected, this will set the line and the fill color. In 
any other case, you can alter the line color by "Shift + clicking" on the Color Line. 

If a bitmap or a bitmap-filled shape is selected, then clicking on Color Line will 
contone the bitmap. That means, the bitmap is converted to greyscale (black and 
white) and the used color is used as a contone light color. The contone dark color is 
usually black. You can set both contone colors via the Color Line context menu (see 
above). See Bitmap coloring (on page 217) for more information. 
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To set a fill or line to no color (clear), perform the 
operations as outlined above but use the "No color" option 
instead of a color. 

 

Editing an object’s color 
To edit the fill color of the selected object(s): 

• Choose "UTILITIES" > "COLOR EDITOR" ("Ctrl + E"). 
• Or click the EDIT COLOR icon on the Color Line. 
• Or right click the object and choose FILL COLOR 
• Or double click on the current line and fill color icon on the Color Line (the edge 

of the leftmost panel). 

To edit the line color of the selected object /s 

• "Shift + click" on the EDIT COLOR icon 
• Or double click on the current line and fill color icon (the edge of the leftmost 

panel). 

This displays the COLOR EDITOR which allows you to select from any color of the 
spectrum. Unlike most graphics programs the Color Editor can remain on screen 
while you continue to work. It changes to reflect the color of the selected objects, and 
the fact that you can also drag the lower right corner to resize the COLOR EDITOR 
window means that you can easily and precisely adjust the color of the selected 
object.  
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The Color Editor in detail 

 

 Shows what you are editing 

 New named color 

 Show/hide advanced options 

 Eye dropper color picker 

 Previous color 

 Current color 

 Color panel (Color model dependent)  

 HSV hue selector 

 Numeric values (Color model dependent)  

 RGB hex color value 

 Color model (HSV, RGB, CMYK or grayscale) 

 3D editor mode option (only RGB & CMYK) 

 No color patch (only available when editing local color) 

 Make Named Color local to Frame/Layer 

 Rename named color 

 Color editor help 

 Type of color: Normal, Spot (if available), Tint, Shade or Linked 

The illustration shows the full version of the COLOR EDITOR. Click HIDE ADVANCED 
OPTIONS to display the smaller, simpler version. 
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Using the eye-dropper to pick colors 
Instead of selecting hues and shades on the COLOR EDITOR you can instead pick a 
color from any part of the document or any part of the computer screen—even from 
other windows and programs. 

To do this just click and drag on the eye dropper icon. As you drag you see the color 
editor continuously picks up the color under the eye dropper. Release the mouse 
button when you have the desired color.  This is an easy and quick way to use the 
same color again or copy colors from photos or from one object to another. 

If the object under the mouse pointer is complex (eg. has transparency applied) and 
the color cannot be determined, screen RGB color is applied. 

The color sampler shows a small popup at the mouse 
pointer which indicates the color that is being sampled 
at that point. This will either be the palette color name, 
the name of a named color, or the color model and color 
value. 

 
Previous and Current color 
As you drag on the color editor the two small color swatches in the upper right of the 
color editor show the current color and the previous (before you started changing the 
color). This is useful if you want to make a small change and want to compare the old 
and new colors. 

3D color editor 
When editing RGB or CMYK colors the editor can be put into an advanced 3D mode 
that displays colors in a color cube. Some people may prefer to work this way. 

Specifying colors in the Color Editor 

 

Shows the expanded color editor, with the HSV 
picker on the left, RGB picker on the right. 

You can enter precise RGB (or HSV or 
CMYK) color values in a number of 
ways. The most common requirement 
for web graphics is to enter a hex RGB 
color. 
You can do this with the color editor 
showing either HSV colors (the 
default) or showing RGB colors. 
To select the RGB picker, right click on 
the dialog and select RGB. This allows 
you to enter RGB values as 
percentages or 0-255 values. 
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Percentages are used by default, but Page & Layout Designer allows you to change 
which format is used. To do this: 

1. Display the UNITS tab of the OPTIONS dialog box (UTILITIES -> OPTIONS). 
2. Click the appropriate radio button in the COLOR UNITS section. 
3. Click OK to close the dialog box. 

The color models 
Color models let you define a color in terms of different color components. RGB and 
HSV are typically used for screen use. If you know your document is going to be 
printed and require very specific CMYK color values, then you can use CMYK colors. 

Unlike some graphics software, MAGIX Page & Layout Designer 2013 allows you to 
mix RGB, HSV and CMYK colors in the same document. 

Models provided by Page & Layout Designer are: 

• RGB (Red–Green–Blue), 
• CMYK (Cyan–Magenta–Yellow–Key), 
• HSV (Hue–Saturation–Value), 
• Grayscale. 

RGB and HSV colors are stored within Page & Layout Designer in 24-bit format. This 
gives you 16.7 million possible colors. 

CMYK colors are stored in 32-bit format. When printed or output as EPS or PDF they 
are output in CMYK format. 

Colors on the screen and on the printer 
One problem with computer screens is that their colors do not match the available 
colors on a printer. Screens emit combinations of red, green, and blue. The brightness 
control has a dramatic effect on displayed colors. Printed images reflect combinations 
of cyan, magenta, yellow and black. 

Tip: To get bright blue on a printer, select a color on screen that is almost pure cyan 
(printer’s cyan is much more blue than screen cyan). 

As an example, pure green on computer screen is a fluorescent bright color that is 
impossible to reproduce accurately on any printer. Similarly pure blue on a computer 
screen will often print as a much darker purple-blue. Technically, the range of colors 
on a computer screen (known as the "color gamut") is far greater than that on a 
printer. So there will always be differences between screen and print colors. 
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MAGIX Page & Layout Designer 2013 provides the ability to simulate how printed 
colors will look. Select the "WINDOWS -> SHOW PRINTER COLORS -> SIMULATE PRINT 
COLORS" menu to get a better idea of how your colors will look when printed. This is 
an approximation only since printers vary slightly, but it is far more accurate than 
normal screen colors. 

Local colors and Theme colors 
Page & Layout Designer has two types of color: 

• LOCAL COLORS are used in only one place in the document. Each object has a 
separate color and nothing is shared. This is useful if you want to change the 
color of an object without affecting other objects. Local colors are the easiest 
method and best for simple documents that use relatively few colors. "Applying 
color" and "Editing an object’s color" above describe local color handling. 

• THEME COLORS (OR NAMED COLORS) can be used again and again in the document. 
(As such, they are like styles in a word processor.) Any edits you make to a 
Theme color are immediately reflected on all objects and parts of the drawing 
that use that color. You can also copy Theme colors between documents. Theme 
colors appear on the Color Line and in the COLOR GALLERY. If there are any Theme 
colors already present in the design and you import or paste templates from the 
Designs gallery containing Theme colors with the same name, you will be asked if 
you want to match the actual color of the imported Theme colors to the existing 
ones. The Theme colors in most templates are consistently named so when you 
import elements from different themes colors are matched perfectly. 

IMPORTANT: If you just select an object on the page that has a NAMED COLOR applied 
to it, and alter it with the color editor, this will always turn it into a LOCAL COLOR 
instead of a NAMED COLOR (because it is assumed that if you try to edit the color of 
the object that’s what you mean to do. If you really want to change the NAMED COLOR 
so this and all occurrences of the color change, then you should do so by editing the 
NAMED COLOR (on page 168) ). 

Theme color schemes 
Many of the web themes offered in the DESIGNS GALLERY and in separately 
purchasable Template Packs include alternative color schemes which can easily be 
applied to websites which use the same theme, to transform the color scheme 
instantly.  The color schemes are normally found in the Designs Gallery in each theme 
under WEBSITE TEMPLATE THEMES, after all the page layouts and separate graphic 
elements that make up the theme. They all have "Color scheme" in their titles in the 
Designs Gallery, so they are easily identified.  

To apply a color scheme to your website, simply drag the scheme from the Designs 
Gallery and drop it on your page. You can try applying the color schemes of one 
theme to a website created from the templates of another theme. But you will get 
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mixed results doing this and some schemes will not work acceptably with some 
themes. So for best results stick to the color schemes of the theme that you used to 
create the site. 

One of the color schemes provided with each theme matches the default colors used 
by that theme. This allows you to easily return to the original colors if you prefer, after 
experimenting with the alternate schemes. 

Of course you don’t need to use the provided color schemes to re-color your website. 
You can customize the theme colors yourself and choose a combination of colors that 
you think work well together. See "Editing named colors (on page 168)".  

Creating your own color schemes 
It’s very easy to create your own color scheme files, which you can pass on to other 
Page & Layout Designer users for them to apply to designs created with the same 
theme. 

1. Load one of the page templates for the theme. Choose one which shows off all 
the colors of the theme most effectively. You can add more elements to the 
page if required, to help show off the range of theme colors. 

2. Edit the named colors of the theme one at a time, as described in the ‘Editing 
named colors’ section (on page 168) below. 

3. Once you are happy with your new color scheme, use "FILE" > "SAVE AS" to 
save it. The filename you choose MUST include "themecolorscheme" as part of 
the filename. That is how Page & Layout Designer  identifies color scheme files 
– just by looking for that sequence in the filename. It’s a good idea to also 
include the name of the theme to which the scheme applies. For example a 
new blue color scheme for the "Beta" themeset could be named something like 
"betathemecolorschemeblue.web". 

To test your color scheme, drag and drop it from File Explorer onto a page that still 
has the default theme colors. The page should be instantly re-colored using your color 
scheme. 

Creating new named colors 
If you want to use the same color in different parts of the drawing, and there is any 
chance you might want to change that color in future, it is highly recommended that 
you create a NAMED COLOR. This is easy in MAGIX Page & Layout Designer 2013: 

Select an object whose color you want to use and then click NEW NAMED COLOR in the 
COLOR EDITOR. 

Click to create a new named color Give the color a suitable 
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Editing named colors 
There are three ways to display the color in the COLOR EDITOR so it can be edited: 

• Choose from the menu in the COLOR EDITOR. 
• Or right click on the color on the COLOR LINE and choose EDIT from the menu that 

appears. 
• Or drag & drop a color from the Color Line onto the COLOR EDITOR. 
• Or drag & drop a color from the COLOR GALLERY (described later) onto the COLOR 

EDITOR. 

You can then edit the color as required. All objects that use this color are 
automatically and immediately updated to show the new color. 

Renaming named colors 
While editing a NAMED COLOR, right click on the COLOR EDITOR and select RENAME 

• Or select the color in the COLOR GALLERY and select the NAME button, or 
• Or right click the color on the Color Line and select RENAME. 

Deleting named colors 
To delete a named color: 
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1. In the COLOR GALLERY, select the color or colors you want to delete. 
2. Click DELETE in the COLOR GALLERY. 

or: 

Right click on the color on the Color Line and choose DELETE. 
Importing named colors 
When a design is imported into the current document (e.g. import from the DESIGNS 
GALLERY, import a XAR file or paste objects in from another design) if there are any 
named colors in the imported design which have the same names but different color 
values as colors in the current design, an alert appears as follows: 

 

If you want the imported objects to inherit the colors of your current design, choose 
the “MATCH” option. This makes all objects using a given named color use the existing 
instance of that color as it appears in the current document.  

Alternatively if you want the imported objects to keep their own independent colors, 
select the “DON’T MATCH” option. This adds new named colors into your design, with 
a number appended to the color names to distinguish them from the colors already in 
the current design. This allows the imported objects to keep their original colors.  

Note that if you import objects from lots of different designs and choose “DON'T 
MATCH” each time, you will end up with a large number of separate Named Colors on 
your color line. 

The same prompt is shown if there are Text Style definition differences between the 
document and the imported design. So seeing this prompt does not necessarily mean 
that there are different named color definitions – it could just be due to Text Style 
differences. See the Text Styles section of the Text Handling chapter for details. 

The match prompt above includes a “DON’T ASK ME AGAIN” checkbox. If you check 
this, the option you choose will be assumed for all future imports, without asking you 
again. However this only applies during the current session, so after a program restart 
you will be asked again on the next import if there is a color clash. 

Using the MATCH option means that you can choose a template, change its theme 
colors and then import more templates of the same theme and the imported designs 
will immediately pick up your modified theme colors.  
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For example, import a red graphical button from the DESIGNS GALLERY, change its 
main theme color from red to green, then import a red logo graphic of the same 
theme and choose the “MATCH” option. When the logo appears in your design, 
instead of being red it will have picked up your chosen green theme color 
automatically. Since most themes have their main theme color named “Theme color 
1”, you will also usually get good results when importing graphics from different 
themes and matching the colors. 

Make Named Color local to Layer 

 
When you click this button, a new named color is created which is identical to 
the one you have selected.  

This new color is then applied to all objects in the current layer that use the selected 
named color. This means that with one click you can localize a color to the layer. You 
can then independently edit the original color and this localized color. 

This button is dimmed unless you are editing a named color that is also used in 
another layer. 

Normal colors, Tints, Shades and Linked colors 
Normal colors 
These are the normal stand-alone colors you apply to objects. 

MAGIX Page & Layout Designer 2013 can also define colors that are linked to another 
color, that is when the parent color changes the linked color will change as well. There 
are three ways you can link a color to its parent TINTS, SHADES, and LINKED COLORS. 
These are very powerful techniques that allow, for example, single-click re-coloring of 
complex shaded drawings. Some of the example clipart uses this technique. 

Tints 
Tints are based on other colors (called the parent color) and are always a paler 
version of the parent. They have two main uses: 

• Where you have paler shades of a parent color and you may want to change the 
parent color in future with the tints automatically updating. 

• To extend the range of colors available from printing inks. 
 
For example, a 25% red tint gives a pink color. Therefore using just a red ink you 
can have both a pure red and a pink using only one ink. Similarly, if just using 
black-and-white printing, it’s often useful to be able to use tints to create various 
shades of gray. 
 
If you are printing with a limited range of colors (it’s usually cheaper to print one 
or two color, instead of full or four color printing). 

A tint can be based on any type of color, including another tint. 
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Any changes you make to the parent color also change tints based on it. For example, 
you might define the color pink as 50% of a red parent color. Changing the parent 
color to orange automatically changes pink to light orange. 

Shades 
These allow both lighter and darker colors to be created all based on a parent color. 
Changing the color of the parent changes all associated shades. For example, a 
drawing of a car might use shades for the highlight and shaded regions of the car 
body. A single edit to the parent changes all the colors of the entire body but keeps 
the shading correct. Setting up shades this way is more time consuming but it is a 
very powerful way of altering colors. 

For best results, the parent color should be a "pure" saturated color. When using the 
HSV color mode, saturation and value should ideally be 100%. When viewed in the 
COLOR EDITOR the cross should be in the top left-hand corner. 

Linked colors 
Linked colors are similar to shades but give greater flexibility. These are also based on 
a parent color but you define which attributes you want the linked color to share with 
its parent. For example you can create a linked color that is a more or less saturated 
version of the parent, but the hue and lightness / darkness follow the parent. 

Creating a Tint, Shade or Linked color 
TINTS, SHADES and LINKED COLOR have to have a master "parent" color, which needs 
to be a named color, so that when you change this parent color, the tint will change as 
well. So, if necessary, first create a named color (see Creating new named colors (on 
page 167)). 

To create a tint, shade or linked color: 

1. Select the object or objects to which you want to apply the color. 
2. Open the COLOR EDITOR showing the advanced options. 
3. Select the "normal color" drop-down menu and select the TINT, SHADE, or 

LINKED option. 
4. From the PARENT dropdown menu, select the named color that you want this 

color to be linked to. 
5. Adjust the TINT, SHADE or LINKED COLOR on the top section of the color editor. 
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On the left you can see the new color is a tint of the parent "yellow" and so the editor provides 
only paler tints of the parent color. On the right, if you select a shade, you get to choose any 
lighter or darker shades of the parent color. 

If you want to use this color in many places in the document it’s recommended that 
you also make this a Named Color, so it appears on the Color Line, for easy picking. 
Just click on the NEW NAMED COLOR label icon on the top of the Color Editor and give 
it a name. It will now appear on the Color Line where you can pick it for use on other 
objects. 

Editing the parent color 
The key point of using tints, shades and linked colors is that they track any changes to 
the parent color. To see this working try editing the NAMED COLOR that is the parent 
(drag it from the COLOR LINE to the COLOR EDITOR and alter the color). You will see 
the objects with the tint, shade or linked color change in sync with the parent. 

NOTE: Be careful not to edit the color of objects on the page to which you’ve applied 
NAMED, TINTS, SHADES, or LINKED COLORS as this will change them to LOCAL COLORS. 
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The Color Gallery 
The COLOR GALLERY displays all the NAMED COLORS used in the current, and other 
open documents. It also lets you create, edit, copy and delete NAMED COLORS. 

To access the COLOR GALLERY: 

• Choose UTILITIES -> GALLERIES -> COLOR GALLERY ("F9"). 
• Or click the COLOR GALLERY button on the GALLERIES bar. 

 

 

The Color Gallery shows colors for all documents currently loaded. 

Buttons at the 
top are dimmed 
if they are not 
available, for 
example, if there 
is no selected 
color, or more 
than one color is 
selected. Most 
of the options 
are common to 
all Galleries and 
are described in 
Document 
handling (on 
page 64). 
The REDEFINE 
button redefines 
the selected 
color in the 
gallery to be that 
of the selected 
object. 

Document handling (on page 64) has general information about galleries. 
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PANTONE® Colors 
PANTONE COLOR BRIDGE gives access to a wide range of standard pre-defined 
colors that you can use when creating materials that will be professionally produced 
using litho printing.  Using PANTONE color numbers enables a more reliable way of 
reproducing known colors.  For example, the Scottish Parliament has defined that the 
blue color used in the Scottish flag be PANTONE 300.  This means anyone 
reproducing the flag can be sure to get the correct shade of blue. 

PANTONE colors can be used two ways. The "spot color" expensive way involves 
your commercial printer using special inks that are exact PANTONE colors. So when 
you specify, say PANTONE 120 (a shade of yellow), the printer purchases an ink that 
is exactly this shade of yellow. This is expensive because it requires special inks to be 
used. It’s usually only economically viable if you require large or very large production 
runs. This is sometimes referred to as PANTONE solid or spot colors. 

The alternative, less expensive way, is to use PANTONE 4-COLOR PROCESS colors, 
which use a mix of the standard CMYK inks to re-create a given color, sometimes 
called a Process Color. This is less exact because mixing CMYK inks to create a given 
color is not as reliable as using a solid pure ink of the required color.  However it 
provides a way of ensuring much more accurate color reproduction than judging 
colors by eye or assuming your computer monitor screen or inkjet printer is accurate 
(computer screens and desktop printers vary quite considerably). 

MAGIX Page & Layout Designer 2013 also supports both type of PANTONE color 
system. You can use them as spot or solid colors or use the PANTONE 4-COLOR 
PROCESS library which defines exact mixes of CMYK colors. You can find the 
PANTONE color libraries in the COLOR GALLERY. 

Introduction 
PANTONE COLOR BRIDGE gives access to a wide range of standard pre-defined 
colors that you can use when creating materials that will be professionally produced 
using litho printing.  Using PANTONE color numbers enables a more reliable way of 
reproducing known colors.  For example, the Scottish Parliament has defined that the 
blue color used in the Scottish flag be PANTONE 300.  This means anyone 
reproducing the flag can be sure to get the correct shade of blue. 

PANTONE colors can be used two ways. The "spot color" expensive way involves 
your commercial printer using special inks that are exact PANTONE colors. So when 
you specify, say PANTONE 120 (a shade of yellow), the printer purchases an ink that 
is exactly this shade of yellow. This is expensive because it requires special inks to be 
used. It’s usually only economically viable if you require large or very large production 
runs. This is sometimes referred to as PANTONE solid or spot colors. 

The alternative, less expensive way, is to use PANTONE 4-COLOR PROCESS colors, 
which use a mix of the standard CMYK inks to re-create a given color, sometimes 
called a Process Color. This is less exact because mixing CMYK inks to create a given 
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color is not as reliable as using a solid pure ink of the required color.  However it 
provides a way of ensuring much more accurate color reproduction than judging 
colors by eye or assuming your computer monitor screen or inkjet printer is accurate 
(computer screens and desktop printers vary quite considerably). 

MAGIX Page & Layout Designer 2013 also supports both type of PANTONE color 
system. You can use them as spot or solid colors or use the PANTONE 4-COLOR 
PROCESS library which defines exact mixes of CMYK colors. You can find the 
PANTONE color libraries in the COLOR GALLERY. 

PANTONE COLOR BRIDGE 
These colors are listed in the gallery under PANTONE® COLOR BRIDGE™ Coated and 
PANTONE® COLOR BRIDGE™ Uncoated. Using these PANTONE solid colors will 
create spot colors. See Imagesetting (on page 293) for more information on spot 
colors. 

If you have a PANTONE color swatch you can pick a required PANTONE color for 
your design and specify it with a color from this section of the COLOR Gallery. 

When sending the artwork to your print company, an additional plate will be created 
for each PANTONE color that you choose. The company will then print the normal 
plates as usual for CMYK colors and will print spot plates using the specified 
PANTONE inks. As the print company will use the exact PANTONE number you 
specified you can be assured of the color appearing exactly as expected. This is 
particularly useful for corporate logos where the color needs to be exactly the same 
whenever you produce company literature, stationery etc. 

PANTONE colors are displayed on screen using an approximation of CMYK colors, 
and if you print to a home printer then the color will be converted for printing. But any 
conversions are approximations; the only way to accurately see a PANTONE color is 
to look at a printed color swatch which you can purchase from PANTONE or one of its 
resellers, or to see a wet proof from the print company. 

Technical note: To convert a PANTONE COLOR BRIDGE color to the equivalent 
process color, select the color in the color editor then change the color type to 
normal color. Note that normal (CMYK) colors cannot accurately reproduce some 
PANTONE colors which may show significant color shifts from the true color. 

PANTONE 4-COLOR PROCESS 
These colors are listed in the gallery under PANTONE® 4-COLOR PROCESS Coated 
and PANTONE® 4-COLOR PROCESS Uncoated. 

These PANTONE colors are pre-defined CMYK colors. If you have a PANTONE 4-
COLOR PROCESS swatch you can pick a required PANTONE color for your design 
and specify it with a color from these sections of the COLOR Gallery. MAGIX Page & 
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Layout Designer 2013 will then create the color with the exact CMYK colors specified 
by the PANTONE system and not adjust it in any way when printing. 

This option is cheaper than using the PANTONE COLOR BRIDGE as no additional 
plates are required, and the print company does not need a special ink — all colors are 
created using the normal CMYK color process. But you will not be able to achieve 
some of the colors available through PANTONE COLOR BRIDGE 

Using a PANTONE color 
To use a color from a library either: 

• Just drag & drop the color from the COLOR Gallery onto the object to which you 
wish to apply the color (for other ways of applying colors from the COLOR Gallery, 
see Color handling (on page 159)). 

• Or in the COLOR Gallery, drag the color you want to use from the library section 
up to the section for your current document. This lets you copy several colors in 
one operation. (See Galleries (on page 64) for details of selecting items in a 
gallery.) 

This copies the library color into the document and displays it on the color line. 

You cannot delete, rename or redefine colors in the color libraries. However, you can 
change copies of colors used in your document.  

Note: Altering a PANTONE COLOR BRIDGE color will cause it to become a process 
(CMYK) color. 

Important notes when using PANTONE colors 
PANTONE colors (and CYMK colors in general) are useful for reproducing a known 
color. There is no other reason to use CMYK or PANTONE colors, and for all normal 
use we recommend using HSV or RGB colors. 

If you use any of the MAGIX Page & Layout Designer 2013 transparency effects on or 
over any CMYK or PANTONE color, the color will be modified by the transparency 
process (which mixes any transparent colors with those underneath the object) and 
will not produce the expected PANTONE color. This is an unavoidable consequence 
of the way transparency works. 

So a simple rule if you require a PANTONE COLOR BRIDGE color or a specific CMYK 
color value (and that includes the use of pure K shades of gray) is to not use 
transparency, feathering, soft shadows, bevels or Live Effects on or over these objects. 
Doing so will result in that object or portion of the object being processed as RGB 
colors and so will result in color shifts. 
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Viewing print colors on screen 
There is a huge difference between screen and printed colors. Computer monitor 
screens can reproduce a much wider, much brighter range of colors. Printers use 
CMYK inks instead of RGB colors, and so the method of reproducing color is entirely 
different.  As an example, pure bright RGB green on screen is completely impossible 
to reproduce on any printer. 

Technically speaking the screen color gamut is much larger than available on printers. 
MAGIX Page & Layout Designer 2013 provides a simple way to simulate the printer 
colors, which adjusts all on-screen colors to more closely match that of a typical 
printer. Select WINDOW -> SHOW PRINTER COLORS -> SIMULATE PRINT COLORS to adjust 
the screen colors.  

Note: This does not alter the actual RGB or CMYK color values, it just adjusts the 
screen color gamut to more closely match that of your printer. 

Note: Some Adobe software, such as Photoshop and Illustrator, handles printer 
colors very differently. They only support one color model at a one time and will 
convert all colors to the current color model. e.g. when operating in CMYK mode, all 
RGB colors are converted to CMYK colors. They also show all CMYK colors as 
"printer simulated". MAGIX Page & Layout Designer 2013, on the other hand, 
supports mixed color models (you can use CMYK and RGB color in the same 
document) and does not alter the actual color value. 
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Text Handling 

The Text Tool 
Use the TEXT Tool ("F8") to enter or edit text. 

 

Text Tool InfoBar Left Side 

 Font 

 Font Size 

 Style 

 Bold 

 Italic 

 Underlined 
 

 

Text Tool InfoBar Right Side 

 Justify 

 Subscript/Superscript 

 Line Spacing 

 Bulleted Lists 

 Numbered Lists 

 Outdent 

 Indent 

 Spell Checker 
 

 

Text Tool InfoBar flyout 
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 Space before paragraph 

 Space after paragraph 

 Baseline shift 

 Tracking 

 Aspect ratio 
 

MAGIX Page & Layout Designer 2013 supports three basic type of text objects 

• Simple text lines: Click on the page, and type. 
• Text columns: Click and drag to create a column, and type. 
• Text areas: Click and drag diagonally to create a rectangular area, and type. 

After you’ve created any text object you can transform it (rotate, scale, skew) and can 
apply all the normal attributes, fill color, transparency, feather etc, using the normal 
tools. You can also attach it to a curve. The text will remain editable. 



 

180   

www.xara.com 

The Font Menu 

 

The font menu lists all installed fonts, and is split into three sections. The top section 
displays those fonts that are currently used in the document. The second section 
shows the “web safe” fonts. These are the fonts you can safely use in web pages, 
because all commonly used web browsers will support these fonts. See Web Safe 
Fonts section. The final section displays an alphabetical list of all other installed fonts. 
Each font name is displayed in the menu using its own typeface, making font selection 
easier. 

Those fonts for which multiple font styles are available are shown with small black 
triangles against them on the right hand side of the menu. Simply hold the mouse 
pointer over such a font name for a second or two and a small sub-menu appears to 
the right of the main menu, listing the available variant of that font. While this sub-
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menu is displayed, you can move the mouse pointer over it to select the desired font 
variant. 

Instant font menu navigation 
While the font menu is displayed, you can type the initial characters of the font name, 
and the menu will be scrolled to that section of the list. E.g. if you type "ver" it will 
instantly scroll and locate the Verdana font. 

Bold, Italic & Synthesized fonts 
MAGIX Page & Layout Designer 2013 does not allow you to apply italic or bold to text 
if the necessary italic/bold font is not installed. Page & Layout Designer 3.2 and 
earlier versions would allow this and would artificially synthesize an italic or bold 
appearance as required. The results produced by doing this were generally poor 
quality. Besides this, you would encounter problems if later trying to export your 
design to PDF, since other applications would either not synthesize the bold/italic 
appearance or produce even worse results. 

Simple text 
If you wish to type a small amount of simple text, position the pointer where you want 
to enter text and click. A red cursor appears where you clicked and you can now start 
typing on the keyboard. 

If you make a mistake, use "Delete" and "Backspace" in the usual way. 

Pressing "Enter" completes the line and starts a new line of text below it. The inter-
line spacing is controlled by the line spacing text box on the InfoBar. 

Simple text is not suitable for large paragraphs of text because there is no automatic 
line wrapping (because the width is unlimited). Use a Text Column or Text Area 
instead (see below). 

By default text has no outline color. "Shift + clicking" on a color on the Color Line will 
give the selected text an outline color - the thickness of which can be controlled by 
the line width control, as usual. You will probably want to set the Line join type (on 
page 95) to be rounded to give it a more smooth appearance (control at the top of the 
LINE GALLERY).  

Line width is described in Changing the line width (thickness) (on page 92). 
Applying color is described in Color handling (on page 159). 

You can continue to enter text even after rotation, color filling or placing it on a curve. 
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Text in a column 
If you are entering larger amounts of text, over multiple lines, using a column is more 
useful. Changing the width of the column will automatically re-flow the text. 

To type a column of text: 

1. Select the TEXT TOOL. 
2. Move the mouse pointer where you want the column to start. 
3. Drag right to create a horizontal line the width of the column. This red line just 

shows you the width of the column. It is never exported or printed. 
4. Type in the text. You don't need to press "Enter" at the end of a line. When the 

text reaches the edge of the column, it automatically flows onto a new line. 

NOTE: If you click away or change tools before you start typing, the text column will 
be removed and nothing left on the page. Therefore always start typing after you’ve 
dragged the column width line. 

Instead of typing in the text you can create the text in a separate text editor or word 
processor, copy it to the clipboard and paste it into MAGIX Page & Layout Designer 
2013. Copy and paste supports RTF-formatted text. 

Words only split across lines if they contain a hyphen character (minus key) 

 

The effect of typing a hyphen into "running" 

If you type "Ctrl + -" (minus key) it inserts a soft hyphen which is a hyphen that only 
appears if the word can wrap at the end of a line. This is particularly useful for narrow 
columns of text, to avoid rivers of white, you might need to hyphenate some words. 
Inserting a normal dash character will split the word at the end of the line. It's called a 
'soft' hyphen because when the word appears in the middle of a line the hyphen 
vanishes (unlike a normal dash or minus character), so it intelligently hyphenates the 
words only if it needs to. 

When editing the text a soft hyphen is treated as an invisible character (it takes no 
space), but you can tell it's in the text by moving the cursor left/right over where the 
invisible character is. 

A hard hyphen can be inserted by typing "Ctrl + Shift + -" (minus key). A hard hyphen 
is one that will not cause a wrap at all. This is useful in situations where you have 
dashes in words that you do not want split at the end of lines. 
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Changing the width of the column 
Drag either of the two red handles at the ends of the line. 

Changing the angle of the column 
"+ drag" either of the red handles at the end of the line to change the angle of the 
column. Alternatively, "Ctrl + drag" to restrain the line to the constrain angles. Or 
alternatively you can use the SELECTOR TOOL to rotate the object in the usual way. 

For more on constrain angles, see Introduction to MAGIX Page & Layout Designer 
2013 (on page 63). 

Text areas 
In the TEXT TOOL if you click and drag diagonally on the page you will create a 
rectangular text area. The blinking cursor will be positioned in the top left corner and 
you can type or paste text. 

A text area can contain a "flowing" text story. This is where a single piece of text flows 
from one text area to another. It’s called flowing text because, like water, as you add 
or remove text in one area it overflows into connected text areas or flows back from 
text areas. 

If the text overflows the bottom of the text area the overflowing text is shown gray, 
although you can continue to edit this text as usual. 

Connecting text areas—text flow 
When text overflows the bottom of the text area, an overflow indicator is shown on 
the bottom of the area. If you drag this over any other text area, the overflow text will 
flow into the new text area, and the two areas become connected. This is shown with 
a flow arrow. 

 

Dragging the overflow indicator from 
one text area to another will connect 
the two areas so text flows from one to 
another. You can link as many together 
as you require. 
 

There is a quick way to create flowing text. If the text cursor in an area with 
overflowing text, then just click-drag on the page to create a new text area. The new 
text area is automatically connected and text will flow into the new area. 
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Tip: You can flow text from one area to another on any page, even earlier pages. If 
you need to flow into an area many pages away, it’s probably easier to use the above 
method, although if you zoom out to a small page size you can drag the overflow 
arrow across pages. 

To disconnect one text area from another, just drag on the overflow indicator and 
drop it away from any text area. 

If you delete a text area that is connected to another only the area is deleted, the text 
will simply re-flow into the remaining text areas. 

Resizing text areas 
Using the TEXT TOOL, you can click and drag on any of the corner control handles. The 
text in the area will be reformatted to fit the new size. 

Alternatively you can use the SELECTOR TOOL to resize the text object, but in this case 
the behavior is different. If you resize a text object using the SELECTOR TOOL, the text 
itself changes size. This is consistent with the normal operation of the SELECTOR TOOL. 

However in the case of flowing text areas this would cause undesired side-effects; 
you almost certainly do not want part of a flowing text story to be a different point 
size than the rest. Therefore, the SELECTOR TOOL behavior varies depending on 
whether you are resizing one text area that contains a flowing text story, or resizing 
the whole text story. The rule is: 

• If you resize a single unconnected text area (or simple text or text column) then 
the area "container" and text content are resized together. 

• If you select the text areas of the whole flowing text story (they have to be on a 
single page) then a resize will resize the text and areas together. 

• But if you resize a text area that is part of a flowing series of text areas, then only 
the container size is altered and the text inside remains the original size, and will 
be re-formatted to fit the new size. This is like resizing a text area with the TEXT 
Tool. 

If you want to resize all text in a text story, select it all with "Ctrl + A", and apply the 
required font size. 

You can rotate a text area, using the SELECTOR TOOL as normal, and the text will flow 
through the rotated text area normally. 
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Text flow is unaffected if you rotate any of the text areas 

Hold down "Ctrl" while rotating to constrain the text rotation angle to 90° angles and 
screen aligned angles. 

Word count 
The word and character count total of the current text is shown in the status line. This 
also shows the number of overflowing words. If any region of text is selected, it shows 
the count of this selection instead. 

Text along a curve 
To place text along a curve of your choice: 

1. Create either basic text, text in a 
column or a text area (see above). 

2. Select your text object and one curve. 
3. Choose "ARRANGE" > "FIT TEXT TO 

CURVE". 

Alternatively, select a curve or line and then in the TEXT TOOL, click on the line, where 
you want the text to start, and type. This automatically fits the text along the line. 
When you reach the end of the line the text will wrap onto a new line, immediately 
below the start of the previous one. 

If you do not want the text to wrap to a new line, "Shift + click" on the line. 

To hide the curve so it’s not visible, select the SHAPE EDITOR TOOL and set the line 
color to NO COLOR or a width of NONE. You can also edit the curve as usual this way. 

Applying color is described in Color handling (on page 159). 
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Adjusting the left and right margin of text on a curve 
If you just start typing or place a column of text on a curve, you can change the start 
and end position of the red handles. Just drag them along the curve as required.  If you 
center text it will be between these two margins. 

Swapping sides of the line 
Right click on the text and select the REVERSE TEXT ON CURVE menu option. 

Alternatively, if you reverse the direction of the line (SHAPE EDITOR TOOL, REVERSE 
PATHS button on the InfoBar), then the text will move to the other side of the line or, 
in the case of a closed shape, move from the inside to the outside of the shape. 

Editing text 
Double clicking on a text object in any tool takes you into the TEXT TOOL and places 
the cursor at the click position in the text. 

All the normal word processor-style cursor and mouse operations can be used. For 
example: 

• Click where you want to place the cursor. 
• Use the left and right arrow keys to move left, right, up or down. 
• Use "Ctrl + left and right arrow keys" to move left or right one word. 
• Press "Home" or "End" to move to the start or end of the line. 
• Press "Ctrl + Home", or "Ctrl + End" to move to the start or end of the text object. 

Text selection: 

• "Shift + any" of the above keys to select text 
• Double click to select a word 
• Triple click selects a whole line of text, or "Ctrl + L" 
• Quadruple (4x) click selects a paragraph of text 
• Or just drag across the text in the Text Tool to select the text 
• "Ctrl + A" will select all the text in the text object (you must be in the TEXT TOOL.) 

If you have a text selection any attribute change will apply only to the selected region 
of text. If you have only the cursor in the text, then any attribute change, say selecting 
a new color, will only appear when you type new text. 

Selecting the whole text object 
There is a quick shortcut for selecting the whole text object. Instead of using "Ctrl + 
A" or dragging across all the text, simply press the "ESC" key. This removes the cursor 
but selects the whole text (the status line will confirm 1 text object). This makes it 
easy to apply an effect or attribute to the whole text story. 
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For example, to change the font size of the whole text object, just press "ESC" and 
select the new size from the InfoBar. 

Swap case 
Pressing "Ctrl + W" will swap the case of the character after the cursor and move the 
cursor on. So, if you've accidentally typed a section of text with the caps lock key on, 
just place the cursor at the start and press and hold "Ctrl + W".  

You can swap the case of a selected region of text, the same way. The cursor will not 
be moved. 

Smart Quotes 
When you type quote ' or double quote " characters, MAGIX Page & Layout Designer 
2013 will automatically convert these into the more appropriate and aesthetically 
accurate opening or closing quotes. So this changes 'this' into ‘this’ and "quotes" into 
“quotes”. It's smart enough to understand the use of single quotes within words to 
signify missing characters, so that 'don't' becomes ‘don’t’. 

Entering special characters 
There are a number of useful shortcuts to allow insertion of special characters, like © 
or ™. See Special characters (in Text Tool) (on page 383) section in "Menus and 
keyboard shortcuts". 

All these shortcuts (with the exception of the hard space) are compatible with 
Microsoft Word. 

Entering dummy text ('Lorem Ipsum') 
You can insert a paragraph of dummy "Lorem ipsum" text by typing "Ctrl + Shift + L" 
("L" for Lorem) while using the TEXT TOOL. To insert a larger block of text, just press 
the key combination a few times. 

Spell checker 

 
The TEXT TOOL includes a spell checker. To turn it on, select the SPELL CHECKER 
icon on the TEXT TOOL infobar, which opens a menu.  

 

Select “CHECK SPELLING AS YOU TYPE”. Now all 
unrecognized words in your document and as 
you type are shown with a red dashed underline. 

To correct a misspelled word, right click on it 
and the context menu shows you suggested 
correct spellings of the word at the top of the 
menu. Simply select one of the suggestions to  
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replace the word. 
 

Language selection 
The menu shown when you click on the Spell Checker icon on the infobar lists all the 
languages for which you have dictionaries installed. By default the language 
corresponding to the current locale setting is selected.  

To change the language associated with a text object, select the text object, then in 
the TEXT TOOL choose the required language from the Spell Checker menu. Now the 
text object will be checked against the dictionary for the language you chose.  

If you want to enter many text objects using  a language other than the default, you 
can change the current language text attribute so that you don’t have to change the 
language on every text object individually. To do this, make sure you have nothing 
selected (click an empty area of your design using the SELECTOR TOOL). Then in the 
TEXT TOOL, choose the language you want to make current using the Spell Checker 
menu. You will be asked if you want to set the current language text attribute. Click 
“Set” to confirm. Now each new text object you create will be associated with the 
chosen language. Note that this current attribute is not re-loaded when you save and 
load your design.  

If you have a text object which you don’t want to be spell checked at all, select the 
object and choose the “No language (ignore)” option from the Spell Checker menu. 

User dictionary 
Words that you use regularly which are not in the dictionary provided with MAGIX 
Page & Layout Designer 2013 can be added to your own personal dictionary. Right 
click on the word and choose “ADD TO USER DICTIONARY”. Now the word is no longer 
shown as being misspelled. The user dictionary applies to all documents that you use 
on your computer and it applies to all languages. 

Find & Replace 
The Find & Replace function performs live search so that as you type the search string 
the text is searched and highlighted in real-time. 

To search for some text select the menu "EDIT" > "FIND/REPLACE..." or "Ctrl + Alt + F" 
and the following dialog is displayed: 
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Enter the search string and it's shown highlighted in the text. You can choose to 
search just the current text story, page or the whole document (all text flows on all 
pages). 

The WHOLE WORD option will only search for whole words that match the search 
string. E.G. searching for 'met' will not find 'metro'.  The CASE SENSITIVE option will 
match only the exact case. E.g., with this option on, searching for 'aBc' will not find 
'abc'. 

Synchronising text across multiple text objects 
Sometimes you may want the same text to appear in multiple text objects and for 
those objects to always have the same text, so that if one is edited they are all 
updated. You can achieve this using LIVE COPIES if the only difference between the 
text objects is in the way they are transformed (ie. only their position, scale, rotation 
or skew needs to differ). See LIVE COPIES in the Object Handling chapter for details. In 
some circumstances you can also use SOFT GROUPS to achieve text synchronization. 
See the SOFT GROUPS (on page 123) section of the Object Handling chapter for details. 

Tabs, Margins and Indents 
Rulers 
To adjust tabs, margins and indents you need to turn on rulers in your document. 

To do this: 

• Choose "WINDOWS" > "SHOW RULERS" or right click a page and choose "SHOW 
GRID/GUIDES" > "SHOW RULERS". 

• Or press "Ctrl +  + R". 
• Or press "Ctrl + L" (when not in the TEXT TOOL). 
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The enhanced text features will only appear on the ruler when you are using the TEXT 
TOOL and when the text cursor is in a text story or the text object is selected when in 
the TEXT TOOL. 

In the TEXT TOOL when you drag the margins or tabs on the ruler, you get a temporary 
vertical guide to make it easier to align the tabs or margins to objects elsewhere on 
the page. In addition when dragging tabs or margins, if you have magnetic snap 
switched on, these will snap to each other making it easier to position tabs and 
margins. 

Margins and indents 
Any changes you make are made to the current paragraph of text. (i.e. the paragraph 
containing the text cursor) or, if you have a selected region of text,  to the paragraphs 
of the selected region. 

You can apply changes to all text in a text story by selecting all the text within that 
story ("Ctrl + A"). To change more than one text story, select the text objects while in 
the SELECTOR TOOL then change to the TEXT TOOL and make the required changes. 

 Left margin. Drag this to change the left margin of the text. 

 First line margin. Drag this to change the left margin for the first line of the 
paragraph (useful for lists, as shown below). 

 Right margin. Drag this to change the right margin of the text. 

 

 

Demonstrating the left margin and first line margin  

Demonstrating a right margin 
 

Tabs 
By default, text stories are created with tabs set 0.5 cm apart. This means you can 
just press "Tab" and your text will be moved along to the next tab stop. You only need 
to define new tab stop positions if you want alternative tab spacing. 

These default tabs are shown as faint Ls on the ruler: 
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Standard tabs, indicated by faint "L"s 

Custom tabs 
To create a custom tab position, just click on the ruler where you wish to place the 
new tab. It will replace default tabs up to that point on the ruler. 

For example: 

 The triangle indicates a custom 
tab 

• To set more than one tab click multiple times on the ruler. 
• To move a custom tab drag it along the ruler. 
• To remove a tab drag it off of the ruler (default tabs will come back). 

Custom tab types 
You can set different types of custom tab. By default, custom tabs are left align tabs. 
This means that text will be aligned with the tab on the left of the text. 

To change the tab type, click the tab icon on the ruler. 
The following custom tab types are available. You are not 
limited to just one type in a story, and can choose a different 
type then set additional tabs. 

 

 Left align: The text will be aligned with the tab to the left. 

 

 

 Right align: The text will be aligned with the tab to the right. 
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 Center align: The text will be centered on the tab. 

 

 

 Decimal point align: The decimal points in the text will be aligned with the tab. 
This is useful for lists and, however long the number, the decimal points (periods) 
will be tab-aligned. 

 

 
 

How to creating hanging indents 
Hanging Indents, as they are known, are where the first line of a paragraph has a 
negative margin or a margin that hangs to the left of the normal left margin. 
Numbered or bulleted lists are examples of hanging indents. 

To create hanging indents: 

1. Drag the left margin inwards. 
2. Click on the ruler away from the left margin (creates a new tab stop) and drag 

this tab stop to be exactly over the left margin. 
3. Now each line will start outdented—you can insert any special character or 

number and press "Tab" to move to the left margin. And (as with this 
paragraph) all subsequent lines of text are indented to the left margin. 

Repelling text objects 
You can make any object in MAGIX Page & Layout Designer 2013 repel text so that 
text underneath it automatically flows around the object, instead of appearing 
underneath it. This makes it easy to lay out pages containing long passages of text 
combined with photos and graphics. Once you've set them to repel, you can adjust 
the positions of your graphics and photos and the text will automatically adjust and 
reflow around them. 

You can also choose to only repel text within a layer, which stops objects within a 
layer from repelling text on other layers and also stops text on the layer being repelled 
by objects on higher layers.  
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Making an object repel 
To make an object repel text, right click it and select the REPEL TEXT UNDER option. 
Any text in the same layer underneath the object will be repelled with a default 
margin of 5 pixels between the text and object. Note that repelling text objects only 
repel text that is underneath the objects, not any text that is on top. 

Alternatively right click on the object and select REPELLING & ANCHORING to display 
the Text repelling & anchoring dialog. 

 

Click the REPEL TEXT AROUND THIS GRAPHIC checkbox. 

If desired, set a repel margin for the object to set the space between the text and the 
object. If you want a different height and width for the repel margin, click the padlock 
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symbol and enter the margin height in the H (horizontal) box and width in the V 
(vertical) box. Click OK. 

To turn off repelling right click the object and choose the REPEL TEXT UNDER option 
again to deselect it. Or right click and select REPELLING & ANCHORING to display the 
Text repelling & anchoring dialog again. Click the REPEL TEXT AROUND THIS GRAPHIC 
checkbox to deselect it and click OK. 

Note that single lines of text do not respond to repelling objects, only text areas and 
text columns do. 

To only repel text within the same layer as the repelling object, see Layer Properties 
(on page 155). 

Anchored Graphics 
You can position any graphic, or group, so it's tied (anchored) to a position in some 
text, so that as the text moves because of editing, the graphic object will move to 
remain at the same relative position. However anchoring should only normally be 
used for objects that sit outside the margins of the text (eg. A photo sitting to the 
right or left of a text column), or behind the text. Use Embedding for objects that sit 
within the text bounds (see below). 

1. The quickest way to anchor a graphic or group is to right click it and choose 
the ANCHOR TO TEXT option. However, if you also want to edit anchoring 
properties, you can right click on the object and select REPELLING & ANCHORING 
to display the Text repelling & anchoring dialog.  

2. Click the MOVE GRAPHIC WITH TEXT checkbox.  
3. By default MOVE VERTICALLY ONLY is also selected, so that your anchored 

graphic will only move vertically as the text is edited. This is usually the most 
useful option – if you want the object to track the anchor position horizontally 
as well, embedding the object is usually a better option. 

4. An anchor symbol appears in the top left of the object, indicating it's now 
anchored.  

5. Using either the SELECTOR TOOL or TEXT TOOL, click and drag the anchor 
symbol so that a red arrow appears.  

6. Move the arrow head and drop it in the location in the text where you would 
like the object anchored. A red caret (inverted 'T' mark) indicates the anchor 
position.  

7. As you edit the text around this caret mark, the anchor point and anchored 
object moves with the text.  
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An anchored object displays an anchor symbol and an arrow pointing to the anchor point, shown 
as a red caret mark.These disappear as you type, unless you're close to the anchor point. 

Note: If you drag the anchoring arrow to a place on the page where there is no text, 
the arrow turns into a red anchor that indicates the object's anchoring properties will 
be lost if it's dropped here. This also happens when the arrow is dropped on the 
object itself. 

However note that the anchored object will not move outside the area of the page as 
a result of the anchor point moving. The anchored object will only move up to the 
edge of the page.  

 

This is an example column of text with various graphic elements hanging to the left. Each of 
these is anchored to the start of a line of text immediately to its right. 



 

196   

www.xara.com 

It's possible to anchor any graphic object or group, including groups containing text, 
such as the example side-panel, shown above. 

It's also possible to anchor objects to appear on top of, or below the text. The example 
pale blue flower graphic, shown above, is anchored this way and will flow with the 
text. 

NOTE: If an anchored object is also set to repel, only the text that the object is 
anchored to is repelled.  

NOTE: Repelling is restricted for repeating objects: Text inside a repeating group is 
only repelled by repelling objects inside the repeating group.  Individual repelling 
objects inside a repeating group only repel text that is also inside the repeating 
group. Repeating groups as a whole can repel any text stacked below on the page. 

Moving Anchored Objects 
As new text is added or deleted, the object moves as the text flows, but will always 
maintain its new position relative to the anchor point. You can move an anchored 
graphic by dragging on it as usual. This changes its position relative to the anchor 
point, but does not move the anchor point, which remains visible at the end of the 
anchor symbol arrow as you click/move the graphic.   

If you want to move the anchor point to another location within the text, click and 
drag on the anchor symbol again to create a new arrow and drag it to the new 
location. 

If you cut and paste the text containing the caret mark, the anchored object is also cut 
and pasted. 

Viewing the anchor point 
The anchor point of an anchored object is only visible if you click the anchored object 
in the SELECTOR TOOL or click in the surrounding text area in the TEXT TOOL.  

When you click in a region of text with the TEXT TOOL, it shows any anchors points 
within an inverted 'T' symbol, and also draws an arrow from the anchor point to the 
anchor symbol in the top left of each anchored object. So the easiest way to see all 
the anchor points for any text is to click in it with the TEXT TOOL. 

However, when you start to edit the text, the red caret, arrow and anchored symbol 
temporarily disappear until you stop typing. If you are close to the anchor point, Page 
& Layout Designer displays the caret mark, along with an arrow pointing to the anchor 
symbol, to let you know when you're close.  
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Removing an anchor 
To remove an anchor from an object, right click it and choose ANCHOR TO TEXT again 
to disable the option. Now when you click the object in the SELECTOR TOOL or in the 
text in the TEXT TOOL, the anchor symbol is no longer displayed. 

Embedding Graphics 
You can insert any object into text so that it behaves just like a character in the text. 
Simply copy the object to the clipboard (Ctrl+C), go into the Text Tool and position 
the text caret where you want to insert the object, then paste (Ctrl+V).  

 

You can select, copy, paste and delete the embedded object along with the text 
around it, just as if it was a character in the text. However you can also still select it 
and transform it directly using the Selector Tool. 

Use this embedding technique in preference to Anchoring where you can, because it 
is more efficient in terms of the processing required to format the text. 

Applying text attributes 
Changing the font size 

 
There are several ways to change the font size: 

• Type a new value into the size text box on the InfoBar and press . 
• Or select from the FONT SIZE drop-down list on the InfoBar. 
• Or use the Font size pop-up slider. 
• Or manually increase/decrease font size with the "Ctrl + Shift + >" and "Ctrl + 

Shift + <" keyboard shortcuts. This applies only if all selected text parts are of the 
same font size. 

• Or use the SELECTOR TOOL to scale the whole text object. 
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Condensing and expanding characters (aspect ratio) 
The aspect ratio is the ratio between the height and width of the text. Ratios over 
100% make the text wider than normal; under 100% make the text narrower. 

To change the aspect ratio: 

 
Type a new value into the ASPECT text box on the InfoBar and press "". 

Or use the SELECTOR Tool to stretch or squash the complete line of text. 

It is not recommended to use values below 80% or above 130%. Better to use a 
special condensed variant of the font family if available. Alternatively use the tracking 
control to adjust the spacing without distorting the actual shapes of the characters. 

Bold & Italic 

 
Click the BOLD or ITALIC button on the InfoBar ("Ctrl + B" or "Ctrl + I") 

This applies the bold or italic variant of the current font. 

Attention: MAGIX Page & Layout Designer 2013 does not allow you to apply italic 
or bold to text if the necessary italic/bold font is not installed. However you can 
easily emulate the same effect. To embolden a font, just give it a small line width 
and apply a line color. To slant a font, use the skew / slant feature of the SELECTOR 
TOOL. Read more in the "Font menu" section (on page 181) 

Text Underlining 

 
Click the underline button on the InfoBar to apply an underline to the selected 
text. 

The underline color and size is automatically derived from the text color and size. 

Justification or text alignment 
Justification always applies to the complete line. Any selected region is ignored. 

 

 LEFT justification: Align the left-hand edge of the text to the initial click position. 

 CENTER justification: Centers the text around the click position. 

 RIGHT justification: Align the right-hand edge of the text to the initial click 
position. 

 FULL justification: This only applies when text is along a curve or in a column and 
when there is at least one full line of text to justify. 
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When using simple text the initial click position on the page is taken as the origin for 
text justification. 

Subscript & superscript 

 
Click the appropriate button on the InfoBar. 

Normal text   subscript   superscript 
 

Bulleted Lists 

 
You can turn any text into a bulleted list by selecting the text and then 
selecting the bulleted list button on the infobar. 

Each paragraph of text becomes a separate bullet. If you press return to finish a line at 
the end of one bullet point, the next line starts with a bullet point too.  

To finish entering a bulleted list, hit return on the end of the last bullet and then 
immediately hit return again on the new bulleted line. This removes the last empty 
bulleted line and allows you to start entering normal text again. 

 
You can nest bulleted lists by pressing the indent button on the infobar. This 
indents the current bulleted line and changes the bullet character to a different 
style, to distinguish it from the parent bullet. 

 

Example of a nested bulleted list 

 
To move a bullet point from a sub-list into its parent bulleted list, simply place 
the text cursor in it and press the outdent button. 

So it’s easy to make and edit arrangements of nested bulleted lists using the indent 
and outdent buttons. 

Numbered lists 

 
You can create and edit numbered lists in just the same way as described for 
bulleted lists above, using the numbered list button.  
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You can also choose the numbering scheme to be used for each list, using the LIST 
PROPERTIES dialog. Place the text cursor in one of the numbered list points, press the 
right mouse button and choose ‘LIST PROPERTIES…" from the context menu. 

 

In the dialog you can choose from a variety of numbering schemes and also enter the 
value that should be used for the very first entry in the list. Then the number is 
automatically incremented for the second and subsequent entries in the list. 

Graphical Bulleted and Numbered Lists 
You can use any graphic for the bullet or number in a list. You can design your own 
bullets and numbered lists by using any of the normal drawing or text tools, or use 
one of the many bullet designs from the Designs Gallery (under  PAGE ELEMENTS > 
GRAPHIC  ELEMENTS > BULLETS). Create a simple circle using the Ellipse Tool for 
example, give it a fill and a drop shadow, and copy it to the clipboard. Then highlight 
the list you want to apply the style to using the Text Tool. Right click the list and 
choose Paste as list bullet from the menu. The design will now appear as a bullet for 
each of the list items.  

 

For a numbered list it's exactly the same procedure except you group a text item with 
your graphic and then select Paste as list number to replace all the numbers or text 
items in your list. The text object in the group is used to show the number. 

Line spacing 

 

Line spacing allows you to change the space between two lines 
(so affects vertical spacing). 
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Line spacing is measured in percentages (120%) or points (12pt). You can either type 
the line space value in the text box or click the arrows to nudge the values. 

A percentage setting has the benefit of scaling accordingly if you change your font 
size. If a percentage is applied to a line of text with more than one font size, the 
largest font size is used. For example, if a line contains 90% and 100% text, the line 
spacing is calculated on 100%. 

Tracking 
Whereas kerning (see below) changes the spacing between two characters, tracking 
changes the spacing equally within a region of text. An EM is the width of the capital 
letter "M" in the current font and font size. It is therefore relative to the font size and 
not a fixed value. 

 

1. Select the region to which you want to apply tracking. 
2. Type a value into the TRACKING text box (values are in 

1/1000ths of ems). 

From the keyboard you can increase or decrease the tracking by pressing "Alt + Right 
arrow", or "Alt + Left arrow". Each key press changes the tracking by 10/1000. 

Kerning 

 

Kerning lets you alter the space between two characters (so 
affects horizontal spacing). 

Most good fonts have auto-kerning which means they already move appropriate pairs 
of characters together slightly, as you can see from this diagram: 

 

Auto-kerning off  Auto-kerning on  Manual kerning 

Kerning is measured in "ems" (enter values in 1/1000ths of "ems".) You can either 
type the kerning value in the text box, or click the arrows to nudge the values. 

It shares the same key shortcuts as above. If there is just a cursor, it alters the kerning, 
but if there’s a selected range of text, then it alters the tracking. Each key press alters 
it by 10/1000ths of a em. 

Baseline shift 

 

Baseline shift allows you to move part of a line up or down. 
Positive values move the text upwards, negative downwards. 

The baseline is the imaginary line at the bottom of characters. 
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Select the characters for which you wish to change the baseline shift then enter a 
value in the BASELINE SHIFT text box. 

 

The effect of selecting AG and then applying a downwards baseline shift (i.e. -5pt). 

Baseline shift is measured in points but you can use any of Page & Layout Designer’s 
standard measurement units. Note that baseline shift is an absolute value, in points, 
and does not change if you change the font size. 

Paragraph Spacing 

 
The last two fields on the end of the TEXT TOOL InfoBar allow you to 
set the spacing above and/or below paragraphs.  

This is particularly useful where you want half line spaces between paragraphs. 

Like Microsoft Word, when you use both spacing above and below paragraphs, the 
spacing between paragraphs is whichever is the greater value (it's not 
cumulative). Paragraph spacing above paragraphs will move the first paragraph down 
in a frame of text. 

Advanced text properties 
Right click on a text object and select "ADVANCED TEXT PROPERTIES…" to bring up the 
Advanced text properties dialog. 

 

Here you can turn off auto-kerning on the selected text object if desired. See the 
kerning section above for information on kerning. 

You can also specify that the selected text should be converted to shapes before 
being sent to the printer, which is useful if there are any problems printing with the 
font used.  
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Text Styles 
TEXT STYLES are a powerful way to alter the appearance of text throughout a 
document with a few clicks.  
 
A TEXT STYLE is a named collection of attributes, such as font, size, color, line spacing 
and other text attributes. For example, the main heading at the top of this document 
might have a style called ‘Heading 1’, the smaller sub-heading, such as for this section, 
and all other equivalent section headings, a Style called ‘Heading 2’. 
 
By updating the definition of ‘Heading 2’, say, to be a different font, then every similar 
heading throughout the document will be updated instantly.  
 
Similarly the main text, sometimes called the ‘body text’ of a document is also a 
particular style, which Page & Layout Designer calls the "Normal text" style. By 
updating that style to be, say, 12 point Times New Roman, then all "Normal text" 
throughout the document can be changed in one go, without having to select and 
apply the same font change over and over again. 
 
TEXT STYLES are, therefore, rather like the "Named Colors" feature that Page & Layout 
Designer also supports, where you can update "Theme Color 1" to be a new color and 
all parts of the document using that Named Color take on the new color. 

Text Styles InfoBar 
There is a Styles drop-down menu on the TEXT TOOL INFOBAR, that allows you to 
create Styles, apply them to any text, and to update the definition of the Style. 

 

By default there is a small set of pre-defined Styles, including ‘Normal text’ and three heading 
styles, Heading 1 to Heading 3. 

Paragraph Style and Character Style 
TEXT STYLES comes in two varieties. Paragraph Styles apply to whole paragraphs, and 
are also typically used for headings. It’s not possible to apply a Paragraph Style to a 
smaller section than a paragraph, so you cannot, for example, apply a Paragraph Style 
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to a single word within a paragraph. If you try, then the whole surrounding paragraph 
will take on this Style. 

Just place the text cursor anywhere on the line and select a Paragraph Style from the 
Style menu, and the whole paragraph will take on that Style. 

Character Styles, on the other hand, can be applied to any selection of text, from a 
single character upwards. For example, if you wanted to highlight certain words in 
your text in a different color a Character Style would be ideal. The advantage is that 
you can then change the color (or font, etc) of all these highlighted words with a 
single Style update. 

Paragraph styles can define all text attributes except for bulleted/numbered list 
properties. Character styles can only define text attributes that can be applied to 
individual characters, such as text color, font size, font weight, etc. 

Updating Text Styles 
To update a Style definition: 

1.  Select some text already in the style you want to update. 
2.  Apply whatever changes you require, say an alternative font, or font size. 
3.  Select "Update style" from the Style drop-down menu on the Text InfoBar. 

For example to change all the "Normal text" to be a different font, select a few words 
in the "Normal text" Style, change the font (and any other attribute) and then Select 
"Update Style" "Normal text" from the Style Menu on the TextTool InfoBar 
 

Note: When you update a style based on a selection of text, the updated style is re-
applied to the selection. So if you select just a few characters of a Heading 1, say, 
and make it a new color, then do an Update Style ‘Heading 1’, the whole paragraph 
will take on this new color (because it’s a paragraph style and can only apply to 
whole paragraphs). 

Styles based on other styles 
In Page & Layout Designer, you can base one style upon another. For example, if you 
wanted another variant of Heading 2 style, that was identical in every respect, except 
a different color, then when you create the new style you would make it based on 
"Heading 2" in the CREATE STYLE dialog. This means that if you update "Heading 2" to 
be, for example, a new font or size, your new Style would also take on that new font or 
font size. 

New Character Styles are typically based on the "Underlying Paragraph Style", but just 
with the changes you want. So this means if you have a Character Style that just sets 
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the text color and nothing else, applied to a single word, then when you altered the 
Paragraph Style of the paragraph, this word would change to match, except its color. 

Creating new Styles 
To create a completely new Style, change a selection of text to appear how you want 
and then select the CREATE STYLE menu from the Style list drop-down on the TEXT 
TOOL INFOBAR. 
 
If you want to create a new Paragraph Style it’s recommended that you select and 
apply your changes to a whole paragraph, before selecting the CREATE STYLE menu 
option. 

 

This dialog shows a new style, (NewStyle2) being created that is a PARAGRAPH STYLE, 
based on an existing HEADING 2 style. The NEXT PARAGRAPH option determines what 
style will be used for the subsequent paragraph when typing. The lower section of the 
dialog shows the complete definition of this Style. In this case you can see it’s based 
on Heading 2, with only a color change. 
 
To create a Style that is based on no other Style, that is to say, it inherits no attributes 
from another style, select (No style) from the Based on: option, as below. 
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This dialog shows I am creating a NewStyle2, that is a Paragraph Style and based on 
no other style. The lower section lists all the attributes that make up this Style, so you 
can see I’ve used Palatino font, 12px in size and it has a margin indent. The remaining 
attributes listed here have also been taken from selected text, so this Style consists of 
a complete definition, listing all possible text attributes. 
 
In this case when entering text in this Style, the ‘Next paragraph’ (i.e. when Return is 
pressed) will be in the same style again. 

Deleting Styles - Styles that are not used anywhere in a document are automatically 
deleted when you save and re-load a document. However the default styles (Normal 
text and Heading 1 to 3) are never deleted. 

Removing Styles 
The STYLES list in the STYLES menu includes the entry NO STYLE. Selecting this 
removes the Style (paragraph and/or character Style) from the selection and also 
resets the selected text back to default formatting. 

Style Properties 
If you want to change the definition of a style, such as the style it’s based on, or just 
look at its definition, use the PROPERTIES… option in the style menu. You need to select 
some text that has the style applied before you do this, to indicate the style you want 
to edit. 

The STYLE PROPERTIES dialog appears, which looks the same as the CREATE STYLE 
dialog shown above. 

The style description at the bottom of the dialog describes how the style differs from 
the style on which it is based. So if you want to see all of the style’s attributes, just 
temporarily select NO STYLE from the BASED ON list, to see a full description. Don’t 
forget to reset this to the correct BASED ON style, or click cancel in this dialog, if you 
don’t want to change the style! 

Indents and Outdents 

 
Indent a paragraph of text. 

 
Outdent a paragraph of text. 
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Copying text appearances 
It’s easy to copy the style of any text to any other region of text using the PASTE 
FORMAT/ATTRIBUTES feature: 

• Select the source region from where you want to copy the style. This can be as 
little as a word (just double click). 

• Select "EDIT" > "COPY" ("Ctrl + C"). 
• Select the region of text to which you want to apply the style. 
• Select "EDIT" > "PASTE FORMAT/ATTRIBUTES" ("Ctrl +  + A"). 

If you just have the text cursor positioned in some text when you PASTE 
FORMAT/ATTRIBUTES the paragraph attributes will be pasted to this paragraph. 

If you have a region of text selected, then PASTE FORMAT/ATTRIBUTES will paste all 
the visual attributes of the source text.  

Applying attributes to whole text stories 
When you have the cursor in a simple or column text object, pressing "Esc" will select 
the whole text object. You can then apply an attribute, say a color, and the whole text 
object is altered. This is often quicker than performing "Select all" ("Ctrl + A"). 

With text areas this method only works if all text areas of the story are selected. You 
can do this in the SELECTOR TOOL clicking and "Shift + clicking" on the different text 
areas to select them. But this method is only possible if the text areas are on a single 
page. If your text story flows over several pages and you want to change all the text, 
then it’s necessary to "Select all" ("Ctrl + A"), and then apply the required attributes. 

Copying/Pasting formatted text (RTF) 
You can copy "rich text" (as it's sometimes known) from other applications such as 
word processors or editors and paste into MAGIX Page & Layout Designer 2013 as 
text, and the fonts, margins, line spacing and text links will be preserved. This makes it 
dramatically easier to retain the style and appearance of your text.   

When you paste "Rich Text Format" (RTF) from other applications you are given the 
choice of pasting the text in as "Unformatted text" which means it will appear in the 
font and style at the cursor where you paste, or "Rich Text Format", i.e. it will retain 
the style of the source text. 

This also works the other way around. You can copy text in Page & Layout Designer 
and paste into other applications that support rich text editing and the style (font, 
size, colors, margins etc) will be retained. This will only work if you select and copy a 
single text object or from a single text flow.  
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Some applications, such as Microsoft Word, have a "Paste special" menu option that 
provides a wider range of paste options. These applications will sometimes allow you 
to choose the format of the pasted object (text or graphic). 

Seeing fonts in use 
It is sometimes useful to see what fonts are used in your document, particularly if you 
are sharing files with other Page & Layout Designer users who may not have the same 
fonts installed. 

For a complete list of fonts used in your document choose "FILE" > "DOCUMENT INFO". 

Any fonts that are used in the document but are not currently installed on your 
computer have NOT INSTALLED by them. 

Another way to see which fonts are used in your document is to just open the font 
menu of the TEXT TOOL InfoBar. The top section shows fonts used in your document. 

Changing text into editable shapes 
You may want to convert some text into editable character outlines for further 
manipulation or if you wish to give the document to someone who does not have the 
fonts used in your document. 

To do this: 

1. Change to the SELECTOR Tool. 
2. Select the text. 
3. Choose "Arrange -> Convert to editable shapes" ("Ctrl + Shift + S"). 

This converts the individual characters into a series of straight and curved lines. To 
manipulate individual characters, select the text then select "ARRANGE -> UNGROUP"  
(Ctrl + U) twice. All characters will then be separate objects. 

Note: you cannot edit the text with the TEXT Tool after you have converted it, so make 
sure the text is correct before you convert it. 

The Fonts Gallery 
The FONTS GALLERY serves a number of useful purposes: 

• It’s an easy way to preview the style of all fonts on your system. 
• It lists all the fonts included on the MAGIX Page & Layout Designer 2013 CD 

(whether or not they are installed). 
• You can install fonts from the CD (or hard disk), or un-install fonts 
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• You can apply fonts by drag-and-drop 

  
To display the FONTS GALLERY click its tab in the galleries bar to the right of the 
Page & Layout Designer window. Or you can toggle display of the FONTS 
GALLERY by choosing UTILITIES > GALLERIES > FONTS GALLERY or pressing "Shift 
+ F9". 

 

The fonts are grouped into several categories: 

• At the top are fonts installed on the computer (i.e. all the fonts in your 
Windows/Fonts folder). 

• Next are all fonts (installed or available on the Page & Layout Designer CD)  
grouped by appearance (for example: script, decorative, sans serif) 

• Last is a complete alphabetical list of all fonts, installed or ready to install. 

Chapter Document handling (on page 64) has general information about galleries. 

Applying a font from the Fonts Gallery 
This is an alternative to using the TEXT Tool INFOBAR. You can either: 

• Select the font in the gallery and click APPLY to apply to the selected text object, 
or double click a font 
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• Or drag & drop the font name onto any text (selected or not). The pointer 
changes shape when in position. 

If you apply a font that is not installed it asks if you want the font installed. 

Installing or uninstalling a font 
The first part of the gallery shows fonts already installed. Remaining sections show 
fonts on the CD (either from the CD or from the hard disc made at install time). 

1. Click on a font name to select it. You can select additional fonts by either "+ 
clicking" to select a group or "Ctrl + clicking" to add an individual font to the 
selection. 

2. Click INSTALL or the UNINSTALL button on the top of the gallery. Alternatively if 
you apply an uninstalled font this automatically installs it. 

You can also click GET FONTS to download a selection of fonts, but this is only useful if 
you haven’t installed the fonts from the Page & Layout Designer CD. 

Fonts from other suppliers can also be installed using the Windows Control Panel 
(described in the Windows Help and Support section of Windows). 

Note that to install fonts from the Font Gallery MAGIX Page & Layout Designer 
2013 must be running with Administrator privileges. To do this on Windows Vista, 
start MAGIX Page & Layout Designer 2013 by right clicking on the program shortcut 
and choosing "Run as Administrator" from the menu that appears. 

Fonts and PDF 
When you create a PDF ("FILE -> EXPORT…"), you get the option to embed fonts into 
the PDF file. Font embedding ensures that anyone who receives the PDF can view and 
print the document with the correct font, but it does make the PDF files larger. 
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PDF Export options 

This is only possible for those fonts that are marked by their creators as having 
permission for embedding. You are warned if it’s not possible to embed fonts. 

Document Font embedding 
MAGIX Page & Layout Designer 2013 stores the character shapes of all the fonts 
used in your document. This means if you give someone else your design file, or 
transfer the file to another computer, the text will still look exactly right, even if the 
correct fonts are not installed on that computer. 

Adding Hyperlinks 

 
With this button you open the Link Dialog. With this dialog you can apply 
hyperlinks to selected text or any other object like photos or graphical 
elements. 

When exporting your document to PDF (on page 314) this link is kept. When you 
click the link when the exported PDF file is shown the internet browser will open with 
this adress. 

Note: The links are ignored when exporting to bitmap files or when the document is 
printed :) 

  

The settings on this tab apply to the selected object(s) or selected text. To add a link 
to just some of the words in a paragraph of text, go into the Text Tool and drag over 
the text you want to link, to select it. Then setup the link in this dialog. 

Enter a web or email address to link to that address. If you leave the “CORRECT 
ADDRESS AUTOMATICALLY”  checkbox selected, your address will be adjusted if 
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required when you click OK or APPLY. For example, if you enter "www.example.com" it 
will correct it to "http://www.example.com/". 

When you have created a link to an object you can quickly change its behavior by just 
clicking on the object. A Pop-up will appear with the link's details and options to 
Change or Remove the link. 
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Fills 

The Fill Tool 
Creating a graduated color fill 

 
The process of creating a different fill is almost identical for all the fill types: 

1. Select the object or objects to which you want to apply the fill. 
2. Select the FILL Tool ("G"). 
3. Select the fill type from the dropdown menu. 
4. Click-drag across the object to create the fill. Or, drag one of the fill handles to 

adjust the fill size and position. 

MAGIX Page & Layout Designer 2013 provides a smooth interactive live preview of 
the fill as you drag.  

 

As you drag a fill arrow is created indicating the direction 
of the fill. Fill handles can be selected and dragged to adjust 
the position and angle of the fill. 

Coloring fills 
Select one of the fill handles and click a color on the COLOR LINE or bring up the COLOR 
EDITOR and choose a new color. You can press "Tab" to alternate between the fill 
handles. 

Fill Tool InfoBar 

 

 Fill type 

 Fill tiling 

 Fill effect 

 Bitmap name 

 Profile 

 Fill handle/resolution 

 Handle color/Grain 

FILL TYPE selects the type of fill. Selecting from this menu: 

• with a selected object, applies the fill to the object; 
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• without a selected object, sets the current fill type which will then be used for 
newly drawn objects. 

FILL TILING is used when applying bitmap and fractal fills. The options are described 
later in bitmap fills. Fill tiling changes the repetition of the fill effect. The options are: 

• Simple-the fill is used only once, regardless of the size of the object. 
• Repeating/repeating tile-repeats the effect so that it fills the entire object. 
• Repeating tile inverted-only available on fractal and bitmap fills. This is similar to 

repeating tile, but every other tile is inverted. 

 

A repeating elliptical fill inside an ellipse shape

Fill tiling options are not available for 
conical. All other fill types can be made 
to repeat. This can produce some 
useful effects. 

FILL EFFECT is used for all fill types, except 3 and 4-color fills. It controls how the fill 
colors fade from the start color to the end color: 

• FADE: Fades between the two colors in a linear fashion 
• RAINBOW: Blends along the shortest edge of the HSV color wheel. For example, a 

blend from yellow to cyan runs yellow-green-cyan. 

This option has no effect when the two colors are black, white or gray. 

• ALT RAINBOW: Similar to rainbow except the blend is along the longest edge of the 
color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan. 

BITMAP NAME displays a pop-down menu showing thumbnails of all the bitmaps in 
the BITMAP GALLERY and is an easy way to select the required bitmap for a bitmap fill. 

FILL PROFILE-you can change the rate of the color transition between the start and end 
of fills. This applies to all fill types except flat, three color, four color and bitmap 
(unless it's a contone colored bitmap). 

To change the profile of a fill: 

1. Select the filled object. 
2. On the FILL Tool InfoBar click PROFILE. This opens the PROFILE dialog box. 
3. You either select a predefined profile from the dropdown list or drag the sliders 

to create a custom profile. The top option in the dropdown list (the straight 
line) creates a linear transition between the start and end of the fill. 
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Show three different black-to-white graduated color fills and the corresponding profile dialogs. 
The center, default, is a linear black-to-white  transition. 

FILL HANDLE: Indicates if the start or end handle is selected. This field is blank for flat 
fills. 

RESOLUTION (bitmap and fractal fills only)-shows the resolution of the bitmap (as long 
as you don't have a fill handle selected). You can type in a new resolution to change 
the size of the bitmap. Low resolutions show the individual pixels of the bitmap. You 
rarely need a resolution greater than 150 DPI, even for typeset output. 

FILL HANDLE COLOR (except bitmap fills): Indicates the color applied to the selected fill 
handle. 

Changing the colors in a fill 
To change a color in a fill: 

• Drag & drop the color from the COLOR LINE onto a fill handle (you do not have to 
select the handle first.) 

• Or, drag & drop the color onto the object. Each fill has an imaginary center line 
halfway along the fill arrow. Dropping the color on the start handle side changes 
the start handle color, and the end handle side changes the end handle. 

• Or, if one of the end handles is selected (it's shown highlighted) just click on a 
color. You can press "Tab" to select the other fill handle, and click the color 
required for the other end 
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The Color Line is described in Color handling (on page 159). 

Each method changes the color of one handle only; they do not change any other 
selected fill handles, or: 

1. Select the required handle (or handles, also works with multiple objects). 
2. Choose the required color from the Color Line. 
3. This changes all selected fill handles. 

Moving the start or end handle of the fill 
To change the direction and extent of the fill: 

 

1. Move the pointer over the handle you want to move. When over the 
handle, the pointer changes shape. 

2. Drag the handle. 
 

Bitmap fills 

 

 Fill Type 

 Fill Tiling 

 Not used 

 Bitmap name 

 Resolution 

 Not used 

The BITMAP GALLERY is described in THE BITMAP GALLERY (on page 255) in the 
Photo Handling chapter, for the FILL GALLERY see below (on page 220). 

Bitmap fills are one of the most powerful fill types. It allows any photo or texture to be 
used as a fill for any shape and you have direct immediate control over the size, angle, 
position and tiling. You can color bitmap fills. You can use any type of bitmap as a fill, 
including JPEG photos, and alpha-channel (semi-transparent) bitmaps. 

When you import a photo file into MAGIX Page & Layout Designer 2013 (eg. a JPG or 
PNG file) it appears as a shape with a bitmap fill type. When such an object is 
selected the status line shows it as a “photo”, but it is just the same as a shape that 
has had the photo applied as a bitmap fill. 

To fill a shape with a bitmap or photo fill, do one of the following:  
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• Drag any bitmap from the BITMAP GALLERY or from your Windows File Explorer 
over any shape, hold "Shift" and drop, or  

• Drag any fill from the FILL GALLERY onto the shape (there is no need to hold 
"Shift" to drop in this case)  

• Select 'Bitmap' from the left side drop down menu of the FILL TOOL INFOBAR, and 
then select the required bitmap from the dropdown menu of bitmap names (this 
only shows bitmaps that are or have been previously loaded).  

You can fill an object with single or multiple tiles (repetitions of the bitmap image). 

   

Single tile (photo) Repeating tile Repeat inverted-the tiles fit together 
perfectly. 

The fill has three handles. Use it for Resizing and re-positioning bitmap fills (on page 
218). An alternative way to set the size of the bitmap is to type in a resolution into the 
InfoBar field. You first have to un-select the fill handle by clicking anywhere on the 
image away from a fill handle, then just type a new dpi resolution. 

Replacing Bitmap Fills 
If a shape already contains a bitmap, or is a photo, then you can just drag and drop a 
new bitmap from any source, such as Windows Explorer, and it will replace the 
existing bitmap. The new image is ‘best fitted’ into the shape so that it just fits in. By 
default, doing this will also replace all other instances of that photo on the current 
page, if they are in the same soft group.  

Holding down SHIFT while replacing a photo in this way causes the position, scale and 
rotation of the bitmap fill to be preserved. 

Bitmap coloring 
You can color any bitmap or photo fill by just clicking on a color on the COLOR LINE 
(make sure no fill handles are selected, by just clicking on the image). This will create 
a Contone (technically a Duotone) which uses colors between black and the selected 
color. Alternatively right click on the object and choose CONTONE > SET LIGHT COLOR 
or CONTONE > MAKE BLACK AND WHITE. You can also right click the color line and 
select either the 'SET CONTONE LIGHT COLOR' or 'SET CONTONE DARK COLOR'. 

So, for example, to make a picture black and white, just requires you to click on the 
White color patch on the color line. 
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To cancel any applied color, apply NO COLOR to either fill 
handle. This restores the bitmap to its original bitmap 
colors. 

The RESOLUTION box on the INFOBAR shows the resolution, which can be altered by 
moving the fill handles or typing in a value. 

Resizing and re-positioning bitmap fills 
If you hold down Shift and click and drag on a shape which already has a bitmap fill, a new bitmap fill is created centered on the click point. If you hold the "Ctrl" key down too, it limits the angle, so this makes it easy to create an upright bitmap fill. 

Once the fill has been created, you can drag anywhere 
on the image to re-position the fill inside the shape. 

When you mouse over the outer fill handles the 
mouse pointer changes into a “rotate” mouse pointer. 
Dragging on these  handles will stretch and rotate the 
bitmap fill with the current aspect ratio locked; hold 
down "Shift" while dragging to change the horizontal 
and vertical size independently and to skew the fill. 
The InfoBar shows you the resolution of the bitmap fill 
(you can adjust this, and thus the bitmap size, by 
entering a new value). 

 

Fractal fills 
MAGIX Page & Layout Designer 2013 supports two types of fractal fill which are 
mathematically created naturalistic fill patterns. They are great for simulating sky and 
clouds or other natural textures. 

Each time you create a new fractal fill a new pattern is created. To replace an existing 
fractal with a new pattern choose fractal from the fill menu again. 

 

The GRAIN control on the INFOBAR 
provides control over the graininess of 
the pattern. Low values give a smooth 
flowing pattern, and high values give a 
grainy pattern. 

You can adjust the size and position of the fractal fill in the usual way by dragging and 
adjusting the fill handles. De-select the fill handles (click on the fill away from a 
handle) to show the above resolution and grain controls. 
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Fractal clouds fill. On the left a grain of 1, on the right a grain of 50. 

 

Fractal plasma fill. On the left a grain of 5, on the right a grain of 50. 

Note the difference between grain and resolution. Grain controls the flow of the 
pattern. Resolution sets the size of the fractal bitmap and how noticeable the 
individual pixels are. 

You can change the start and end colors of a fractal fill. Select the center or outer 
handles and then apply a color using either the Color Line or COLOR GALLERY.  To 
cancel any applied color, apply no color. 

Multi-stage color graduations 
Many of the graduated color fill types support multi-stage graduation fills, which 
means instead of just fading from one color to another, you can go through a number 
of different color fill stages. 

 

To add a new color stage to a graduation, select the Fill Tool so the fill arrow shows 
and then: 

• Either drag a color onto the fill arrow where required. 
• Or double click on the fill arrow to create a new fill handle, and now click a color 

or display the COLOR EDITOR. 

You can re-position the fill handles by dragging. 

With one fill handle selected pressing "Tab" will select the next. If the COLOR EDITOR 
is open, this is updated to reflect the new fill handle 
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To remove a fill stage handle, just click on it to select, and press "Del". 

The Fill Gallery 
The FILL GALLERY contains bitmap textures suitable for use as bitmap fills. Only when 
you use a fill is it copied into the document. 

To display the FILL GALLERY: 

  
To display the FILL GALLERY click its tab in the galleries bar to the right of the 
Page & Layout Designer window. Or you can toggle display of the FILL GALLERY 
by choosing UTILITIES > GALLERIES > FILL GALLERY or pressing "Shift + F11". 
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IMPORT - imports the selected bitmap into the document. A copy of the bitmap then 
appears in the BITMAP GALLERY. You can also drag-and-drop the bitmap onto a blank 
part of the page. This is usually easier than clicking IMPORT. 

FILL - imports and applies the selected bitmap as: 

• A bitmap fill to the selected object (if any). 
• Or, if no objects are selected, it inserts the bitmap into the document as a new 

photo object. 

You can also drag-and-drop the bitmap onto an object to apply a bitmap fill.  

There are some differences between either dragging a bitmap from the BITMAP or 
FILL GALLERY: When dragging bitmaps from the FILL GALLERY and dropping on 
shapes to create a bitmap fill, the fill will be tiled and the bitmap won’t be best-fitted 
into the shape. This different behavior to that seen when dragging from the BITMAP 
GALLERY is because normally textures are applied from the Fill Gallery and these 
should normally be tiled and not best-fitted. 

TRANSP - (transparency) imports and applies the selected bitmap as: 

• A transparent bitmap to the selected object (if any). 
• Or sets the current transparency attribute. 

GET FILLS - download free fills from MAGIX. 

BACKGROUND - set the selected fill as the page background. 

REMOVE - delete the selected fill or folder. 

DISC FILLS - add new fills from your hard drive or a CD. 

MORE - lets you select the size of the preview icons and whether full information 
about the bitmap is shown, as well as find and sort the fills. 

STOP DOWNLOADING - if you have a slow connection and find getting fills from the 
Internet too slow, you can stop downloading them and then resume later. 

Find & Sort are described in the Document handling (on page 64) chapter. 

Document handling (on page 64) includes general information about galleries. 
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Transparency 

 
The TRANSPARENCY Tool lets you specify how much of the underlying colors 
and objects appears through an object.  

 

 Shape 

 Transparency type 

 Tiling 

 Bitmap name 

 Profile 

 Handle/Resolution 

 Amount of transparency 

You have control over the level of transparency from fully opaque to fully transparent. 
Page & Layout Designer goes further than other drawing packages by offering a wide 
range of different graduated transparencies. 

You can apply flat and graduated transparency to all types of objects including 
bitmaps. 

Some uses of transparency: 

• Simulating water or glass. 
• Anywhere you want objects to fade to parts of objects to fade or blend with the 

background. 
• Clouds or mist-fractal transparencies are particularly good for this. 
• Using the special type of transparency you can lighten, darken and apply special 

effects to objects and photos. 
• Creating highlights and reflections. 

 

The windshield is created with multiple overlaid objects with different transparency. 
The reflection is 100% opaque white in the center fading in an elliptical fashion. 
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Applying flat transparency 
It's called "flat" transparency because all parts of the objects have the same 
transparency, as opposed to graduated transparency. 

1. Select the object or objects 
2. Select the Transparency Tool ("F6") 
3. Drag the transparency slider on the InfoBar 

MAGIX Page & Layout Designer 2013 provides live-preview. As you drag the 
transparency slider the objects on the document are changed so you can see the 
effect immediately. 

Applying graduated transparency 
Graduated transparency works in a very similar way to graduated color fills. You just 
drag on the objects in the Transparency Tool to create a fading transparency. You 
have a very similar range of transparency shapes, the simplest being linear, but you 
can also have circular, elliptical, conical, fractal and bitmap transparencies, and others.  
To create a graduated fade: 

1. Select the object or objects 
2. In the TRANSPARENCY TOOL, drag across the objects to create a linear fade 

across the object. 
3. Select alternative transparency shapes from the dropdown menu on the 

InfoBar 

You can select and adjust the position and transparency strength using the "fill" 
handles shown on the object. 

Refer to Fills (on page 213) for more information on manipulating fill handles and the 
different fill shapes (in this case transparency shapes) 

Multi-stage graduated transparency 
Just as you can add multiple stages to a graduated fill, you can do the same with a 
graduated transparency. This allows you to fade, for example, from opaque to 50% 
transparent then back up to 25% transparent, back to opaque, etc.  

You can set the level of transparency at each stage, by selecting a handle and then 
adjusting the transparency slider. Add additional stages by double-clicking on the 
graduated transparency line then adjusting the slider.  

See the Fills chapter (on page 213) for more information on manipulating the handles. 
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Transparency types 
The most common type of transparency, and the only type that many other 
applications understand is called "Mix transparency". But MAGIX Page & Layout 
Designer 2013 supports different type that affect the objects in different ways. 

Page & Layout Designer has these types of transparency: 

Mix 
The color of the object mixes with the color of underlying objects. The effect is similar 
to spraying a thin coat of color (or paint) over underlying objects.  

Stained glass 
The effect is similar to viewing underlying objects through colored glass. It is useful 
for the simulation of glass and selectively darkening objects. The color of the object 
with Stained Glass applied: 

• White - no effect on the colors of underlying objects. 
• Gray & Black - darkens the colors of underlying objects. 
• Other colors - darken underlying colors towards saturated color (light red over 

light red results in mid-red: green over red results in black). If you want to use a 
colored object to darken underlying colors, you may find DARKEN transparency 
type easier to use. 

Technically the process is subtractive in RGB color space. 

Bleach 
Bleach has no clear analogy in the physical world. It is useful for highlights when the 
light source is not white. The color of the object with Bleach applied: 

• Gray & White - lightens the colors in underlying objects. 
• Black - no effect on the colors of underlying objects. 
• Other colors - lighten underlying colors towards unsaturated color. (Light-red 

over light-red gives a pale-red: green over red gives yellow.) If you want to use a 
colored object to lighten but not color-shift underlying colors, you may find 
LIGHTEN transparency type easier to use. 

Technically the process is additive in RGB color space. 

Contrast 
Usually you would use C on a separate object to modify the color of underlaying 
objects (that is, you would use an object as a filter). Depending on the color chosen, it 
increases the contrast of underlying colors (make them brighter or duller).The color of 
the object with Contrast applied: 

• Gray (below a 50% tint of black) & White - increase contrast (compress the 
color range) to make the underlying colors brighter. 
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• Gray (above a 50% tint of black) & Black - make underlying colors duller 
(towards gray). 

• Other colors - convert the color to the equivalent shade of gray. (Yellow gives 
light gray, Red dark gray.) Then increase or decrease the contrast of underlying 
objects. 

Saturation 
Usually you would use Saturation on a separate object to modify the color of 
underlaying objects (that is, you would use an object as a filter). Depending on the 
color chosen, it makes the colors of underlying objects brighter or duller. The color of 
the object with Saturation applied: 

• Gray (below a 50% tint of black) & White - increases saturation in the colors of 
underlying objects towards pure color. 

• Gray (above a 50% tint of black) & Black - reduces saturation (colorization) 
towards black. 

• Other colors - convert the color to the equivalent shade of gray. (Yellow gives 
light gray, Red dark gray.) Then increase or decrease the color saturation of 
underlying objects. 

Darken/Lighten 
Darken/Lighten is useful for making underlying objects darker or lighter. Usually you 
would use it on a separate object to modify the color of underlaying objects (that is, 
you would use an object as a filter). Darken/Lighten are grayscale versions of Stained 
Glass/Bleach transparency types. The color of the object with Darken/Lighten 
applied: 

• White - no effect on the colors of underlying objects. 
• Gray & Black - darkens/lightens the colors of underlying objects. 
• Other colors - convert the color to the equivalent shade of gray. (Yellow gives 

light gray, Red dark gray.) Then darken/lighten the colors of underlying objects. 

Brightness 
Depending on the color chosen, Brightness makes the colors of underlying objects 
lighter or darker. The color of the object with Brightness applied: 

• Gray (below a 50% tint of black) & White - makes the colors of underlying 
objects lighter. White has maximum effect 

• Gray (above a 50% tint of black) & Black - makes the colors of underlying objects 
darker. Black has maximum effect. 

• Other colors - convert the color to the equivalent shade of gray. (Yellow gives 
light gray, Red dark gray.) Then lighten or darken the colors of underlying objects. 

Luminosity 
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Luminosity uses the grayscale equivalent of the color to control the luminosity (or 
Value) of underlying objects. Note that Luminosity has no effect on gray, white or 
black underlying objects. The color of the object with Luminosity applied: 

• Gray & White - increase the luminosity of underlying objects. White has the 
greatest effect, producing saturated color. 

• Black - remains as a black object. 
• Other colors - convert the color to the equivalent shade of gray. (Yellow gives 

light gray, Red dark gray.) Then increase the luminosity of underlying objects. 

Hue 
Hue is useful for color-shifting underlying objects. Its action is most easily understood 
using the HSV color model. The color of the object with Hue applied: 

• Gray, White, & Black - has no effect. These colors lie at the center of the color 
wheel and so have no hue. 

• If the underlying color is gray, white, or black - Hue transparency type has no 
effect. 

• Other colors - replace the Hue of the underlying color with the Hue of this object. 
Use the Saturation and Value of the underlying color. 

For more information on HSV refer to Color handling (on page 159). 

For all these, the slider controls the amount of transparency from opaque (0% 
transparent) to fully (100%) transparent. 

Applying a flat transparency to an object also applies transparency to the line around 
the object. It is not possible to set different transparencies, but you can remove the 
line by setting it to no color or by selecting "None" as the outline width. To create an 
object with a transparent fill and a non-transparent line, use a non-flat transparency 
type. 

For more information on colors see Color Handling (on page 159). 

Enhance 
See Enhance below for more information on Enhance transparency. 

Enhance 
Enhance transparency allows you to modify any part of your design using the Enhance 
Photo Tool, just as if it was a photo. For example you can draw a shape over any part 
of your design, apply enhance transparency to it and then adjust the brightness of just 
the area of your design which is covered by the shape. 



 

Transparency 227  

 

Applying Enhance transparency 
To apply enhance transparency:- 

1. Draw or select the shape to which you want to apply the enhance 
transparency effect. 

2. Go into the TRANSPARENCY TOOL and select "ENHANCE" from the 
TRANSPARENCY TYPE list on the infobar. 

3. The shape seems to have disappeared from your page! That’s because it will 
only apply enhancements to objects underneath it, and you’ve yet to specify 
the enhancements it will apply. The object should still be selected however. 

4. Switch into the PHOTO ENHANCE TOOL. Turn up the brightness using  the 
control on the infobar. Now you can see that the area covered by your shape is 
brightened compared to the area outside the shape. 

5. You can adjust brightness, contrast, saturation and temperature. 
6. Move your shape around, or transform it and it always applies the photo 

enhancement(s) to the area underneath the shape. 

Normally you’ll also want to apply some feathering to the shape using the FEATHER 
TOOL (on page 148), to soften the edges of your shape and blend it into your design.  

Profile 
You can change the rate of change of transition between the start and end of 
transparencies. This applies to all single stage graduated transparency types except 
three point and four point (where the option is not available) 

To change the profile of a transparency: 

1. Select the object. 
2. On the TRANSPARENCY Tool InfoBar click PROFILE. This opens the PROFILE 

dialog. 
3. You either select a predefined profile from the dropdown list or drag the sliders 

to create a custom profile. The top option in the dropdown list (the straight 
line) creates a linear transition between the start and end of the transparency. 

Bitmaps 

BITMAP & FILL GALLERIES are described in Photo Handling (on page 255) and Fills (on 
page 220). 

When you select a transparency type of BITMAP, a default bitmap is initially used. 
Click on BITMAP NAME in the transparency InfoBar, or use the BITMAP or FILL 
GALLERIES to change the bitmap used (click the TRANSP button in the gallery or drag-
and-drop from the gallery). 
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By default, the lighter colors in a bitmap are the most transparent (you can, of course, 
alter the relative amounts of transparency later). 

Handle/resolution 
If you have a handle selected, this box tells you what handle it is. With no handles 
selected, and when using a bitmap transparency, it controls the DPI. 

Applying transparency to several objects 
If you group objects and apply transparency, the whole group is treated as one object 
and the entire group is made transparent. But if the objects are not grouped and you 
apply transparency, each individual object is given a separate transparency and you 
get an entirely different effect when the objects are overlaid. 

 

Individual transparency (left) or group transparency (right) 

Mixing individual and group transparencies 
You can combine the methods above to create complex transparency combinations. 
For example you could set an object to 50% transparency, then group it and apply a 
transparency to the group as well. You are also able to apply a transparency to a 
group first, and then later apply attributes to individual objects within a group. Just 
hold down "Ctrl", click the individual object and change its attributes. 

Group transparency on blends 

For more on blends see Blends (on page 242). 

When adding a transparency to a Blend object, the transparency will be applied to the 
blend as a whole. It is treated like group transparency. 

 

If you want the transparency to be applied to each individual step of the blend, first 
make the objects transparent, and then blend. 
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Bevels 

The Bevel Tool 

 
The BEVEL Tool (shortcut "Ctrl + F3") gives objects an appearance of depth 
instead of being flat on the page. 

Bevels are resolution-independent so you can scale them without losing quality. 

 

 Bevel type 

 Slider type list 

 Slider and numeric value for selected parameter 

 Outer bevel 

 Inner bevel 

 Join style 

You can apply bevels to most types of object. The exceptions are: 

• Part of a block of text (such as a single letter)-the bevel is instead applied to all 
the text. 

• To the curve in text along a curve. 
• Contoured objects. 
• Live effects (the bevel is applied to the object before the effect is applied if the 

effect is live, or to the bounding box of the effect if the effect is locked). 

Applying a bevel 
To apply a bevel to a single object: 

1. Select the object 
2. Choose the BEVEL Tool. 
3. Choose the bevel shape you want from the BEVEL TYPE list. Note that NONE 

removes any applied bevels. 

Modifying a bevel 
You can change the angle and elevation of the light and change the shape, direction 
and size of the bevel edge. 
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Bevel direction 
Bevels can be inside the object or outside. Outside bevels make objects larger; inside 
bevels do not change the object size. 

To change bevel direction: 

1. Select the object. 
2. Click either the INNER or OUTER button.  
 

Changing the bevel light source 
The bevel effect is created by a light shining across the object and highlighting the 
shape (profile) of the bevel. You can change the direction and height of the light and 
its strength (the contrast). 

Changing the light angle (horizontal direction): 

1. Select the object. 
2. Drag the arrowhead to change the position of the light 

source. 

You cannot move the center of the arrow, only the arrowhead. 
 

For precise angles, select LIGHT ANGLE from the SLIDER TYPE list. Then drag the slider 
or type into the text box. 

 

If you have several beveled objects selected, light angle changes all bevels. Dragging 
the arrow changes just the bevel (or bevels) to which the arrow refers. 

Changing the light strength (contrast) 
To change the light strength: 

1. Select the object. 
2. Select CONTRAST from the SLIDER TYPE list. Then drag the slider or type into the 

text box. 

 

If you have several beveled objects selected, any changes apply to all the bevels. The 
colors used in the bevel affect the contrast. For example, strong (saturated) colors 
require more contrast than weak colors to get the same effect. For best results, you 
will probably have to adjust the contrast for each object. 
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Changing the light elevation (vertical angle) 
This lets you move the light anywhere from immediately above the object (90º) to 
the side of the object (0º). 

1. Select the object. 
2. Select LIGHT ELEVATION from the SLIDER TYPE list. Then drag the slider or type 

into the text box. 

 

For rounded bevels we recommend a light elevation of 30º. At this angle the bevel 
blends smoothly with the object. 

Changing the bevel size 
How to change the bevel size: 

1. Select the object. 
2. Drag any of the outside arrows to enlarge the bevel. 

Alternatively: 

1. Select the object. 
2. From the SLIDER TYPE list choose SIZE. 
3. Either drag the slider or type a value into the text box. 

 

Changing the bevel shape 
1. Select the object 
2. Choose the BEVEL Tool. 
3. Choose the bevel shape you want from the BEVEL TYPE list. 

Changing the bevel color or fill effect 
After applying a bevel to an object, you can change the bevel's color or fill effect. You 
can apply any of MAGIX Page & Layout Designer 2013's color effects including multi-
stage fills. 

For more on colors and the Color Line, refer to Color handling (on page 159). 

How to change the bevel color: 
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• The easiest way is to drag-and-drop a color from the Color Line onto the bevel 
(make sure you drop the color onto the bevel and not the object.) 

Alternatively, this method is slightly more complex but you have full control over the 
color: 

1. Select the bevel using the SELECTOR Tool (make sure you select the bevel and 
not the object.) 

2. Use the COLOR EDITOR to edit the color. 

Changing the bevel join style 

 

After applying a bevel to an object, you 
can change the shape of the corners 
(joins). 

How to change the bevel join style: 

1. Select the object. 
2. Click the appropriate join button on the BEVEL Tool InfoBar. 

 
 

 Miter  Round  Bevel 
 

Removing a bevel 
To remove a bevel: 

1. Select the object(s) from which you want to remove the bevel. 
2. Choose the BEVEL Tool. 

Choose NONE from the BEVEL TYPE list. 
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Shadows 

The Shadow Tool 

 
The SHADOW Tool (shortcut "Ctrl +  F2") lets you apply, remove, and modify 
semi-transparent (or "soft") shadows.  

The transparency of soft shadows increases towards the edges, which gives a very 
realistic effect. Shadows are resolution independent so you can scale them without 
losing quality. 

 

 No Shadow 

 Shadow Types 

 Shadow Blur 

 Shadow Transparency 

 Profile 

 Shadow Position 

MAGIX Page & Layout Designer 2013 has three shadow types: 

• Wall where the shadow is cast on a wall behind the object 
• Floor where the object appears to be standing upright on a surface. 
• Glow where the shadow is used to add a halo effect around the object 

 

The transparency of soft shadows increases towards the edges, which gives a very 
realistic effect. Shadows are resolution independent so you can scale them without 
losing quality. 

Applying a shadow 
Applying a shadow 
To apply a shadow: 
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1. Select the object. 
2. Choose the SHADOW Tool. 
3. Select the WALL, FLOOR OR GLOW button on the 

SHADOW Tool InfoBar. 
4. You can drag the shadow away from or towards 

the object to create more or less distance 
between the object and the imaginary wall. 

 

 

Alternatively to create a wall shadow you can: 

1. Select the object. 
2. Choose the SHADOW Tool. 
3. Drag from the center of the object in the direction of the shadow. 

Blur the edges of the shadow 

 

This changes the size of the shadow. A small 
blur gives the effect of a sharp light source, a 
large blur, a diffused or distant light source. It 
is recommended that shadows are always 
blurred slightly as this is more realistic. 

To blur the shadow edge: 

1. Select the object 
2. Choose the SHADOW Tool. 
3. On the SHADOW Tool InfoBar either drag the blur slider or type a value into the 

text box on the right. 

 

Change the transparency of the shadow 
A semi-transparent shadow is more realistic 
than a solid shadow. But you can change the 
transparency level of the shadow to suit your 
needs. 

To change the transparency: 

1. Select the object 
2. Choose the SHADOW Tool. 
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3. On the SHADOW Tool InfoBar, drag either the transparency slider or type a 
value into the text box on the right. 

 

Changing the shadow profile 
After applying a shadow, you can change how the shadow transparency changes 
across the blur. You can have a linear transition (which is the default profile and 
usually gives the most realistic results) or a profiled transition. 

To change the shadow profile: 

1. Create the shadow. 
2. In the SHADOW Tool, click PROFILE. This opens the PROFILE dialog box. 
3. You can either select a pre-defined profile from the dropdown list or drag the 

sliders to create a custom profile. The top option in the dropdown list (the 
straight line) creates a linear transition. 

Changing the shadow color or fill effect 
After applying a shadow to an object, you can change the shadow's color or fill effect. 
You can apply any of MAGIX Page & Layout Designer 2013's color effects including 
multi-stage fills. 

How to change the shadow color: 

For more on colors and the Color Line refer to Color handling (on page 159). 

• The easiest way is to drag & drop a color from the Color Line onto the shadow 
(make sure you drop the color onto the shadow and not the object). 

• Alternatively, this method is slightly more complex, but you have full control over 
the color: 

1. Select the shadow using the SELECTOR Tool (make sure you select the 
shadow and not the object). 

2. Use the COLOR EDITOR to edit the color. 

Converting shadows to shapes 
You can convert a shadow into a group containing the shadow and the object (or 
objects) casting the shadow. The shadow is converted to a simple shape and, after 
ungrouping, can be edited. Note that after converting a shadow to a shape, you 
cannot use the SHADOW Tool to edit it, as it is no longer a shadow. 
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To convert a shadow to shapes: 

1. Select the shadow or the object (or objects) casting the shadow. 
2. Choose ARRANGE -> CONVERT TO EDITABLE SHAPES. 

Or to convert a shadow quickly, right-click on the shadow or the object (or objects) 
casting the shadow. This opens the pop-up menu. Choose CONVERT TO EDITABLE 
SHAPES. 

Removing a shadow 
To remove a soft shadow: 

1. Select the object 
2. Choose the SHADOW Tool. 
3. Select the NO SHADOW button on the SHADOW Tool InfoBar. 

 

 
 

Copying shadows onto other objects 
Once you've got a shadow looking how you want it on one object, you can copy it 
onto other objects using "PASTE FORMAT/ATTRIBUTES". Simply copy the object that 
has the shadow ("EDIT" > "COPY"), select the object or objects you want to paste the 
shadow onto and choose "EDIT" > "PASTE FORMAT/ATTRIBUTES". 
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Contours 

The Contour Tool 

 
The CONTOUR Tool ("Ctrl + F7") lets you create interesting effects around 
the edges of objects. The CONTOUR Tool creates a series of concentric 
outlines either on the inside or the outside of a selected shape. 

 

 Edit distance between steps 

 Number of steps 

 Remove contour 

 Color effect 

 Contour width 

 Outer contour 

 Inner contour 

 Position profile 

 Attribute profile 

 Inset path 

 Join types 

 

Contouring objects 
To contour an object: 

1. Select the object. 
2. Choose the CONTOUR Tool. 
3. Then: 

• Drag any of the eight handles that surround the 
selected objects. As you drag, you see the outline 
of the contour.    

• Or drag the contour width slider. 
• Or type a new value into the text box. 

 

Contours can be either inside or outside of objects (outside contours make the 
objects larger). 
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To swap the contour direction: 

1. Select the contoured object. 
2. Choose the CONTOUR Tool. 
3. Then: 

• Drag any of the eight handles that surround the selected 
objects (drag the handles inside or outside the objects to 
swap). 

• Or click the INNER or OUTER contour buttons. 

 

Note that objects cannot have both a contour and a bevel. 

Changing the number of steps in a contour 
Contours are initially created with five intermediate steps. You can increase the 
number of steps to make each step less obvious. Alternatively, you can reduce the 
number of steps so you can clearly see each step. You can either enter the number of 
intermediate steps or enter the distance between steps. 

To change the number of steps in a contour: 

1. Select the contoured object. 
2. Choose the CONTOUR Tool. 
3. Select either distance or number of steps by pressing one of the two buttons 

on the left side of the InfoBar. 
4. Type the required value into the steps (or distance, depending on the above 

selection) field on the CONTOUR Tool InfoBar and press "". 

If required, MAGIX Page & Layout Designer 2013 rounds the distance to give a whole 
number of steps. 

Changing the contour color 
After applying a contour to an object, you can change the contour's color. 

For more on colors and the Color Line refer to Color handling (on page 159). 

How to change the contour color: 

The easiest way is to drag-and-drop a color from the Color Line onto the contour 
(make sure you drop the color onto the contour and not the object). 

Alternatively this method is slightly more complex but you have full control over the 
color: 

1. Select the contour using the SELECTOR Tool (make sure you select the contour 
and not the object). 
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2. Use the COLOR EDITOR to edit the color. 

Note that you can also select the contour using the CONTOUR Tool. Click on the 
contour to select it. 

Changing the contour join style 

 

After applying a contour to an object, 
you can change the shape of the 
corners (joins). 

How to change the contour join style: 

1. Select the object. 
2. Click the appropriate join button on the CONTOUR Tool InfoBar. 

 

 Miter Round  Bevel 
 

Changing the contour attribute profile 
After creating a contour you can change how the attributes (such as color or line 
thickness) change. You might want a regular rate of change or a more pronounced 
change towards one end or the center. 

To change the attribute profile: 

1. Create the contour. 
2. In the CONTOUR Tool click ATTRIBUTE PROFILE. This opens the PROFILE dialog 

box. 
3. You can either select a pre-defined profile from the dropdown list or drag the 

sliders to create a custom profile. The top option in the dropdown list (the 
straight line) is the default and creates a regular rate of change. 

Changing the contour position profile 
After creating a contour you can change how the intermediate steps are spaced. You 
can have regular spacing or closer at one end than the other or closer in the center. 

To change the position profile: 

1. Create the contour. 
2. In the CONTOUR Tool click POSITION PROFILE. This opens the PROFILE dialog box. 
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3. You either select a pre-defined profile from the dropdown list or drag the 
sliders to create a custom profile. The top option in the dropdown list (the 
straight line) is the default and creates regular spacing. 

Applying a contour to several objects 

 

If the objects are grouped, 
overlapping contours merge 
together. The contour color is 
the same as the rear-most 
object in the group. 

If the objects are ungrouped, each object has a separate contour. The contour color is 
the same as the object color. 

The contour steps are not separate objects. To make them selectable, you need to 
convert the contour to editable shapes (see below). 

Using contours to resize objects 
You can use contours to change the size of objects by making the outline thicker or 
thinner. This has advantages over resizing for shapes like the letter "C": 

 

On the left is the original object. The center 
letter is resized using a contour, the right letter 
is resized by scaling the object up. 

To resize using contours: 

1. Select the object. 
2. Choose the CONTOUR Tool. 
3. Give the object a contour of the required size. 
4. Click INSET PATH on the CONTOUR Tool InfoBar. The contour steps disappear 

and the object is now the size of the contoured object. 

Converting contours to shapes 
You can convert a contour into a group containing all the contour steps. Each step is 
converted to a shape and, after ungrouping, can be edited. Note that after converting 
a contour to shapes, you cannot use the CONTOUR Tool to edit it as the object is no 
longer a contour. 

To convert a contour to shapes: 

1. Select the contour. 
2. Choose ARRANGE -> CONVERT TO EDITABLE SHAPES. 
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To convert a contour quickly, right-click on the contour to open the pop-up menu and 
choose CONVERT TO EDITABLE SHAPES. 

Removing a contour 
If a contour does not give the desired effect, you can easily remove it: 

1. Select the contoured object. 
2. Choose the CONTOUR Tool. 

Click on the Remove button on the CONTOUR Tool InfoBar. 
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Blends 

Blends 
This operation blends one object into another by a series of intermediate objects. This 
is sometimes known as interpolation, in--betweening, tweening, or morphing. 

 A five-stage blend of a star into an 
arbitrary shape. 

Blends have several different uses. This section describes firstly some of the uses and 
then using the BLEND Tool. 

A blend is treated like a group and you can move and copy the blend as you would a 
group. 

Groups are described in Object handling (on page 120). 

Using the Blend Tool 
To create a blend: 

1. Select the BLEND Tool ("F7") 
2. Move the pointer over a visible part of the start object. 
3. Drag the pointer over the end object. As you drag the pointer a "blend 

line" appears. 
4. When over a visible part of the end object, release the mouse button. 

For object-to-object blends the blend line is colored black. When blending 
between control handles, it is colored red. 

 

 

The Blend Tool InfoBar 

 Edit distance between steps 

 Edit number of steps 

 Steps in blend 

 Remove blend 
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 Blend color effect 

 Position profile 

 Attribute profile 

 1:1 node mapping 

 Anti-alias blend steps 

 Blend along a curve 

 Rotate blend steps along the curve 

STEPS is the number of intermediate stages in the blend. At lower settings the 
individual steps are apparent. This is useful for object transforms. At higher settings 
the steps merge together. This is more suitable for highlight effects. Experience shows 
that you rarely need more than 50 steps even in a complex blend. 

The two objects can have different numbers of control handles and can be different 
types (for example, shapes to lines). 

When MAGIX Page & Layout Designer 2013 blends, it has to have a "start" handle on 
one object that maps onto an equivalent "start" handle on the other object. 

 

 If you create a blend by dragging from the filled 
interior of one shape to the other, then MAGIX Page & 
Layout Designer 2013 will automatically choose the 
bottom-left control handles to match. However, you 
can force a blend to use any control handle as the 
starting handle by dragging exactly from one control 
handle to another. 
Blending between different control handles gives 
different blend patterns. 

 

 

A second way to adjust the blend is 
to add control handles to one object. 
The left-hand example is a blend 
between two triangles. The right-
hand example has an extra control 
handle in the lower triangle. The 
blend was then made to that control 
handle. 

A third way is using the 1 TO 1 NODE MAPPING button. 

 
This only has an effect if the two objects have the same number of control 
handles. Usually Page & Layout Designer adds or removes handles as 
necessary to transform one shape into another. 

When blending with shapes that have the same number of handles (such as copies or 
duplicates) this can sometimes produce strange results. In this situation, the 1:1 
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button prevents extra handles being added. You can still control the start handles by 
dragging exactly between control handles as previously described. 

The left-hand example is a normal blend 
between the rectangles. The right-hand 
example uses 1:1 

 

Selecting the start or end object 
After creating the blend you may want to change some attribute of either the start or 
end object such as its color or line width or position. 

To change an object’s attributes: 

1. Select the SELECTOR Tool. 
2. "Ctrl + click" on the start or end object to "select inside" 
3. Make the required changes. 

The Selector Tool is described in Selecting objects (on page 98). 

To change the color, drag-and-drop the color from the Color Line onto the object. You 
can’t select intermediate steps of a blend, unless you CONVERT TO EDITABLE SHAPES – 
see later. 

Multi-stage blends 
You are not limited to blending between only two objects. Page & Layout Designer 
can blend between several objects. 

 

The original three objects, left, and the resultant blends right  
 (It also shows blending between different types of object.) 

The produce a multi-stage blend just blend from the fist to the second, and then again 
from the second to the third, etc. 

Producing highlight effects 
By increasing the number of blend steps you can create some complex highlight 
shading effects. One of the most powerful features of Page & Layout Designer is that 
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it allows blends from just about any shape to any other shape, with dissimilar 
numbers of handles. 

However, blends between objects with sharp corners can produce unwanted twists in 
the blend. 

 

The two shapes have different numbers of handles, and a blend from one to the other 
produces the result on the right. It has a twist in the top right corner. 

You can control exactly which point handles map, when creating the blend, by 
dragging from the point handle of one shape to a corresponding handle on the other 
shape. You will need to have both shapes selected in order to see the control points. 

 

The left example has the top right handles mapped so now there is no twist in the 
right side. In order to get the exact desired effect it’s sometimes necessary to 
experiment by mapping between alternative points or adding or removing point 
handles to one of the shapes. The Apple drawing on the front of this chapter is an 
example of complex highlights created entirely from blends. 

The number of steps 

 

To change the number of steps in your blend, just enter a 
value in the STEPS box. 

It is also possible to change the distance between steps, but this option is only 
available when creating a blend along a curve (see below). 

The Anti-Alias button on the InfoBar 
When producing highlight effects, anti-aliasing the intermediate steps has no visible 
benefit. However, it slows down screen redraws by up to 30% on slow computers.  

 
Therefore, deselecting the ANTI-ALIAS button means that Page & Layout 
Designer never anti-aliases the intermediate steps of this blend. 
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Profiles 

 
POSITION PROFILE lets you select how to space the intermediate steps in a blend. 
You can have regular spacing or closer at one end than the other or closer in the 
center. 

 
ATTRIBUTE PROFILE lets you select how attributes (such as transparency, colors 
or line thickness) change in a blend. You can have a regular rate of change, 
greater change at one end, or greater change in the center. 

Changing profiles 
To change a profile: 

1. On the BLEND Tool INFOBAR click either POSITION PROFILE or ATTRIBUTE PROFILE. 
This opens the required profile dialog box. 

2. You either select a predefined profile from the dropdown list or drag the sliders 
to create a custom profile. The top option in the dropdown list (the straight 
line) creates regular spacing. 

Blending along a curve 
To make your blend follow a curved line or shape: 

1. Select both the blend and a line or shape. 
2. Select the BLEND Tool. 
3. Select the BLEND ALONG A CURVE button. 

 

 

 

 

You will most likely want to hide the line or shape, and just leave the items going 
along an invisible curve. To do this: 

1. Select the blend. 
2. "Ctrl + click" (select inside) to select just the line, or choose the SHAPE 

EDITOR Tool. This selects just the line or shape. 
3. "+ click" (or right click) on the NO COLOR button on the Color Line, 

(described later in Color handling (on page 159)), or, select a line width 
of none. 
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Rotating along a curve 
If you have blended along a curve, you can make 
the objects rotate to match the curve. 

 
To do this, select the ROTATE ALONG CURVE button on the BLEND Tool INFOBAR. 

 

Blends and PDF or PostScript files 
When printing or exporting to a PDF file, using a large number of blend steps can 
result in large files (megabytes in some cases) which can be very slow to print or 
view. If necessary reduce the number of blend steps. 

Editing the shapes in a blend 
The intermediate steps of a blend are calculated on-the-fly and are not selectable or 
editable. Use the menu, ARRANGE -> CONVERT TO EDITABLE SHAPES to convert the 
individual blend steps to separate objects. (The result is grouped so you would need 
to ungroup before editing the individual steps.) Doing this is less efficient because to 
change the blend you will have to re-blend from the start object to the end object. 

Color Blend Effect 
The COLOR BLEND EFFECT menu on the BLEND Tool InfoBar gives you a control over 
intermediate colors: 

• FADE: Fades between the two colors. 
• RAINBOW: Blends along the shortest edge of the HSV color wheel. For example, a 

blend from yellow to cyan runs yellow-green-cyan. (This option has no effect 
when the two colors are black, white or gray.) 

• ALT RAINBOW: Similar to rainbow except the blend is along the longest edge of the 
color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan. 

The HSV color wheel is described in Color handling (on page 159). This menu is 
identical to the fill effect menu in the Fill Tool. 

Viewing blends as outlines 
WINDOW -> QUALITY controls how blends are displayed: 

• At OUTLINE only the start and end objects appear. The intermediate objects are 
not drawn. 

• At OUTLINE WITH BLEND STEPS start, end and intermediate objects are drawn as 
outline. 

• At FULL COLOR the outlines and fill colors of the intermediate objects are drawn. 
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• At HIGH & VERY HIGH QUALITY all the information is shown anti-aliased if the ANTI-
ALIAS button (described above) is active. If not, the intermediate steps are not 
anti-aliased. 

 

With the view quality slider in the second position you can see all the intermediate steps of a 
blend as outlines. 

Removing blends 
Removing a standard blend 
Select the blend, then click REMOVE on the BLEND Tool InfoBar. 

Removing blend from a curve 
Select the blend, then deselect the BLEND ALONG A CURVE button. 
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Photo Handling 

Introduction 
Photos are an integral part of almost all creative work nowadays, from websites, to 
flyers, brochures, DTP work and more. 

Photo handling in Page & Layout Designer is very different than you may be used to 
with other graphics programs. 

In MAGIX Page & Layout Designer 2013 you can color, crop, copy, blend, enhance, 
clone, feather (fade the edges of) photos as much as you like. The object oriented, 
non-destructive nature of the photo handling means that, for example, when you 
resize a photo, you are not really altering the original photo, but just resizing a visual 
copy. The original imported image is saved in the .xar file, so that you can later edit, 
and resize again, or apply any of the Photo Tool editing options, with no loss of 
quality.  You can even un-crop cropped photos. 

The photo handling is astonishingly fast. You can open a 50 Megapixel photo, and 
perform any of the enhance operations, and rotate the full resolution image in real-
time. 

This chapter covers the basic principles of manipulating photos and bitmap images in 
MAGIX Page & Layout Designer 2013. The operation of the Photo Tool is covered in 
the separate Photo Tool chapter. 

*Benchmarks based on photo compositions created with multiple hi-res JPG digital photos 

Photo Objects 
In Page & Layout Designer photos (or bitmaps) are just another type of object on the 
page. You can drag and drop photos onto the page from your file explorer, and then 
you can resize, rotate, copy and move them around just like any other object. 
Importantly you can adjust the transparency, even graduated transparency, feather 
edges and clip and cut shapes out of photos with ease. The transparency feature lets 
you blend, merge or create composite photos. 

Where you might have to use layers in other photo tools, every object in MAGIX Page 
& Layout Designer 2013 is on its own layer and, just as with any object on the page, 
you can move it forward to be in front, or backwards to be behind other objects. 

Photo Groups 
If you edit a photo using some tools such as the integrated Red Eye tool or Clone Tool, 
the photo becomes grouped with other objects that modify the image in some way. 
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For example with the Red Eye tool, the ellipse shapes that are used to modify the red 
eye areas of the photo are grouped with the photo itself. This is called a PHOTO GROUP 
and you’ll see this on the status line when you select such a modified photo.  

Just like an ordinary group it keeps the photo together with the other objects that 
have been added to modify it, but unlike a group it is still treated as if it was an 
ordinary photo by the Photo Tools and other tools. Normally photo groups are 
automatically placed inside a clipview object, which clips any objects which overlap 
the edge of the photo, to the boundaries of the photo itself. That’s why when you 
select a photo group the status line usually shows you have a "Clipped photo group" 
selected. 

Differences between Photo Groups and Photos: 

• Photo Groups collect together a simple photo and some vector edits. 
• You can push a photo around in its clipping shape within the Fill Tool but you 

can't do quite the same thing with Photo Groups (either select inside and move 
the base photo, or use the right click context menu to select the clipped objects 
and then drag them in the selector tool). 

• Some operations will convert Photo Groups to photos. 

If you want to convert a Photo Group into an ordinary photo object, you can use 
UTILITIES->OPTIMIZE PHOTO. But note that this is destructive in that thereafter you will 
not be able to modify any of the photo edits you’ve applied to the photo. Some other 
operations such as content-aware scaling and contoning also convert photo groups 
into flat photos, because these operations aren’t able to preserve the photo group 
structure. When a photo group needs to be converted in this way a warning alert is 
shown first.  

Importing Photos 
MAGIX Page & Layout Designer 2013 supports a very wide range of photo or bitmap 
types including JPEG, PNG, TIFF and RAW digital camera images, as well as many 
more types. The term "bitmap" is the general term encompassing all types, but 
interchangeable with the word "photo". 
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The easiest way to open an image is to drag the photo or bitmap file from your 
Windows file explorer onto the Page & Layout Designer Window. The photo is 
imported at the position you drop it. Or you can select the FILE -> OPEN or IMPORT 
menu options. 

You can select multiple photo files in the file dialog by clicking with Shift or Ctrl held 
down to add to the selection, just as in Windows Explorer, to open or import multiple 
photos. 

Optimization on import 
When importing high resolution photos (anything above 1920 pixels either wide or 
high) into a document, MAGIX Page & Layout Designer 2013 asks you if you want to 
import a lower resolution version of your photos. If your document is to include many 
photos, you may want to choose this reduced resolution option. Otherwise with large 
photos you may find that your saved design file is much bigger than it needs to be 
(because it contains a copy of each of your photos) and you may not have enough 
memory in your computer to load, edit and export your documents. 

Automatic conversion to JPEG 



 

252   

www.xara.com 

The JPEG image format is usually the best choice for photo images, because it 
maintains high quality with smaller file sizes. So when you import non-JPEG photo 
files, MAGIX Page & Layout Designer 2013 will examine the image to see if it would 
be more appropriate as a JPEG. If so, a prompt is shown giving you the option to 
convert it to JPEG on import. This reduces the size of your document files and reduces 
memory usage when editing. 

When pasting in images from the clipboard, the same analysis is done and the image 
is imported as JPEG if that’s appropriate. This is done silently with no prompts. This is 
particularly useful when copying and pasting in images from web browsers because 
although the images are often JPEGs in the web page, some browsers don’t 
communicate this to the clipboard. 

Replacing photos 
If you drag and drop a photo file (from Windows Explorer or from the Bitmap Gallery) 
onto an existing photo it will replace that photo, but keep the same container or frame 
size. This makes it very easy to replace photos on templates. You can use the Fill Tool 
to adjust the size, position and angle of the photo inside its outline.  This is not true for 
photo documents (on page 273), where dropping a photo on the page will always 
import it as a new photo document. 

When replacing a photo or bitmap this way, it is sized to best fit in the existing picture 
outline.If you hold "Shift" when replacing a photo, the new one will inherit the same 
scale and rotation as the old photo, instead of being ‘best fitted’. This is useful where 
you've manually adjusted the scale or rotation of a fill and then want to replace the 
image with another which has the same aspect ratio. 

When you drop a new photo onto a Photo Group (on page 249), the entire Photo 
Group is replaced, leaving you with a photo object showing the new image. 

Using photos as fills 
You can also use any bitmap as a fill style for any drawn shape. Simply drag the file 
over the shape (which can be from your file system, or from the Bitmap or Fill 
galleries), and hold the "Shift" key down before you drop. This will replace the existing 
color fill with a bitmap, fitted to the object.  Again you can use the FILL TOOL to adjust 
the size, angle and position. 

Initial Photo size 
When you import a photo into a document, by default if it’s bigger than 500 pixels 
wide the photo is automatically scaled down to 500 pixels. This is because it’s rarely 
useful to drop a huge digital camera photo into a drawing document and have it 
displayed at its full size, so it’s scaled down to a more manageable size. You can 
change this behavior on the VIEW tab of the UTILITIES->OPTIONS dialog: 
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You can choose a different size to which photos should be scaled, or elect for them to 
be imported at 96dpi (default screen resolution) so that at 100% zoom they are 
displayed at 1:1. Or you can choose to have photos imported at the dpi which is 
indicated in the photo file itself. Note that some digital cameras set this dpi value 
wrongly and so this third option may not always give you the results you expect. 

When importing at 96dpi each pixel of the photo takes one pixel of screen, so you're 
seeing the full resolution image when viewing at 100%.  

However because most digital photos are very high resolution, this means you may 
only see a small part of your photo, so initially MAGIX Page & Layout Designer 2013 
will automatically alter the zoom scale to zoom out so you can see the whole image.  
This also means that a typical digital photo will be far, far larger than your page size 
(your screen is probably only about 1200 pixels across, and a typical digital photo is 3 
or 4 times as wide, sometimes a lot more) 

To reduce the size, just drag a corner handle using the SELECTOR Tool, or enter a new 
width in the Selector Tool InfoBar width field. 
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Photo resolution 
One fundamental difference between MAGIX Page & Layout Designer 2013 and other 
photo tools is that when you resize a photo it retains the full resolution. Scaling an 
image to be smaller, just increases the dpi or ppi (pixels per inch). In other words no 
pixels are lost, they are just made smaller. 

 

96ppi image on the left when scaled down to half size becomes twice the resolution, 192ppi. 

The status line shows the resolution of any selected image.  Retaining the full 
resolution is important because it means you can see all the detail when you zoom in, 
and that when printing the maximum resolution is sent to the printer. Also it means 
you can enlarge all or part of the image and Page & Layout Designer retains the 
original maximum quality. 

Zero-memory Copies 
One of the most revolutionary differences between Page & Layout Designer and other 
software is that when you copy any photo on the page, it doesn't really make a 
complete new copy of the original imported photo but instead just displays another 
'view' of the original image.  Page & Layout Designer's rendering engine is fast enough 
that it can display any number of copies of the same image 'on the fly' this way. This 
saves huge amounts of memory and dramatically reduces files sizes. 

This doesn't detract or limit what you can do with each copy, and they can be treated 
as completely separate independent copies. Each copy does not have to be identical. 
You can manipulate each as required, resizing, rotating, cropping. coloring, feathering, 
or applying a wide range of photo and transparency effects. All for no memory or 
native file size increase. 
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This shows separate copies of the same image, each manipulated in a different way. 
Each retaining the full resolution of the original imported JPEG, as you can see from 
the right image. The memory (RAM and file size) is no more than the original JPEG 
size. 

The Bitmap Gallery 

The Document handling chapter (on page 64) has general information about 
galleries. 

The BITMAP GALLERY shows all the bitmaps or photos used in any document, along 
with information about its pixel size and file size.  

 
You can open it by clicking it in the Galleries bar, or from within the 
"UTILITIES" > "GALLERIES" menu, or "F11". 
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This shows the BITMAP GALLERY for the above document, and shows the original JPEG 
image of the girl which is embedded into the native .xar file. As mentioned above, all 
copies of this image are displayed directly from the one master, so only the single 
image is shown and not all four variants that appear on the page. 

The following useful information is displayed about the original image: 

• Filename of the original JPEG 
• The file type, in this case a JPEG, and the file size, 1,006K. (This is the original 

size of the file, and also how much of the .xar file will be taken up by this image.) 
• The pixel dimensions of the original, the Megapixel size (in this case just under 

2MP) 
• The color depth, in this case "24 bit" which is sometimes called true color. 
• The original resolution of the image, in these cases 96dpi 

The BITMAP GALLERY always contains a default bitmap, with the gray default image. 
This is used as the default bitmap for bitmap fills and in cases where other bitmaps 
are missing. It's useful to have as a placeholder as well. 

As with all galleries, you can drag the objects from the gallery onto the page to create 
a new copy. Or you can select an image in the gallery and click one of the buttons 
across the top. The following section details the operation of the BITMAP GALLERY 
controls, most of which are for the more advanced user. 

Filling shapes with a bitmap 
Select the shape on the page, then select the bitmap in the gallery and click the fill 
button. Alternatively drag the image from the BITMAP GALLERY and drop it onto any 
shape while holding "Shift". You can adjust the size, angle etc in the FILL TOOL. 

Setting a Bitmap Transparency 
This is for the more advanced user. You can use any bitmap as a transparency mask 
on any filled shape or bitmap. The lightness of the bitmap affects how transparent the 
selected object is. The bitmap transparency size, rotation and tiling can be controlled 
from the TRANSPARENCY TOOL (on page 222) InfoBar. 

Deleting images from the Gallery 
When you delete a bitmap from the page, it remains in the BITMAP GALLERY. Any 
unused bitmaps will be deleted from the file when saved and re-opened.  However 
you can force the deletion of any bitmap by selecting it and pressing the DELETE 
button. If the bitmap is used in the document, it will be replaced by the standard X 
bitmap. 

Setting the page background to a bitmap 
Select the bitmap in the gallery and click the BACKGROUND button. This will tile the 
image. When exporting the page as HTML, this image is tiled across the whole visible 
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page background of the browser, unless you’ve also given the pasteboard (the area 
around the page) a different background. 

Save 
Select the bitmap and click SAVE will save the original image. In the case of an 
embedded JPEG this will save the original JPEG file.  Other bitmap types are best 
saved as PNG bitmap type. 

Bitmap Properties 
The PROPERTIES button will display information about the selected bitmap in the 
gallery. It also provides a way to stop image smoothing when bitmaps are enlarged. 
Usually all bitmaps are smoothed when enlarged, or zoomed into, on screen. There is 
a check-box option in the Properties dialog to turn this feature off, so that individual 
pixels are visible when you zoom in.  

Note that this option only affects scaled up bitmaps. Note also that NEVER SMOOTH 
in the VIEW tab of the OPTIONS dialog box overrides this check box. 

It also provides information about the Animation properties of the bitmap. This is only 
really applicable to animated GIF images 

GIF ANIMATION:  

• DELAY (the time this frame is left on screen) 
• RESTORE: The Animated GIF Restore setting sets what happens between each 

frame in an animated GIF. Nothing means no action is taken. Many browsers take 
this as meaning the same as the Leave As Is option. Leave As Is displays the 
frames one on top of another - this leaves many frames visible in a stack if some 
are transparent. Some browsers clear the animation before it loops again, some 
do not. Background restores the area covered by the graphic to the background 
color of the GIF (usually white). Restore Previous restores the area covered by 
the frame to what it was before the frame was displayed. This is interpreted by 
some browsers to mean that the frame should be cleared to the background 
before each frame is displayed and by others to mean that the frame should be 
shown on top of the previous frame. As browsers interpret these values in 
different ways, you may need to experiment to achieve the desired result. 

Embedded JPEG files 
JPEG files are hugely compressed from their original state, being up to 10 times 
smaller than the original uncompressed image.  In the above example, the original 
uncompressed image requires more than 7mb of memory, but as the BITMAP GALLERY 
shows, this JPEG file is only 1mb. A very significant reduction. This is why JPEG 
images are the standard file type for digital photography and use on the web. 
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When you drag and drop a JPEG file (or use the "Open" or "Import" menu options) 
the JPEG (reduced in size if it was large) is stored in the document, and this is what is 
saved in the .xar file when you save your document. 

It's important to understand how this differs from other graphics tools, both vector 
drawing software and photo editing programs. Other products will typically un-
compress the image and store the un-compressed "raw" image in memory and the 
native file when you save to disc. What's more each copy you make is typically a 
complete copy of the original raw image, as mentioned above. Make four copies of 
your photo and save your file - it will be four times larger. In MAGIX Page & Layout 
Designer 2013 the file is no larger, no matter how many copies you make. 

So by embedding the JPEG file instead of saving the un-compressed image, that's a 
file size saving of more than 7:1 compared to other graphics editors. The fact that 
there are four complete copies of the image means that in this particular case the 
memory used is more like 30 times less. So this represents a huge file size (and time) 
saving over other graphics tools*. 

*This is easy to test. Import a JPEG into your favourite graphics editor, make four copies, perhaps 
change each one slightly, to be colored or blurred or rotated. Then save the native file and 
compare it against the original JPEG size, and the equivalent .Xar file. A .Xar native file is about 
the size of the original JPEG, no matter how many copies of the image are made. 

Extracting the original JPEG 
Right click on any image in the BITMAP GALLERY and select the SAVE menu option to 
save the original JPEG back to your file system. 

Blending & Merging photos 
By making copies of photos on top of each other, and applying different effects to the 
copies, combined with Page & Layout Designer's advanced transparency controls, you 
can easily create blended photo compositions. For example to selectively blur parts of 
a photo takes a few seconds. 
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By placing the blurred copy with the 'hole' created by the transparency effect over the 
sharp original, the blended result shows the sharp face area through. 

 

Creating copies of any object requires a single key press, or click (drag with right 
mouse button). Blurring a photo takes a single drag on a blur slider of the PHOTO 
TOOL, applying a gradated transparency is just another click-drag in the 
TRANSPARENCY TOOL, and finally positioning the photos on top of each other takes a 
second. So the whole process takes a few clicks, drags and just a few seconds in 
MAGIX Page & Layout Designer 2013. 

Photo display quality 
MAGIX Page & Layout Designer 2013 can display photos in one of five useful quality 
levels. The top two settings smooth the screen pixels so avoiding visible pixels or 
rough sections along the edges (anti-aliasing). Change the quality level using the 
QUALITY entry in the WINDOW menu. 

VERY HIGH 
QUALITY 
(DEFAULT)   

Displays images using bicubic sampling. This displays images at 
the best quality, particularly for large hi-res images that are scaled 
down or zoomed out a lot. 

HIGH QUALITY Anti-aliasing on, but images are rendered faster and at lower 
quality. 

FULL COLOR No anti-aliasing, thus showing individual pixels. This can be useful 
when you're zoomed in and you need to clearly see the separate 
image pixels.  The downside is that images generally look poor 
when reduced or enlarged resulting in clearly visible pixelation and 
jagged "staircase" edges, especially if you rotate the image. 

OUTLINE WITH 
BLEND STEPS 

Is particularly useful for seeing outlines of the various steps of a 
blend. Blends are not supported in MAGIX Page & Layout 
Designer 2013 but imported .xar files could contain blends. 

OUTLINE  Only object outlines are shown. This is useful for finding and 
selecting objects that are difficult to see due to other objects in 
front of or behind them. 
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There is an additional control that allows you to stop all image smoothing or anti-
aliasing on images that are scaled up or zoomed in. In other words, instead of a 
smoothed image, you see all the pixels when zoomed in. Open the BITMAP GALLERY 
and right click on the image and select "properties". In the dialog un-check the 
"Smooth when scaled up" option. Now, no matter what viewing quality you select the 
image (and all copies) will always show the un-smoothed pixels when enlarged or 
zoomed in. 

Note: If you use the PHOTO TOOL sharpen / blur control then images have to be 
displayed at maximum quality. So if you think the viewing quality has stopped 
working, it's almost certainly because you have sharpened or blurred the image with 
the PHOTO TOOL. 

Saving & Exporting Photos 
Selecting the SAVE option will always save a native .xar file file (unless you’re editing a 
Photo document – see Photo Document section below). To save a photo as a JPEG, 
PNG or other image file type, it's necessary to use the EXPORT option, or the shortcut 
"Ctrl + Shift + E". 

You may select from a very wide range of file types, such as JPEG, PNG, GIF, TIFF, 
PDF, PSD, Flash (.swf), BMP, as well as other lesser well known types. 

  
There are two icons available on the top bar that are short-cuts to save 
the selection as JPG or PNG. These are in the flyout bar shown when 
you move the mouse pointer over the Export HTML icon. 

For photos we recommend saving as JPEG (sometimes called JPG) as this offers the 
greatest compatibility and the best size / quality compromise. 

When you export a JPEG or PNG, there is a SETTINGS option on the Save Dialog. 
Selecting this provides many advanced export options, as well as compare side-by-
side alternative settings or even alternative file types such as PNG. 

When you export a JPEG, an export preview dialog is shown where you can adjust 
many export options, as well as compare side-by-side alternative settings or even 
alternative file types such as PNG. 

The Export Preview dialog allows you to adjust the size, resolution, JPEG quality and 
even select from 3 alternative export file types if you so wish. The default values 
should be fine for all normal purposes and you can just click the export button to save 
your photo. 

Things to remember when exporting: 

• First select the object or objects you want to export 



 

Photo Handling 261  

 

• The default exported size of the image will be the size you see on screen at 100% 
zoom. 

The Export Preview dialog (on page 333) is described in more detail here. 

Tip: You can control the JPEG quality in the Export Settings dialog on the Options 
tab. The default and recommended value is 85% 

The JPEG system is designed that a setting of 
85 is the optimum value. We recommend you 
do not save JPEGs at 100% quality, as the 
results are visually identical to the 85% 
quality, only the file size and memory use is 
dramatically increased with no benefit.   
 

When saving for use on the web it's quite possible to reduce the quality below 85 to 
increase page view speed. The preview window shows the quality of any value you 
select. 

Tip: If you expect you may want to perform any further edits on your exported image, 
for example to create the image again at another size, we strongly recommend saving 
the .xar file as well. This will preserve the lossless master image along with all its edits 
and changes. 

Example: To resize a photo and save as a new JPEG 
This process is very quick and simple: 

• Drop your photo onto MAGIX Page & Layout Designer 2013 (either onto a blank 
page or onto the title bar to create a new document) 

• In the Selector Tool either drag a corner handle to resize the image, or enter the 
required width or height into the "W" or "H" field on the InfoBar. Check the image 
size is correct at 100% 

• Type "Ctrl + Shift + E" to start the export process 
• Enter a filename, and ensure JPEG is selected from the file type dropdown 
• In the preview dialog simply click the export button 

To save any image as a PNG go through the same process except choose the PNG file 
type. 

Photo Edit Attributes 
All edits performed using the PHOTO TOOL (on page 276), such as any altering of the 
brightness, contrast, color, blur or sharpen values, or even the more advanced levels 
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adjustment, are all just stored on the photo as attributes. See the terminology section 
(on page 13).  

Just as you can alter the color of a shape or line without altering the underlying shape, 
so Photo Tool attributes alter the visible appearance of the photo without affecting 
the original image (this is called non-destructive editing).  Another way of looking at 
this is that MAGIX Page & Layout Designer 2013 just stores a list of edits applied to 
your photo, and you can change, remove or add new edits. You can always recover 
the original untouched photo, even after the brightness, resizing, even clipping or 
cropping. 

Attributes can be copied and pasted between objects. Not only does this apply to 
traditional attributes such as line color and thickness, it also works with all the PHOTO 
TOOL attributes including the LEVELS settings. So this means you can easily copy all 
the enhancements made on one photo to any other using the copy / paste attribute 
feature. For example to apply the same white balance adjustment (made using the 
levels control) to another photo, just copy the edited photo to the clipboard and then 
select the "EDIT -> PASTE ATTRIBUTES" menu on any image to which you want to 
apply the same corrections. 

This also applies to some other attributes of the photo, such as line width and 
shadows, etc.; all these can be copied from one photo to another using the same 
technique.  

Editing the outline of Photos 
You can use the SHAPE EDITOR TOOL to directly adjust the outline shape of a photo.  
Similarly you can apply outlines the same way as for any shape, and shadow, etc. 

 

Using the SHAPE EDITOR TOOL you can push or 
pull on the sides. This example also has a black 
outline and soft shadow added. To restore the 
image back to its original rectangular shape, 
select the "Un-clip"  in the clip mode of the 
PHOTO TOOL InfoBar. 
When photos are edited this way, they are treated 
like any normal vector shape, containing a bitmap 
fill. This is why you can use the normal line and 
shape editing features, and indeed you can use 
the FILL TOOL to adjust the size, angle and position 
of the photo "fill" inside the shape. 
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Cropping photos 

 
The easiest way to crop a photo is to just drag 
on it when in the ENHANCE TOOL, or you can just 
drag one of the 8 control handles around the 
outside to adjust the edge of any selected photo.

 

 
For more advanced cropping control, select the CLIP BUTTON on the PHOTO 
TOOL flyout bar which provides aspect ratio control and precise numeric 
clipping control.  

This also provides an Un-clip button that will remove any clip rectangle and restore 
the original image. 

One important feature is that this crop feature is really a dynamic clip, in other words 
it's a non-destructive crop, and you can adjust the crop boundary afterwards to reveal 
hidden parts of the photo.  If you want to really crop - i.e. make this a destructive crop, 
that really removes the invisible parts of an image then use the Optimize Photo 
feature. 

Screenshots 
In combination with a built-in screen capture feature you can easily capture and 
create screen shots.You can either use the SCREEN CAPTURE UTILITY which is included 
in MAGIX Page & Layout Designer 2013 or use the screenshot capability built into 
Windows. 

Using Windows to capture screenshots 
• Press the "Print screen" button on your keyboard. This places a screen capture of 

the whole screen on the clipboard. Alternatively, select "Alt + Print screen" which 
will capture just the current window. 

• In MAGIX Page & Layout Designer 2013 select "Ctrl + V" to paste, and select 
"Bitmap" to have the results pasted onto the page. 

You can now crop, add text annotation, resize as required and save the results. It's 
best to save this type of image as a PNG file.  

Screen capture utility 
This utility offers some advantages over the method above, including the option to 
capture the mouse pointer in the image. Open it by choosing UTILITIES  > SCREEN 
CAPTURE.  
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SCREEN AREA:  Here you can choose the screen area you would like to capture. You 
can capture the full screen, the active window in its entirety, or just the content of the 
active window without the window border. 

OPTIONS: Here you can choose whether or not the mouse pointer is included in the 
screenshot. Also choose whether you just want to capture one screenshot or whether 
to keep the utility turned on for the session so you can take successive shots each 
time you press the assigned key shortcut.  

The output section lets you choose how to handle the captured screen image. By 
default it will be directly inserted into the current MAGIX Page & Layout Designer 
2013 design. Alternatively you can also save a BMP (Windows Bitmap) or PNG file for 
each screenshot into any folder. The files created are named "ScreenCapture", 
"ScreenCapture1", "ScreenCapture2", etc. Choose the TARGET FOLDER for the files 
using the BROWSE... button. 

You can define almost any hot-key combination (Shift, Alt, Ctrl + key) to trigger the 
screenshot. Just click in the key shortcut field and then press the desired key 
combination, e.g. “Ctrl+S”. The chosen shortcut appears in the key shortcut field. If it 
clashes with any defined Page & Layout Designer shortcut, you'll be warned with a 
message appearing at the bottom of the dialog, but this doesn’t matter if you will have 
other windows active when taking the screenshots. Press RESTORE to return to the 
previous selected shortcut. 
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Instead of using a shortcut key to take the screenshot, you can instead use the TIME 
option. This is useful in cases where any keyboard activity can change the display you 
want to capture, such as a pop-up tooltip which may disappear if you were to press a 
key. Select the time option and enter a delay value in seconds. The screenshot will 
then be taken for you automatically once the specified period of time has elapsed. The 
timer starts as soon as you click the START button. 

Pressing the START button closes the Screen capture dialog and activates the system-
wide hotkey. Switch to the window you want to capture and press the chosen key 
combination, or wait for the chosen time period to elapse if the timer option was 
chosen. The screenshot is taken and inserted into Page & Layout Designer or saved to 
file, depending on the option chosen. If you selected the “Capture always” option you 
can take additional screenshots by pressing the key combination again (this is 
unavailable with the timer option). To deactivate the utility if you chose this option, 
close down MAGIX Page & Layout Designer 2013 to end the session. Alternatively 
return to the Screenshot dialog, choose the “once only” option and take one more 
screenshot. 

Coloring photos 
With any photo selected just click on the Color Line to apply a color to any photo. 
Clicking the white color patch will turn the image black and white. Technically this is 
called a "contone" (it's a continuous tone from black to white), or sometimes a 
"duotone". 

Simply click a pale yellow color on the color line to create a yellow contone picture. 

Or, right click on the Color Line which shows a context menu for you to apply the 
selected color as either the light or dark color. 

 

You can also use the color 
editor to select any color 
as either the light or dark 
contone colour. Right click 
the photo and choose 
CONTONE > LIGHT to 
display the color editor 
("Ctrl + E"). Select the 
light or dark contone from 
the dropdown menu at the 
top of the color editor. 

You can restore the original color of a photo by clicking the cross-hatched "no color" 
patch on the left of the Color Line, or right clicking on it and selecting the "Restore 
color" option. 
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Integration with external Photo Editors 
While MAGIX Page & Layout Designer 2013 provides a great many photo editing and 
compositing features, it is not a "pixel editor", and for these purposes you may want 
to use a separate program. MAGIX Page & Layout Designer 2013 makes integration 
with these easy. You can configure any external program to be launched when you 
double click a photo  while in the Photo Tool, and after editing, for the photo to 
automatically be transferred back into your Page & Layout Designer document. 

Double clicking a photo when you are not in the Photo Tool, selects the Photo Tool so 
you can edit the photo using MAGIX Page & Layout Designer 2013’s integrated 
editing features. Double click the photo while in the Photo Tool to invoke the external 
editor. 

To choose an external editor, select the PHOTO EDITING tab in the Options dialog. 

 

XPE is a basic picture editor. Most of its functionality is now provided by the Photo 
Tool directly and so this tool provides little benefit. It's here mostly for back 
compatibility reasons. 

Alternatively, if you select the "Edit bitmap with this program" option and browse to 
select an external program, then this can be launched by double clicking on any image 
when in the Photo tool (you will probably need to browse to your program files folder 
on your local hard drive and select the program executable .exe file). 

It should be understood that images transferred to and from external editors are 
transferred as uncompressed images (to avoid compression / decompression cycles) 
and so this will increase the file size of your .xar file. 

When editing a photo in a separate program in this manner, you can carry on using 
MAGIX Page & Layout Designer 2013 as normal. Each time you save the image from 
the photo editor (or just close the program and click the Save option) MAGIX Page & 
Layout Designer 2013 will automatically pick up the changed version and replace the 
original image. This means you can just continue editing the photo in the external 
program, and to see how this looks in context in your Page & Layout Designer 
document, just click "Ctrl + S" (or whatever the normal saving shortcut in your photo 
editing software). 
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Note: MAGIX Page & Layout Designer 2013 always sends the original un-clipped 
whole photo to the external editor. Any images that are enhanced (e.g. brightness 
altered) or clipped with the photo clip, or have any live effects applied, will have 
these changes missing when you edit them this way. However, when the edited 
image is returned, the clip and photo attributes are re-applied to the edited image.  
For this reason, it's not recommended that you alter the size or crop images in an 
external editor. 

You can, of course, Undo any external edits you've applied by using the usual Page & 
Layout Designer Undo feature (it always stores a copy of the 'before' image). 
However when you save and re-open the .xar file all Undo information is lost. 

Editing images this way is a destructive edit. i.e. the image is permanently altered by 
the external Photo Editing Tool, and the original cannot be recovered once the file has 
been saved and closed. 

Resize, rotate and position a photo within its 
frame 
Photos in MAGIX Page & Layout Designer 2013 are treated like a "bitmap filled" 
rectangle. The shape of your photo is really a fully editable outline around the image 
contained inside.  So when you crop, or edit the outline shape, you're not affecting the 
fill, which is clipped inside the shape. 

Photos and bitmaps on the page are always contained within an outline shape. Not 
only can you change the shape of the outline, you can also adjust the size, angle and 
position of the photo within its frame using the FILL TOOL. Just select the photo, go 
into the FILL TOOL and you will see fill arrows at right angles from the center (or you 
can go into FILL TOOL, and click on the photo to select). 

 

For example, to enlarge and rotate the image on the left inside its frame, select the 
FILL TOOL and drag on one of the arrowheads. 
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• To resize drag on one of the arrow heads away from the center. You can hold 
"Ctrl" to constrain the angle. 

• To rotate the image, drag one of the arrowheads around the center. 
• To re-position the image, drag anywhere on the image. 

On the InfoBar of the FILL TOOL, you can select the 
"repeating tile" option which makes the image a tiling 
bitmap fill. By dragging the fill handles you can now 
resize and rotate the image tile dimension. There is no 
better demonstration of the speed of MAGIX Page & 
Layout Designer 2013 than to do this with a huge 
multi-megapixel image. 

If you have a Photo Group instead of just an ordinary photo object you can’t use the 
FILL TOOL as described above to scale and rotate the image in its frame. If you want to 
convert a Photo Group into an ordinary photo object so you can adjust it using the FILL 
TOOL, you can use "UTILITIES" > "OPTIMIZE PHOTO" to do this. But note that this is 
destructive in that thereafter you will not be able to modify any of the photo edits 
you’ve applied to the photo. 

Horizon Straighten 
Using the FILL TOOL, as previously described, means it's easy to straighten the horizon 
of an askew picture. 

• Select the Fill Tool and click on any photo. This will show the fill handles, which 
are arrows showing the extent of the fill inside the shape. 

• Drag on the end of one of the fill arrows to resize, and rotate as required. 

The following shows a landscape (created using the panorama stitching feature of 
Page & Layout Designer) that has a sloping horizon. 
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In the FILL TOOL, drag on one of the arrowheads to rotate and resize as required. You 
can re-position the photo by dragging on the center handle of the fill arrows, or 
holding "Shift" and pushing anywhere on the image. 

Viewing a scaled photo at its full size 
The ZOOM TO 1:1 button on the PHOTO TOOL infobar adjusts the zoom so that the 
selected image is shown at full size, which is where each pixel of the image is mapped 
to each screen pixel. This is useful if you want to edit an image that’s been scaled 
down on the page, but want to see it at its full size while you work on it. 

Making a photo its full size 
The SCALE PHOTO TO 100% button on the PHOTO TOOL infobar takes the currently 
selected photo and scales it to its full size on the page. So for example if the selected 
photo is scaled down to 500 pixels wide, but the original imported photo was 1000 
pixels wide, the photo on the page will be scaled up to 1000 pixels wide. When the 
document zoom is 100%, that means that each pixel of the image is mapped to each 
screen pixel. 
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Optimizing Photos and Bitmaps 
With the ever increasing resolution and file size of digital camera JPEGs, if you have a 
document containing many images, the file size can quickly become very large. For 
example, a multi-page document containing 20 full resolution JPEGs, each of 5mb, 
would produce a .xar file of over 100mb*. 

Furthermore, these photos are often unnecessarily high resolution. Reducing a photo 
from a 8 megapixel digital camera to be 2 inches (5 cm) wide on the page will result 
in this image being around 1500 dpi.  Whilst a very high resolution image gives 
greater flexibility for printing (and you can zoom in, or enlarge small parts of the 
photo), this is far higher than required for even the best quality commercial printing, 
and even more so for web graphics or HTML production. 

If you clip to a small part of the image, or cut-out only a small part of your photos, 
there could be large parts of hidden image outside the visible area. For editing 
purposes this "live crop" is a great feature, as you can un-crop, alter the size, position 
and scale and everything remains as sharp as possible. But for finished documents 
you may want to remove the invisible parts. 

 

The cut-out butterfly image still has the rest of the photo attached. If you go into the 
FILL TOOL you can easily see this by resizing the fill inside the outline. So the parts of 
the image outside the butterfly will probably be superfluous in your final document. 

Right click a photo and choose OPTIMIZE PHOTO or choose "UTILITIES" > "OPTIMIZE 
PHOTO..".. This dialog performs three important functions: 
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• Removing invisible parts of photos 
• Reducing resolution of photos 
• Converting PNG or bitmaps to embedded JPEGs to optimize file size 

Selecting this menu option for any bitmap will display the OPTIMIZE PHOTO dialog. 

 

By default for JPEG images the settings are such that the photo will be optimized to a 
96dpi (normal screen resolution) JPEG at the size that it appears on your page. This is 
normally what you will want for photos in a website. 

When optimizing non-JPEG images, Page & Layout Designer will automatically decide 
whether it’s best to optimize to a PNG or JPEG, depending on the nature of the image 
itself. 

You can click the SETTINGS button on this dialog, if you want to change any settings 
such as the image format used for the optimization, JPEG quality, etc. 
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You can change the resolution used in this dialog, by either choosing the physical size 
you want for the optimized image (width/height in pixels), or by entering a different 
dpi (eg. perhaps 150dpi if you want print quality). 

If you choose the dpi option the value you enter is remembered and becomes the 
default just for the current session. You can also maintain the photo's current 
resolution by choosing CURRENT from the PPI list. 

You can also choose to optimize as a PNG (produces much larger images, but better 
quality for graphics and text images) or change the quality used for JPEG optimization 
(higher quality means larger JPEG sizes). 

If your photo is cropped, only the visible part of the image is preserved in the 
optimized image. 

For printing, a photo resolution of 150dpi gives very good results, whilst 300 dpi will 
provide the highest quality commercial printing (most people cannot tell the 
difference between 150dpi and 300dpi, but the 300dpi requires four times as much 
memory or file space). 

Note: The optimum JPEG quality is 85%.WE DO NOT recommend saving JPEGs 
with a quality at 100% - they are virtually indistinguishable from JPEGs saved at 
85%, but use considerably more memory and file space.  

Warning: "OPTIMIZE PHOTO" is a "destructive" operation. When you save the file the 
parts of the image removed are lost, and the resolution changed permanently (you 
can of course undo the changes while the file is open for editing). 

You can optimize multiple photos at once if you want them to all have the same DPI. 
Select the photos you want to optimize and then choose the OPTIMIZE operation as 
described above.  If your photos have different dimensions, the option to optimize by 
pixel size is disabled and you must just choose the required dpi.  

Or you can use the "UTILITIES" > "OPTIMIZE ALL IMAGES" facility to optimize all the 
bitmap images in your document in one operation. 

The optimization process will convert large non-JPEG images to smaller JPEG images 
if it decides that the image can be stored and exported as a JPEG without an 
unacceptable loss in quality. 

Note that after optimizing the original unoptimized and now unreferenced photo 
remains in the BITMAP GALLERY. This means it is still in memory and so the memory 
requirements of your design will not have been reduced. Simply save your design and 
reload after optimizing, to eliminate the original large images. 
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Converting objects or drawings to bitmaps 
You can easily create a bitmap from any object, or part of your drawing, including 
from other bitmaps. The bitmaps can be any size or resolution and can contain 
transparency. You can also create bitmaps with reduced numbers of colors which can 
be useful for web use. 

To create a bitmap from objects: 

1. Select the object/s on the page. 
2. Right click and choose CREATE BITMAP COPY or choose CREATE BITMAP COPY 

from the ARRANGE menu ("Ctrl + Shift + C"). 
3. In the dialog box, select the color depth, the size and other options. 

For maximum quality select a color depth of true color, or if you want transparency to 
be included select "true color + alpha" (alpha transparency is the technical term).  
You can create bitmaps with fewer colors by selecting a color depth of 256 colors or 
less. This also provides control over the dithering and palette options. These options 
are described in the section on exporting bitmaps (on page 333). 

Note this always creates PNG images, which are the highest quality image type. 
However for full color photo purposes, these require a lot of memory and file space. 
Use the optimize photo option to convert PNG images into embedded JPEG images 
to reduce the file size. 

Photo Documents 
Sometimes it's useful to work on one photo alone, rather than as "objects on a page". 
This is called a photo document or "photo mode" in Page & Layout Designer, and it 
behaves more like a traditional photo editor. You can create a photo document in a 
number of ways: 

• Drag a photo file from your file explorer onto the title bar or toolbar of Page & 
Layout Designer 

• Select "FILE" > "OPEN" and select a photo file 
• Create a blank photo document by selecting "FILE" > "NEW" > "BLANK PHOTO" 

Photo documents are characterized by the following behavior differences compared 
to traditional Page & Layout Designer documents: 

• There is no visible white page. In fact the page dimensions are set automatically 
to match the photo plus any other objects you've added. 

• Photo documents have a 1 pixel grid by default and snap to grid is turned on. This 
makes it easier to get pixel-accurate crop or clip regions. 
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• The Pasteboard (the area around the photo) is a darker color. This makes it easy 
to distinguish at a glance between photo documents and drawing documents. 

• The document zoom is set so that the photo fills the view and the PHOTO TOOL is 
automatically selected as the current tool. 

• Dropping additional photo files on top of an existing photo just adds a new photo 
to the document instead of replacing the photo in its frame.  And the view will 
zoom out so you can see the whole image. 

• Images are not resized to be 500 pixels on import as they are in normal 
documents, but are imported at 1:1, so that at 100% zoom you're seeing the 
image at full size. 

• The pixel smoothing options are altered. By default it selects the "Very high 
quality" display mode, which is best for images scaled down or zoomed out. It 
also has pixel smoothing turned off when zooming in, so you can see the pixels 
are very large zoom factors. 

• If you’ve opened a JPEG photo file as a photo document, when you save changes 
your JPEG file will be overwritten. See Editing Photo Files below for details. 

In all other respects Photo Documents behave like normal MAGIX Page & Layout 
Designer 2013 documents. You can use all the normal drawing and text tools as usual.  
If you want to create a photo document of a given size, you can alter the "canvas" or 
page size by selecting "UTILITIES" > "OPTIONS" and the "PAGE" tab and entering the 
required dimensions. 

 

In Photo Documents two extra controls become enabled. The PREVIOUS and NEXT 
button will move onto the Previous or Next image in the folder from which this image 
was opened. This will close the current image, so you may be prompted to save the 
file. 

Editing Photo Files 
You can use MAGIX Page & Layout Designer 2013 to easily edit your JPEG photos 
and save back the modified JPEG. And unlike with most photo editors, you can do this 
multiple times without loss of quality, even though the JPEG format is a lossy format. 
That’s becauseMAGIX Page & Layout Designer 2013 is able to save your edits in a 
lossless way, along with the original photo. Here’s how it works. 

First open the JPEG, using "FILE" > "OPEN", drag and drop, or in Windows File Explorer 
right click and choose MAGIX Page & Layout Designer 2013 from the "open with" list. 
The photo is opened as a Photo document. 

Edit the photo using the photo tools as described above. 
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If you then do "FILE" > "SAVE" ("Ctrl + S"), the JPEG file you loaded will be overwritten 
with the modified image. However by default MAGIX Page & Layout Designer 2013 
also saves your photo in its native .xar format. This file is placed into a "Masters" 
folder alongside your JPEG file. It has the same name as your photo file but with a .xar 
extension. The .xar file includes within it your original photo without the modifications 
applied, and of course details of your edits. 

In future if you load the modified JPEG file in order to edit it further, MAGIX Page & 
Layout Designer 2013 will look in the Masters folder to see if there is a .xar file 
available for that photo. If so, the .xar file is loaded instead of the JPEG file and you 
can continue editing from where you left off. When you next save, the JPEG file is 
again overwritten and an updated .xar file also saved into the Masters folder. 

Of course if you don’t want to overwrite your original JPEG file with your changes, you 
can use "FILE" > "SAVE AS", to save the modified photo elsewhere, or use the many 
export facilities to export your photo into different formats.  

You can get hold of the original photo from the .xar file by opening it, opening the 
BITMAP GALLERY, right clicking on the photo and choosing the SAVE option. 

In the Photo Editing tab of the "UTILITIES" > "OPTIONS" dialog you can choose to 
change the saving behavior described above. You can choose to not have a .xar file 
automatically saved for you into the Masters sub-folder, or you can choose to have 
the original photo file saved there instead. 

Note if you turn off this original photo preservation, you'll lose the original photo 
when you do a Save! 
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The Photo Tools 

Using the Photo Tools 

 
To access the PHOTO TOOLS, move your mouse pointer over the Camera icon 
in the main toolbar on the left of the window. A flyout bar appears with icons 
for each of the available photo tools. 

 

If you’re in the Selector Tool a double click on a photo will switch into the PHOTO 
TOOL. 

Common photo functions 
The following buttons are available on the infoBar when you are in the ENHANCE or 
CLIP photo tools.  

 

Rotate by 90° controls 

 

The two rotate icons will rotate the selected photo or photos by 90 degrees anti-
clockwise or clockwise. 

Previous & Next 

 

When you 'open' a photo using MAGIX Page & Layout Designer 2013 the photo is 
loaded into a new Photo Document, because Page & Layout Designer assumes you 
want to edit or view the photo itself rather than use it as part of a drawing or other 
document. When you've opened a photo you can use the 'Previous' and 'Next' 
buttons on the PHOTO TOOL infobar to close the current photo document and open 
the next (or previous) photo in the same folder as the current photo.  This allows you 
to browse through the photos in a folder, without having to open and close each one 
individually. If you've made any unsaved changes to the photo you'll be asked if you 
want to save the changes when you press previous or next. 

See Photo Handling for more information on Photo Documents. 
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Zoom 1:1 

 
Select a photo and click the Zoom 1:1 button. 

The ZOOM TO 1:1 adjusts the zoom so that the selected image is shown at full size, 
which is where each pixel of the image is mapped to each screen pixel. Use this 
option if you want to work on a photo at full size in a document where you have 
scaled the photo down. 

Scale photo to 100% 

 
The SCALE PHOTO TO 100% operation takes the currently selected photo and 
scales it to its full size. It also puts the photo onto the pixel grid. 

So for example if the selected photo is scaled down to 500 pixels wide, but the 
original imported photo was 1000 pixels wide, the photo on the page will be scaled up 
to 1000 pixels wide. When the document zoom is 100%, that means that each pixel 
of the image is mapped to each screen pixel. 

Enhance Tool 

 
Click the Camera icon to enter the ENHANCE TOOL. 

The Photo Tool provides a direct and very fast way of cropping, adjusting the 
brightness levels and sharpening photos, even for ultra high-resolution images. This 
tool provides: 

• One-click auto-enhance your photos; this is particularly good for dull, 
underexposed images. 

• Manually adjust the brightness, contrast, color saturation, hue and blur or 
sharpness of photos. 

• Crop images. This is "live crop" so you can un-crop and adjust the crop at any 
time. 

• Display a brightness levels histogram of your photo. 
• Adjust the brightness levels curve for more advanced levels control. 
• Correct color casts or white balance. 
• A single-click "Compare" function to quickly compare changes against the 

original. 
• Easy copy / paste all photo enhance edits between different images. 

All these operations are interactive with live update. As you adjust the values, the 
image is updated instantly. They are also all non-destructive, meaning that your 
original image is not altered and you can always adjust or remove any adjustment. 
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The first six InfoBar buttons to the left (not shown above) are common to all tools and are 
described above 

 Auto-Enhance 

 Brightness 

 Contrast 

 Color Saturation 

 Color Temperature 

 Hue 

 Blur / Sharpen 

 Compare with original 

In this tool you can adjust brightness, contrast, saturation, temperature, hue and 
blur/sharpen. You can either enter values directly into the text fields or use a small 
pop-up slider for adjusting the values interactively. 

Pop-up slider controls 
The pop-up sliders can be used in one of two ways: 

 

1. Click and release the pop-up arrow. The slider control now remains on screen 
and you can adjust the values as many times as you like by dragging the slider 
control.  Alternatively, if the mouse is held over the control, the mouse-wheel 
can be used to make small adjustments up or down. The slider will hide when 
you click anywhere else in the document. 

2. Or you can click & hold the mouse button down, and drag over the slider bar to 
adjust the value. When you release the mouse the pop-up vanishes. This is a 
quicker more direct way, since it requires only one click & release to alter the 
values. 

Auto Enhance 
Clicking the "ENHANCE" button will analyze the overall brightness and contrast of the 
picture and automatically adjust the enhance values to obtain the best image. It is 
particularly effective with under-exposed (dark) images. After applying automatic 
enhancement to a photo you can adjust the values that were chosen, using the 
controls to the right of the "enhance" button. Clicking the "COMPARE" button will 
restore the original, clicking it again restores the last enhance values. 
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Brightness/Contrast/Color Temperature/Saturation/Hue 

 
Brightness 

 
Contrast Saturation Color Temperature 

The image is altered as you adjust these values. The saturation alters the color 
intensity. At the minimum setting of -100 this will make a picture black and white. 
The Color Temperature control makes a picture more ‘warm’ or ‘cool’. The Hue 
control applies a particular color tint to the image and allows you to control the 
intensity of the selected color. 

Hue 

The HUE slider lets you choose the color to 
apply and the STRENGTH slider sets the 
intensity of the color change applied. 

  

Blur/Sharpen 

 

This control blurs images if it's taken below zero, and sharpens images above 0. For 
sharpen it's recommended that only small values be used, and typically only on 
images that have been reduced in size a lot. You can enter blur values larger than the 
-100 maximum value available on the slider. E.g. entering -400 will produce a very 
blurred image. 

Easy crop 
While in the Enhance tool you can drag on the handles shown around the edge of the 
selected photo to quickly adjust the cropping of the photo without needing to go into 
the Clip Tool. 

Cropping or clipping images 
The simplest way to clip a photo is just start dragging on or across the photo with the 
ENHANCE TOOL selected. The clipping is performed instantly after releasing the 
mouse. The resulting clipped photo has clip handles around it, where you can adjust 
the clip borders afterwards. 

 

This is a non-destructive operation meaning that you can both adjust the clip region 
after you've copped the image and even un-crop to restore the whole image. A way to 
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look at the process is that it just adjusts the picture outlines, but the whole picture 
remains clipped inside the rectangular outline.  This is why it's called a clip, and not 
crop, although it serves the same goal as a traditional CROP TOOL. 

You can select different photos while using the photo tools by just clicking on them. 
This also works for photos inside groups. 

Clip Tool 
Alternatively you can enter CLIP TOOL by selecting the Clip icon on the PHOTO TOOL 
fly-out bar. This provides a range of additional crop options. You can enter exact pixel 
values, and select from various crop aspect ratios 

 
For interactive clipping and some more options regarding aspect ratio, enter 
the CLIP TOOL with the CLIP TOOL button.  

This alters the InfoBar to look like this: 

 

As you drag over the photo, the clip rectangle is highlighted. 

• You can adjust the region by dragging on the corner or side handles 
• You can push the region around by just dragging inside the clip region 
• Select the CLIP button or just double click inside the clip region to perform the clip 

operation. 

 

You can tell whether a photo has been clipped or not from the status bar which will 
describe it as a "clipped photo". 

Clear 
Press the "CLEAR" button, or just click outside the marked clip region to clear the 
current clip rectangle. 
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Un-clip 
Press the UN-CLIP button with any clipped photo selected, to restore the original 
photo. This restores the clip rectangle, which you can adjust or clear by clicking 
outside it. 

The UN-CLIP button in the CLIP TOOL will change the outline of any clipped photo, and 
also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of the 
complete photo or bitmap used as the fill. You may have to select the Clear button to 
clear the crop rectangle (or click outside the rectangle). 

Adjusting the clip region 
Because the un-clip button restores the clip rectangle (showing the area outside 
faded), you can easily make fine adjustments to a clipped photo. Just select the photo, 
press the Un-clip button and adjust the sides of the clip rectangle as required. Double 
click inside the photo to clip it again. 

Width / Height 
After drawing a clip rectangle, you can enter values directly into the width and height 
fields on the InfoBar to set the clip rectangle dimensions to exact values. 

Lock Aspect 
Select the "LOCK ASPECT" check-box to constrain the clip rectangle to a specific 
aspect ratio as you drag. The radio buttons to the right of the check-box determine 
the aspect ratio used. Select "CURRENT" to maintain the aspect ratio to that of the 
photo before the clip. Note that the clip rectangle automatically changes between 
landscape and portrait orientation as you drag a corner of the rectangle.  So if you 
drag sideways it tends to create a clip in landscape orientation. If you drag 
downwards more, then it will create a clip region in portrait orientation. 

The common preset crop aspect ratios are available of 4:3 (most consumer digital 
cameras and old-style TVs and monitors), 3:2 (that of traditional film cameras and 
higher end SLR digital cameras), and 16:9 (aspect ratio of widescreen TVs). 

You can override the lock-aspect option by using "Ctrl" while dragging. So if you're 
dragging out a clip rectangle (or adjusting one) without aspect ratio lock, then holding 
"Ctrl" will lock the aspect to the last selected aspect ratio. Similarly if you have lock 
aspect option on then "Ctrl" will temporarily un-lock the aspect ratio. 

Clipping in Photo Documents 
In photo mode, there is a one-pixel grid applied to the photo (when at 96dpi, the 
default resolution) and the clip rectangle snaps to this grid. This makes it very easy to 
get pixel exact clipping. For highly accurate or exact pixel snapping, it's recommended 
to operate in photo mode and to zoom in so you can see the pixels clearly. 

See Photo documents (on page 273) for more information. 
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3D Extrude Tool 

Extruding a shape 

 
To turn a 2D shape into a 3D extruded object, go into the EXTRUDE TOOL on 
the main toolbar and simply click and drag on your object to rotate it in 3D 
space. 

Initially, your extrusion is given a default depth. The face color of the 3D shape is 
determined by the fill color of the original shape and the color of the extrude (or side) 
by its line color. After creating an extrude in this way, move your mouse pointer 
around over the 3D object. You'll see that the mouse pointer changes as follows to 
indicate what will happen if you click and drag at any point: 

 

This is shown when the mouse pointer is over the front or back face of the 
object. Clicking and dragging rotates the object in 3D space. 

 

This is shown when the mouse pointer is over the extrusion (the side) of the 
object. Clicking and dragging changes the depth of the extrusion. 

 

This is shown when the mouse pointer is over the extrusion and "Ctrl" is 
held. Clicking and dragging changes the bevel size (see below) 

You can also rotate an extrusion by holding down the Alt key while dragging on the 
extruded side. This is useful when only the side of an extrude is visible and so you 
aren’t able to drag on the face in order to rotate it. As when dragging on the front face, 
Ctrl and Shift can also be used to constrain the rotation. 

Extrude Tool InfoBar 

 

 Extrude on/off 

 Slider type list 

 Slider and numeric value for selected parameter 

 Bevel type 

 Bevel size slider and value 

 Lights on/off 

 Gloss/matt 

 Rounded/mitred corner 

You can adjust a 3D extruded object by manipulating it directly on the page as 
described above, or by selecting it and using the controls on the InfoBar of the Extrude 
Tool. 
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Turning extrudes on and off 

 
EXTRUDE ON/OFF 

Once a shape or other object has been extruded, there are only limited modifications 
that can be made to the original object with the extrusion in place. For example, if 
you've extruded a shape, it's not possible to then edit that shape in the SHAPE EDITOR 
TOOL because it's no longer a simple 2D shape that you can interact with. However, 
using this control you can temporarily turn the extrusion off, so that you can see and 
modify the underlying object using other tools, before turning the extrude on again. 
After making a modification and turning the extrusion on again the extrusion is re-
applied to your modified 2D object, with all the same 3D attributes that it had when 
you turned off the extrude. 

Note that in some cases if you dramatically change the form of the object while the 
extrusion is turned off (such as changing it to a completely different type of object), 
the 3D extrude attributes you applied may not be preserved. In such cases you 
should be able to use PASTE FORMAT/ATTRIBUTES to copy the attributes from a copy 
of your original extrude before the modification. See Copying styles: Paste attributes 
(on page 128). 

Extrusion depth 
The easiest way to adjust the depth of an extrusion is to simply click and drag on it, as 
described above. However, you can also use the slider on the left of the EXTRUDE 
TOOL InfoBar to adjust it. Make sure that EXTRUDE DEPTH is selected in the dropdown 
list to the left of the slider (this is the default setting) and then use the slider to adjust 
the extrude depth. The current extrude depth is shown in a numeric field to the right 
of the slider, and you can also enter extrude depth values directly into that field to set 
an exact extrude depth. 

Bevel Type & Size 
The bevel type determines the profile of the extruded side of your 3D shape and of its 
edges and corners. By default it's set to rounded which gives a flat side with rounded 
corners. The bevel type dropdown list contains a large selection of different bevel 
types you can choose from. You can adjust the size of the bevel using the slider to the 
right of the bevel type list. To the right of the bevel size slider is a numeric field 
showing the current bevel size and you can enter exact bevel sizes into this field.  

An alternative shortcut to adjust the bevel size is to drag on the side of the 3D object 
holding "Ctrl" (while in the EXTRUDE TOOL). 
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Lights 

 
LIGHTS ON/OFF 

You can adjust the lighting of your shape in 3D space by turning on the lights. There 
are 3 lights, each of which can be given their own color and position in 3D space 
around the 3D shape. 

 

In this example the face color of 
the shape is set to white. But you 
can see that it appears green 
because there is a green light 
shining almost directly onto the 
front face of the shape. 
By adjusting the colors of the face 
and extrude and the positions 
and colors of the three lights, you 
can enhance the realism of the 
3D objects in your design.  

Behind the object is a beige / orange colored light and another that is a purple color. 
Both lights cause reflections down the side, and changing the color, or direction of the 
lights behind will change the reflected highlights. 

To move a light around the 3D object, simply drag on the light arrow. If you happen to 
drop a light so that it is behind the 3D object and therefore isn't selectable, you can 
retrieve it by using the left slider on the Extrude InfoBar. Select one of the light angles 
from the dropdown list to the left of the slider (e.g. "Light 2 Angle 1") and then adjust 
the slider. The light moves around the 3D object in your design. The various "light 
angle" options in this dropdown list allow you to move any of the lights in any 
direction in 3D space to achieve the positions you want. However for most purposes 
you can achieve good results most easily by dragging the light arrows directly on the 
page. 

To change the colors of the lights, you can simply drag colors from the color bar and 
drop them directly onto the light arrows. To edit a light color with the color editor, 
double click on the light arrow you want to change and the color editor opens with 
that light color selected. You can now edit the light's color. With the color editor open, 
as you click on the different light arrows, extrude face and extrude sides, the color 
selected in the color editor dropdown list changes to match your selection, so you can 
quickly select the different colors on your extrude to modify them. 
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Gloss / Matt 

 
Use this toggle button to make the surface of a 3D object more or less 
reflective. With the gloss option on lights placed at the correct position 
behind the object will "bounce off" the sides to good effect. 

 

Mitred corner / Rounded corner 

 You can choose either MITRED or ROUNDED corners for your 3D object. 
"Mitre" gives square edges, while "Round" produces rounded edges. 

 

Copying 3D extrude attributes 
You can copy and paste the style of the 3D extrusion, from one 3D object to any 
other. This works the same way as for all Page & Layout Designer attributes. Simply 
copy the source extruded object to the clipboard, and then select a new one and 
select "EDIT" > "PASTE FORMAT/ ATTRIBUTES".  Note this will only paste the 3D 
attributes onto another 3D extruded objects. So you will have to extrude any shape 
first before pasting the 3D attributes. 

This will copy all the 3D attributes such as the extrude depth, light colors, bevel type 
as well as the face and outline colors. 
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Printing 

Show print borders 
The "WINDOW" > "SHOW PRINT BORDERS" menu shows a yellow and red line around 
the page (non-printing) showing the print margins and borders. The page boundary is 
shown by a yellow rectangle and the printing area by a red rectangle. The printing 
area is determined by the margins on the currently selected printer. Some printers let 
you adjust the margins, but few let you print right up to the edge of the page. 

If any objects on the page lie outside the red rectangle they are unlikely to be printed. 

Selecting and setting up a printer 
"FILE" > "PRINTER SETUP" opens the standard Windows PRINT SETUP dialog: 

 

Selecting a printer also selects a suitable paper size and paper orientation. Note that 
these are the size and orientation of the sheets of paper used in the printer. They are 
separate from the size/orientation of the document. PORTRAIT prints the page without 
rotation. LANDSCAPE prints the page turned through 90° (these buttons are 
duplicated in the PRINT OPTIONS dialog box, described later). We recommend leaving 
the LANDSCAPE/PORTRAIT buttons on this dialog box on their default setting. 

Please note: We cannot give you advice about installing or configuring printers as 
these are standard system operations. In case of difficulties, contact the supplier of 
your printer or computer. 

Properties button 
This displays a dialog box letting you set options for the selected type of printer. This 
dialog box is not controlled by Page & Layout Designer. 
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Network button 
If your computer is connected to a network, this lets you connect to shared printers 
on the network. This dialog box is not controlled by Page & Layout Designer. 

The print dialog box 
Choose "FILE" > "PRINT" ("Ctrl + P"). 

 

Print button 
When you have selected the required options click this to start printing. 

Printer… button 
This opens the "PRINT SETUP" dialog box (described earlier). 

Options button 
This opens a tabbed dialog box that lets you set additional print options. These are 
described later (on page 289). 

Pages 
ALL PAGES:  Prints every page of the document. 

CURRENT PAGE(S): Prints the currently selected page or spread. 

SELECTED OBJECTS: This option is available when any objects in the document are 
selected. When active, only the selected objects are printed. Note that other objects 
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within the bounds of the selected objects are not printed – only the objects which are 
actually selected are printed. 

Hidden objects, objects on hidden layers and the guides layer never print. See Page & 
Layer Gallery for more details. 

PAGE RANGE: Allows you specific control over which pages you wish to print. You can 
type specific pages numbers, separated by commas, or page ranges by typing two 
numbers with a hyphen in between them. 

Page range examples: 

2 will print just page 2. 

1,3,5-7 will print pages 1, 3, 5, 6 and 7. 

2,3,6-8,11-12 will print pages 2,3,6,7, 8,11 and 12. 

The Options section of the dialog will indicate if your page range is OK or invalid. 

Double page spreads 
If the document comprises a double-page spread, you can print both sides or just the 
left or just the right page. 

This option is dimmed when the spread comprises a single page (see Document 
Handling (on page 49) for how to select single or double-page spreads). Or the 
"PRINT/EXPORT INDIVIDUAL PAGES" is active in the Page Options (on page 353), so 
that the two pages of a double-page spread are treated as individual single pages. 

Print to File 
You can select the PRINT TO FILE option to create a document that you can give to a 
printing company (if they are able to accept this type of file). 

After checking this option, when you click PRINT Page & Layout Designer displays the 
standard Windows SAVE dialog box so you can specify a file name and location for the 
file. 

Print files have a default extension of .prn. 

If you want to create a PDF file we recommend selecting the "File -> Export…" option 
and selecting PDF. This produces a higher quality, and usually more compact PDF file 
than you'd get from printing to a PDF file. 

For more information on exporting as PDF refer to Importing and Exporting (on page 
304). 
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Number of copies 
Sets how many copies of the document to print. 

Collated 
This is dimmed except when printing multiple copies of a double-page spread as two 
separate pages. With this option selected, pages are printed as left-right-left-right, 
etc. With this option deselected, all the left-hand pages are printed then all the right-
hand pages. 

Printers that hold a page image in memory take some time to process the image. The 
printer can then print multiple copies at its maximum speed. For such printers it is 
often faster to manually collate the pages after printing. 

Other types of printers have to process the page for each copy. For these, select 
collate copies and save yourself the chore of collating. 

Print Options: Output tab 

 

Print layers 
There are two options: 

• Print ALL FOREGROUND LAYERS. 
• Print only the currently VISIBLE FOREGROUND LAYERS. 
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Note that only foreground layers are printed. Background layers are never printed. 

Print As 
NORMAL is suitable for most types of document. 

However some printers do not reproduce consistent colors when printing bitmaps or 
vector objects that are the same color (this is a fault with the printer driver). This is 
noticeable if objects overlap onto bitmaps or onto objects with transparency applied 
to them. In this case, select BITMAP or ANTI-ALIASED BITMAP and retry. 

The choice between BITMAP and ANTI-ALIASED BITMAP depends on the printer and 
personal preference. Some printers give best results with anti-aliasing turned off 
especially when printing thin lines. As a rule, using anti-aliasing allows lower 
resolution printing. For example, 150 DPI bitmap printing is usually good enough for 
all uses-even typesetting. Without anti-aliasing, higher resolutions may be needed 
which gives much slower printing. 

Transparency resolution 
When printing, MAGIX Page & Layout Designer 2013's transparency effects are 
created using bitmaps. 

This option controls the resolution of those bitmaps when sent to the printer. 
Automatic is suitable for most drawings, and means MAGIX Page & Layout Designer 
2013 automatically selects a resolution suitable for the current printer.  This might be 
unsuitable if printing to a very high resolution printer such as image setting devices. In 
this case you may wish to control the print resolution manually by entering the 
desired value. 

Note that modern printers often claim to be able to print at over 1000 dots-per-inch, 
but this is not the same thing as "pixels-per-inch", which is what you see on screen. 
Generally, it's never necessary to print at more than 600 pixels-per-inch, and typically 
300 pixels per inch produces perfectly adequate print results, especially if anti-
aliased. 

Fill quality 
Using this option, you can choose how many steps make up the graduated fills in your 
document when it is printed. The NORMAL setting is suitable for most purposes. This 
option is dimmed for PostScript printers. 

Text options 
If your printer has problems reproducing fonts, select the PRINT ALL TEXT AS SHAPES 
option. All text is then converted to vector shapes before the document is sent to the 
printer. This may be slower, but will reproduce exactly what you see on screen. 
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Print Options: Print Layout tab 

 

Most options in print layout are dimmed if you have BEST FIT or AUTOMATIC FIT 
selected. We recommend using these options as they are the easiest way to print. 

However you can choose custom options (see “custom fit” below). 

Best fit 
Your design will be moved to the center of the page and it will be expanded or shrunk 
to suit the paper size. 

This option is best if you have a large or small design and want it to fit on one page. 

Automatic fit 
Your design will be orientated as necessary, but Page & Layout Designer will not 
change the size. We recommend this option if you are having any difficulty getting the 
orientation right (there are at least four places where you can set the page orientation, 
sometimes more for some printer drivers). 

This option is best if you have a set size for your design and don't want it altered. 

Custom fit 
Allows you to have control over your print out, including orientation, size and margins. 
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The ORIENTATION buttons can be used to choose the orientation of the printout. The 
scale can be altered using the SCALE field. The top and left margin fields can be 
changed (these set where the top left-hand corner of the page appears on the 
printer's paper). 

The WIDTH and HEIGHT fields give you an alternative way of setting the print scale 
(when you change one of these settings, the other changes to ensure the page is 
always printed with a 100% aspect ratio). 

Multiple fit 
To print multiple copies on one page, choose MULTIPLE FIT, enter a value for the 
number of copies needed across the page (rows), the number down the page 
(columns), and the distance between each (gutter). 
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Imagesetting 

Spot colors 
Normally four colors are used when printing, cyan, magenta, yellow and black (key) 
commonly known as CMYK. But it’s also possible to produce spot colors. Spot colors 
are not normally printed using the CMYK inks, and are instead additional inks. 

Spot colors have two uses: 

• Many simple jobs use only two or three ink colors (for example a simple 
newsletter with black text and blue headings). Creating a spot color for each ink 
color can make the job cheaper to print. 

• Some complex jobs require either PANTONE COLOR BRIDGE colors or special 
inks that cannot be reproduced in CMYK such as gold or silver. These special 
colors require spot colors. 

See chapter PANTONE colors (on page 174) for more on PANTONE COLOR 
BRIDGE. 

Note: As each spot color is an additional ink and printing plate, it does increase 
printing costs. 

Spot colors appear as circles on the COLOR LINE and COLOR Gallery. 

Spot colors are always Named colors.  

Technical notes on color separations: 

• Tints based on a spot color output on that spot separation. So if you require a 
lighter shade of a spot color, define the color as a Tint (on page 170) of the spot 
color.  

• Shades and linked colors based on a spot color output on the CMYK separations. 
• Objects with transparency applied always output on the CMYK separations, not 

to the spot separation. 

For more information on how spot colors are affected by transparencies, fills and 
blends see "Transparency and Color Separations" later in the chapter. 

On screen printer plate previews 
The process of printing requires that your artwork is separated into CMYK print 
colors. It can sometimes be useful to see and understand exactly what inks are 
printed on each printer plate, especially if using spot colors.  MAGIX Page & Layout 
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Designer 2013 can show a simulation of the CMYK separation process on screen, 
showing a preview of each printer ink color separation. Normally this would be the 
four CMYK colors, but if you use spot colors you can preview these as well. 

To preview any required plate or ink color, select "Window -> Show Printer Colors" 
and the required ink color. 

Simulating print colors on screen 
Because printed colors are often a very different shade to those available on screen, 
MAGIX Page & Layout Designer 2013 can adjust the screen color to more accurately 
simulate the printed color.  Simply select "Window -> Show Printer Colors -> 
Simulate Print Colors".  See the section "Viewing Print Colors on Screen" in 
PANTONE Colors (on page 174) for more information. 

Imagesetting dialog 
The IMAGESETTING dialog gives control over printer’s marks and film settings. 

To open it, choose "File -> Print Options", then select the IMAGESETTING tab. Or, from 
the PRINT dialog, click "Options", then select the IMAGESETTING tab. 
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Output Printer’s Marks 
This switches selected printer’s marks on or off in one operation. Printer’s marks 
provide useful information when printing professionally, for example indicating the 
edge of the document so that it can be cropped to the proper size after printing. 

The default options that are then selected will be suitable for most print jobs. Only 
change them if asked to do so by your print company. 

As well as for printing, these settings also apply to PDF/X export if the INCLUDE CROP 
AND PRINTER MARKS option is selected in the ADVANCED OPTIONS, LAYERS tab of the 
PDF export dialog. 

See PDF Export (on page 314) for more information on exporting as PDF/X. 

These are the various printer’s marks options that you can turned on or off. 

 

1) Crop marks 

These are used for jobs that will be trimmed to size after printing. They tell the print 
shop where to cut the paper. 
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2) Plate information 

This is information such as plate name, file name and date & time. 

3) Registration targets 

Registration targets appear in the same position on each separation so the print 
company can align the separations when making printing plates and when printing. 

4) Registration stars 

These are a further check that the separations are lined up. 

5) Grayscale bar 

This shows that the imagesetter or printer has rendered the full range of gray tones 
from 10% to 100%. It also provides the print shop with useful information during 
printing. Useful for both monochrome and color work. 

6) Progressive color bar 

Similar to the grayscale bar. Provides the print company with useful information when 
printing multicolor work. 

7) Long registration targets (Not shown in the example)  

These are an alternative form of registration targets. Some print companies may 
prefer to work with this type of target. They replace the registration marks shown 
(option number three) with this target type: 

 

8) Overprinted color bar 

Similar to the grayscale bar. If your document uses overprint, this provides the print 
company with useful information during printing. 

Print films 
Films used to be used for press printing, but have been phased out by most print 
companies in favor of PDF/X. But if you need to create films, these settings may be 
relevant, and again only change them if asked to do so by your print company. 

Emulsion down (reflect image): Creates a mirror image. This option, if enabled, will 
only work when outputting to PostScript printers. The imagesetting material is coated 
with photographic emulsion on only one side. With this option off, the emulsion is on 
the top of the film when you can read it normally. This may be known as "right 
reading, emulsion up". With this option on, the emulsion is on the back of the film as 
you read it. Called "right reading, emulsion down" or "wrong reading, emulsion up". 
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Negative: Produces a negative image. This option, if enabled, will only work when 
outputting to PostScript printers. Leave off if you are asked for "positive" or just "pos". 
Turn on for "negative" or "neg". 

Always overprint black: Overprints any objects that are over 95% Key (CMYK black). 
Black is a relatively opaque ink and overprinting reduces registration problems. This 
option is particularly useful if you have a lot of black text. If your document has large 
areas of solid black, overprinting all black can cause problems with over-inking on the 
press. Overprinting is described later in the chapter. 

Separations dialog 
The SEPARATIONS dialog gives control over separations and PostScript settings. 

To open it, choose "File -> Print Options" then select the SEPARATIONS tab. Or, from 
the PRINT dialog, click OPTIONS then select the SEPARATIONS tab. 

 

PostScript options 
The settings give you control when sending to a PostScript printer. They are ignored 
by any other type of printer. It is unlikely you will need to change these, but if asked to 
do so you can change the settings described below. 
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Use printer defaults: Selecting USE PRINTER DEFAULTS uses the standard settings for 
the selected printer. Generally these give good results, but if you want greater control 
choose USE CUSTOM SETTINGS. 

Use custom settings: Selecting USE CUSTOM SETTINGS lets you configure the printer 
settings to suit your requirements. Note: No check is made whether the settings you 
choose are suitable for the type of printer; it is assumed you know your requirements. 

Target printer resolution: Specified in dots-per-inch (DPI). 

Default screen frequency: Specified in lines-per-inch (LPI). Tints of the basic ink color 
are printed as small dots called halftone dots. The dots are arranged in rows and the 
number of rows to the inch is the screen frequency. The lower the screen frequency, 
the larger the individual halftone dots and the more noticeable they are. Your print 
company may ask for “120 line screen” which would be a screen frequency of 120LPI. 

Screen/dot type: PostScript printers can print halftone dots in a variety of shapes. 
Generally round dots give the best results but some presses work better with a 
different dot shape. 

Print Color Separations 
If you want to print all the colors in one pass through the printer, deselect PRINT 
COLOR SEPARATIONS. This full color output is referred to as a composite output. 

If you want to produce output separated into the CMYK process colors and any spot 
colors, select PRINT COLOR SEPARATIONS. If you have one spot color, for example, you 
will get five printouts: one for each of the CMYK colors, and one for the spot color. 

Your print company can advise you on whether they want composite or separated 
files. Separating to a local printer is useful if you want to view each separation. 

You can now set options for the individual separations. 

To output a separation for an ink color, select the left-hand check box. By default all 
plates are set to print. 

You can also view each separation within MAGIX Page & Layout Designer 2013 
with the "Window -> Show Printer Colors" options. 

To set an ink color to overprint, select the right-hand check box. Overprinting is 
described later in the chapter. 
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To change the screen angle and 
frequency, click on the ink name 
to select it then click PROPERTIES. 
This opens the SEPARATION 
PROPERTIES dialog: 

 

Angle: To change the screen angle for this color, type in a new value in degrees. 

Frequency: To change the screen frequency for this color, type in a new value. This 
overrides the default screen frequency (described in PostScript options earlier) for 
this color. 

Print this ink: This duplicates the check box in the main SEPARATIONS dialog. 

Overprint this ink: This duplicates the check box in the main SEPARATIONS dialog. It 
protects the selected color from being knocked-out, so works in the reverse to object-
level overprinting. Overprinting is described later in the chapter. 

Print spot colors as process colors: Desktop printers and some printing processes 
can only print process (CMYK) colors. Select this option to print any spot colors as 
their equivalent CMYK color. Note: some spot colors look very different when output 
as CMYK, and it removes the ability to use PANTONE COLOR BRIDGE colors or any 
special inks. The main use of this option is when checking your artwork on a local 
printer. 

Overprinting 
If you are producing color documents that will be printed on litho printing presses, 
you may find overprint useful. Printing presses are mechanical devices with the 
inevitable slight misalignments when they are running. Overprinting lets you 
overcome these misalignments. For example, your job may have a black circle on a 
cyan background. When the document is imageset, the circle appears on the black 
separation and the cyan separation has a non-printing area under the circle (the 
technical term is that the circle "knocks-out" the background). The knock-out is the 
same size as the circle. 

 

A black circle knocks-out out the cyan background 
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If the two plates do not line up exactly during printing, the circle will slightly offset 
from the knock-out (known as "out of register") and a small white gap can appear. 

 

This example is exaggerated to illustrate the out of register 
printing, but even thin lines can be noticeable with dark colors. 

Overprinting compensates for this problem. MAGIX Page & Layout Designer 2013 
has two types of overprinting: object level and ink level. 

Object level overprinting 
You can separately specify overprint for the line and fill colors of an object. 

To overprint the line on an object, select the object then: 

• Right click and choose "IMAGESETTING" > "OVERPRINT LINE" 
• Or choose "UTILITIES -> IMAGESETTING -> OVERPRINT LINE". 
• Or right click the object, then choose "IMAGESETTING -> OVERPRINT LINE". 

To overprint the fill on an object, select the object then: 

• Right click and choose "IMAGESETTING" > "OVERPRINT FILL" 
• Or choose "UTILITIES -> IMAGESETTING -> OVERPRINT FILL". 
• Or right click the object, then choose "IMAGESETTING -> OVERPRINT FILL". 

To turn off overprint on an object, just select the relevant option again. You can 
overprint both the line and a fill on an object if required. The object’s fill and/or line 
will then not knock-out the colors any colors below it. Overprinting the fill is most 
commonly used to overprint dark colored text. 

Overprinting the line is the normal way of avoiding out of register printing. The print 
company can tell you the tolerance to allow (usually 0.5pt to lpt). The line color 
depends on the background and object colors. Unless you want a specific line color, 
set the line to the lighter color. 

Ink-level overprinting 
MAGIX Page & Layout Designer 2013 has two ink-level overprint options: 

• Overprint everything, including tints, in the specified ink color. Set in the 
SEPARATIONS dialog box (see above). This option is rarely useful, but works in the 
reverse of object-level overprinting. For example if you select Cyan to be 
overprinted, it will cause cyan to not be knocked-out. 

• Always overprint black (everything over 95% Key). Set in the IMAGESETTING 
dialog box. Black is a relatively opaque ink and overprinting reduces registration 
problems. This option is particularly useful if you have a lot of black text. If your 
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document has large areas of solid black, overprinting all black can cause 
problems with over-inking on the press. 

Printing on all plates 
PRINT ON ALL PLATES is known in some programs as REGISTRATION BLACK. 

You sometimes want an object to appear on all separations. To do this, select the 
object then right click and select "IMAGESETTING" > "PRINT ON ALL PLATES" or choose 
"UTILITIES -> IMAGESETTING -> PRINT ON ALL PLATES". 

The object color changes to black or gray, depending on its original color, to remind 
you that PRINT ON ALL PLATES is applied. 

To cancel PRINT ON ALL PLATES, select the option again. 

Usually PRINT ON ALL PLATES is applied only to small areas such as additional printer’s 
marks or lines of text. Do not apply PRINT ON ALL PLATES to large areas as this can 
flood the printing press with excess ink. 

Printing & color separating: technical details 
Color separating 
MAGIX Page & Layout Designer 2013 converts RGB, HSV and grayscale colors to 
CMYK for printing. Because the inks in printers are not pure color, some color 
correction is required. For example, theoretically 100% red in RGB is 100% magenta 
and 100% yellow in CMYK. In practice, less magenta is required to get the right color. 
Also, in dark colors and grays, black ink can replace a proportion of CMY. Color 
correction in MAGIX Page & Layout Designer 2013 is entirely automatic. 

CMYK colors do not need color correction and so are usually printed without 
modification. The exception is areas where transparency has been applied. This is 
described in detail below. 

Transparency and color separations 
Transparency helps create some outstanding illustration, but can also cause 
unexpected results when color separating because PostScript imagesetters, and 
printers do not directly support transparency. Areas covered by objects with 
transparency applied are output as an RGB bitmap. This bitmap is then color 
corrected and separated to CMYK. This process happens even to objects with 100% 
transparency. 

This means that in objects under a transparent object: 
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• CMYK color values change. This is particularly noticeable with black and grays 
which will then appear on all four separations rather than just the black 
separation. 

• Spot colors (and PANTONE COLOR BRIDGE colors) are separated to CMYK (and 
color corrected) (see PANTONE Colors (on page 174) for more on PANTONE 
COLOR BRIDGE). 

Watch out for: 

Objects under totally transparent objects. Instead of using 100% transparency you 
can use NO COLOR (see The color line (on page 159) for how to apply NO COLOR).                                       

• Text under a transparent object. Where possible, have text as the front object so 
these problems don't occur. 

Intermediate colors in blends and fills 

This section applies to all blends and multicolor fills. That is, all fill types except flat. 

Normally, a graduated color fill mixes colors using the RGB color model. The 
exception is when both end colors are defined as CMYK. In this case, colors are mixed 
in CMYK. One advantage of this for grayscale blends. An RGB gray is printed as a 
mixture of the four CMYK inks. Defining the gray as a tint of CMYK black gives better 
printed results. 

Rainbow and Alt Rainbow mix colors using HSV. 

Three-color, four-color, fractal and bitmap fills always output as RGB bitmaps and are 
color-corrected. This means that any spot colors used in these fill types output to the 
CMYK separations not to the spot separation. 

Special rules apply for spot colors: 

• In blends: If either end color is a spot color, you can do fade mixes but not 
rainbow mixes (the reason is because you cannot alter the hue of a spot color). 

• In fills: If either fill color is a spot color, you can do fade mixes but not rainbow 
mixes. 

• In blends: If both end colors are the same spot color (or tints of the spot color), 
the blend outputs only to the spot separation. 

• In fills: If both fill colors are the same spot color (or tints of the spot color), the fill 
outputs only to the spot separation. Note: this does not apply to three-color, four-
color, fractal and bitmap fills which output only to the CMYK separations. 

If you blend or fill from a spot color to a non-spot color, MAGIX Page & Layout 
Designer 2013 creates the requested blend. For example, if you blend from cyan 
(CMYK color) to gold (spot color) the cyan separation shows a blend from 100% 
color to no color and the Gold separation shows no color to 100% color. This is 
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approximately what you see on screen (allowing for differences between screen and 
printer colors). 

If you convert the blend to editable shapes, the intermediate shapes lose all spot color 
information. They separate only to CMYK. Only the final object prints as a spot color. 

RGB and CMYK Blacks 
Because shades of black and gray that are defined as RGB or HSV colors will separate 
into a mix of all four CMYK process colors when printed, you can sometimes get less 
than perfect gray shades. And any slight mis-registration of the CMYK color printing 
process will sometimes be visible on the edges of black objects. 

Although the theory is that an equal mix of CMY inks will give a perfect shade of gray, 
it does not (and this is why the black "K" ink is added to the mix). So a gray that is 
defined as an RGB or HSV gray will contain a mix of all four colors to improve the gray 
color.  But the best gray can be achieved by using only the K (black) ink plate. Thus if 
you require perfect grays it’s better to use gray shades that are defined as a tint of a 
CMYK "pure" black. 

When creating documents based on the default templates designed to be printed, 
such as US Letter or A4, then the shades of gray defined on the Color Line are defined 
to be tints of pure "K" black.  So if you use these gray colors from the Color Line, you 
will get quality printed grays. 

There is a corollary situation that a printed black that is based solely on the use of "K" 
ink, is not that black. You can get far darker blacks by adding some of the other inks 
printed on top of the black. So if you require really dark blacks for large objects or 
areas, then you can define a CMYK color that has 100% K ink and a percentage of the 
other colors (30% of each of the CMY colors is sometimes used). 
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Importing and Exporting 

General notes on exporting and importing 
You may want to export MAGIX Page & Layout Designer 2013 documents to other 
applications, or export them for use on a website. Or you may want to import designs 
from other sources. For easy transfer, Page & Layout Designer offers a wide range of 
import and export options. 

Firstly, it is important to note the distinction between saving and exporting files: 

• SAVING deals with storing your work so that you can open it and work on it at a 
later date. MAGIX Page & Layout Designer 2013 saves your work in the .xar file 
format. Think of this as the "master document" format. 

• EXPORTING deals with converting designs to other supported formats. Exporting 
allows you to use and distribute your designs. For example, you may want to 
create a PNG file for a website, or a TIFF or PDF file for a printing company. 
Exported files are no substitute for saved .xar files because they are not a 
complete representation of your MAGIX Page & Layout Designer 2013 design, so 
always save your design as a .xar file too.  

Recommended formats 
The universal export formats, that can be read by the widest range of programs are 
the bitmap formats, GIF, PNG and JPEG. These are also guaranteed to look exactly as 
you see on screen in MAGIX Page & Layout Designer 2013.  PNG is the highest 
quality and can include transparency support and is recommended for Microsoft 
Office applications. 

PDF is the recommend export format for sharing files to be viewed or exported into 
Adobe Illustrator. MAGIX Page & Layout Designer 2013's PDF export is very high 
quality, is vector based, and supports advanced features such as graduated 
transparency. 

Other notes 
With EPS and bitmap files you have a range of options on how to translate the data. 
Some of these options can produce very large files (if, for example, your document 
has a lot of graduated or radial fills or transparency). 

File translation can take some time for a complex illustration. 

Please note that other manufacturers can, and often do, change the specification of 
other file formats. Information is given here in good faith but no guarantee is given 
that files can be transferred between Page & Layout Designer and any other package. 
Further, there are often numerous different variations of a given file format, and 
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MAGIX Page & Layout Designer 2013 cannot support them all, especially if they are 
recent and non-documented formats. 

Because other programs do not support all of the features of MAGIX Page & Layout 
Designer 2013, for example, the advanced fill and transparency types, these have to 
be simulated, usually by exporting these objects as bitmaps. 

Import and Export Supported File Formats 
You can change the order of supported import and export file formats in the FILE > 
EXPORT and FILE > IMPORT dialogs by editing the FileFormats.xml file found in the 
program folder where you installed Page & Layout Designer. 

Import formats 

It is important that you use the three letter file extensions listed below when you 
load files into MAGIX Page & Layout Designer 2013. 

Bitmap Import Formats 
.BMP Windows Bitmap 
.CUT Halo CUT (256 color) 
.DCM Digital Imaging and Communications in Medicine (DICOM) image format 
.DCX DCX 
.FAX Fax image from a fax received or created with fax software 
.GIF Graphics Interchange Format 
.ICO Microsoft Windows Icon (16 color) 
.JPG JPEG 
.PEG2000 (.JP2, .J2C, .J2K, .JPX, .JPF) 
.MXB MAGIX Bitmap 
.PAI MAGIX Photo Clinic Image 
.PBM UNIX monochrome 
.PCD PhotoCD 
.PCT PICT 
.PCX PCX Paintbrush 
 PGM UNIX grayscale 
.PNG PNG 
.PPM UNIX color (up to 24 bit) 
.PSD Photoshop (see importing (on page 307) and exporting PSD files (on page 311)) 
.RAS Sun Raster 
.SGI Silicon Graphics Image 
.TGA TrueVision TARGA  
.TIF TIFF (RGB, RGBA with alpha-channel transparency).  
MAGIX Page & Layout Designer 2013 supports: fax TIFF files (black and white 
images. Multi-page faxes will be imported as multiple pages); Mac or PC byte order 
TIFF files; TIFF with layers and transparency (if saved from Photoshop the rules for 
blend mode compatibility are the same as for PSD files); JPEG in TIFF (transparency is 
not possible in this case) 
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.XAR MAGIX Page & Layout Designer 2013 

.XBM X Windows (2 color) 

.XPM X Windows (256 color) 

.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by 
mobile devices 

EPS Import Formats 
.AI Illustrator EPS 
.EPS ArtWorks EPS 
.EPS Illustrator EPS 
.EPS CorelDRAW 3 & 4 EPS 
.EPS FreeHand 3.0 EPS 
.EPS Photoshop EPS (For importing data from Photoshop into MAGIX Page & Layout 
Designer 2013, use PSD files instead of EPS files for best results) 
.EPS XaraX EPS 

Other Import Formats 
.ART Xara Studio 
.WEB Xara Webster files 
.AFF Acorn Draw 
.CDR CorelDRAW (3,4 & 5)  
.CDT CorelDRAW Template 
.CMX Corel CMX 5 & 6 
.DRW Acorn Draw 
.WMF Windows Metafile (16bit) 
.EMF/ .WMF Enhanced Windows Metafile 
.RTF Text 
.WIX For internal use by Xara 

Palette Import Formats 
.CPL CorelDRAW Palette 
.PAL CorelDRAW Palette 
.PAL Microsoft Palette 
.PAL PaintShop Pro Palette 
.ACT Adobe Color Table 
.ACO Adobe Color Swatch 

For information on how to import palettes, see Importing colors and palettes 

Export formats 
Bitmap Export Formats (see GIF, PNG, BMP and JPEG export dialog overview (on 
page 333)) 
.BMP Windows Bitmap  
.DCX DCX 
.PCX PCX 
.GIF CompuServe GIF 
.JPG JPEG  
.PSD Photoshop (see importing and exporting PSD files (on page 311)) 
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.PCT PICT 

.PNG PNG 

.RAS Sun Raster 

.TGA TrueVision TARGA 

.JP2, .JPX, .J2C, .J2K, .JPF  JPEG 2000 image format. An improvement on the standard 
JPEG format that can compress image files using lossy or lossless compression. 
.TIF TIFF (RGB and CMYK) 
.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by 
mobile devices. 

EPS Export Formats 
.AI Illustrator EPS 
.EPS ArtWorks EPS 
.EPS Illustrator EPS 
.EPS Xara Xtreme EPS 

Other Export Formats 
.XAR CorelXARA 
.XAR Page & Layout Designer 
.WEB Xara Webster files 
.WMF Windows Metafile  
.EMF Enhanced Windows Metafile 
.CMX Corel CMX 5 & 6 
.PDF + PDF/X Portable Document Format, High quality PDF files (on page 480). 
.RTF Rich Text Format 
.XPS Microsoft XML Paper Specification (on page 312)  
.SVG Internet Scalable Vector Graphics 
.WIX For internal use by Xara 

Importing files 
To import a file: 

• Select "FILE" > "IMPORT" -  This normally merges the file's contents into the 
existing document. With some formats you get the choice of importing the 
document into the current page or adding it as a new page. 

• Or select "FILE" > "OPEN" - This opens the file as a new document. 

MAGIX Page & Layout Designer 2013 supports drag and drop import of files. If you 
drag a file from your File Explorer onto an open MAGIX Page & Layout Designer 2013 
document it will import the file and place it on the current page, centered on the drop 
point. Or drag & drop a suitable file from Windows Explorer onto any bar or the title 
bar of Page & Layout Designer's window - it will open the file as a new document. 

Importing a Photoshop PSD file 
To import a PSD file, import the file as normal with File > Import, or just drag and drop 
the .psd file into MAGIX Page & Layout Designer 2013. 
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Attention: Only Xara Designer Pro can import PSD files with 16bit colors or CMYK 
color model 

The layers in the PSD file, and the layer visibility setting will be preserved and will 
become MAGIX Page & Layout Designer 2013 layers. You can view them by opening 
the PAGE & LAYER GALLERY.  

The Photoshop blend modes Normal, Multiply and Screen are compatible with the 
equivalent MAGIX Page & Layout Designer 2013 transparency types Mix, Stain and 
Bleach and will remain editable in MAGIX Page & Layout Designer 2013 using the 
TRANSPARENCY Tool. 

Photoshop calls it Opacity, but it’s the same thing as Transparency (just the other 
way around), i.e. a 90% opacity value in Photoshop becomes a 10% transparency 
setting in MAGIX Page & Layout Designer 2013. 

Tip: if you have separate objects in Photoshop that you wish to be able to move and 
change independently of one another in MAGIX Page & Layout Designer 2013, place 
them on separate layers in Photoshop before exporting. 

TIFF Import 
MAGIX Page & Layout Designer 2013 TIFF import supports a much wider range of 
TIFF file types, including: 

• CMYK TIFF files. 
• Fax TIFF files (black and white images. Multi-page faxes will be imported as 

multiple pages into MAGIX Page & Layout Designer 2013). 
• TIFF with transparency (if exporting a TIFF from Photoshop (Save As) you can 

select the SAVE TRANSPARENCY checkbox). 
• Mac or PC byte order TIFF files. 
• TIFF with layers and transparency (if saved from Photoshop the rules for blend 

mode compatibility are the same as for PSD files). 
• JPEG in TIFF (transparency is not possible in this case). 

Usually TIFF files have a file extension of .tif. 

PDF Import 
PDF is a complex vector graphics format that has evolved over 10 years or more and 
contains numerous sub-formats and options. PDF was designed as a portable 
document format for viewing and printing only, and was not intended as a file format 
for transferring data between applications. However MAGIX Page & Layout Designer 
2013 should load the vast majority of PDF files. 
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PDF is now the recommended way of transferring vector files from Adobe Illustrator 
to MAGIX Page & Layout Designer 2013. Save as PDF and then import the resulting 
file into MAGIX Page & Layout Designer 2013. 

The following points are worth noting: 

• Multi-page PDF files are imported as multi-page documents in MAGIX Page & 
Layout Designer 2013. 

• Text in PDF files is typically broken into many separate small text objects in the 
PDF file. This doesn’t stop it viewing and printing, but means when imported 
what might appear as one or more continuous paragraphs of text is not. MAGIX 
Page & Layout Designer 2013 tries to re-assemble the lines of text into lines and 
paragraphs of editable text, but often you will find the text broken into separate 
text objects. 

• In order to make it easier to extract just the text of a PDF file, a new layer is 
created containing just the text on that PDF page. Use the PAGE & LAYER GALLERY 
to view this layer. 

• PDF files make liberal use of clipping. This appears in MAGIX Page & Layout 
Designer 2013 as ClipView objects, and so it’s often necessary to use "Arrange -> 
Remove ClipView" in order to edit the objects on the page. 

• Any annotations in the PDF file are imported onto a separate layer called “PDF 
annotations” in your MAGIX Page & Layout Designer 2013 document. 

What might not work: 

• Many PDF files include embedded fonts. It’s not possible to legally extract and 
install these fonts onto your system. So if you do not already have the fonts used 
in the PDF file you will find alternative fonts have been substituted. 

• Files that are encrypted or password protected cannot be imported. 
• Any text in PDF files that use embedded subset fonts will not be readable or editable. 

PDF is a highly complex format, and often can't be imported perfectly. The best way 
to import it may depend on how you intend to use it. The "OPTIMIZE FOR VIEWING" 
option attempts to make the imported result look as similar to Acrobat as possible, 
but it may be more difficult to edit (it could have many nested clipviews for example). 
The alternative “OPTIMIZE FOR EDITING" option strips out some constructs which are 
difficult to manually edit (for example, nested clipviews). 

Exporting files 
To export a file: 

• Right click and choose EXPORT 
• Or select "FILE" > "EXPORT". 
• Or press "Ctrl + Shift + E". 
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An EXPORT dialog box will appear. Choose a name for your file, and select the required 
format from the SAVE AS TYPE dropdown list. Some of the supported formats are 
detailed below. 

Exporting as PDF 
The PDF format is an ideal way to distribute your document for a variety of uses. It 
can be used to supply artwork to a printing company, or it can be used to import in to 
other programs such as Adobe Illustrator 9 and later. This is described in detail in the 
next section. 

Exporting as Page & Layout Designer EPS 
This saves the document as an EPS file. It is the recommended EPS format for 
exporting to (for example) DTP programs, as all information is retained. 

Exporting as ArtWorks EPS 
This saves the document so that you can load it into ArtWorks, Computer Concepts' 
illustration program for Acorn RISC computers. Files in this format cannot be loaded 
into other programs on the PC. Some features, such as transparency, do not exist on 
ArtWorks. 

Exporting as Illustrator EPS 
This is recommended for older versions of Adobe Illustrator (for version 9 onwards 
we recommend using PDF export, see above). 

Exporting as Windows metafiles (.wmf) 
Files in this format can be read by Word and several other programs. 

Exporting as Extended Metafile Format (EMF) 
Modern Windows applications support this enhanced type of vector graphic format. 
This format is also available to applications that provide a Paste Special menu option. 

Note that MAGIX Page & Layout Designer 2013 can contain features, such as 
advanced fill styles, that cannot be represented in vector formats such as EMF. In this 
case parts of the image will be exported as bitmaps. Those vector parts that can be 
exported as vectors are exported as vectors. 

Exporting as a bitmap 
JPEG, GIF and PNG are universal formats supported by most modern computer 
applications. PNG is the highest quality. JPEG is better suited to photographic work, 
but can produce acceptable, compact files (you can control the quality and file size). 

GIF format only supports 256 colors, and although common on many websites, PNG 
is a better format.  PNG also supports semi-transparent graphics (use the True Color 
+ Alpha option), but this is not correctly supported by older Microsoft Internet 
Explorer versions (it is by all other web browsers). 
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The fewer colors you have in a file, the smaller the file and the lower the quality. 
However, when using 256 colors or less MAGIX Page & Layout Designer 2013 
provides very advanced techniques to simulate a much wider range of colors, and so 
you can get very high, near photographic quality results using only 256 colors or less. 

See also GIF, PNG, BMP and JPEG export dialog overview (on page 333). 

Important 

 

Bitmaps are output at the current view quality so for best results 
make sure that "WINDOW" > "QUALITY" or the slider on the 
Standard control bar is set to anti-aliased. 

 

Exporting a Photoshop PSD file 
Photoshop is a bitmap editor, so when exporting to PSD format all the vector objects 
in MAGIX Page & Layout Designer 2013 are rasterized. You can select the resolution 
(dpi) when exporting. 

Always save your work in MAGIX Page & Layout Designer 2013 prior to exporting. 
Then, if you wish to alter your original objects in the future, just load MAGIX Page & 
Layout Designer 2013, make any changes and then export the required objects again. 

To export as a PSD file choose "FILE" > "EXPORT" then select ADOBE PHOTOSHOP in the 
SAVE AS TYPE list. 

Layers 
Layers in MAGIX Page & Layout Designer 2013 are retained when exporting to PSD 
format. Each layer is rasterized as a separate PSD layer, including layer names. Layers 
visibility is also passed through, so layers set to invisible in MAGIX Page & Layout 
Designer 2013 will be exported and set to invisible in Photoshop. You can turn the 
layers on and off in Photoshop using the LAYERS palette. 

Transparency and layers 
The three most common MAGIX Page & Layout Designer 2013 transparency types 
(Mix, Stain and Bleach) are compatible with Photoshop transparency (blending 
mode) types (Normal, Multiply and Screen). But because MAGIX Page & Layout 
Designer 2013 is vector object-based, it’s possible for each individual object to have 
its own transparency type and value. In Photoshop this is not possible, and you can 
only set the opacity or blending mode for a whole layer. This means that for maximum 
compatibility and editability in Photoshop, you should place objects that use Stain and 
Bleach transparency on a layer of their own in MAGIX Page & Layout Designer 2013.  
This way, when you export, these objects remain as separate editable layers, and with 
the correct transparency type (or blending mode as Adobe calls it). 

If you combine objects that use different types of transparency on the same layer in 
MAGIX Page & Layout Designer 2013, you will get an alert warning you of this when 
you export. This may look OK when you export. Transparency types other than Mix, 
Stain and Bleach are not compatible with Photoshop. 



 

312   

www.xara.com 

Text 
You can export text from MAGIX Page & Layout Designer 2013 to be editable text in 
Photoshop, but the text must be on a layer on its own (on import you may be asked to 
update the text objects for them to be editable in Photoshop.) 

Text that is on a layer with any other graphic objects will be rasterized into that layer, 
and thus not be editable. 

Export DPI 
You will be able to set the DPI of the bitmaps in the exported PSD file. 

A DPI of 96 is the normal Windows 
screen resolution, and so exporting 
at 96dpi will appear in Photoshop at 
the same size at 100% as it does at 
100% in MAGIX Page & Layout 
Designer 2013. 

For print work you should choose a higher DPI. 

You can select to export the whole MAGIX Page & Layout Designer 2013 page area 
or just the areas of the visible objects only. 

Exporting as Microsoft XPS (XML Paper Specification) 
This is an entirely new "page description" file format invented by Microsoft. Designed 
for Vista, this is also supported on older versions of Windows by getting a free 
download. The benefit of XPS format is that it is vector based, and so is ideal as a 
resolution-independent portable document format. Fonts are embedded into the 
document and so you are ensured very high quality WYSIWYG documents. If you’re 
using Windows Vista, you can view and print these documents directly. If you’re 
using older versions of Windows, you can obtain a free XPS Viewer download from 
the Microsoft website, enabling the viewing and printing of these files. 

It should be noted that the Xara XPS export does not use the Microsoft standard XPS 
print system, but writes XPS files directly, which ensures far higher fidelity and far 
smaller XPS files. 

XPS supports advanced vector features such as transparency, CMYK colors and 
embedded fonts. 
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XPS export dialog 

Font Subset: Any fonts used in your document are automatically embedded into the 
XPS document to enable the viewer to correctly display all text. Selecting this option 
embeds fonts containing only those characters used in the document. This can 
significantly reduce the XPS file size. 

View XPS when finished: This will automatically open the XPS viewer and display the 
saved file. 

Rasterization 
XPS is a vector format, but it doesn’t support some of the advanced effects, fill and 
transparency types supported by Xara. Files containing, for example, objects with 
feathered edges will result in that object being rasterized, that is converted into an 
alpha-channel bitmap. The resolution of this rasterization process is controlled by 
these fields. 

Resample JPEG images 
JPEG photo images contained in a Xara file are usually embedded as the full 
resolution original JPEG file (and is thus a lossless process). However, for many 
applications this might be overkill. E.g. a typical modern digital camera can easily 
create a 4Mbyte JPEG file, 3000 pixel across or more. If this is placed on the page in 
Xara and scaled to be say 2 inches across, that photo would be at a resolution of more 
than 1500dpi – way more than is required for any printing application. (The resolution 
of bitmap object is shown on the Status line in Xara). 
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You can therefore choose to resample JPEG photos to a lower resolution more suited 
for viewing on screen (e.g. 96dpi) or printing (typically not more than 300 dpi)., and 
thus reduce the size of the XPS file. The JPEG quality slider controls the quality of the 
resampled JPG. The lower the quality, the smaller the resultant XPS file. A quality of 
75 is the recommended setting which is actually very high quality image. 

Color Mode 
XPS files, like Xara documents can contain a mix of both RGB and CMYK colors. 
However, the XPS viewer shows CMYK colors as color corrected for the printer. Xara 
on the other hand shows all colors (CMYK and RGB) as screen colors or printer colors 
(depending on the Show Printer Color menu option). This slightly different approach 
to displaying colors can result in significant differences between RGB and CMYK 
version of the same color. In Xara, for example, cyan is shown as the same color on 
screen whether it’s been defined as CMYK or RGB. XPS displays the same color 
completely differently. 

Selecting the RGB colors option will force all colors to be converted to RGB to provide 
consistency with the way Xara displays colors. Selecting Native colors will export 
objects using whichever color model you’ve used in Page & Layout Designer, but this 
will likely result in color changes where you’ve mixed RGB and CMYK colors in the 
same document. 

PDF Export 
The Portable Document Format (PDF) provides the best way to transfer drawings and 
document to others.  The free Adobe PDF Reader is very popular and enables anyone 
to view and print your PDF document. 

For very complex vector graphics, PDF can be very slow (sometimes 20 times or 
more than MAGIX Page & Layout Designer 2013), so drawings that take a few 
seconds to draw in MAGIX Page & Layout Designer 2013 can take minutes, 
especially when printing. So sometimes it’s quicker to convert complex vector 
graphics into a bitmap before exporting your PDF. 

PDF files are vector graphics files-which means they are resolution independent, and 
are great for printing on high resolution devices, and you can zoom in to view detail 
with no loss of quality.  Your graphics or document exported as a PDF should look 
exactly like it does in MAGIX Page & Layout Designer 2013. 

There are different versions of PDF, including a specialized version, known as PDF/X 
which was developed by the printing industry and has become a very popular way of 
transferring files for commercial printing. 

PDF/X creation is only available in Xara Designer Pro 
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MAGIX Page & Layout Designer 2013 provides very comprehensive controls over 
many aspects of your PDF output. These are just some of the options and features 
you can control in MAGIX Page & Layout Designer 2013 PDF output. You can: 

• embed fonts in the file which means all readers can be sure of seeing the file 
exactly as you intend, but this makes the files larger. You can also select to 
embed only a subset of the fonts (only the used characters) to reduce the PDF 
file size; 

• set it to re-sample all images or photos to be any required resolution so they are 
not unnecessarily high resolution; 

• set it to convert bitmaps to JPEG or remain in their raw state; 
• make it so that layers in your MAGIX Page & Layout Designer 2013 drawing are 

visible and can be switched on and off in Adobe Reader; 
• select which version of PDF or PDF/X file you want to create; 
• select which pages of a multi-page document are exported; 
• make your PDF file password protected; 
• even embed the original .xar file (or other files) into the PDF for the ultimate in 

document portability. 

To make life easier all the options have been distilled down to four easy choices. 
When you export as a PDF you are presented with a choice of the following presets: 

• Draft quality. 
• Email distribution or Web download. 
• High quality. 
• Commercial printing (PDF/X). (Xara Designer Pro only) 

You can customize the settings of any of these presets by clicking the ADVANCED 
OPTIONS button. 

Exporting PDF files 
PDF versions 
PDF has evolved over the years as more features have been added. Typically, along 
with each new version of PDF, a new version of Adobe Reader is released to support 
the new PDF features. Unfortunately, the version number of PDF Reader and the PDF 
file do not match. So, for example, Adobe Reader version 5 is required to read PDF 
versions 1.4. 

PDF version 1.4 was the first version to support transparency and so is the minimum 
generally recommended version to use.  Later versions support some of the extra 
features. For example, if you want to use the Layer feature (so you can switch MAGIX 
Page & Layout Designer 2013 layers on and off in Adobe Reader), you need to export 
as a PDF version 1.5, or higher, and this requires Adobe Reader version 6, or higher. 



 

316   

www.xara.com 

You can export files in PDF version 1.3, 1.4, 1.5, 1.6 and 1.7 formats as well as the 
following PDF/X standards: 

• PDF/X-1a:2001 (ISO 15930-1). 
• PDF/X-1a:2003 (ISO 15930-4). 
• PDF/X-3:2002 (ISO 15930-3). 
• PDF/X-3:2003 (ISO 15930-6). 

Objects not supported by PDF 
Some MAGIX Page & Layout Designer 2013 features do not exist in PDF, so the 
conversion to PDF has to simulate these features, usually by converting to a bitmap or 
bitmap fill. 

Transparency 
PDF version 1.3 does not support transparency. Any objects containing transparency 
will be exported as bitmaps, a process sometimes called "flattening". MAGIX Page & 
Layout Designer 2013 does this automatically. The resulting PDF file should still look 
correct however. 

Transparency Types 
MAGIX Page & Layout Designer 2013 supports a number of different transparency 
types and three of these have direct equivalents in PDF 1.4. 

• Mix:  This is the default transparency type in MAGIX Page & Layout Designer 
2013 and it's directly mapped to "normal" transparency in PDF. 

• Bleach: This is mapped to PDF transparency type "screen". 
• Stained Glass: This is mapped to PDF transparency type "multiple". 

Other transparency types in MAGIX Page & Layout Designer 2013 have no direct PDF 
equivalents, so they are converted to bitmap in the PDF file. 

Fill types 
Fill types flat, linear, circular and elliptical are all mapped directly to equivalent PDF 
types, but the other more complex fill types (Conical, Diamond, Three Color, Four 
Color, Fractal Cloud fills and Fractal Plasma fills) supported by MAGIX Page & Layout 
Designer 2013 have to be represented using bitmap fills in the PDF. 

ClipViews 
The PDF export filter does not directly support ClipViews comprised of lines or text. 
Convert all lines and text to shapes to ensure that a ClipView that contains these 
objects is properly converted. 

Blends, Molds and QuickShapes. 
Blends and Molds are not part of the PDF format. They are exported as individual 
objects. All QuickShapes are converted to simple shapes. 
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Font embedding 
The PDF filter includes support for embedding fonts within a PDF document where 
permission has been granted by the font vendor for this purpose. Where fonts are not 
embedded, if readers do not have the correct font on their system, then usually a 
"best guess" font is substituted by the reading application, resulting in loss of fidelity. 

During the export of a PDF file, you are warned about missing fonts or where required 
fonts could not be embedded. If you intend to distribute your PDF file or submit it to a 
service bureau for printing it is recommended that you: 

Ensure that the target platform has legal copies of any required fonts. 

To export a PDF file 
1. Choose "File -> Export" ("Ctrl + + E"). 
2. Select PDF OR PDF/X (*.PDF) from the SAVE AS TYPE list. 
3. Name the file then click SAVE. The PDF Export dialog will appear: 

 

The four preset options will be suitable for most PDFs. They are: 
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Draft quality (96 DPI, no font embedding) 
The draft setting is typically used when proofing a design and offers the fastest mode 
of PDF generation. The following settings are used: 
• PDF version 1.4. 
• No fonts are embedded. 
• All bitmaps and photos are embedded as JPEG images at 96dpi. 

This option will produce the smallest file, but note that because no fonts are 
embedded, if you give the file to anyone they must have the fonts used installed on 
their system in order to be able to see the document exactly as you intended. 

E-mail distribution or web download (Adobe Reader version 5 and above) 
This setting specifies filter options that are optimal for distributing PDF documents 
through e-mail and the web. Fonts are included, so you can be sure your document 
will be viewed exactly as you intended and all images are medium resolution suitable 
for inkjet printing and viewing on screen 
• PDF version 1.4. 
• Fonts are embedded, and subsetted (meaning only characters used are 

embedded as fonts). 
• All bitmaps and photos are converted to JPG at 150 dpi. 

High quality (300 DPI, larger PDF files)  
The high quality setting includes options for rendering designs as PDF documents 
where full fidelity is required at high resolution. This if most suitable for printing on 
inkjet printers or viewing at high zoom. The following are the key settings: 
• PDF 1.4. 
• Fonts are embedded, and subsetted (meaning only those characters used are 

embedded as fonts). 
• All bitmaps and photos are passed through untouched, unless they are more than 

300 dpi in which case they are sampled down to be 300 dpi but retain their 
existing type (they are not all converted to JPG). 

Commercial printing (PDF/X, 300 DPI images)  
This setting specifies the options required for generating PDF/X documents that will 
be submitted to a print company. The following are the key settings used: 
• PDF version 1.3 (as required by PDF/X). 
• Files are conformant to PDF/X-1a: 2001 (ISO standard 15930-1). 
• Fonts are embedded and subsetted. 
• Bitmaps are converted to CMYK in native (uncompressed) format according the 

ICC Color Profile "US Web Coated SWOP". 
• Bitmaps are limited to 300 dpi (high res bitmaps are sampled down). 
• Crop and printer’s marks are included if these are switched on in the PRINT 

OPTIONS dialog in MAGIX Page & Layout Designer 2013. 
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Customizing PDF export using advanced options 
If you select the ADVANCED OPTIONS button you can customize any of the above 
presets. Once you have altered any of the preset values, the next time you export a 
PDF it remembers the last settings, and the CUSTOM option will be shown. The 
following section provides an overview of this feature. 

While the four presets included in the PDF Export Filter will cover most typical 
scenarios for generating PDF output, situations may arise when greater control is 
required in order to specify the properties of the resulting document. 

To customize the output filter settings: 

1. Select the preset that is closest to the desired type of PDF. 
2. Click ADVANCED OPTIONS.... 
3. Modify the desired filter settings. 
4. Click EXPORT to generate the PDF document. 

The modified settings will automatically be stored under the CUSTOM option for use 
from that point on. 

When the ADVANCED OPTIONS button is clicked, the PDF Export Filter options appear 
in a separate dialog box grouped within the following categories: General, Objects, 
Document, Layers, Pre-Press (only Xara Designer Pro) and Security. 

PDFs for import into Adobe Illustrator (V9 onwards) 
PDF is the best format to use if you need to transfer designs from MAGIX Page & 
Layout Designer 2013 to recent versions of Adobe Illustrator. Vector shapes, bitmaps, 
text and the simple fill and transparency types will all transfer with no loss of fidelity. 

Layers 
Adobe Illustrator 9 & 10 fully support editing of layers exported in PDF files. Unselect 
the EXCLUDE INVISIBLE LAYERS option to make sure all layers in your design are 
included. Illustrator CS & CS2 will not preserve design layering. 

Text 
In order to edit text in PDF documents in Adobe Illustrator 9 and 10, embedded fonts 
must be installed on the host system. Also, you must unselect the USE UNICODE FOR 
TEXT ENCODING option in the SETTINGS dialog. 

Bitmap tiling 
Adobe Illustrator 9 and 10 will not read the PDF if tiling is used, so unselect the 
PRESERVE BITMAP TILING option. This is not necessary for CS or CS2 versions. 

Groups 
Select the PRESERVE GROUPS option in the export settings if your document contains 
groups so that they are maintained in Adobe Illustrator. 
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Note however that because PDF does not natively support groups, clipping masks will 
appear as part of imported groups in Illustrator CS & CS2. Therefore, when 
ungrouping you also need to remove the clipping mask. 

PDF Export Filter Settings: General Options 

 

The GENERAL OPTIONS tab in the PDF Export Filter provides a range of settings that 
can be configured to specify PDF document attributes including version compatibility, 
how content is encoded, and which pages are to be rendered. 

PDF Version compatibility 
The PDF Export Filter supports versions 1.3, 1.4, 1.5, 1.6 and 1.7 of the PDF format, as 
well as the most commonly used PDF/X standards to ensure compatibility with a 
wide range of applications. Unless PDF version 1.3 compatibility is required, select 
PDF version 1.4 or greater as the output format as this will provide support for 
transparency. 



 

Importing and Exporting 321  

 

Color Model 
The color encoding standard for the PDF document can be selected from CMYK, RGB, 
and NATIVE. The NATIVE option represents colors in the PDF file as they are specified 
in the drawing using RGB and/or CMYK. 

When CMYK is selected as the color model for a PDF document, an ICC 
(International Color Consortium) profile can be specified. Please refer to the section 
on Pre-Press options later in the chapter for additional information.  

Note: PDF/X documents are limited to CMYK color encoding. 

Note that Adobe Reader (and Adobe applications generally) display CMYK colors 
very differently from their RGB or HSV equivalents. To preview what your colors will 
look like when exported to PDF/X select the option "Window -> Show Printer Color -
> Simulate Print Colors". 

Options 
• OPTIMIZE FOR FAST WEB VIEWING (LINEARIZATION). Linearization of PDF files 

generated by the export filter encodes the PDF for optimal transfer and viewing 
over the Internet. Be default this option is enabled. 

• EMBED FONTS WHEN PERMITTED. Select this option to include copies of fonts in the 
PDF file that are not included in the PDF base 14 fonts supported by Adobe 
Reader. Note that only those fonts that are not restricted by copyrighting 
restrictions will be embedded in the PDF file. By default this option is enabled.  

Note: PDF/X documents (Xara Designer Pro only) require that all fonts are 
embedded in the resulting document. When exporting PDF/X with font embedding 
turned on, all fonts are embedded. However when exporting PDF the 14 base fonts 
are not embedded as these fonts are generally available to all PDF readers. 

• FONT SUBSET ONLY. This option can be used in conjunction with the EMBED FONTS 
WHEN PERMITTED option to indicate that only those characters that are used 
within a typeface will be embedded in the resulting PDF file. Selecting this option 
can reduce the size of the PDF file that is generated however it will also limit the 
level of editability. By default this option is unselected. 

• VIEW PDF WHEN FINISHED. This option can be selected to automatically launch and 
view the resulting PDF using the default application that is associated with the 
format under Windows. This option is enabled by default. 

• ENABLE CONTINUOUS SCROLLING IN ADOBE READER. Choose this option to have 
Adobe Reader synchronize the scrolling of the PDF document with the movement 
of the scroll bars in the viewing application. By default this option is selected. 
Note: this option only applies to PDF documents that contain more than one 
page. 
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Page Generation 
When generating a PDF document from a multi-page design,  MAGIX Page & Layout 
Designer 2013 optionally allows a range of pages to be specified.  

To specify which pages are to be rendered to the resulting PDF document: 

• Select ALL to export all pages contained within the design 
• Select CURRENT PAGE to export the currently selected page or 
• Select SELECTED OBJECTS to print only those objects that are selected. 
• To export a range of pages within the design, select PAGES and enter the desired 

range in the edit box. Specify individual pages by their number, separated by 
commas. To specify a range, enter a starting and ending page. For example, to 
specify that the first, third page and pages 5 through 12 of a design should be 
exported to the resulting PDF document enter the following: 1, 3, 5-12. Note: pages 
will be exported to the PDF document in the order in which they appear in the 
original design. 
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PDF Export Filter Settings: Objects Options 

 

The OBJECTS tab in the PDF Export Filter provides a series of settings that can be used 
to specify how design elements are rendered in a PDF document. 

Bitmap Compression 
Choose the compression scheme for bitmapped images that appear in the document 
by selecting from the options in the dropdown list. Supported compression schemes 
include: NATIVE (use the bitmap compression in the document), NONE (do not apply 
compression), JPEG and FLATE. 

Flate is lossless compression, the same compression used in PNG graphic files or zip 
archives. FLATE can give better results if the PDF contains lot of schematic drawings 
with less colors, but not recommended for PDFs with many photos. 
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JPEG Quality 
Use the slider control to set the JPEG quality index when using JPEG compression for 
bitmapped images. Values range from 0 to 100, with higher values specifying 
increased quality and lower values specifying increased compression and the loss of 
some image fidelity. The default JPEG quality is 85. 

Rasterization Resolution (DPI) 
For MAGIX Page & Layout Designer 2013 graphic objects that cannot be exported as 
native vector PDF objects (things like soft shadows, feathered objects, bevels), 
MAGIX Page & Layout Designer 2013 will automatically rasterize, that is convert to a 
bitmap. This option allows you to choose the DPI (dots per inch) for the rasterization 
resolution using the dropdown list, or click USE CUSTOM DPI and enter a custom value 
by checking the USE CUSTOM DPI option and specifying an integer value between 20 
and 600. The default preset value for rasterization is 150. The higher the resolution, 
the larger the PDF file. It is not usually necessary, even for the highest quality printing 
to use a value above 300dpi. 

Options 
INCLUDE HYPERLINKS: Select this option to preserve any objects containing hyperlinks 
in the outgoing PDF file. By default, this option is selected for standard PDF 
documents. This option is not selected and disabled for PDF/X documents, since 
hyperlinks are not allowed. 

CONVERT TEXT INTO SHAPES: This option can be selected to convert all text content 
into vector shapes. This option can be specified to preserve the appearance of text 
when equivalent fonts may not be available on the target system or when font 
embedding is not permitted. Note that the text in the resulting PDF file is translated 
into shapes and is no longer editable as text. By default this option is not selected. 

USE UNICODE FOR TEXT ENCODING: This option can be used to select the method to be 
used for encoding text in the resulting PDF document. By default, this option is not 
selected and text is encoded using the ANSI encoding scheme. Selecting this option 
specifies that text should be encoded using Unicode. 

PRESERVE BITMAP TILING: This option determines the method that the export filter 
uses to generate tiles in the PDF file. By default, the preserve bitmap tiling option is 
selected and a series of individual bitmaps are used to fill the corresponding object. 
This option should be unchecked when the resulting PDF files are to be used in Adobe 
Illustrator 9 and 10 or in any other application that does not directly support bitmap 
tiles as fills. 

PRESERVE GROUPS: Use this option to maintain groups in the resulting PDF document. 
Note that because the PDF format does not natively support groups, grouping is 
emulated using clipping masks. 
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PDF Export Filter Settings: Document Options 

 

The DOCUMENT tab contains items that can be used to specify authoring information 
and how a PDF document will be opened within Adobe Reader. 

Description 
Within this section, the title, author, subject and keywords for the outgoing PDF 
document can be optionally added. Select INCLUDE DOCUMENT INFORMATION to 
embed these details in the resulting PDF file. By default this feature is not selected. 

Initial View 
Select from among the document viewing options in the dropdown list to specify the 
magnification level of the resulting PDF file when it is viewed in applications that 
support this feature. The default magnification level is 100%. 

Note: This feature is not available for PDF/X documents. 
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Reader Display Setup 
When generating a PDF file that is intended for display in Adobe Reader, you can 
select from among the display setup options in the dropdown list to specify how the 
viewer is configured when the file is opened. 

Options are included for displaying only the page, the bookmarks panel and page, the 
pages panel and page, a full screen version of the document, the layers panel and 
page (PDF 1.5) and the attachments panel (PDF 1.6). The display setup options for 
showing the bookmarks, pages and the layers panel are particularly useful when 
generating PDF documents in which layers are used. 

The default Reader display setup option is PAGE ONLY. 

Note: This feature is not available for PDF/X documents. 

File Embedding 
A unique feature supported by the PDF document format is its ability to embed files 
at the document level. The MAGIX Page & Layout Designer 2013 PDF Export Filter 
allows one file of any size and  type to be added to the exported PDF. When the PDF 
document is opened by applications that support file embedding (such as Adobe 
Reader or Acrobat), the embedded file appears in the attachments list panel. 

Embedding a file within the PDF document is particularly useful when distributing an 
illustration or submitting it to a service bureau. Examples for the use of this feature 
include attaching the original MAGIX Page & Layout Designer 2013 .xar file, a readme 
file outlining author and copyright information or a high resolution rasterized version 
of the illustration to the resulting PDF. 

To embed a file within an outgoing PDF document, simply click the ellipses button [...] 
to select a file from within a file open dialog or type in the path of the file manually.  

Enable EMBED SELECTED FILE to add the file to the PDF document. By default this 
option is not selected. 

An optional description may also be provided for the embedded file. This description 
will appear as a comment when the attachments panel is viewed in Adobe Reader 
and Acrobat. 

Note: File Embedding requires that the PDF Version compatibility be selected as 1.4 or 
greater. 
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PDF Export Filter Settings: Layer Options 

 

The LAYERS tab within the PDF Export Filter provides a means to specify how layers 
within a drawing are rendered for in the PDF document. 

General Options 
Exclude invisible layers. This option can be checked to exclude all invisible layers in 
the outgoing PDF file. To eliminate guide layers from a PDF document, set the layer to 
invisible in the MAGIX Page & Layout Designer 2013 Page & Layer Gallery and export 
the drawing with this option checked. 

Layering Methods (standard PDF only) 
DO NOT GENERATE READER LAYERS: Separate layers do not appear in the resulting PDF 
document. This option is enabled by default. 
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ENABLE READER LAYERS IN A SINGLE PAGE (PDF 1.5 AND ABOVE ONLY): Layers are 
rendered within the document on a single page, with layering labels included for 
display within Adobe Reader's Layer Gallery. 

GENERATE BOOKMARKS FOR EACH PAGE: Select this option to include bookmarks in the 
resulting PDF document for each page of your document. A bookmark is generated 
for each page, using the page name as defined in the PAGE & LAYER GALLERY 
("Rename page" in the context menu). If there is no page name set, then the 
bookmarks are named simply “Page 1”, “Page 2”, etc. In Adobe Reader you can display 
the list of bookmarks in the document and then just click on them to jump to each 
page.  

Crop and Printer’s Marks 
Include crop and printer’s marks in the PDF document. Select this option to include 
crop and printer’s marks in the outgoing PDF document. This feature is particularly 
useful when submitting PDF files to be printed through a service bureau. By default 
this feature is unselected. Note: to use this feature you must check the OUTPUT 
PRINTER'S MARKS option and select the desired types of marks to be included within 
the Imagesetting tab of the PRINT OPTIONS dialog. 
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PDF Export Filter Settings: Pre-Press Options 

 

The PRE-PRESS tab includes items for specifying characterization settings and the 
embedding of ICC (International Color Consortium) color profiles for print production. 

ICC profiles are files containing data that specifies how colors are to be rendered on a 
particular output device. The use of an ICC profile is mandatory for PDF/X 
documents, optional for CMYK-based PDF documents and not applicable for all other 
types of PDF documents. 

Specifying an ICC profile of use in PDF/X documents: 

Output Intent Profiles 
When generating a PDF/X document for print production, output intent profile 
settings based on an ICC profile must be specified in order to ensure that the output is 
rendered properly on the intended output device. MAGIX Page & Layout Designer 
2013 includes presets for the most popular output intent profiles used in North 
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America, Europe, and Japan. To specify the use of one of the preset output intent 
profiles, simply select it from the list. 

Custom Output Intent Profiles 
If the output intent profile that is required for print production is not provided in the 
list provide with MAGIX Page & Layout Designer 2013, it is possible to enter the 
desired output by selecting "Custom" in the intent profiles list. Here you may enter 
the optional Output Condition and the required Output Condition Identifier that 
corresponds to the output device. 

Note that for PDF/X compliance, Custom profiles must be embedded in the resulting 
documents. Follow the instructions below for details on how to specify the location of 
ICC profiles. 

ICC Profile Embedding 
The MAGIX Page & Layout Designer 2013 PDF filter includes provisions for 
embedding ICC files within a PDF document.  An embedded ICC profile is required for 
a Custom output intent if the characterized printing condition is not in the registry of 
CMYK characterizations on the ICC web site (www.color.org). 

The output intent profiles included with MAGIX Page & Layout Designer 2013 are not 
embedded in the resulting PDF/X document as they are readily available in workflow 
environments. 

To embed an ICC profile within a PDF document: 

1. Click the ellipses button [...] to select a file from within a file open dialog or 
type in the path of the file manually. 

2. Click EMBED THIS PROFILE to include the ICC profile in the outgoing PDF 
document. 

By default the file embedding feature is unselected. 

Note: Please be sure to consult with your print service bureau to determine the 
appropriate settings for all pre-press options. 

Specifying an ICC profile of use in CMYK-based PDF documents: When a CMYK 
color model is selected for standard PDF documents a profile may be specified from 
the Output Intent Profiles list as a reference when performing the actual color 
conversion. The output intent profiles included with MAGIX Page & Layout Designer 
2013 may be embedded in the resulting PDF document by clicking EMBED THIS 
PROFILE. If you wish to use a profile that is not included in the list of presets, specify a 
Custom profile as described above and select whether or not you wish to embed it in 
the document. 
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PDF Export Filter Settings: Security Options 

 

The SECURITY tab provides support for specifying security attributes and permissions 
settings that determine how the PDF document can be used once it is distributed. 
These options are only available for standard PDF documents and cannot be used 
when generating PDF/X files. 

To include these security settings in the outgoing PDF document, check "Apply 
security". By default this feature is not selected. 

File Open Password 
To password-protect a PDF document, specify and confirm a password. This 
password will be required when a user attempts to open the document for viewing. 

Note that it is strongly recommended that a document also be encrypted if a file 
open password is applied as this security scheme is known to be relatively easy to 
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compromise. As a result, file open passwords should only be used as a means of 
security to prevent inexperienced users from accessing sensitive documents. 

Document Encryption and Permissions Password 
To encrypt a PDF document, select an encryption method and specify and confirm a 
password. This password will be required when a user attempts to make changes to 
the document, including modifying security and permissions settings. The encryption 
password is often referred to as the owner or master password and it may also be 
used to open the PDF document. 

Additional document permissions settings (outlined in the section below) may be 
applied to determine the degree to which a user can interact with the encrypted 
document. 

Four encryption methods are available: 

• NONE: This setting will not apply any document encryption. This is the default 
encryption option for the document. 

• 40-BIT RC4: This setting will apply a 40-bit encryption algorithm to the document. 
• 128-BIT RC4: This setting will apply a 128-bit encryption algorithm to the 

document. 
• 128-BIT AES: This setting will apply the 128-bit AES encryption algorithm to the 

document. If the PDF document contains confidential or highly sensitive material 
this method of encryption is considered to be the most effective means of 
securing the contents. Note: PDF 1.6 is required to support this encryption 
method. 

Document Permissions Settings 
The document permissions settings section allows you to specify actions that can be 
undertaken on an encrypted PDF document when it is rendered or processed by 
another application. 

Within the DOCUMENT PERMISSIONS SUMMARY section, check any of the following 
settings to allow a user to perform the following tasks: 

Printing: Selecting this option allows a user to print the PDF document. By default this 
option is selected. 

Extraction for accessibility: Selecting this option allows content to be extracted by 
applications that assist users with impairments. By default this option is selected. 

Commenting: Checking this option allows users to add comments and annotations to 
the PDF document. By default this option is selected. 

Modification: Enabling this option allows users to change the contents of the PDF 
document. By default this option is selected. 



 

Importing and Exporting 333  

 

Document assembly (requires 128-bit encryption): Checking this option allows a 
user to merge or append this document with other documents. By default this option 
is selected. 

Content copying or extraction (requires 128-bit encryption): Selecting this option 
allows a user to copy or extract elements of the document, including text and 
graphics. By default this option is selected. 

Note: The PDF document must be encrypted in order for these permissions settings 
to be applied. In addition, the responsibility for respecting these permissions settings 
is left to the application that is used for processing the PDF document. 

JPEG, PNG, GIF and BMP export dialog overview 

 

The Export settings dialog has two 
preview windows, IMAGE A on the 
left and IMAGE B on the right, so you 
can compare alternative export 
settings or file types, side-by-side. 
Just click on the left or right 
preview window to change the 
active preview. 
Above the preview window is a 
small dropdown that lets you select 
from the most common four export 
type, JPEG, PNG, GIF and BMP. 

When you have selected preview A or B you can then adjust a wide range of export 
options using the five tabs below the preview. Some options, such as the Palette 
Options are only applicable to some file types such as PNG and not relevant to JPEG 
type. 

Other options under the OPTIONS tab change depending on the file type. e.g. when 
exporting a JPEG this is where you can set the required quality. 

So the process for exporting an image: 

1. Select the object or objects on the page you want to export 
2. Select the Export menu, or "Ctrl + Shift + E", enter a file name, and select file 

type from the drop down list. The main export type will display the above 
preview dialog. 

3. In this Preview dialog adjust the settings if you want, or skip this if you're 
happy with the default settings 

4. Click the EXPORT button 
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For most commonly used JPEG and PNG formats, at step 2 you can instead use the 
direct operations available in the FILE MENU: EXPORT JPEG and EXPORT PNG. The export 
dialog shown includes a “Settings” button which takes you to the export settings 
dialog shown above. 

Most export settings are remembered for the next time you export. For example if you 
adjust the JPEG quality, the next time you export a JPEG it will remember the last 
quality setting. 

Exported Image Size 
When you export the normal default size is the same as you see on screen at 100% 
zoom. The pixel size is shown under the preview window. You can adjust the pixel 
dimensions either by adjusting the object size on the page before you export, or by 
entering alternative pixel or dpi values in the BITMAP SIZE tab. 
Preview Controls 
These buttons alter the preview of the images, but do not affect the exported file: 

 

• ZOOM TOOL: Click on a preview to zoom in. Shift-click to zoom out. 
Drag over an area of the preview to zoom into that area. 

• PUSH TOOL: Lets you drag the image around in the preview window. 

• ZOOM TO FIT: Scales the preview image to fit the window. 

• ZOOM TO 100%: Scales the image to full-size (100%). 

• ZOOM TO RESOLUTION OF IMAGE (1:1): Has no effect for GIFs. Scales 
the image so one pixel in the bitmap is one pixel on screen. This is 
useful for previewing detail in the bitmap. 

The following tool is only relevant to files using less than 256 colors (but you will see 
the result when you have the PALETTE OPTIONS tab selected): 

 
COLOR SELECTOR: Moving the pointer over the image highlights the color under 
the pointer. Click to select that color in the palette. You can then use PALETTE 
OPTIONS buttons (described below) to alter that color. 

PREVIEW: The preview button is available on all tabs of this dialog. It updates the 
preview windows to reflect any changes you have made to the export options. 

Palette Options tab 
This tab allows you to alter the color settings of your exported image. 

Dithering & Palette 
The DITHERING and PALETTE options only apply when you export with 256 color or 
less, and affect how the image is displayed and its color palette. It is recommended to 
always use an OPTIMIZED PALETTE. Set DITHER to none, which produces smaller files 
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but may be banded, or ERROR DIFFUSION, which creates higher quality results, but 
larger files. 

Color Depth 
Choose the number of colors your bitmap requires. The more colors, the larger the file 
(usually), and the higher the quality.  The TRUE COLOR option supports up to 16 
millions colors. TRUE COLOR + ALPHA includes semi-transparent features such as soft 
shadows and transparency. For applications that support alpha-channel PNG files this 
is the recommended format. 

If you choose 256 colors of less, you have the option to use simple transparency 
(Wine glass icon-see below). This doesn't support semi-transparent pixels, only 
"on/off" fully opaque or fully transparency pixels, and so can produce jagged edges. 

Max Colors 
If you select a Color Depth of 256 or less you can control exactly how many colors are 
used in the file. This provides a high degree of control over quality vs. file size. Just 
enter the required number of colors and press the PREVIEW button to preview. 

Buttons 
These buttons (except TRANSPARENT BACKGROUND) apply when exporting 256 color 
images or less. These files are created with a limited palette of colors, and these 
controls provide a great degree of control over those palette colors. See COLOR 
SELECTOR above on how to select a color, or click on a color in the COLOR PALETTE). 

 
Lock a Color 

You can specify the number of colors you want in the palette of exported bitmaps. 
You may want to ensure that certain colors always appear in the palette; you can lock 
these colors. Click on a color to select it, then select the LOCK button. A small square 
appears in the bottom left of the color to tell you it is a locked color. 

 
Make a Palette Color Web Safe 

When clicked this button will shift the selected color to be one of the 216 common 
web browser palette colors. This is a legacy system that is no longer particularly 
important or relevant, as nearly all computers can display millions of colors, and 
there's no benefit in restricting web graphics to only this limited palette. 

 
Make the Image Background Transparent 

Make any areas not covered by the selected objects transparent. Selecting this option 
automatically makes one entry in the palette transparent. 
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Make a Palette Color Transparent 

Make this color entry transparent. Note the difference between this option, which 
makes parts of the selected objects transparent, and Make The Image Background 
Transparent which makes those areas behind the selected objects transparent. 

 
Delete a Palette Color 

Delete this color from the palette. Any areas in the bitmap that use the deleted color 
then use the nearest color in the palette. The fewer colors in the palette, the smaller 
the bitmap file. 

 
Restore a Previously Deleted Color 

Undelete a deleted color. 

 
Add system colors 

Adds 28 colors to the palette. These colors are the regular Windows system colors 
and a number of primary colors. This ensures the palette includes a spread of colors 
and may improve the quality of the image, particularly if it contains a wide range of 
colors. You may need to experiment with this option to get the best results. 

Bitmap Size tab 
With this tab, you can change the size of the exported image. 

Bitmap Size and Resolution 
You can change the size of the exported bitmap by changing: 

• SIZE: Type the required width or height into one of the fields. Note that the aspect 
ratio of the bitmap is fixed, so changing one dimension automatically changes the 
other. SIZE is more suitable than SCALE if you want to create a bitmap of a 
particular size in pixels. 

• SCALE: (Dimmed for JPEG & PNG). This lets you scale the bitmap up or down by a 
percentage. SCALE is more suitable than Size if you want, for example, a bitmap 
50% bigger than the original. 

• RESOLUTION: (Dimmed for GIF & BMP) Type the resolution into the DPI field. If 
you are exporting an image for viewing on screen (i.e. a website), you do not 
need a setting higher than 96 DPI. 96 DPI also ensures the bitmap is the same 
size as the objects on screen (at 100% magnification). 

Area to Save 
The bitmap can be created using one of these areas of the document: 

• PAGE: The whole page area. 
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• DRAWING: The area covered by objects. 
• SELECTION: The area covered by the objects in the selection. Only available when 

objects are selected. 

Anti-aliasing 
Anti-aliasing improves the appearance of graphics by smoothing jagged edges: 

• MAINTAIN SCREEN ANTI-ALIASING: The exported bitmap uses the exact same 
positioning as shown on screen, and so has identical anti-aliasing. This can result 
in the edges of objects being slightly blurred because they do not fall exactly on 
pixel boundaries. 

• MINIMIZE VISIBLE ANTI-ALIASING: This will slightly reposition the objects by 
fractions of a pixel to minimize the anti-aliasing around the edge of the exported 
bitmap. If in doubt which option to use, select this. 

Put HTML Image Tag on Clipboard 
This lets you save out the basic HTML IMG tag information when you save the 
bitmap. You can then paste the tag into your text or external HTML page editor. 

Options tab 
With this tab you can alter JPEG compression and turn on progressive/interlacing 
options if required. 

Progressive: (JPEG only) Selecting this option creates a progressive JPEG. This is 
useful when the JPEG is large and used on a web page.  Web browsers will start 
displaying the image before the JPEG file has completely downloaded. 

JPEG Quality: (JPEG only) A low setting will result in a small file with a loss in quality 
whereas a high value will give only slight file size reductions, but high quality. Note 
that a setting of 100% will still compress the file. A setting of 75% gives good 
compression without causing a noticeable loss in quality for most uses. 

Interlaced: (GIF and PNG only) This is like progressive JPEG. In the browser the 
picture first appears as a low resolution image. As more of the file loads, the 
resolution increases. 

Transparent: (GIF and PNG only) This makes any areas not covered by the selected 
objects transparent. Selecting this option automatically makes one entry in the palette 
transparent. 

Export each layer to a file of its own: Selecting this option when exporting a design 
that contains multiple layers results in a separate file being exported for each layer. 
The names of each layer (as set in the PAGE & LAYER GALLERY) are used to name the 
exported files. 
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Other bitmaps Export dialog box 
Bitmaps other than GIF, PNG BMP and JPEG (for example TIF) use this EXPORT dialog 
box. Not all options apply to all types of bitmap: 

 

Bitmap size and resolution 
Lower resolutions produce smaller files but at reduced image quality. The best 
resolution depends on where the bitmap will be used. For display on screen a 
resolution of 96 DPI is adequate. For printing, higher resolutions are required. 

Experience shows that it is rarely necessary to output bitmaps at more than 300 DPI 
(especially when anti-aliased) even for highest quality typeset results. 

Enlarging or reducing the displayed image changes the apparent resolution. For 
example, a 100 DPI bitmap displayed at half size has an apparent resolution of 
200 DPI. Conversely, enlarging the image reduces the apparent resolution. 

You can also specify the size in pixels. Either choose from the menu or type a value 
into any of the text boxes. 

Compression 
The compression options vary depending on the bitmap type. BMP files offer RLE 
compression. TIF files offer LZW compression, or for monochrome (1-bit) you also 
get a choice of HUFFMAN, GROUP 3 FAX, GROUP 4 FAX, OR PACKBITS COMPRESSION. 

Save Spread/Save Drawing/Save Selection 
You can: 
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• Save the entire area (the spread). This can create very large files especially if you 
select more than 256 colors. 

• Or save the area covered by the drawing. 
• Or save the area containing all the selected objects. Everything within the area is 

saved including any unselected objects. 
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Working with Templates 
Using the templates available in the Designs Gallery is the quickest and easiest way to 
create high quality designs such as Photo Albums, Flyers, Calendars, Cards, 
Newsletters and other Documents. 

To load a template, open the Designs Gallery and double click on a template 
thumbnail in one of the design categories. Once loaded, you can customize the 
template to produce your own personalized high-quality design. Typically you’ll want 
to replace any photos with your own, enter your own text and perhaps change the 
color scheme, all of which is trivial in MAGIX Page & Layout Designer 2013. This 
chapter describes how to do these customizations easily. 

Replacing photos 
To replace a photo simply drag your own image file (JPEG, GIF, PNG, BMP) from your 
Windows File Explorer and drop it on top of the picture that you want to replace. Your 
photo will automatically be scaled appropriately to replace the template photo. The 
new photo will be selected and you’ll be put into the Fill Tool so that you can easily 
adjust the position and scale of your photo if desired (see below). 

Alternatively you can load your photos into the current design using "File -> Import". 
This adds a new photo object to your design and also adds it into the BITMAP 
GALLERY. Remove the new photo from the page by selecting it and pressing "Delete". 
Then drag your photo from the BITMAP GALLERY and drop it onto a template photo to 
replace it, as described above. 

By default when you replace a photo, any other copies of that photo on the current 
page are also replaced. This is usually what you will want, because some templates 
have multiple copies of the same photo which need to be replaced, including some on 
hidden layers. E.g. perhaps a large version of a photo and a thumbnail version of the 
same photo. However if you want more control over the photo replacement, hold 
down CTRL while dropping your photo and then you’ll be asked which instances of the 
photo you want to replace. 

You can also replace multiple photos at once in most templates. Select the photo files 
in Windows File Explorer (Ctrl+click to add to the current selection) and then drag the 
files onto the page in MAGIX Page & Layout Designer 2013. 

See the Photo Handling chapter for more information. 

Note: Normally you should not replace photos by first deleting the template photo 
as this will also delete the shape that holds the photo, which determines its size. If 
you have deleted a photo in this way, use the Undo function ("Ctrl + Z") to restore it 
and replace the image as described above instead.. 
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Adjusting a photo in its frame 
You’ll often want to adjust the position, scale and rotation of a photo in its frame. 
Select the Fill Tool, then click on the photo. You will see a two-way fill arrow appear 
on the photo. You can move the photo around inside the frame by dragging on the 
image away from the fill arrow. By dragging on the ends of the fill arrows, you can 
rotate and scale the photo within the frame. Hold "Ctrl" down when doing this to keep 
the picture upright while scaling. 

Note: If you want to move a photo around the page with its frame, instead of moving 
the photo within its frame, go into the SELECTOR TOOL. Then deselect the photo by 
clicking an empty area of the page, or by hitting Escape, and then, you can click and 
drag on the photo to move it with its frame. 

Editing photos 
The easiest and most convenient way to edit photos in your design is to use the built-
in PHOTO TOOLS. These can be found on the Photo Tools fly-out bar on the main 
toolbar. 

 

 Enhance Tool 

 Clip Tool 

 Clone Tool  

 Red-eye Tool  

 Content Aware Photo Scaling/Zooming  

 Levels Tool  

 Panorama Tool  

 Perspective Correction Tool  

 EXIF Tool 

Use the Photo Enhance Tool to perform the most common adjustments to your 
photo, such as adjusting brightness, contrast and saturation. You can also crop 
photos while in this tool by just dragging on the photo. Or go into the dedicated Clip 
Tool for more clipping options. The Clone Tool is useful for removing unwanted parts 
of an image non-destructively, by copying one part of a photo to another. There are 
also tools for intelligently resizing an image, removing red eye effects, making 
panoramas, correcting perspective  and other photo editing functions. 

See the Photo Tool chapter (on page 276) for full details. 
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Changing text 

 
Double click on the text you want to edit to go into the TEXT TOOL, or just click 
the TEXT TOOL icon on the main Toolbar. 

You can drag over the text to select it and then type to replace it, just as in a Word 
Processor.  

To change the font, drag select the region of text to be changed and select from the 
font dropdown menu on the InfoBar 

 

You can add new passages of text to the design by just clicking and typing, or, to 
create a block of text with a set width and height, click and drag diagonally on the 
page while in the TEXT TOOL and then enter your text into the text frame that appears. 
You can easily make a passage of text automatically flow around photos and other 
objects on your page. All you have to do is right click on an object and choose 
“REPELLING & ANCHORING” to make that object repel text that is underneath it. See the 
Repelling Text section (on page 192) of the TEXT TOOL help for details. 

Or you can anchor an object to a particular point in text, so that the object follows the 
text as the anchor point moves. Right click on it and choose ANCHOR TO TEXT. After 
anchoring, move the object to where you want it relative to the text, using the 
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SELECTOR TOOL. Now as you edit the text and the anchor point moves, the anchored 
object moves too. See the Text Tool chapter (on page 194) for more details. 

Changing colors 
Editing theme colors individually 
To edit a template’s theme colors, right click on one of the larger square named color 
patches on the left of the Color Line at the bottom of the window and choose Edit in 
the menu that appears. This opens the Color Editor. There will usually be several 
named theme colors in the Color Line - hover the mouse pointer over the color to see 
the tooltip showing the color name. Sometimes there will also be several colors linked 
to a theme color that will change at the same time; these are shown on the Color Line 
with smaller color squares, but normally you won’t need to edit these because they 
change automatically with the main theme colors. 

You can also click on any object in the design to select it and then click a named or 
palette color on the Color Line to change the object’s color. But this is not the best or 
recommended way to edit the colors in a template, because choosing a palette color 
permanently separates the object from the theme colors of the design. It’s better to 
edit the theme colors as described above so that all instances of that color, and 
shades of that color, are updated in your design. 

Once you’ve changed the theme colors in your document, if you then paste in or 
import templates which still use the original theme colors, you’ll be presented with a 
choice. You may want to import the new objects with their original colors, in which 
case choose the ‘Don’t match’ option. But more likely you’ll want them to be changed 
to match the colors you’ve chosen for your document, in which case choose the 
‘Match’ option. The color matching prompt is shown whenever you import objects 
which share a color name with the colors already in your document, where the actual 
color values differ. See Color Handling for more information. 

Page background color 
If you drag a color from the Color Line over the page, and drop it, it will set the page 
background to that color. 
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Once you’ve set the color this way, if you want you can refine it using the color editor. 
Right click on the page and choose CHANGE PAGE BACKGROUND from the menu. The 
color editor appears allowing you to edit the page color. 

 
To set a repeating background texture, drag the photo or bitmap onto your 
document. Open the Bitmap Gallery, scroll to the photo you just loaded, click 
on it to select it, and then click the BACKGROUND button on the Gallery. 

 

Adding Pages 
You can easily add more pages to your design to create multi-page documents. 
Simply drag a page template from the Designs Gallery onto your document and it will 
be added as a new page immediately following the current page.  
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Customizing Page & Layout Designer 

Changing the blank template document 
The blank template documents are the options available under "FILE" > "NEW".  

  Pre-designed templates are available from the DESIGNS GALLERY (or "FILE" > 
"NEW FROM DESIGNS GALLERY"). 

To add a template document: 

1. Open an existing document ("FILE" > "OPEN", or "Ctrl + O") or create a 
new one with the NEW button on the Standard control bar or "Ctrl + N". 

2. Make any required changes (these could be changing the page size, 
adding a logo or adding a message). You can edit the template 
document just like an ordinary document. 

3. When you are happy with the changes choose "FILE" > "SAVE 
TEMPLATE" and choose a template name. 

 

To make your new template the default template (i.e. which is there when you first 
open Page & Layout Designer, and which appears when you press "Ctrl + N") check 
the USE AS DEFAULT TEMPLATE option when saving the template. 

Options in the Utilities menu 
Keyboard shortcut: "Ctrl + Shift + O" or right click the page/pasteboard and choose 
PAGE OPTIONS. 

This menu option opens the OPTIONS dialog box. This lets you set various options for 
Page & Layout Designer. 
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General tab 

 

Current layer always visible and editable 
With this option selected, selecting a layer in the PAGE & LAYER GALLERY automatically 
makes it visible and editable. 

With this option unset, the visible and editable states of a layer remain unchanged 
when you select that layer. 

Give new objects most recent attributes 

Examples of attributes are line width, dash pattern, arrowheads, color, fill color and 
type of fill. 

With this option set, new objects take the attributes of the object that was last drawn 
or selected. For example, you might give an existing shape a red fill and green line 
color. If you then draw a new shape it will also have a red fill and green line color. See 
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the "Current attributes" (on page 21)  section of the Getting Started chapter for a full 
description of current attributes and this option. 

This option is on by default. 

Ask before setting current attribute 
This applies when changing a current attribute (this happens when you change an 
attribute with no objects selected). With this option set, you are asked to confirm 
whether you want to change the attribute. With this option unset, the change is made 
without confirmation. 

Make groups be transparent as a whole. 

See Transparency (on page 222) for more on transparencies. 

When applying transparency to a group of objects, by default Page & Layout Designer 
will apply the transparency to the group as if it were one object (i.e. you will not see 
individual transparencies within the group). Unselecting this option will make Page & 
Layout Designer add transparency to each object in the group separately. 

Maintain imported layer names 
With this option set, layer information is preserved when you import templates or 
other files. With IMPORT LAYERS INTO THE ACTIVE LAYER instead selected, all imported 
objects appear in the current layer and the layering information in the incoming data 
is ignored. IMPORT LAYERS INTO NEW LAYERS will create a layer for each imported 
layer. 

Recent file list size 
The File menu shows a list of the most recently loaded or saved files in its ‘Open 
recent’ sub-menu. This list gives a quick way to reload any of those files. This option 
lets you change the number of files listed (between 1 and 20 files). 

Marquee Object Selection 
This option enables you to change the default setting for marquee selection (on page 
99) (where you drag a selection rectangle over the objects you want to select). So 
you can choose to have objects touching the selection rectangle selected or only the 
objects wholly inside the rectangle. 

Show Windows compatible text lengths 
See Browser text compatibility in the TEXT HANDLING chapter. 

Angle constraint 
This applies when rotating or moving an object with "Ctrl" pressed. 

You can either select from the menu or type in a value in degrees. 
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Nudge size 
This applies when moving objects using the arrow� keys on the keyboard. 

This text box defines how far the object moves for each key press. If the document 
uses scaled units (for example, 1inch to 1mile), this text box shows the distance in the 
scaled units. 

When nudging, "Ctrl" and "Shift" increase the nudge distance by five and ten times, 
respectively. 

Duplication distance 
"EDIT" > "DUPLICATE" (Ctrl + D) creates a duplicate which is offset from the original 
object. These text boxes set the offset distance. 

Positive values create the duplicate above or to the right of the original object. 

Negative values create the duplicate below or to the left. 

Grid and Ruler tab 

 

Grid and Ruler spacing 
MAJOR SPACING defines the distance between the major grid and ruler divisions. The 
units used for the grid and rulers are defined by the units you use for the major 
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spacing. For example entering a major grid spacing of 2CM will set the grid and ruler 
units to centimeters regardless of the page units specified in the units options. 

Grid type 
MAGIX Page & Layout Designer 2013 allows the use of a standard RECTANGULAR grid 
or an ISOMETRIC grid. 

Origin (0,0 point) 
Normally, the origin for the grid and rulers is at the bottom left-hand corner of the 
page. If you wish to move it to a different location, change the origin value. 

Coordinate Direction 
Here you can change the direction of page coordinates so that, for example, Y values 
increase as you go down the page. This is useful when you want the 0,0 point to be 
the top left corner and increase down the page like it does for HTML.  

Internet tab 

 

Internet Cache 
When MAGIX Page & Layout Designer 2013 downloads gallery items from the 
Internet, it stores them in a reserved area of disk memory called a "cache". When 
MAGIX Page & Layout Designer 2013 uses these items in the future, it can load them 
directly from the cache, which is much more efficient than downloading over the 
Internet. 
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CACHE USAGE indicates the amount of cache space currently in use. This gives an idea 
as to whether the cache size is correct. That is, if cache usage is consistently nearing 
100% the cache size should be increased if possible. A larger cache size does not 
affect the program adversely or take up unnecessary space on the drive. We 
recommend a cache size of 15 - 20 MB. The minimum cache size is 500KB, the 
maximum is the free space on the drive when the size is set. Anything outside these 
limits generates an error. You can type in byte values directly (800000). For 
kilobytes or megabytes, follow the value with K or M (500K or 8M). 

The EMPTY CACHE button removes all files from the cache except a few essential data 
files needed by MAGIX Page & Layout Designer 2013 (this means that cache usage 
might not return to 0% after emptying). To use a file that has been removed from the 
cache, you have to download it again. 

Connection Type 
Over faster modems, ISDN, and networks, MAGIX Page & Layout Designer 2013 can 
speed up downloads by using multiple connections. These multiple connections are 
invisible to you and you just see an increase in speed. 

If you connect to the internet using a dial-up modem, select the appropriate speed 
option. If you are not sure about your modem, use the default setting. If you connect 
to the Internet using broadband (like ADSL or cable), select dual ISDN or better. 

Proxy Server Settings 
If your computer is using an Internet proxy, then it will list its details here. This 
information is not relevant to most users. 
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Mouse tab 

 

Mouse button function 
Page & Layout Designer gives you a range of possible actions when you click either 
the left or right mouse buttons. For example, if you're left-handed, you may prefer to 
use the right-hand button as the normal button. You would therefore assign the 
normal click to the right mouse button (you can also set both buttons to have the 
same action if you wish). 

Possible actions: 

• Normal click - At least one button should always be assigned as the normal click. 
• "Shift + click". 
• "Ctrl + click". 
• "Alt + click". 
• Display a pop-up menu (see below). 
• Toggle full-screen mode (described in Document Handling (on page 44)). 
• Zoom in or out -click to zoom in, "Shift + click" to zoom out (described in 

Document Handling (on page 44)). 
• PUSH TOOL (as if you pressed "Shift + F8") 
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The pop-up menu contains options suitable for the object you click on. For example, 
for most object types the menu contains CUT, COPY, PASTE, DELETE, DUPLICATE, CLONE 
(these are described in Object Handling (on page 103)). 

MOUSE WHEEL MOVEMENT: You can change the mouse wheel action here between 
Scrolling and Zooming.  

Click RESET DEFAULTS to return to the original button assignments. This has 
immediate effect; you don't need to click OK or APPLY NOW. 

The Windows Control Panel also lets you swap the left and right mouse buttons. 

Magnetic Snap Radii 

Snapping is described in Object Handling. 

These text boxes define how close you can drag an object before it snaps to a 
magnetic object. These are distances on the screen and independent of any document 
scaling. 
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Page Size tab 

 

These options apply only to the selected document. 

Paper 
Options relating to setting the page size (paper, orientation, spread) are described in 
“changing the page size” in Document Handling (on page 46). 

If the Lock page size option is turned on, you can't resize a page by dragging the 
bottom or right edges and any PUSH objects that get pushed off the bottom edge of 
the page will not cause the page to grow. 

Page 
OUTER MARGIN sets the size of the margin (or Pasteboard) around the page.  
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BLEED determines the bleed area size around your document. This area (typically 1-
3mm) is important for format filling prints in print shops. Read more in the "Changing 
the page size" section in the chapter Document Handling! 

SHOW PAGE SHADOW sets whether a shadow is displayed under the page (this is only 
on-screen, it is not exported or printed). 

If you select DOUBLE PAGE SPREAD you can create a document consisting of two 
pages. This option adds a second page to your document. 

PRINT/EXPORT WHOLE SPREAD: When this option is selected, each double page spread 
is printed and exported (for example to PDF) to a single page, just as it appears in 
MAGIX Page & Layout Designer 2013. 

PRINT/EXPORT INDIVIDUAL PAGES: When this option is selected, each double page 
spread is printed and exported as 2 separate pages, just as if they were designed as 
separate pages in MAGIX Page & Layout Designer 2013. 

Document 
ALL PAGES IN DOCUMENT THE SAME: When this option is selected, all the pages in your 
multi-page document will be given the same dimensions. So if you change the 
dimensions on one page, all the other pages will update too.  

SAME LAYERS ON ALL PAGES: When this option is selected, all pages in your multi-page 
document will have the same layers. If you add or delete layers from one page, all the 
other pages are similarly updated. See the Page & Layer Gallery (on page 149) 
chapter for information about Layers. 

Backups Tab 
This tab allows you to turn the automatic backup facility on and off. This facility saves 
a copy of all your modified open documents at regular intervals. It’s recommended 
that you work with this backup option turned on, so your work is saved regularly. You 
can also choose whether you are prompted about unsaved documents when closing 
the program, or if instead all open documents should be backed up and restored for 
you when you next start up. 

See the Document Handling chapter (on page 56) for full details about these facilities. 



 

Customizing Page & Layout Designer 355  

 

Photo Editing 

 

Photo Editing 
You can choose what should happen when you save a Photo Document with a 
modified photo in it. By default the original photo file is preserved in a .xar file in a 
"Masters" sub-folder and the original opened photo file is overwritten. You can 
choose to have the original photo file saved in the "Masters" folder instead, or you can 
choose to not have the original photo preserved at all. See the Editing Photo Files (on 
page 274) section of the Photo Handling chapter for details. 
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Tune-ups tab 

 

Redraw 
The value set in this option is used when redrawing the document on the screen and 
during exporting and printing. Normally automatic gives the best results, but if you 
have an old computer with limited memory you can specify a lower value. This may, 
however, slow down redraws. 

Gallery cache 
When displaying items in a gallery, Page & Layout Designer reads the information off 
disk into a cache. This speeds up gallery redraw speed for recent items. 

The default value is generally suitable. You may want to reduce it if memory is tight, 
or increase it if you use galleries frequently. 

Undo size 
Applies only to the selected document-described in Undo & Redo (on page 77). 

Cache Control 
Complex objects including layers, groups, bevels, shadows, blends, molds, contours, 
ClipViews and Live Effects can be cached as bitmaps when they are rendered. This 
means that the next time these objects need to be redrawn, the bitmap can often be 
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used instead of re-rendering the objects, making redraws and object drags very much 
faster. The difference is particularly noticeable with complex documents. 

Since caching involves storing additional bitmaps in memory, it has the potential to 
increase the amount of memory used by MAGIX Page & Layout Designer 2013 
significantly. Therefore in this dialog you can turn caching on and off and you can also 
control how much memory is used for caching when it's turned on. Increase the 
percentage memory figure to make MAGIX Page & Layout Designer 2013 cache more 
objects in your design, generally making redraws and object drags faster at the 
expense of larger memory usage. Or reduce it to lower the amount of memory that 
MAGIX Page & Layout Designer 2013 uses for caching. In complex designs, some 
cacheable objects will not be cached if there is insufficient memory to do so. This 
dialog also shows you how much memory is currently being used for caching. 

Live drag is described in Document Handling (on page 43). 

Note: Cached bitmaps will only be used during object dragging if you use LIVE DRAG. 
If you have LIVE DRAG turned off, then as you would expect you will just see the 
outlines of objects when moving them. 

Units tab 

 

Described in Measurement Units in Document Handling (on page 60). 
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View tab 

 

Display 
Show progress bar: During long operations Page & Layout Designer can display a 
progress bar on the status line. If instead you'd prefer an hourglass to replace the 
mouse pointer until the operation is completed, uncheck the SHOW PROGRESS BAR 
setting. 

The hourglass and progress bar are for information only-they have no effect on the 
document itself. 

Interactive fill dragging: Interactive fill dragging allows you to see how fills and 
transparencies look as you drag the fill handles. This is on by default. 

Dithering 
These options set the dithering method used to display your document on the screen. 

It is recommended that you leave this on its default setting. 



 

Customizing Page & Layout Designer 359  

 

Bitmaps 
These options apply only to the current document. They have no affect on any other 
documents currently loaded. 

NEVER SMOOTH: When MAGIX Page & Layout Designer 2013 scales a bitmap, it 
usually smoothes (interpolates) between the individual pixels to give a smooth look to 
the bitmap. Usually this gives the best results. Check this option if you if you do not 
want this effect. 

DPI WHEN AUTO-GENERATED: Some features such as shadows and bevels are created 
using bitmaps. MAGIX Page & Layout Designer 2013 calculates the resolution of 
these bitmaps when they are displayed. However, when you perform actions on 
shadows and bevels such as CONVERT TO EDITABLE SHAPES, COMBINE SHAPES, EXPORT 
AS EPS and EXPORT AS FLASH, MAGIX Page & Layout Designer 2013 creates a new 
bitmap using the resolution you specify here. For on-screen use (such as web page 
graphics) 96 DPI is the best value. For work that will be printed, you may need a 
higher value. Changes to this value apply to new auto-generated bitmaps; it has no 
effect on existing bitmaps. 

The 3 radio button group allows you to choose how large photos should be handled 
when you import them. Given the large size of digital camera photos, often if you’re 
working on a document the photo you import will be many times the size of your  
page.  

RESIZE LARGE IMPORTED IMAGES DOWN TO ... PIXELS: This is the default option. Large 
images are scaled down to a more manageable 500 pixels wide, or whatever size you 
set here. The document zoom is not altered. 

IMPORT ALL PHOTOS AT 96DPI (1:1 AT 100% ZOOM): With this option the DPI of the 
image is ignored and it is loaded as if the DPI is 96 (screen 1:1 size). So if an image is 
1000 pixels wide, it will display as 1000 pixels wide in Xtreme Pro. Also MAGIX Page 
& Layout Designer 2013 will automatically zoom out if required, so that the whole 
photo fits into the view. 

IMPORT AT DPI SPECIFIED IN THE IMAGE: With this option, any DPI value specified 
inside the image itself is read and the image is imported at that DPI. Note that some 
digital cameras write incorrect or unhelpful DPI values into photos and so this option 
may not always give you the results you expect. 

Note that the above import options do not apply to photo documents. Photos are 
always imported/opened at their full size in photo documents. 

Color 
COLOR LINE SIZE: This lets you select the size of the color bar at the bottom of the 
screen. A scroll bar is displayed when the number of colors is wider than the width of 
the color bar. 
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EDIT LOCAL COLORS IN: This affects the color model displayed when editing a local 
color. 

Automatic displays the color model of the original color style that the local color is 
based upon. For example, the HSV color model for a color style defined in HSV. This 
is important if you need to ensure your objects are in CMYK, for example. 

The other options let you select which of the four color models (RGB, CMYK, HSV, 
grayscale) to always use by default. 

RIGHT CLICK ON COLOR: This option is to turn off the color-line right-click menu (on 
page 160) and make right click set the line color, as in earlier versions of MAGIX Page 
& Layout Designer 2013.  

DELETE UNUSED COLORS WHEN SAVING AND LOADING: When this option is selected, 
any unused named colors in your document will be deleted when you save/load. This 
prevents your Color Line becoming cluttered with named colors which are not used in 
the design. This is particularly useful when loading older designs, because earlier 
versions of MAGIX Page & Layout Designer 2013 used to create named colors 
implicitly. So many older designs contain numerous unused named colors. Load them 
with this option turned off and it’s hard to identify the important used named colors 
on the COLOR LINE from the unused ones.  

Control bars 
You can move Page & Layout Designer's control bars to different places around the 
window, re-order the buttons, create new control bars, move or copy buttons 
between control bars and many other operations. 

You cannot change the tool-dependent InfoBar or the contents of the fly-out bars 
which are on the main toolbar and top bars. 

Full screen mode 
Page & Layout Designer has two configurations of control bars: 

• One configuration appears when the window is its normal size. 
• The second configuration appears after you choose "WINDOW" > "FULL SCREEN". 

Any changes to one configuration of control bars (for example, resizing or moving) 
have no effect on the other configuration. Changes to individual buttons (for example, 
setting an option) apply in both normal and full screen modes. 
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Displaying & hiding control bars 

 

The display of control bars is controlled 
by the CONTROL BARS dialog box 
("WINDOW" > "CONTROL BARS"). 
Against the name of each control bar is a 
check box. A tick in the check box shows 
that the control bar is currently displayed. 
Click on the required control bar's check 
box to display or hide that bar. 

You can also quickly turn CONTROL BARS on or off if you right-click in any empty area 
at the top of the program window. Use the drop-down menu to choose which bars 
you want to display. 

Docked and free floating control bars 
Normally, control bars are docked (attached to the edges of the window). Moving the 
window also moves docked control bars. 

Control bars can also be floating. These do not follow movements of the window. 

  

 

Floating control bar Docked control bar 

You can hide a floating control bar either using the CONTROL BARS dialog box 
(described above) or by clicking its CLOSE icon. 

To make a control bar float, drag it away from the edge of the window either onto the 
editing area or off the Page & Layout Designer window. 

To dock  a control bar, drag it over: 

• The edge of the window. 
• Or the menu bar. 
• Or another control bar. 

A floating control bar has a double line outline while dragging. This changes to a 
single line when in a docking position. If you want the control bar to remain floating, 
hold down "Ctrl" while dragging. 
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Resizing a control bar 
Move the pointer over the edge of the control bar. It changes to a double-headed 
arrow. You can now drag the edge to resize the control bar. 

Creating new control bars 
To create a new control bar: 

• Drag a button onto the editing area or off the window. This opens a new control 
bar containing the button. 

Or click NEW on the CONTROL BARS dialog box. This lets you create a new control bar 
and allocate a name to it. The new control bar is empty. You can then drag buttons to 
it. 

Moving buttons is described below. 

Deleting control bars 
You can only delete control bars that are empty. Therefore move any buttons to 
another control bar. Close the control bar (either click on the CLOSE icon or use the 
CONTROL BARS dialog box). The control bar is automatically deleted when you quit 
Page & Layout Designer. 

Changing the size of buttons 
Buttons can be large or small as selected in the CONTROL BARS dialog box. 

Moving buttons and tools 
To move buttons or tools: 

1. Move the mouse pointer over the button you want to move. 
2. Hold down "Alt" (left ALT) to move the button or "AltGr" (right ALT) to copy 

the button when used on user-defined control bars and other control bars. 
Although on the predefined "Button palette" both ALT-keys do only copy the 
button. 

3. Drag the button to: 

- A different place on the same control bar. 

- Or another control bar. 

- Or onto the editing area/off Page & Layout Designer to create a new control 
bar. 

You cannot move buttons onto or off the InfoBar. 
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Hiding buttons and tools 
Move the unwanted buttons or tools to another control bar and then hide that control 
bar (described above). 

If you need the button or tool in the future, use the CONTROL BARS dialog box to 
redisplay the control bar. 

You cannot delete buttons or tools. 

Fly-out menus 
Some buttons have a small black triangle which indicates that there is a fly-out bar, 
which appears when the mouse pointer is held over the button for a short period. You 
cannot customize the contents of these flyout bars, but you can drag the button as a 
whole onto and off bars, just as you do with ordinary buttons. 
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Menus and Keyboard Shortcuts 

 

Introduction 
This chapter describes the operations available on each of the menus and those 
available via keyboard shortcuts. In many cases the operations described in this 
chapter apply to the selected object. In most cases, the described action also applies 
when you have several selected objects. We use selected object as shorthand for 
selected object or objects. 

Often you can select options from either a menu, a control bar or a keyboard shortcut. 
Where a button on a control bar and/or keyboard shortcut exists, these are shown 
after the menu name. For example, the following means there is a button on the 
STANDARD control bar that has the same effect as selecting new, or you can use the 
shortcut "Ctrl + N". 

New (Standard control bar or "Ctrl + N") 

File menu 
New (Standard control bar or Ctrl+N) 
Opens a new document. 

New from Designs Gallery 
This option opens the DESIGNS GALLERY if it’s not open already, allowing you to 
choose a template for a new document. Click on the folder icons in the gallery to open 
a folder and double-click on a template thumbnail to start a new document using that 
template. 

 You can also open the DESIGNS GALLERY by clicking the tab in the Galleries 
bar. 

 

Open (Standard control bar or Ctrl+O) 
Opens a new editing window and loads a file into it. This file can be: 

• An Page & Layout Designer .xar file to view or edit an existing Page & Layout 
Designer document, 

• Or any of the other import formats (see Importing & Exporting (on page 304) for 
a list of formats). This opens a new document showing the drawing in the file. 
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Open recent 
A list of the most recently loaded or saved files. Provides a quick way to reload any of 
these files. 

You can change the number of files in this list (refer to Customizing Page & Layout 
Designer (on page 345) for details). 

Close (Ctrl+W) 
Closes the current editing window. Page & Layout Designer remains loaded. You are 
warned if the file has unsaved changes. 

Save (Standard control bar or Ctrl+S) 
Saves the selected document. 

Save As 
Lets you save the selected document under a different name or to a different directory 
or drive. 

Save All 
Saves all loaded documents. 

Save Template 
Saves the selected document as a template document (see Customizing Page & 
Layout Designer (on page 345)). 

Import (Ctrl+Alt+I) 
Loads a file into the selected document. The file can be any of the import formats (see 
Importing & Exporting (on page 304) for more information). 

Note the difference between OPEN and IMPORT: both load a variety of file formats but 
OPEN opens a new document. IMPORT loads the file into the current open document. 

Export (Ctrl+Shift+E) 
Or right click and choose EXPORT. 

Lets you export the document in any of the export formats supported by Page & 
Layout Designer (see Importing & Exporting (on page 304) for a list of formats). 

Export JPEG 
 
Lets you export selected objects, a page or the whole document as a JPEG.  

Export PNG 
Lets you export selected objects, a page or the whole document as a PNG.  



 

366   

www.xara.com 

Document Info 
This displays an information box about the selected document, including which fonts 
and Live Effects plug-ins are used in the current document. 

Page Options 
Also right click and choose PAGE OPTIONS. 

Allows you to edit the page layout, size, etc. 

Printer Setup 
Sets options relating to the current printer or print file (refer to Printing (on page 286) 
for more information). 

Print Options 
Alter the various options when printing, including orientation and scaling (refer to 
Printing (on page 286) for more information). 

Print (Ctrl+P) 
Sets options relating to printing the document and lets you print the document (refer 
to Printing (on page 286) for more information). 

Exit 
Closes all windows and removes Page & Layout Designer from memory. You are 
warned if any files have unsaved changes. 

Edit menu 
Undo (Standard control bar or Ctrl+Z) 
Undo the previous operation. The description of this option reflects the last operation 
performed. For example, UNDO CUT (refer to Undo & Redo (on page 77)). 

Redo (Standard control bar or Ctrl+Y) 
Cancel the last UNDO command. The description of this option reflects the last UNDO 
operation (refer to Undo & Redo). 

Cut (Edit control bar or Ctrl+X) 
Cut the selected object to the clipboard. The description of this option reflects the 
type of object selected (refer to Object Handling (on page 104)). 

Copy (Edit control bar or Ctrl+C) 
Copy the selected object to the clipboard. The description of this option reflects the 
type of object selected. The object remains in place in the document (refer to Object 
Handling (on page 104)). 
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Paste (Edit control bar or Ctrl+V) 
Or right click and choose PASTE. 

Paste the clipboard contents into the selected document. The wording of this option 
reflects the contents of the clipboard (refer to Object Handling (on page 104)). 

Sometimes, when you paste the contents of the clipboard into a document, it could be 
inserted using several different formats. If this is the case the PASTE SPECIAL dialog 
box will appear so you can choose a format. 

Paste unformatted text 
Pastes any text on the clipboard into your document without any formatting. 

Paste in place 
The same as PASTE, except your object will be pasted in the exact same position from 
which you copied it. This is useful for moving objects from one layer or page to 
another, without changing its X/Y position. However note that if the copied object is a 
‘footer’ (that is, it always stays the same distance from the bottom of the page, when 
the page is resized) when pasted in place it will be positioned relative to the bottom of 
the page. This is normally what you want from footer objects. 

Paste format/attributes 
Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill 
color) of the pasted object. 

Paste position 
This option applies the position of a copied object on the clipboard to a currently 
selected object, which moves to the exact same position as the copied object. 

If multiple items have been copied to the clipboard, Page & Layout Designer treats 
them as if they are a group and moves the currently selected object to the position of 
the copied group as a whole. 

The currently selected object is pasted or moved into the center position of the copied 
object or group of objects. 

Paste size 
This option applies the size of a copied object on the clipboard to a currently selected 
object, which resizes around its center to the exact size of the copied object. 

If multiple items have been copied to the clipboard, Page & Layout Designer treats 
them as if they are a group and resizes the currently selected object around its center 
to the exact size of the copied group as a whole. 
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Paste replacing selection 
This is similar to PASTE POSITION, except that the copied object on the clipboard 
replaces the currently selected object and retains the deleted item's position. 

The copied object is pasted into the center position of the deleted object. 

Paste in current layer 
The same as PASTE IN PLACE, except your object will only be pasted into the current 
layer. 

This is useful if you want to display or hide just your pasted object when layers above 
or below are displayed. 

Paste in place in current layer 
The same as PASTE IN CURRENT LAYER, except your object will be pasted into the 
current layer in the exact same position from which you copied it. 

Paste in place (Ctrl+Shift+V) 
The same as PASTE, except your object will be pasted in the exact same position from 
which you copied it. This is useful for moving objects from one layer or page to 
another, without changing its X/Y position. 

Paste format/attributes (Ctrl+Shift+A) 
This option lets you copy attributes (such as the line pattern or fill color) between 
objects. It is a quick way of applying multiple attributes. When you Paste Attributes, 
the attributes of the objects on the clipboard are applied to all the objects currently 
selected (refer to Object Handling (on page 128)). 

Paste position 
This option applies the position of a copied object on the clipboard to a currently 
selected object, which moves to the exact same position as the copied object. 

If multiple items have been copied to the clipboard, Page & Layout Designer treats 
them as if they are a group and moves the currently selected object to the position of 
the copied group as a whole. 

The currently selected object is pasted or moved into the center position of the copied 
object or group of objects. 

Paste size 
This option applies the size of a copied object on the clipboard to a currently selected 
object, which resizes around its center to the exact size of the copied object. 

If multiple items have been copied to the clipboard, Page & Layout Designer treats 
them as if they are a group and resizes the currently selected object around its center 
to the exact size of the copied group as a whole. 
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Paste replacing selection 
This is similar to PASTE POSITION, except that the copied object on the clipboard 
replaces the currently selected object and retains the deleted item's position. 

The copied object is pasted into the center position of the deleted object. 

Paste in current layer 
The same as PASTE IN PLACE, except your object will only be pasted into the current 
layer. 

This is useful if you want to display or hide just your pasted object when layers above 
or below are displayed. 

Note: To open a layer, double-click on it in the Page & Layer Gallery (on page 55).  

Paste in place in current layer 
The same as PASTE IN CURRENT LAYER, except your object will be pasted into the 
current layer in the exact same position from which you copied it. 

Note: To open a layer, double-click on it in the Page & Layer Gallery (on page 55).  

Delete (Edit & Standard control bars or Delete) 
Or right click and choose DELETE. 

Delete the selected object. The description of this option reflects the type of object 
selected (refer to Object Handling (on page 103)). 

Select All (Ctrl+A) 
Select all objects in editable layers (editable and locked layers are described in Layers 
(on page 149)). 

Clear Selection / Reset current attributes (Esc) 
Deselect all objects. If nothing is selected, the current attributes (on page 21) are set 
back to its default values. You can easily get this by pressing ESC twice. 

Find/Replace (Ctrl+Alt+F) 
Find/Replace for text objects, see chapter Text Handling, section Find & Replace (on 
page 188). 

Duplicate (Edit control bar or Ctrl+Alt+D) 
Or right click and choose DUPLICATE. 
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Copy the selected object placing the copy slightly offset from the original. The copy 
becomes the selected object. The offset distance can be customized (see 
Customizing Page & Layout Designer (on page 348)). 

Clone (Ctrl+K) 
Like DUPLICATE copies the selected object, but places the copy directly over the 
original. The copy becomes the selected object. 

Pages 
Or right click and choose PAGES. 

The Pages submenu lets you add or remove pages from your multi-page document, 
duplicate the current page or move the current page up and down. Read more on 
multi-page documents in Multi-page Documents. 

Arrange menu 
Move to Layer in Front (Arrange control bar or Ctrl+Shift+U) 
Or right click and choose ARRANGE > MOVE TO LAYER IN FRONT. 

Move the selected object forward by one layer. The selected object becomes the back 
object in the new layer. 

Bring to Front (Arrange control bar or Ctrl+F) 
Or right click and choose ARRANGE > BRING TO FRONT. 

Move the selected object to the front of all other objects in the same layer. See Object 
Handling (on page 103) for more information. 

Move Forwards (Arrange control bar or Ctrl+Shift+F) 
Or right click and choose ARRANGE > MOVE FORWARDS. 

Move the selected object one step towards the front (refer to Object Handling (on 
page 103)). 

Move Backwards (Arrange control bar or Ctrl+Shift+B) 
Or right click and choose ARRANGE > MOVE BACKWARDS. 

Move the selected object one step towards the back (refer to Object Handling). 

Put to Back (Arrange control bar or Ctrl+B) 
Or right click and choose ARRANGE > PUT TO BACK. 

Move the selected object behind all others in the same layer (refer to Object Handling 
(on page 103)). 
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Move To Layer Behind (Arrange control bar or Ctrl+Shift+D) 
Or right click and choose ARRANGE > MOVE TO LAYER BEHIND. 

Move the selected object one layer backwards. The selected object becomes the front 
object in the new layer. 

Group (Arrange control bar or Ctrl+G) 
Or right click and choose GROUP. 

Group the selected objects together to appear as a single object (refer to Object 
Handling (on page 103)). 

Ungroup (Arrange control bar or Ctrl+U) 
Or right click and choose UNGROUP. 

Split the group or groups into separate objects.  Dimmed unless the selected object is 
a group. Or, for several selected objects, there is at least one group. 

Apply soft group (Ctrl+Alt+G) 
Or right click and choose APPLY SOFT GROUP. 

Make the selected objects form a soft group. Unlike groups, soft groups can include 
objects on different layers. Refer to Object Handling (on page 123) for details. 

Remove soft group (Ctrl+Alt+U) 
Or right click and choose REMOVE SOFT GROUP. 

Disband the selected soft group, so the objects are separately selectable objects 
again. 

Apply/Remove ClipView (Q/Alt+Q) 
This option reads: 

• APPLY CLIPVIEW when there are two or more objects selected. 
• REMOVE CLIPVIEW when there is a ClipView selected. 

For APPLY CLIPVIEW, the rear object in the selection (the object behind the other 
selected objects) 'clips' or 'masks' the other objects (the effect is similar to viewing 
the other objects through a window the shape of the rear object). REMOVE CLIPVIEW 
removes any clipping applied to the objects in the ClipView. See Object Handling (on 
page 128). 

Apply opacity mask 
Shortcut to quick apply an opacity mask, see Opacity masks in chapter Transparency 



 

372   

www.xara.com 

Flatten photo group 
Converts a photo group to a single bitmap. 

Alignment (Ctrl+Shift+L) 
Or right click and choose ALIGN. 

Used to align several objects. Has no effect when a single object is selected (refer to 
Object Handling (on page 124) for more information). 

Join Shapes (Arrange control bar or Ctrl +J) 
Used to create holes within shapes (refer to Shape Handling (on page 134) for more 
information). 

Break Shapes (Arrange control bar) 
Cancels a JOIN SHAPES command (refer to Shape Handling (on page 135) for more 
information). 

Combine Shapes (Arrange control bar) 
The Combine Shapes sub-menu lets you: 

• Add shapes together. 
• Or subtract the top shape from the other shapes. 
• Or discard parts of other shapes not covered by the top shape. 
• Or use the top shape to slice the other shapes. 

Only shapes in the selection are combined. Unselected shapes do not change (refer to 
chapter Shape handling (on page 135) for more information). 

Convert Line to Shape 
This option converts a line into a shape. 

Convert to Editable Shapes (Arrange control bar Ctrl+Shift+S) 
Convert predefined objects such as rectangles, ellipses, and text into shapes, i.e. Page 
& Layout Designer no longer sees them as rectangles, ellipses or text but as a 
collection of straight and curved lines. 

Create Bitmap Copy (Ctrl+Shift+C) 
CREATE BITMAP COPY creates a bitmap version of the selected objects. 

Fit Text to Curve/Remove Text From Curve 
Or right click and choose FIT TEXT TO CURVE/REMOVE TEXT FROM CURVE. 

Lets you fit a line of text to an arbitrary curve or remove text from a curve (see Text 
Handling for more information). 
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Repelling and Anchoring 
Or right click and choose REPEL TEXT UNDER, ANCHOR TO TEXT or REPELLING AND 
ANCHORING. 

Make the object repel underlying text, and anchor an object within a column of text. 
See Repelling text objects (on page 192) and Anchored Graphics (on page 194) for 
details. 

Repeat on all pages (Shift+Ctrl+Alt+R) 
Or right click and choose REPEAT ON ALL PAGES. 

The selected object will be copied to the same place on all pages. The command 
automatically creates an appropriate Repeating:AutoRepeat name and applies it to all 
copies, so from this point on it will be updated when you select UPDATE REPEATING 
OBJECTS. 

Stop updating (Shift+Ctrl+Alt+O) 
Or right click and choose STOP UPDATING. 

The "ARRANGE" > "STOP UPDATING" operation allows you to turn off the repeating 
nature of an instance of a repeating object, or on all copies of that object in your 
website. 

Read more in the Object Handling Chapter (on page 131). 

Utilities menu 
Galleries 
Color Gallery (Galleries control bar or F9) 
Displays or hides the COLOR GALLERY (see Color Handling (on page 159)). 

Page & Layer Gallery (Galleries control bar or F10) 
Displays or hides the PAGE & LAYER GALLERY. (see Layers (on page 149)). 

Bitmap Gallery (Galleries control bar or F11) 
Displays or hides the BITMAP GALLERY (see Bitmap Handling (on page 255)). 

Line Gallery (Galleries control bar or Shift+F12) 
Displays or hides the LINE GALLERY (see Drawing Lines (on page 93)). 

Fonts Gallery (Galleries control bar or Shift+F9) 
Displays or hides the FONTS GALLERY (see Text Handling (on page 178)). 
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Designs Gallery (Galleries control bar or Shift+F10) 
Displays or hides the DESIGNS GALLERY (see Importing and Exporting (on page 304)). 

Fill Gallery (Galleries control bar or Shift+F11) 
Displays or hides the FILL GALLERY (see Bitmap Handling). 

Name Gallery (Galleries control bar or Ctrl+Shift+F9) 
Displays or hides the NAME GALLERY (see Document Handling (on page 73)). 

Color Editor (Ctrl+E) 
Or right click and choose FILL COLOR. 

Opens the COLOR EDITOR (refer to Color Handling). 

Names 
Or right click and choose NAMES. 

Opens the Apply/remove names dialog (on page 75). 

Imagesetting 

See Imagesetting (on page 293) for details. 

Bitmap-Editor 
When a bitmap is selected, this opens the BITMAP EDITOR. In the Program Options 
("Utilities -> Options -> Effects & Plug-ins Tab") you can also choose the enclosed 
MAGIX Photo Designer 7 or any other program for bitmap editing. For further 
information on the bitmap editor, read the program help or the electronic manual 
(PDF) of the according program. 

Optimize Photo 
Or right click and choose OPTIMIZE PHOTO. 

Optimize bitmap resolution for use in MAGIX Page & Layout Designer 2013 designs. 
See Photo Optimization (on page 270) for details. 

Optimize all Images 
Optimizes all photos and bitmaps in the design. See Photo Optimization (on page 
270). 

Screen Capture 
Open the Screen Capture Tool. 

Check spelling as you type 
This option activates the SPELL CHECKER (on page 187) in the TEXT TOOL. 
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Customize Key Shortcuts 
This command allows you to change the keyboard shortcuts. See Integrated key 
shortcut utility (on page 384) in Menus and Keyboard shortcuts for details. 

Options (Ctrl+Shift+O) 
Or right click and choose PAGE OPTIONS. 

Opens the OPTIONS dialog box (described in Customizing Page & Layout Designer (on 
page 345)). 

Share Menu 
The share menu includes various facilities for sharing the currently selected image 
with other MAGIX and third party services. So for example you can select a photo on 
your page and quickly send it to a MAGIX Online Album, to Facebook, or to Flickr. If 
you have other compatible MAGIX programs installed, you can also send the image 
to those. For example you can send to MAGIX Movie Edit Pro MX to include an 
image from Designer in a movie. 

Publish Online - Upload objects to Facebook 
Send the selection to Facebook. A dialog appears allowing you to optionally specify a 
filename, description and search keywords for your image, and to choose whether the 
image should be private or public. Click the UPLOAD button to proceed and a login 
window appears. If you already have a Facebook account, enter the details, or click 
the Sign Up button to join Facebook. If you intend uploading many images, select the 
checkbox to keep you logged in so you don’t have to keep logging in for each upload. 
Click the Login button and your image will be exported and uploaded, then a browser 
window will open to allow you to access your Facebook account. 

Publish Online - Upload objects to Flickr 
Send the selection to Flickr. The process for this is similar to that for Facebook above, 
except of course you must login with your Flickr account details.  

Publish Online - MAGIX Online Album 
SEND SELECTED OBJECTS 
Send the selection to MAGIX for inclusion in a new or existing online album. Login 
with your MAGIX Online World account details. You can opt to have the login details 
saved on your computer so that you don’t need to login again in future. 

OPEN ONLINE ALBUM 
This opens a web browser window so you can view your albums. 

ONLINE MEDIA MANAGER 
Open the Online Media Manager in a window so that you can manage the photos 
included in your albums. 
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MANAGE LOGIN DATA 
If you’ve elected to have your MAGIX Online World login data stored on your 
computer, this option lets you change the details, or remove them from your 
computer if you no longer want them stored, by pressing the Delete button. 

Publish Online - Publish website 
This initiates a publish operation on the current document - the same operation that’s 
available from the File menu and web toolbar. 

Publish Online - Free web space & more 
This option will open a web browser onto a page telling you about the free MAGIX 
web hosting services available and other related information. 

Sending images to other installed MAGIX applications 
If you have other compatible MAGIX applications installed, the Share menu will 
include options to send the selected image to those applications. For example if you 
have Movie Edit Pro MX installed, an "Add objects to video" entry will be included in 
the menu, allowing you to send the selection to that application for inclusion in a 
movie. 

Window menu 
Clear Selection / Reset current attributes (Esc) 
Deselect all objects. If nothing is selected, the current attributes (on page 21) are set 
back to its default values. You can easily get this by pressing ESC twice. 

Multiple Page View 
Or right click and choose MULTIPLE PAGE VIEW. 

By default Page & Layout Designer shows only the current page of the currently open 
document. Choosing multiple page view shows all the pages in your document. 

New View 
Opens a new window onto the selected document. 

Arrange Views 
Displays all Page & Layout Designer windows as tiles. 

Cascade 
Displays all Page & Layout Designer windows stacked behind each other so that the 
title bars are visible. 

Arrange Icons 
Tidies up any icons for minimized Page & Layout Designer windows. 
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Control Bars 
Displays the CONTROL BARS dialog box (described in Customizing Page & Layout 
Designer (on page 360)). 

Bars 
Menu entries to switch on and off the most important control bars.  

Quality (Standard control bar) 
Selects how objects are displayed from wire frame to anti-aliased (see Document 
Handling (on page 62)). 

Show Printer Colors 
Allows you to simulate what the document will look like when printed. This doesn't 
alter your document, and is just a different way of viewing it on screen. 

In Xara Designer Pro you can also show CMYK color separations (on page 293) here. 

Show Document Tabs 
Toggles display of the document tabs that provide quick access to each open 
document at the top of the Page & Layout Designer window. 

Clicking on a tab makes that document the selected document. A "*" after the 
document name indicates that it currently has unsaved changes. 

Full Screen (8 on numeric keypad) 
Toggles between full-screen and normal screen modes. 

Show Grid (#) 
Or right click and choose SHOW GRID/GUIDES > SHOW GRID. 

Makes the on-screen grid visible (see Document Handling (on page 58)). 

Show Guides (1 on numeric keypad) 
Or right click and choose SHOW GRID/GUIDES > SHOW GUIDES. 

Displays or hides the Guides layer which contains all guidelines and guide objects. 

Show Print Borders 
Most printers have a non-printing margin (the print border) around the edge of the 
paper. With SHOW PRINT BORDERS selected two rectangles are displayed on screen. 
One shows the edge of the paper, the other shows the printable area. 

Snap to Grid (. on numeric keypad) 
Or right click and choose SNAP TO > SNAP TO GRID. 
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With this option set, an object snaps to any grid point it is dragged close to (see 
Document Handling). 

Snap to Guides (2 on numeric keypad) 
Or right click and choose SNAP TO > SNAP TO GUIDES. 

With this option set, an object snaps to any guide it is dragged close to (see Object 
Handling). 

Snap to Objects (* on numeric keypad) 
Or right click and choose SNAP TO > SNAP TO OBJECTS. 

With this option selected, dragging a handle close to another object snaps the handle 
to the object; see Object Handling for more details. You can also adjust the snapping 
distance; see Customizing Page & Layout Designer (on page 345) for more details. 

Documents Loaded 
A list of the currently open documents. Clicking on a name makes that document the 
selected document ("Ctrl + F6" also switches between open documents). A "*" after 
the document name indicates that it currently has unsaved changes. 

Help menu 
MAGIX Page & Layout Designer 2013 help 
Use the command <PROGRAMMNAME > HELP in the HELP menu to open the start page 
of the program Help. Here you can work through the Help step-by-step and jump to 
specific sections via the tree structure on the left-hand side. 

Movies 
A list of movies to help you make the most out of Page & Layout Designer. 

More Page & Layout Designer 
In this menu there are useful internet links to MAGIX’s website and useful online 
resources. 

Tip of the Day 
See the tip of the day. There is also a check box below the Tip of the Day where you 
select whether or not you see a tip each time you start Page & Layout Designer. 

Register 
"Help -> Register" allows you to register your MAGIX Page & Layout Designer 2013 
software. 

You will normally only see this option if you are installing from CD for the first time. 
The register option allows you to register your software if you purchased your CD 
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from somewhere other than MAGIX, for example, from a reseller. If you purchased 
the software from MAGIX directly, and/or registered in the past, you can click 
"Register Now" to stop any further registration messages appearing. 

Update program 
Opens a dialog box giving you access to TalkGraphics, The Outsider 
http://www.xara.com/outsider/, The XaraXone, The Xara Gallery 
http://www.xara.com/gallery/, and the Support http://support.magix.net site. 

Download templates 
Allows you to browse to a network location to download updated MAGIX Page & 
Layout Designer 2013 templates to your DESIGNS GALLERY. 

Info pop-ups 
At several places in Page & Layout Designer, when you chose a specific tool, 
introductory usage hints are displayed in a pop-up message. You can disable each 
pop-up by checking DON'T SHOW ME AGAIN in the message window. With TURN ALL 
ON all messages are enabled again, with TURN ALL OFF all messages are turned off. 

About MAGIX Page & Layout Designer 2013 
Displays copyright info and version number of MAGIX Page & Layout Designer 2013. 

http://www.xara.com/outsider/�
http://www.xara.com/gallery/�
http://support.magix.net/�
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Key shortcuts 
The tools 
Selector Tool F2 or V or Alt + S 
Freehand & Brush Tool F3 or N 
Shape Editor Tool F4 
Rectangle Tool  Shift + F3 or M 
Ellipse Tool Shift + F4 or L 
QuickShape Tool Shift + F2 
Text Tool  F8 or T 
Fill Tool G 
Transparency Tool  F6 
Shadow Tool  Ctrl + F2 
Bevel Tool Ctrl + F3 
Contour Tool Ctrl + F7 
Blend Tool F7 or W 
Mold Tool Shift + F6 
Photo Tool P 
Extrude Tool E 
Push Tool  Shift + F8 or H or Alt + X (or the Space bar 

when not in the Text Tool) 
Zoom Tool Shift + F7 or Z or Alt + Z 

The galleries 
Fonts Gallery Shift + F9 
Clipart Gallery Shift + F10 
Fill Gallery Shift + F11 
Color Gallery F9 
Page & Layer Gallery F10 
Bitmap Gallery F11 
Line Gallery Ctrl + F9 
Name Gallery Ctrl + Shift + F9 
 

Zooming 
Previous zoom Ctrl + R 
Zoom to selection Ctrl + Shift + Z 
Zoom to drawing Ctrl + Shift + J 
Zoom to page Ctrl + Shift + P 
Zoom in (enlarge) Ctrl + + on the numeric keypad 
Zoom out (reduce) Ctrl + - on the numeric keypad 
Zoom to 100% 1 
Zoom to 200% 2 
Zoom to 300% 3 
Zoom to 400% 4 
Zoom to 50% 5 
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You can also zoom and slide the document using a mouse-wheel (Ctrl+Mouse-
Wheel zooms in/out). 

Manipulating documents 
When in the Text Tool, shortcuts marked with a star (*) have a different action-see 
below (on page 382). 

New document Ctrl + N 
Open document Ctrl + O 
Close document Ctrl + W 
Switch document Ctrl + Tab 
Print document Ctrl + P 
Save document Ctrl + S 
Import  Ctrl + Alt + I 
Export  Ctrl + Shift + E 
Time a document redraw Ctrl + Shift + T 
Show grid # 
Show guides 1 on numeric keypad 
Snap to grid . on the numeric keypad 
Snap to guides 2 on the numeric keypad 
Snap to objects * on the numeric keypad 
Select full screen 8 on the numeric keypad 
Show rulers  Ctrl + Shift + R or Ctrl + L* 
Undo Ctrl + Z or < or , 
Redo Ctrl + Y or > or . 
 

Manipulating objects 
When in the Text Tool, shortcuts marked with a star (*) have a different action-see 
below (on page 382). 

Select all Ctrl + A * 
Select next object Tab 
Delete the selection Delete * 
Clear selection/Reset current attributes Esc 
Bring object to front Ctrl + F 
Put object to back Ctrl + B * 
Move object forwards Ctrl + Shift + F 
Move object backwards Ctrl + Shift + B 
Move object to layer in front Ctrl + Shift + U 
Move object to layer behind Ctrl + Shift + D 
Group objects Ctrl + G 
Ungroup objects Ctrl + U 
Apply Soft Group Ctrl + Shift + G 
Remove Soft Group Ctrl + Shift + U 
Clone object  Ctrl + K 
Duplicate object with offset Ctrl + Alt+ D 
Copy object to clipboard Ctrl + C 
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Cut selection to clipboard Ctrl + X 
Paste object from clipboard Ctrl + V 
Paste object in original position Ctrl + Shift + V 
Create bitmap copy Ctrl + Shift + C 
Add shapes Ctrl + 1 
Subtract shapes Ctrl + 2 
Intersect shapes Ctrl + 3 
Slice shapes Ctrl + 4 
Join Shapes Ctrl + J 
Apply ClipView Q 
Remove ClipView Alt + Q 
Convert to editable shapes Ctrl + Shift + S 
Open the alignment dialog box Ctrl + Shift + L* 
Repeat on all pages Ctrl + Shift + Alt + R 
Update repeating objects Shift + Alt + R 
Stop repeating Ctrl + Shift + Alt + O 

Move the selected objects cursor (arrow) keys with the Selector Tool (see Nudging 
objects (on page 104) ) 

Move the selected handles cursors (arrow) keys in tools other than the selector. 

Summary of shortcuts on the numeric keypad 
+ Makes a copy while dragging, resizing, skewing, and so on. The original object 

doesn‘t change. 
/ Toggles leaving line widths unchanged during scaling and scaling with changing 

line widths. 
- Toggles leaving fills unchanged during moves, scaling, skewing, etc.  
* Toggles object magnetic snap on and off. 
2 Toggles snap to guides on and off. 
. Toggles snap to grid on and off. 
 

Text Tool 
Cursor keys Move the text cursor up up, down, left or right 

one character at a time. 
Home Move the text cursor to the start of the line. 
End Move the text cursor to the end of the line. 
Ctrl + left/right cursor Move the text cursor left/right one word. 
Ctrl + Home Move the text cursor to the start of the first line in a text 

object. 
Ctrl + End Move the text cursor to the end of the last line in a text 

object. 
Ctrl + A Selects all characters in a text object. 
Ctrl + B  Apply the bold attribute. 
Ctrl + I  Apply the italic attribute. 
Ctrl + C Copy the selected region of text to the clipboard. 
Ctrl + L Select all characters in the line containing the text cursor. 
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Ctrl + Shift + L Insert 'Lorem ipsum' dummy text 
Ctrl + V Paste text at the text cursor position (if the clipboard 

contains text). 
Ctrl + W Swap the case of the character to the right of the text 

cursor. 
Ctrl + - Insert Soft Hyphen (appears only when wrapping at line 

end). 
Ctrl + Shift + - Insert hard hyphen (dash) to prevent a dash being 

misinterpreted as a hyphen at line end. 
Ctrl + < 
Ctrl + > 

Increase/Decrease font size of selected text (only if the 
selection is all the same point size) 

Alt + cursor keys Increase/Decrease kerning/tracking. 
 Start a new line of text. 
Delete Delete the character to the right of the text cursor. If the 

cursor is on the end of a text line, join this line to the line 
below. 

Backspace Delete the character to the left of the text cursor. If the 
cursor is at the start of a text line, join this line to the line 
above. 

Shift + cursor keys Select all text between the cursor position and the 
beginning of the line. 

Shift + End Select all text between the cursor position and the end of 
the line. 

  

Special characters (in Text Tool) 
Ctrl + Space  Hard space (words with hard spaces 

between will not wrap at the end of a line) 
Ctrl + NumPad – – EN dash  (An EN dash is longer than a 

minus, and is a more correct ‘dash’) 
Ctrl +  Alt + NumPad – — EM dash (An EM dash is a long dash) 
Ctrl + Alt +.(Full stop) … Ellipsis (An ellipsis is three dots) 
Ctrl + Alt + C © Copyright 
Ctrl + Alt + R ® Registered 
Ctrl + Alt + T ™ Trademark 
Ctrl + Alt + B • Bullet  
 

Feather Tool 
You can control the feather slider with your mouse and keyboard. When the feather 
text box or slider are selected: 

Mouse wheel up/down increases or decreases feathering 
Ctrl + Mouse wheel up/down increases or decreases in larger 

increments. 
Page up/page down keys increases or decreases in larger 

increments. 
Home/end keys select minimum or maximum feather values. 
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Pages 
Ctrl + C Copy current or selected pages (with no objects selected) 
Ctrl + X Cut current or selected pages (with no objects selected) 
Ctrl + V Paste page(s) 
Delete Delete current or selected pages (with no objects selected) 
Shift + Ctrl + Delete Delete current or selected pages (with or without objects 

selected) 
Shift + Ctrl + PageUp Move Page Up 
Shift + Ctrl + 
PageDown 

Move Page Down 

 

Other 
Color Editor Ctrl + E (opens and closes) 
Options dialog Ctrl + Shift + O 
MAGIX Page & Layout Designer 2013 
Help 

F1 
 

Integrated key shortcut utility 
This utility provides an easy and direct way to configure key shortcuts. It allows you to 
define a shortcut for a command which doesn't have a shortcut by default, or to 
change a command's shortcut. 

To open the Shortcut Tool, select CUSTOMIZE KEY SHORTCUTS... from the UTILITIES 
menu. 

 

Command categories 
There are many different commands which can be assigned to shortcuts and so they 
are split into several categories to help finding a command easier. The command 
categories are presented in a dropdown list and the "Commands" list below it lists all 
the commands in that category. Many categories correspond with the name of a 
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menu (e.g. File, Edit, Arrange), so finding a command that is on one of the menus is 
easy. Choose "All" to display all available commands in the Commands list. 

Commands 
The Commands list shows all the commands for the selected category. Where a 
command already has a key shortcut, that shortcut is shown in the column to the 
right of the command name. Those commands that don't have any shortcut assigned 
show nothing in the shortcut column. 

If a command has more than one shortcut assigned, then that command will appear 
more than once in the list of commands, once for each of its shortcuts. 

To assign an additional shortcut to a command which already has a shortcut, select 
the command in the list and press the ADD SHORTCUT button. 

Press the REMOVE SHORTCUT button below the Commands list to remove the selected 
shortcut assignment from the list. 

Key press 
Once you've selected a command in the Commands list, assigning a shortcut key to it 
is easy. Simply press the key combination that you wish to use for the selected 
command. The keypress you choose will then appear in the Keypress field on the 
Shortcuts Tool dialog. Note that if the selected command already had a shortcut 
shown in the Commands list, that shor-cut is replaced by your new keypress.  

If you want to add an additional shortcut, first use the ADD SHORTCUT button under 
the Commands list as described in the Commands section above. 

Pressing the CLEAR button below the Keypress field removes the shortcut for the 
selected command and clears the Keypress field. 

After entering a new keypress, check the CLASHES list which is shown below the 
Keypress field. 

Clashes 
A keypress can be used as a shortcut for one command only. If the keypress you 
chose for a command shortcut is already assigned to another command, the CLASHES 
list will show you this and will allow you to quickly resolve the clash. 

If there is more than one command currently associated with the keypress shown in 
the Keypress field, the Clashes list shows you all the commands that are currently 
assigned to it. You need to remove all but one of the shortcut assignments for the 
keypress so that only one command is associated with it.  

To do this simply select one of the clashing assignments shown in the Clashes list and 
then press the REMOVE CLASH button below it to remove the shortcut assignment.  
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Once only two assignments are shown in the Clashes list, deleting one of them will 
leave you with an empty Clashes list, because there is then only one assignment for 
the keypress and so there are no longer any clashes. 

Alternatively you may wish to change the shortcut associated with one of the clashing 
commands. To do this, select the shortcut in the Clashes list and click the EDIT CLASH 
button below it. This automatically locates the command and selects it in the 
Commands list on the left, ready for you to define a new keypress for it. Once it's 
selected, enter the keypress that you want to use for that command and once again 
resolve any clashes shown in the Clashes list. 

Once the Clashes list is empty, your new keypress is defined as a shortcut. You can 
then either select other commands to which you want to assign shortcuts or commit 
your shortcuts changes by pressing OK. You don't need to keep track of all the clashes 
as you change shortcuts because when you click OK to commit your changes a check 
is done to make sure no clashes remain. 

Standard keys / Classic keys 
At any time you can press STANDARD KEYS to set all the command shortcuts back to 
the default settings for MAGIX Page & Layout Designer 2013. 

Alternatively press Classic Keys to reset to a keyset that was used by early versions of 
MAGIX Page & Layout Designer 2013. Over time, as the product has evolved, various 
standard shortcuts that are commonly used by other applications have been adopted 
by MAGIX Page & Layout Designer 2013. Those who have become familiar with 
Xara’s original shortcuts may prefer to use the ‘classic’ defaults instead. 

Save 
Use the SAVE button to save the current shortcut definitions as a ".ini" file, without 
necessarily applying them so they are used by MAGIX Page & Layout Designer 2013 
you to setup different sets of shortcut assignments and allows you to share the 
assignments between different computers or different users. For example, you could 
setup shortcut assignments that make Page & Layout Designer compatible with the 
shortcuts of another application and save them in a .ini file so you can share them. 

Load 
Use the LOAD button to load the shortcuts defined in a .ini file. Once they are loaded, 
you can inspect or modify them in the Shortcuts Tool or apply them to MAGIX Page 
& Layout Designer 2013 OK button. 

Cancel 
Press the CANCEL button to discard all the shortcuts changes you have made since 
you opened the Shortcuts Tool. 

OK 
Use the OK button to commit the changes you have made since you opened the 
Shortcuts Tool. If there are any unresolved clashes, you will be told about them at this 
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point. You are strongly advised to go back and fix any clashes because otherwise your 
chosen shortcuts may not work. Click the Back button on the warning alert to go back. 
When you do this the first keypress with clashes is automatically selected for you, so 
you can quickly resolve it. 

If no clashes are reported when you click the OK button, your new shortcuts have 
been defined successfully. 

Example 
Here's an example of the process you would go through if you wanted to use "Ctrl + 
P" to bring up the Print Options dialog. 

1. Bring up the Shortcuts Tool dialog by choosing "Utilities -> Customize Key 
Shortcuts". 

2. The Print Options command is in the File menu, so choose the "File" category 
from the Commands category list. 

3. Select the Print Options command in the list of commands. 
4. Press "Ctrl + P". You'll see "Ctrl + P" appear in the Keypress field. Also the 

"Print Options..." command is now shown as having the "Ctrl + P" shortcut in 
the Commands list. 

5. You can also see that a clash has been identified. The Clashes list shows that 
Ctrl-P is now assigned to BOTH "Print..." and "Print Options...". 

6. Select "Print..." in the Clashes list and then click the button below it to remove 
this shortcut. This eliminates the clash. 

7. Now the Clashes list is empty, indicating that there are no clashes for "Ctrl + 
P". 

8. Click Ok to confirm your changes. 

Now when you press "Ctrl + P" the Print Options dialog appears. 

Temporary key shortcuts 
Three of the most commonly used tools (Selector, Push and Zoom) have special 
shortcuts that allow quick temporary selection of the tool, and then return to the 
previously used tool after use. 

What’s more these shortcuts can be used two ways; either as a toggle (press the key 
once and it selects the tool, press it again and it returns to the previous) or as a 
temporary switch (hold key down and it switches to the tool, and release key to return 
to the previous tool). 

The default key shortcuts for these tools are: 

• "Alt + Z" for Zoom. 
• Space or "Alt + X" for Push. 
• "Alt + S" for Selector Tool. 
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These key combinations are deliberately chosen to be near the left hand to make very 
easy selection. 

Note: If you have a mouse with a scroll wheel or center button, there is a better 
temporary shortcut to the Push Tool, namely to press and hold the wheel or button. 
Release it to return to the previous tool. 

These three commands are listed at the top of the Tool group and described as 
Switch to Push tool (Hold Down to Switch and Return), etc. (you can see the full 
description of the command in the Status line). 

Tip: Long term users of MAGIX Page & Layout Designer 2013 will notice that the 
space bar no longer acts as a temporary Select Tool. This was changed to get a 
greater workflow compatibility with Adobe software and MAGIX Photo Designer 7 
will be used to having the space bar be used as a temporary Push Tool (although we 
believe the mouse button short cut is much better and is a more standard Windows 
shortcut— see note above). 

Long-term users can quickly reconfigure the Spacebar to activate the Selector tool, 
and restore several other back-compatible key shortcuts, by clicking the "CLASSIC 
KEYS" button. Note that this will reset all your current shortcuts and so we 
recommend that you save your current set first by using the "SAVE..." option. 
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